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1. What is DriveWindow 
DriveWindow is an easy-to-use 32 bit Windows Application for commissioning and maintaining ABB 
premium drives equipped with fiber optic communication. DriveWindow provides the commissioning 
personnel with a powerful tool, which provides also remote connection possibility. 
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1.1.1 Highlights 

• Good for ACS600, ACS800, ACS6000, and DCS600 drives 
• Basic ACS880 support1) 
• Working simultaneously with multiple drives like master and slave drives 
• Uses DDCS communication protocol2) 
• Signal monitoring in numerical and graphical format 
• Working with drive parameters 
• Remote connection via LAN, intranet 
• Views the actual status of the connected drive 
• Graphical trending 
• Data logger(s) functions3) 
• Fault logger functions 
• Complete backup, which makes it possible to make a spare part board at site2) 
• 32-bit Win 2000/XP/Vista/7/8 or 64-bit4) Win Vista/7/8 

1) Requires that you have the DriveDA OPC server (included in Drive composer pro) installed. 
2) Not available for ACS880. 
3) Limited support for ACS880. 
4) NDPA-02 PCMCIA-board is not supported. 

1.1.2 What is DriveWindow? 

• OPC based commissioning and maintenance tool 
• Including DriveOPC (OPC server for DDCS-network) 
• Tool for remote connections (installation in both ends) 
• 32-bit operating system Windows 2000, Windows XP, Windows Vista, Windows 7, or 

Windows 8 
• 64-bit operating system1) Windows Vista, Windows 7, or Windows 8 
• Fully 32-bit code 

1) NDPA-02 PCMCIA-board is not supported. 

1.1.3 DriveWindow features: 

• DriveWindow uses DDCS communication and 
• DDCS/UDP to communicate via intranet with NETA-21 connected to DDCS drives 
• Remote use via intranet is possible (all functions included) 
• Modern user interface 
• Full access to all DDCS drives 
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1.1.4 DriveWindow functions: 

• Control operations (start, stop, references, etc.) 
• Monitoring (signals) 
• Parameters (changing values) 
• Datalogger (controls, display) 1) 
• Fault Logger (display faults, controls) 
• Back-up & Restore (complete software back-up) 2) 
• All functions over network (control, monitoring, etc.) 

1) Limited support for ACS880. 
2) Not available for ACS880. 

1.1.5 Required DriveWindow hardware: 

• PCMCIA-board1) (PCMCIA-slot or PCI-slot with PCI/PCMCIA adapter), or 
• RUSB-02 USB/DDCS adapter, or 
• NETA-21 Remote Monitoring Device with DDCS/UDP gateway enabled 
• Network adapter when using remote connection or NETA-21 
• DDCS cabling 

1) 32-bit operating systems only. 

1.1.6 DriveWindow supports: 

• Maximum 1000 DDCS channels 

1.1.7 DDCS network topology: 

• Ring, or 
• Tree (with optical distributors) 

1.1.8 Supported no more: 

• Windows NT 

• NISA-03 board 

Since DriveWindow version 2.30 Windows NT and NISA-03 board are not supported. However, if your 
operating system is Windows NT or you are using a NISA-03 board, you can install DriveWindow 2.22 
from the same installation CD. The old version is just not in the root but in the root folder  “NT & NISA-
03 Version (2.22)”. 

See Also: Local and Remote Use 
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2. Hardware and Software Requirements 

2.1.1 Computer 

• IBM compatible PC 
• Pentium 150 MHz or a faster processor recommended 
• 64 MB RAM 
• At least 100 MB free hard disk space 
• CD drive 
• Free USB-port or free PCI1) or PCMCIA-slot1) 
• Port 61332 open for UDP traffic in the firewall (if any) for communicating with NETA-21   

1) 32-bit operating systems only. 

The PCI slot can be used only for PCI/PCMCIA adapter. 

2.1.2 DDCS Communication 

• NDPA-02 PCMCIA-board1) (PCMCIA-slot or PCI-slot with PCI/PCMCIA adapter), or 
• RUSB-02 USB/DDCS adapter, or 
• NETA-21 Remote Monitoring Device with DDCS/UDP gateway enabled 
• DDCS cabling 
• Network adapter when using remote connection or NETA-21 

1) 32-bit operating systems only. 

If DriveWindow is used only as a remote client or uses NETA-21 devices only, just the network adapter 
is required. 

2.1.3 Software 

• Win 2000, or 
• 32-bit Win XP, or 
• 32-bit Win Vista, or 
• 64-bit Win Vista1), or 
• 32-bit Win 7, or 
• 64-bit Win 71), or 
• 32-bit Win 8, or 
• 64-bit Win 81) 
• Internet Explorer 6 (or newer) for printing 
• Windows Installer 2.0 (or newer) for installing 

1) NDPA-02 PCMCIA-board is not supported. 

2.1.4  Win 2000/XP/Vista/8 

This documentation is made for Windows 7 with Windows Classic personalization. There are some 
minor differences in the outlook of the user interface, when DriveWindow is run under Win 
2000/XP/Vista/8. Some instructions, which do not concern DriveWindow directly, but use of other 
programs, may differ much more, especially in details. 

See Also: Limitations 
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3. Installing and Uninstalling 
More information can be found in the documents README.pdf (or ReadMe.htm). It resides in the root 
folder of the installation CD. After installing DriveWindow, the document can be found also in the 
DriveWindow installation folder. 

3.1.1 Determining Current DriveWindow Version 

The version of currently installed DriveWindow can be determined by selecting About Command in the 
Help menu. 

 

The About DriveWindow dialog box containing the DriveWindow version is shown. 

 

3.1.2 Installing 

Please read carefully the licence agreement (Licence.pdf or Licence.htm) before installing 
DriveWindow. 

You should quit all applications before starting the installation. We recommend that you uninstall all 
previous versions of DriveWindow 2 or DriveOPC before installing. It is not necessary to uninstall 
DriveWindow 1.x. You can still use DriveWindow 1.x, as long as you do not use DriveWindow 2 and 
1.x simultaneously.  

Note! You must have Administrator privileges to be able to do the installing. 

Your PC may be configured in such a way that when you insert the DriveWindow installation CD into 
your CD drive, installation starts automatically. 
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However, it may be that Windows Autoplay starts instead of starting the installation at once. If so, 
please select Run setup.exe to start installing.  

 

Otherwise, if installation does not start automatically, you can start the setup program from the 
Windows Explorer. Just start the Windows Explorer, browse to the root of the DriveWindow installation 
CD, and double click setup.exe. 

 

Anyway, UAC (User Access Control) may ask your permission to allow the setup program to make 
changes to your computer. Click Yes to allow the installation. 
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Installation starts. 

 

Answer the questions and follow the instructions given by the installation program. 

3.1.3 Installing and Uninstalling Hardware 

The RUSB-02 USB/DDCS adapter uses the Microsoft HID driver. It is thus installed by just connecting 
it to a USB-port. 

We recommend that you install DriveWindow before installing any other hardware. 

DriveWindow includes a plug and play driver for NDPA-02 DDCS/PCMCIA. The driver is copied into 
the hard disk when DriveWindow is installed. 

Note! There is no 64-bit driver for NDPA-02 DDCS/PCMCIA. It means that it can be used in 32-bit 
operating systems. Because of limitations of XP Mode, it cannot be used in XP Mode either. 

The Windows plug and play system starts installing the driver the first time a NDPA-02 DDCS/PCMCIA 
board is found in a PCMCIA slot. 

Note! You must have Administrator privileges to be able to finish the driver installation. 

We recommend that you install DriveWindow before the NDPA-02 DDCS/PCMCIA board. If you do it 
the other way round, the driver is not available at a proper place. It means that the driver installation 
either fails at that moment, or Windows tells that the driver is not working properly. 

DriveWindow 2.40 supports practically unlimited number of NDPA-02 DDCS/PCMCIA boards (under 
32-bit operating systems). 
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NETA-21 Remote Monitoring Device uses Ethernet and no specific drivers in are required for it in 
addition to the normal network communication software. However, NETA-21 itself has to be 
configured. At least the DDCS gateway has to be enabled. Also, you need to configure the DDCS/UDP 
properties by editing DDCS/UDP configurations in DriveWindow. 

Please read README.pdf (or ReadMe.htm) for further details, especially about installing and 
uninstalling the plug and play driver. 

3.1.4 Uninstalling DriveWindow 

Note! If DriveWindow is the last installed application, which uses a NDPA-02 DDCS/PCMCIA board, 
you should uninstall the plug and play driver before uninstalling DriveWindow. Please read 
README.pdf (or ReadMe.htm) for details. 

In Control Panel Items click Programs and Features. 

 

In Control Panel Programs and Features browse for DriveWindow, right click it and select Uninstall. 
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Your confirmation may be requested. 

 

UAC requests your permission to allow DriveWindow to update software on your computer. Click Yes 
to allow uninstalling. 

 

Uninstalling DriveWindow starts. 

 



General 

1-10 DriveWindow 2 

4. Local and Remote Use 

4.1.1 Local Use 

Usually DriveWindow is used locally. 

The environment consists of User, PC, Drive Communication Links, and Drive Controllers (Drives). 
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4.1.2 Remote Use 

In addition of using DriveWindow locally, it can also be used remotely (i.e., the PC operated by the user 
is connected by a network to the PC containing the drive communication links). 

Because of security risks involved in DCOM, we do not recommend using DriveOPC remotely. 

 

The environment consists of User, two PCs connected through a network, Drive Communication Links, 
and Drive Controllers (Drives). 
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You need to have DriveOPC installed in the remote PC. Note that DriveOPC is included in 
DriveWindow, so installing another DriveWindow at the remote end also installs DriveOPC. 

If installation and configuring are done properly at both ends, the remote end can be contacted by 
checking From a Remote PC (address) in the Select OPC Server dialog box shown when 
DriveWindow starts. The name or IP address of the remote end computer has to be entered into the 
field below it. Clicking OK connects DriveWindow to the OPC Server at the remote end. 

 

Configuring a computer to serve as remote end does not prevent DriveWindow to be used locally in 
that computer, too. 

4.1.3 Installing for Remote Use 

DriveWindow has to be installed at client end. At remote end you can either install DriveWindow or 
DriveOPC. 

At the client end there is no need for communication boards if the client end uses DriveWindow only 
remotely. 

At the remote end DriveWindow or some other OPC client program has to be started locally after the 
installation to check the proper installation of the drive communication boards. 

See Also: OPC Server 
Advanced Information 

 

5. On-line Help 
DriveWindow includes a comprehensive on-line help. Actually, the user manual and on-line help 
contain the same information. 

5.1.1  Win 2000/XP/Vista/8 

On-line help is made for Windows 7 with Windows Classic personalization. There are some minor 
differences in the outlook of the user interface, when DriveWindow is run under Win 2000/XP/Vista/8. 
Some instructions, which do not concern DriveWindow directly, but use of other programs, may differ 
much more, especially in details. 
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5.1.2 Opening Help 

To open help, select the Contents command in the Help menu. 

 

The home page of the DriveWindow htmlhelp is shown. In htmlhelp you can select to view the content, 
view the index, or search for specific words. 

 

5.1.3 Context Sensitive Help 

To get help about command on a menu or submenu, use the arrow keys to highlight the command, 
and press F1. 

Another method is to first press Shift+F1, while no menu is dropped-down. While a question mark is 
attached to the mouse pointer, open a menu or submenu and click the command, about which you 
want to get help. 

You can start the Windows help program also by pressing the shortcut key F1. Help program jumps 
directly inside DriveWindow help. 

To get help about command on a menu or submenu, use the arrow keys to highlight the command, 
and press F1. 

If you do not have any dialog or message box open, you can do the same by first pressing the shortcut 
key Shift+F1. This causes DriveWindow to enter “help mode”, which is indicated by a question mark 
attached to the mouse pointer. 
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When in “help mode”, point and click the object, about which you want to get information. This starts 
the help program and also leaves the “help mode”. If you want to leave the “help mode” without getting 
help, press the Esc key, or switch away from DriveWindow and back again. 

To get help about a dialog box, press F1 while the dialog box is displayed. 

If there is no specific topic associated with an object, about which you requested help by using F1 or 
Shift+F1, htmlhelp umps to the home page of the DriveWindow help. 

There are links within the on-line help. When you click an underlined blue or purple text, htmlhelp 
jumps to the topic linked with the text. You can get back by clicking the Back button. 

 



General 

DriveWindow 2 1-15 

 

5.1.4 Help Structure 

In addition to the main contents, DriveWindow on-line help consists of the following parts: 

• General contains general information. 
• User Interface explains in detail different parts of the user interface 
• Workspace and Preferences tells, how to use workspaces and what are preferences. 
• Parameters, Signals, and Faults explains, how to work with drive parameters. 
• Controlling Drives tells, how to control a drive with DriveWindow 
• Trends explains, how to use the monitor and dataloggers. 
• OPC Server tells, how to use an OPC Server with DriveWindow. 
• System Software tells, how to backup, restore and download System Software. 
• Miscellaneous contains miscellaneous information. 
• Advanced Information contains information useful for experts. 

Each part is organized as a separate “book”. It always starts with the contents of the part. The topics 
are ordered, so it is possible to browse to next or previous topic in the DriveWindow htmlhelp. 
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5.1.5 Help Index 

To find a topic or topics associated with a keyboard, select the Index tab, start typing in the keyword 
until you see it in the list, and click the Display button. 

 

If there are several topics associated with the keyword, a list of the topics found is displayed. Select the 
topic you are interested in and click the Display button. 
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The topic is shown on the right. 

 

5.1.6 Searching Help 

To find a topic or topics associated with a word, select the Search tab, type in the word to find, and 
click the List Topics button. 

 



General 

1-18 DriveWindow 2 

. Select the topic you are interested in and click the Display button. 

 

The topic is shown on the right. 
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The word found is highlighted within the topic. If you want to, you can disable highlighting in Options 
menu. 

 

In the Contents tab you can always see the location of the current topic within the help structure. 
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5.1.7 Printing Help 

To print a help topic, click the Print button. A dialog box is shown allowing you to either print only the 
currently shown topic or the selected heading with all of its subtopics. 

 

See Also: Help Menu 
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1. Overview 

 

The user interface consists of the following parts: 

1. Title bar 
2. Menu bar 
3. Toolbars 
4. Status bar 
5. Window area 
6. Within the windows, scrollbars are shown, if scrolling is possible 

Toolbars and status bar can individually be hidden by user. 

User can also move toolbars into different locations. 

User can resize the non-maximized window by dragging any of the sides or corners. 

2. Title Bar 
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The title bar is located along the top of a window. It consists of the following parts: 

1. System menu button 
2. Application name (DriveWindow) 
3. Network (OPC) server and remote location 
4. Name of the drive or open parameter file currently selected in the browse tree pane 
5. Minimize button, same as Minimize in the System menu. Reduces the window to an icon  
6. Maximize/restore button (depends on current maximize status of the window), same as 

Maximize or Restore in the System menu. 
7. Close button, same as Close in the System menu. 

To move the window, drag the title bar. You can also move dialog boxes by dragging their title bars. 
Note that a maximized window cannot be moved. 

Maximize of the maximize/restore button enlarges the window to fill the available space. 

Restore of the maximize/restore button returns the window to its size and position before you chose 
maximize. 

You can also do maximizing/restoring by double-clicking the title bar. 

Clicking close button ends your DriveWindow session. DriveWindow possibly warns you about 
releasing control, prompts you to save documents with unsaved changes, or reminds you about 
unfinished printing. 

You can close DriveWindow also by double-clicking the system menu button, by selecting Exit 
command in the File menu, by selecting Close from the System menu, or by pressing the shortcut key 
Alt+F4. 

You can open the System Menu by left- or right-clicking the system menu button, by pressing the 
shortcut key Alt+Spacebar, or by right-clicking within the non-button area of the title bar. 

See Also: System Menu 
Overview 

3. Menu Bar 

 

The menu bar is located immediately below the title bar. It contains the following main menus: 

• File 
• Edit 
• View 
• Network 
• Drive 
• Desktop 
• Monitor 
• Datalogger 
• Help 

To open (drop-down) a menu, click its name on the menu bar. You can also use the key underlined in 
the menu name, with Alt key down, to open a menu. For example, Alt+F opens the File menu. 
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To execute a command or display a submenu from a menu (or submenu), click its name on the menu. 
You can also use the arrow keys to navigate within the menu bar, menus, and submenus. The 
highlighted command is executed or submenu is displayed by pressing Enter. Pressing Esc key closes 
the menu or submenu. You can also use the key underlined in the command or submenu name to 
execute a command or display a submenu. For example, pressing X, while the File menu is displayed, 
executes Exit. 

To get help about command on a menu or submenu, use the arrow keys to highlight the command, 
and press F1. Another method is to first press Shift+F1, while no menu is displayed. While a question 
mark is attached to the mouse pointer, open a menu or submenu and click the command, about which 
you want to get help. 

Note! Shortcut keys other than F1 do not work while a menu is dropped-down. 

See Also: Context Menus 
System Menu 
Overview 
Help Menu 

3.1 File Menu 

The File menu is located in the menu bar. 

 

Note! The Print dialog is modeless, which means that you can continue doing other actions with 
DriveWindow while the dialog exists. However, we recommend that you finish with the dialog 
before continuing. Especially, quitting DriveWindow while the Print dialog still exists may cause 
complications that can be solved only by logging off. 

The menu contains the following commands and submenus: 

• Workspace submenu. Contains commands for handling workspace. 
• Parameters submenu. Contains commands and submenus for handling parameters. 
• System Software submenu. Contains commands and submenus for handing system 

software. 
• Graph submenu. Contains commands to print, copy, or export the current graph. 
• Status Refresh command, same as status refresh on/off button in the standard toolbar. 

Toggles the drive status display on-line/off-line in the browse tree pane. 
• Exit command (shortcut key is Alt+F4), same as Close command in the System menu, close 

button in the title bar, or double-clicking the system menu button in the title bar. Ends your 
DriveWindow session. DriveWindow possibly warns you about releasing control, prompts you 
to save documents with unsaved changes, or reminds you about unfinished printing. 

See Also: Submenus 
Context Menus 
Menu Bar 
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3.2 Edit Menu 

The Edit menu is located in the menu bar. 

 

The menu contains the following commands: 

• Cut, same as cut items button in the standard toolbar (shortcut keys are Ctrl+X or Shift+Del). 
Action depends on the pane, which has the focus. If item set pane has focus, selected items 
or templates are first copied to the clipboard and then deleted from the pane. If the trend 
settings pane has focus, the selected channels and/or triggering variable are first copied to 
the clipboard and then cleared. The command can be found also in several context menus. 

• Copy, same as copy items button in the standard toolbar (shortcut keys are Ctrl+C or 
Ctrl+Ins). Action depends on the pane, which has the focus. If item set pane has focus, 
selected items or templates are copied to the clipboard. If the trend settings pane has focus, 
the selected channels and/or triggering variable are copied to the clipboard. The command 
can be found also in several context menus. 

• Paste, same as paste button in the standard toolbar (shortcut key is Ctrl+V or Shift+Ins). 
Action depends on the pane, which has the focus. If an item set of type browsed, all 
parameters, or user defined in the item set pane has focus, items or templates are pasted 
from the clipboard. If the trend settings pane has focus, the items in the clipboard are pasted 
into free channels. If browse tree pane has focus, parameter values in the selected drive or 
open parameter file are changed by pasting the new values from the clipboard. However, if a 
drive is selected and a parameter file has copied into the clipboard by Windows Explorer, the 
parameters in the file are downloaded to the drive. 

• Delete, same as delete button in the standard toolbar (shortcut key is Del). Action depends on 
the pane, which has the focus. If browse tree pane has focus, deletes the selected parameter 
group or all parameters are deleted from the file. If an item set of type browsed, all 
parameters, or user defines in the item set pane has focus, selected items or templates are 
deleted from the item set. If the trend settings pane has focus, the selected channels and/or 
triggering variable are cleared. The command can be found also in several context menus. 

• Copy Graph, same as Copy in the Graph submenu of the File menu. Copies the graph into 
the clipboard in graphical format. 

See Also: Context Menus 
Menu Bar 
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3.3 View Menu 

The View menu is located in the menu bar. 

 

The menu contains the following commands and submenus: 

• Toolbars submenu. Contains toggles for showing or hiding toolbars. 
• Status Bar toggle. Displays or hides the status bar. 
• Zoom In toggle, same as zoom in graph button in the standard toolbar (shortcut key is 

Ctrl+Shift+Z). Puts the trend display pane into zoom-in mode, which allows the user to select 
the zoom-in area. The command can be found also in context menu of Monitor Display and in 
context menu of Datalogger Display. 

• Zoom Out command, same as zoom out graph button in the standard toolbar. Restores the 
trend settings to the values they had before last zoom-in was done. The command can be 
found also in context menu of Monitor Display and in context menu of Datalogger Display. 

• Zoom Reset command, same as reset graph zoom button in the standard toolbar. Restores 
the trend settings to the values they had before the first zoom-in was done. The command 
can be found also in context menu of Monitor Display and in context menu of Datalogger 
Display. 

• Graph Cursor. Presents a Graph Cursor dialog box, which allows the user to control, which 
numerical values are shown with the graph cursor and whether the values are shown scaled 
or not. The command can be found also in Graph Submenu, in context menu of Monitor 
Display, and in context menu of Datalogger Display. 

• Change Format command (shortcut key is F3). Presents a dialog box, in which the user can 
temporarily change display format of the values of the selected items in the item set, or 
numerical values shown with the graph cursor of the selected channels in the trend display 
pane. The command can be found also in context menu of Items and in context menu of 
Monitor Settings. 

• Templates/Items command. The status of displaying templates or items in all user item sets is 
toggled. The command can be found also in context menu of Item Set. 

See Also: Submenus 
Context Menus 
Context Menu of Items 
Context Menu of Monitor Settings 
Context Menu of Item Set 
Menu Bar 
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3.4 Network Menu 

The Network menu is located in the menu bar. 

 

The menu contains the following OPC Server handling commands: 

• Network Servers (shortcut key is Ctrl+N). Presents a Select OPC Server dialog box and 
connects to the selected server, which can also reside in a remote PC. The command can be 
found also in context menu of the Empty Browse Tree Pane if DriveWindow is not connected 
to a server. 

• Disconnect Server (shortcut key is Ctrl+Shift+N). Disconnects the currently connected OPC 
Server. The command can be found also in context menu of the Empty Browse Tree Pane if 
DriveWindow is connected to a server but there is no drive. 

• Network Server Status. Shows information about the server in a OPC Server Status dialog 
box. 

• Configure submenu. Contains commands for configuring DDCS/UDP and SAP/http 
communication protocols. 

Note that the Select OPC Server dialog box is also shown when DriveWindow is started. If cancel is 
clicked in the dialog box, DriveWindow is left unconnected. 

See Also: Context Menu of Empty Browse Tree 
Submenus 
Menu Bar 

3.5 Drive Menu 

The Drive menu is located in the menu bar. 
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The menu contains the following drive handling commands: 

• Take Control/Release Control, same as take/release control button in the Drive Panel toolbar 
(shortcut key is Alt+F2). Toggles the control status of the drive, which is selected from the 
browse tree pane. Note that it is possible to control at most one drive at a time. Toggling the 
control status changes the menu text. The command can be found also in context menu of 
Drive. 

• Clear Faultlogger, same as clear faultlogger button in the Drive Panel toolbar. Sends fault 
logger clearing command to the currently selected drive. The command can be found also in 
context menu of Drive. 

• Reset Fault, same as reset fault button in the Drive Panel toolbar (shortcut key is Alt+F8). 
Sends fault reset command to the currently controlled drive. 

• Start, same as start button in the Drive Panel toolbar (shortcut key is Shift+F9). Sends start 
command to the currently controlled drive. 

• Stop, same as stop button in the Drive Panel toolbar (shortcut key is Shift+F10). Sends stop 
command to the currently controlled drive. 

• Reverse, same as reverse button in the Drive Panel toolbar (shortcut key is Ctrl+F5). Sends 
reverse command to the currently controlled AC drive. 

• Forward, same as forward button in the Drive Panel toolbar (shortcut key is Ctrl+F6). Sends 
forward command to the currently controlled AC drive. 

• Coast Stop, same as coast stop button in the Drive Panel toolbar (shortcut key is Ctrl+F4). 
Sends coast stop command to the currently controlled drive. 

• On, same as close contactor button in the Drive Panel toolbar (shortcut key is Ctrl+F5). Sends 
contactor close command to the currently controlled DC drive. 

• Off, same as open contactor button in the Drive Panel toolbar (shortcut key is Ctrl+F6). Sends 
contactor open command to the currently controlled DC drive. 

• Step Settings. Presents a Step Settings dialog box, which allows the user to define properties 
of a step. 

• Step Start/Step Reset, same as start/end step button in the Drive Panel toolbar. Starts or 
ends a step in the reference value of the drive, control of which is taken. 

No drive type has all commands available. If the drive under control does not have a command 
available, the corresponding command is disabled (grayed) in the menu. 

AC and DC drives reuse some menu positions for different commands, which do not exist in the other 
type of drive. The buttons shown in the Drive Panel toolbar are changed correspondingly. 
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See Also: Context Menus 
Context Menu of Drive  
Menu Bar 

3.6 Desktop Menu 

The Desktop menu is located in the menu bar. 

 

The menu contains the following submenu and commands: 

• Item Set submenu. Contains commands and submenus for working with item sets. 
• Add New Item command, same as add item button in the standard toolbar (shortcut key is 

Ctrl+A). In the browsed item set presents an Add Item to Desktop dialog box and adds the 
item, OPC Address of which is given, into the item set. The item is named by the user. In user 
item sets presents an Add New Template dialog box and adds the template, properties of 
which are given, into the item set. The command can be found also in context menu of Item 
Set. 

• Item Properties command. If an item is selected, presents an Item Properties dialog box, 
which allows the user to view properties of the item. If a template is selected, presents a 
Template Properties dialog box, which allows user to view and change properties of the 
template. The command can be found also in context menu of Items. 

• Lock/Unlock Items command, same as lock/unlock items button in the standard toolbar. The 
locking status of the selected items in the browsed item set is toggled. When an item is 
locked (pinned), it stays visible in the item set even if selection in the browse tree is changed. 
An unlocked item disappears from the item set when the selection changes. Note that 
monitoring also locks the items monitored. Unlocking an item does not remove it from the 
item set, but the next selection change in the browse tree pane does. The command can be 
found also in context menu of Items. 

• Update Items command, same as update items button in the standard toolbar. Values of the 
selected items in an item set are read and updated. If an item set of type faults, events, all 
faults, or all events is displayed in the item sets pane, the command concerns all faults or 
events of the item set. In this case the command is enabled only if there is nothing selected or 
only the description selected. The command can be found also in context menu of Items. 

• Put Items Online/Offline command, same as activate/deactivate items button in the standard 
toolbar. Toggles the on-line status of the items, which are selected in an item set on-line/off-
line. Values of items, which are on-line, are periodically refreshed in the item set. The 
command can be found also in context menu of Items. 

• Change Item Value command, same as change value button in the standard toolbar, or 
double-clicking a writable item in an item set. Presents a dialog box, in which the user enters 
a new value for the item selected, and changes the value. The command can be found also in 
context menu of Items. 
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• Preferences command. Presents Desktop Preferences dialog box, which allows user to set 
the default values of item set properties. Panel format usage selection affects also printing of 
parameters and graph cursor values shown in the trend pane. The command can be found 
also in context menu of Item Set and in context menu of Faults and Events. 

See Also: Submenus 
Context Menus 
Context Menu of Items 
Context Menu of Item Set 
Context Menu of Faults and Events 
Menu Bar 

3.7 Monitor Menu 

The Monitor menu is located in the menu bar. Commands in the Monitor menu are enabled only if 
Monitor is selected in the trend settings pane. 

 

The menu contains the following monitor handling commands and submenus: 

• Add/Remove Items command, same as add monitored items button in the monitor toolbar. 
Toggles the monitoring status of the selected items in the browsed item set. A monitored item 
is locked in the browsed item set. 

• Set Variable submenu. For each channel, allows the user to view and change the item, which 
is monitored. 

• Change Drive command. The drive of the selected (or all, if none selected) monitored items in 
the browsed item set is changed. The new drive is the one selected in the browse tree pane. 
The command can be found also in context menu of Monitor Settings. 

• Start command or Continue command, if monitor is paused, same as start or continue 
monitoring button in the monitor toolbar (shortcut key is Ctrl+M). Starts or continues 
monitoring. The command can be found also in context menu of Monitor Display. 

• Stop monitoring command, same as Stop button in the monitor toolbar (shortcut key is 
Ctrl+Shift+M). Stops monitoring. Monitor must be cleared before it can be started again. The 
command can be found also in context menu of Monitor Display. 

• Pause command, same as pause monitoring button in the monitor toolbar (shortcut key is 
Ctrl+Shift+P). The monitored items are still measured, but the display freezes until monitoring 
is continued. The command can be found also in context menu of Monitor Display. 



User Interface 

2-12 DriveWindow 2 

• Clear command, same as clear monitor button in the monitor toolbar. Resets the monitor. The 
command can be found also in context menu of Monitor Display. 

• Fast Mode toggle, same as double clicking Mode in monitor settings. Toggles between fast 
and normal mode of monitoring. The command can be found also in context menu of Monitor 
Settings. 

• Interval command, same as double-clicking Interval in monitor settings. Presents an Interval 
dialog box, where you can change the monitoring interval. The command can be found also in 
context menu of Monitor Settings. 

• History Buffer command, same as double-clicking History Buffer in monitor settings. Presents 
a History Buffer dialog box, where you can change the size of the monitor history buffer, i.e., 
how much data is remembered by the monitor. The command can be found also in context 
menu of Monitor Settings. 

• Axis submenu. Allows the user to view and change current settings of monitor axes. 
• Scaling submenu. For each channel, allows the user to view and change scaling values of the 

monitor. 
• Restore Defaults command. Restores monitor default settings. However, which settings are 

restored, depend on monitoring status. The command can be found also in context menu of 
Monitor Settings and in context menu of Monitor Display. 

See Also: Submenus 
Context Menus 
Context Menu of Monitor Settings 
Context Menu of Monitor Display 
Menu Bar 
Common Trend Settings 
Setting Monitor 

3.8 Datalogger Menu 

The Datalogger menu is located in the menu bar. Commands in the Datalogger menu are enabled only 
if Datalogger is selected in the trend settings pane. 

 or 
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The menu contains the following datalogger handling commands and submenus: 

• Datalogger 2 toggle or Next Datalogger, if the current drive has more than two dataloggers. 
Toggles the current datalogger selection in case the current drive has two dataloggers. Moves 
the current datalogger to the next datalogger (or first, if current is last) in case the current 
drive has more than two dataloggers. Current datalogger can also be selected from the 
browse tree pane by clicking the Datalogger in the browse tree. The command can be found 
also in context menu of Datalogger Display. 

• Add/Remove Items command, same as add/remove datalogger items button in the logger 
toolbar. Toggles the logging status of those selected items in the item set pane, which reside 
in the same drive as the current datalogger. A logged item is not locked in the browsed item 
set as monitored items are. The name of a logged item is taken from the drive, when it is 
displayed in the datalogger settings or in printings. 

• Set Variable submenu. For each channel, allows the user to view and change the item, which 
is logged. 

• Upload command, same as upload datalogger button in the logger toolbar. Uploads values of 
the currently selected datalogger and displays them as trends in the trend display pane. The 
current datalogger settings are frozen, so that they show the uploaded values for the logger, 
even if the settings in the drive change. The command can be found also in context menu of 
Datalogger Display. 

• Start, same as start datalogger button in the logger toolbar. Sends start command to the 
currently selected datalogger. The command can be found also in context menu of 
Datalogger Display. 

• Stop command, same as stop datalogger button in the logger toolbar. Sends stop command 
to the currently selected datalogger. The command can be found also in context menu of 
Datalogger Display. 

• Trig command, same as trig datalogger button in the logger toolbar. Sends trigger command 
(user trigged) to the currently selected datalogger. The command can be found also in context 
menu of Datalogger Display. 

• Clear command, same as clear drive datalogger button in the logger toolbar. Sends clear 
command to the currently selected datalogger. The command can be found also in context 
menu of Datalogger Display. 
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• Clear Graph command, same as clear datalogger graph button in the logger toolbar. Clears 
the uploaded values of currently selected datalogger and the trends in the trend display pane. 
The settings for the datalogger are unfrozen. The command can be found also in context 
menu of Datalogger Display. 

• Status Refresh toggle, same as double-clicking Status (or Trigged by, if current datalogger 
has not been uploaded) in datalogger settings. Toggles Status (and Triggered by, if current 
datalogger has not been uploaded) display on-line/off-line in the datalogger settings pane. 
The command can be found also in context menu of Datalogger Settings. 

• Interval command, same as double-clicking Interval in datalogger settings. Presents an 
Interval dialog box, where you can change the logging interval of the current datalogger. The 
command can be found also in context menu of Datalogger Settings. 

• Trig Settings submenu. Allows the user to view and change triggering settings of the current 
datalogger. 

• Axis submenu. Allows the user to view and change current settings of axes of the current 
monitor. 

• Scaling submenu. For each channel, allows the user to view and change scaling values of the 
current datalogger. 

• Restore Defaults command. Restores datalogger default settings. However, which settings 
are restored, depend on, whether the datalogger is uploaded or not. The command can be 
found also in context menu of Datalogger Settings and in context menu of Datalogger Display. 

See Also: Submenus 
Context Menus 
Context Menu of Datalogger Settings 
Context Menu of Datalogger Display 
Menu Bar 
Common Trend Settings 
Setting Datalogger 
 

3.9 Help Menu 

The Help menu is located in the menu bar. 

 

The menu contains the following commands: 

• Contents. Starts the windows help program presenting DriveWindow help content/index/find. 
• About. Presents the About DriveWindow dialog box, which contains version and copyright 

information about DriveWindow. 

You can start the window help program also by pressing the shortcut key F1. Help program jumps 
directly inside DriveWindow help. 

If you do not have any dialog or message box open, you can do the same by first pressing the shortcut 
key Shift+F1. This causes DriveWindow to enter “help mode”, which is indicated by a question mark 
attached to the mouse pointer. 
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When in “help mode”, point and click the object, about which you want to get information. This starts 
the help program and also leaves the “help mode”. If you want to leave the “help mode” without getting 
help, press the Esc key, or switch away from DriveWindow and back again. 

See Also: Menu Bar 

4. System Menu 
The System Menu is not located in the menu bar. You can open the System Menu by left- or right-
clicking the system menu button in the title bar, by pressing the shortcut key Alt+Spacebar, or right-
clicking within the non-button area of the title bar. 

 

Many dialog boxes also have simple system menus. You can open their System Menu by right-clicking 
within the non-button area of their title bar, or by pressing the shortcut key Alt+Spacebar. 

 

The menu contains the following commands: 

• Restore, same as the maximize/restore button in the title bar, when the window is maximized. 
Returns the window to its size and position before you chose maximize. 

• Move, similar to dragging the title bar. After selecting the command, it is possible to move the 
window with the arrow keys. To finish the move, press Enter. To cancel the move, press Esc. 

• Size, similar to dragging any of the sides or corners of the window. After selecting the 
command, it is possible to resize the window with the arrow keys. To finish resizing, press 
Enter. To cancel resizing, press Esc. 

• Minimize, same as minimize button in the title bar. Reduces the window to an icon  
• Maximize, same as the maximize/restore button in the title bar, when the window is not 

maximized. Enlarges the window to fill the available space. 
• Close, same as close button in the title bar. Ends your DriveWindow session. DriveWindow 

possibly warns you about releasing control, prompts you to save documents with unsaved 
changes, or reminds you about unfinished printing. 

Note that a maximized window cannot be moved or resized. 

You can also do maximizing/restoring by double-clicking the title bar. 

You can close DriveWindow also by double-clicking the system menu button, by selecting Exit 
command in the File menu, by selecting Close from the System menu, or by pressing the shortcut key 
Alt+F4. 

See Also: Menu Bar 
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5. Context Menus 
Context menus are menus that may appear at the cursor, when you right-click within the window area 
of DriveWindow. They are meant for a quicker access to some common commands. 

The particular menu that appears depends on status of DriveWindow and on the point you clicked. 

All the commands in context menus can be found also within normal menu bar menus, although some 
of them may have been renamed. 

To execute a command or display a submenu from a context menu (or its submenu), click the name of 
the command or submenu on the menu. You can also use the arrow keys to navigate within the menu 
and submenus. The highlighted command is executed or submenu is displayed by pressing Enter. 
Pressing Esc key closes the menu or submenu. You can also use the key underlined in the command 
or submenu name to execute a command or display a submenu.. 

To get help about command on a menu or submenu, use the arrow keys to highlight the command, 
and press F1. 

Note! Shortcut keys other than F1 do not work while a context menu is shown. 

DriveWindow has context menus for: 

• The empty browse tree pane. 
• An open parameter file in the browse tree pane. 
• A drive in the browse tree pane. 
• Items in item sets of type browsed, all parameters, and user. 
• Outside items in item sets of type browsed, all parameters, and user. 
• Item sets of type faults, events, all faults, and all events. 
• Monitor settings of the trend settings pane. 
• Datalogger settings of the trend settings pane. 
• Monitor display when DriveWindow is not connected to an OPC Server or datalogger display 

when a datalogger is not available. 
• Monitor display when DriveWindow connected to an OPC Server. 
• Datalogger display when a datalogger is available. 

See Also: Menu Bar 
System Menu 
Overview 
Help Menu 

5.1 Context Menu of Empty Browse Tree 

The context menu appears at the cursor when you right-click the browse tree pane when the pane is 
empty. 
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Note that the browse tree pane is empty only if you have no parameter file open and either 
DriveWindow is not connected to an OPC Server or there is no drive present. 

The context menu has two variants depending on, whether DriveWindow is connected to an OPC 
Server or not. 

  (not connected), or 

 (connected, but no drive present) 

The menus contain the following commands and submenus. The commands can be found also in 
Network Menu. 

• Network Servers (shortcut key is Ctrl+N). Presents a Select OPC Server dialog box and 
connects to the selected server, which can also reside in a remote PC. 

• Disconnect Server (shortcut key is Ctrl+Shift+N). Disconnects the currently connected OPC 
Server. 

• Open submenu. Contains commands for opening various files. 

Note that the Select OPC Server dialog box is also shown when DriveWindow is started. If cancel is 
clicked in the dialog box, DriveWindow is left unconnected. 

See Also: Context Menus 
Network Menu 
Open Submenu 
Menu Bar 

5.2 Context Menu of Parameter File 

The context menu appears at the cursor when you right-click the open parameter file (or a sub-branch 
within it) in the browse tree pane. Note that DriveWindow need not to be connected to an OPC Server. 
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Note that if you right-click outside the tree within the browse tree pane, it is same as if you had right-
clicked the currently selected branch or sub-branch. 

The menu contains the following submenu and commands. The commands can be found also in Edit 
Menu. 

• Parameters submenu. Contains commands and submenus for handling parameters of the 
open parameter file. 

• Paste, same as paste button in the standard toolbar (shortcut key is Ctrl+V or Shift+Ins). 
Parameter values in the open parameter file are changed by pasting the new values from the 
clipboard. 

• Delete, same as delete button in the standard toolbar (shortcut key is Del). If you right-clicked 
the open parameter file, the file is closed. If you right-clicked the Parameters sub-branch, all 
parameter groups are deleted from the file. If you right-clicked a parameter group, the 
parameter group is deleted from the file. 

See Also: Context Menus 
Parameters Submenu 
Edit Menu 
Menu Bar 

5.3 Context Menu of Drive 

The context menu appears at the cursor when you right-click a drive (or a sub-branch within it) in the 
browse tree pane. Note that DriveWindow need to be connected to an OPC Server. 

 

Note that if you right-click outside the tree within the browse tree pane, it is same as if you had right-
clicked the currently selected branch or sub-branch. 

The menu contains the following submenu and commands. The commands can be found also in Drive 
Menu except the paste command, which can be found in Edit Menu. 

• Parameters submenu. Contains commands and submenus for handling parameters of the 
drive. 

• Take Control/Release Control, same as take/release control button in the Drive Panel toolbar 
(shortcut key is Alt+F2). Toggles the control status of the drive. Note that it is possible to 
control at most one drive at a time. Toggling the control status changes the menu text. 

• Clear Faultlogger, same as clear faultlogger button in the Drive Panel toolbar. Sends fault 
logger clearing command to the drive. 

• Paste, same as paste button in the standard toolbar (shortcut key is Ctrl+V or Shift+Ins). 
Parameter values in the drive are changed by pasting the new values from the clipboard. 
However, if a parameter file has copied into the clipboard by Windows Explorer, the 
parameters in the file are downloaded to the drive. 

See Also: Context Menus 
Parameters Submenu 
Drive Menu  
Edit Menu 
Menu Bar 
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5.4 Context Menu of Items 

The context menu appears at the cursor when you right-click the name of an item or template in an 
item set of type browsed, all parameters, or user defined. 

 

Note that right-clicking a selected item or template retains the selection and the operation will concern 
all the selected items and templates. But, if you right-click on the name of an unselected item or 
template, all items and templates are first unselected, then the clicked item or template is selected, 
and the context menu is displayed. In this case the operation concerns only the item or template 
clicked. 

Note that if you right-click outside the name of an item or template, all items and templates are 
unselected, and the context menu of the item set is displayed. 

The menu contains the following commands. The commands can be found also in Desktop Menu, 
View Menu, Item Set submenu, or Edit Menu. 

• Item Properties command. If an item is selected, presents an Item Properties dialog box, 
which allows the user to view properties of the item. If a template is selected, presents a 
Template Properties dialog box, which allows user to view and change properties of the 
template. The command can be found also in Desktop Menu. 

• Lock/Unlock Items command, same as lock/unlock items button in the standard toolbar. The 
locking status of the selected items in the browsed item set is toggled. When an item is 
locked (pinned), it stays visible in the item set even if selection in the browse tree is changed. 
An unlocked item disappears from the item set when the selection changes. Note that 
monitoring also locks the items monitored. Unlocking an item does not remove it from the 
item set, but the next selection change in the browse tree pane does. The command can be 
found also in Desktop Menu. 

• Update Items command, same as update items button in the standard toolbar. Values of the 
selected items in the item set are read and updated. The command can be found also in 
Desktop Menu. 

• Put Items Online/Offline command, same as activate/deactivate items button in the standard 
toolbar. Toggles the on-line status of the items, which are selected in the item set on-line/off-
line. Values of items, which are on-line, are periodically refreshed in the item set. The 
command can be found also in Desktop Menu. 

• Change Item Value command, same as change value button in the standard toolbar, or 
double-clicking a writable item in an item set. Presents a dialog box, in which the user enters 
a new value for the item selected in the item set, and changes the value. The command can 
be found also in Desktop Menu. 
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• Change Format command (shortcut key is F3). Presents a dialog box, in which the user can 
temporarily change display format of the values of the selected items. The command can be 
found also in View Menu. 

• Print command. Presents a Print Comment dialog box, which, before the printing is done, 
allows the user to add a print comment and to select, whether to print all items and templates 
in the item set or just the selected ones. The command can be found also in Item Set 
submenu. 

• Cut, same as cut items button in the standard toolbar (shortcut keys are Ctrl+X or Shift+Del). 
Copies selected items or templates to the clipboard and deletes the items from the item set. 
The command can be found also in Edit Menu. 

• Copy, same as copy items button in the standard toolbar (shortcut keys are Ctrl+C or 
Ctrl+Ins). Copies selected items or templates to the clipboard. The command can be found 
also in Edit Menu. 

• Delete, same as delete button in the standard toolbar (shortcut key is Del). Deletes selected 
items or templates from the item set. The command can be found also in Edit Menu. 

See Also: Context Menus 
Item Set Submenu 
Desktop Menu 
View Menu 
Edit Menu 
Menu Bar 

5.5 Context Menu of Item Set 

The context menu described here concerns only item sets of type browsed, all parameters, and user 
defined. Other kinds of item sets (faults, events, all faults, and all events) have a context menu of their 
own. 

The context menu appears at the cursor when you right-click outside a name of any item or template in 
an item set of type browsed, all parameters, or user defined. 

 

Note that if you right-click the name of an item or template, the context menu of items is displayed. 

The menu contains the following submenu and commands. They can be found also in Desktop Menu, 
View Menu, or Edit Menu. 

• Item Set submenu. Contains commands and submenus for working with item sets. 
• Preferences command. Presents Desktop Preferences dialog box, which allows user to set 

the default values of item set properties. Panel format usage selection affects also printing of 
parameters and graph cursor values shown in the trend pane. The command can be found 
also in Desktop Menu. 

• Templates/Items command. The status of displaying templates or items in all user item sets is 
toggled. The command can be found also in View Menu. 
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• Add New Item command, same as add item button in the standard toolbar (shortcut key is 
Ctrl+A). In the browsed item set presents an Add Item to Desktop dialog box and adds the 
item, OPC Address of which is given, into the item set. The item is named by the user. In user 
item sets presents an Add New Template dialog box and adds the template, properties of 
which are given, into the item set. The command can be found also in Desktop Menu. 

• Paste, same as paste button in the standard toolbar (shortcut key is Ctrl+V or Shift+Ins). Adds 
items or templates into the item set by pasting them from the clipboard. The command can be 
found also in Edit Menu. 

See Also: Context Menus 
Item Set Submenu 
Desktop Menu 
View Menu 
Edit Menu 
Menu Bar 

5.6 Context Menu of Faults and Events 

The context menu described here concerns only item sets of type faults, events, all faults, and all 
events. Other kinds of item sets (browsed, all parameters, and user defined) have a context menu of 
their own. 

The context menu appears at the cursor when you right-click within an item set of type faults, events, 
all faults, or all events. 

 

Note that right-clicking a selected fault or event retains the selection. If you right-click on the 
description of an unselected fault or event, all fault or events are first unselected, then the clicked fault 
or event is selected. If you right-click outside the description of a fault or event, all faults and events are 
unselected. 

The menu contains the following submenu and commands. They can be found also in Desktop Menu 
or Edit Menu. 

• Item Set submenu. Contains commands and submenus for working with item sets. 
• Copy, same as copy items button in the standard toolbar (shortcut keys are Ctrl+C or 

Ctrl+Ins). Copies selected fault or events to the clipboard. The command can be found also in 
Edit Menu. 

• Preferences command. Presents Desktop Preferences dialog box, which allows user to set 
the default values of item set properties. Panel format usage selection affects also printing of 
parameters and graph cursor values shown in the trend pane. The command can be found 
also in Desktop Menu. 

See Also: Context Menus 
Item Set Submenu 
Desktop Menu 
Edit Menu 
Menu Bar 
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5.7 Context Menu of Monitor Settings 

The context menu appears at the cursor when you right-click the trend settings pane while monitor 
settings are shown and DriveWindow is connected to an OPC Server. 

 

Note that right-clicking the setting field of a selected setting retains the selection. If you right-click on 
the setting field of an unselected setting, all settings are first unselected, then the clicked setting is 
selected. If you right-click outside the settings field of a setting, all settings are unselected. 

Note that selections are meaningful only in Cut, Copy, Delete, and Change Format commands. All 
other commands ignore the selection. 

The menu contains the following submenus and commands. They can be found also in Monitor Menu, 
Edit Menu, or View Menu. 

• Set Variable submenu. For each channel, allows the user to view and change the item, which 
is monitored. 

• Change Drive command. The drive of the selected (or all, if none selected) monitored items in 
the browsed item set is changed. The new drive is the one selected in the browse tree pane. 
The command can be found also in Monitor Menu. 

• Fast Mode toggle, same as double clicking Mode in monitor settings. Toggles between fast 
and normal mode of monitoring. The command can be found also in Monitor Menu. 

• Interval command, same as double-clicking Interval in monitor settings. Presents an Interval 
dialog box, where you can change the monitoring interval. The command can be found also in 
Monitor Menu. 

• History Buffer command, same as double-clicking History Buffer in monitor settings. Presents 
a History Buffer dialog box, where you can change the size of the monitor history buffer, i.e., 
how much data is remembered by the monitor. The command can be found also in Monitor 
Menu. 

• Axis submenu. Allows the user to view and change current settings of monitor axes. 
• Scaling submenu. For each channel, allows the user to view and change scaling values of the 

monitor. 
• Restore Defaults command. Restores monitor default settings. However, which settings are 

restored, depend on monitoring status. The command can be found also in Monitor Menu. 
• Cut, same as cut items button in the standard toolbar (shortcut keys are Ctrl+X or Shift+Del). 

The selected channels are first copied to the clipboard and then cleared. The command can 
be found also in Edit Menu. 
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• Copy, same as copy items button in the standard toolbar (shortcut keys are Ctrl+C or 
Ctrl+Ins). The selected channels are copied to the clipboard. The command can be found 
also in Edit Menu. 

• Paste, same as paste button in the standard toolbar (shortcut key is Ctrl+V or Shift+Ins). The 
items in the clipboard are pasted into free channels. The command can be found also in Edit 
Menu. 

• Delete, same as delete button in the standard toolbar (shortcut key is Del). The selected 
channels are cleared. The command can be found also in Edit Menu. 

• Change Format command (shortcut key is F3). Presents a dialog box, in which the user can 
temporarily change display format of the numerical values shown with the graph cursor of the 
selected channels. The command can be found also in View Menu. 

See Also: Context Menus 
Set Variable Submenu 
Axis Submenu 
Scaling Submenu 
Monitor Menu 
Edit Menu 
View Menu 
Menu Bar 

5.8 Context Menu of Datalogger Settings 

The context menu appears at the cursor when you right-click the trend settings pane while datalogger 
settings are shown and there is an datalogger available. Note that DriveWindow must be connected to 
an OPC Server. 

 

Note that right-clicking the setting field of a selected setting retains the selection. If you right-click on 
the setting field of an unselected setting, all settings are first unselected, then the clicked setting is 
selected. If you right-click outside the settings field of a setting, all settings are unselected. 

Note that selections are meaningful only in Cut, Copy, Delete, and Change Format commands. All 
other commands ignore the selection. 

The menu contains the following submenus and commands. They can be found also in Datalogger 
Menu, Edit Menu, or View Menu. 

• Set Variable submenu. For each channel, allows the user to view and change the item, which 
is logged. 
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• Status Refresh toggle, same as double-clicking Status (or Trigged by, if current datalogger 
has not been uploaded) in datalogger settings. Toggles Status (and Triggered by, if current 
datalogger has not been uploaded) display on-line/off-line in the datalogger settings pane. 
The command can be found also in Datalogger Menu. 

• Interval command, same as double-clicking Interval in datalogger settings. Presents an 
Interval dialog box, where you can change the logging interval of the current datalogger. The 
command can be found also in Datalogger Menu. 

• Trig Settings submenu. Allows the user to view and change triggering settings of the current 
datalogger. 

• Axis submenu. Allows the user to view and change current settings of axes of the current 
monitor. 

• Scaling submenu. For each channel, allows the user to view and change scaling values of the 
current datalogger. 

• Restore Defaults command. Restores datalogger default settings. However, which settings 
are restored, depend on, whether the datalogger is uploaded or not. The command can be 
found also in Datalogger Menu. 

• Cut, same as cut items button in the standard toolbar (shortcut keys are Ctrl+X or Shift+Del). 
The selected channels and/or triggering variable are first copied to the clipboard and then 
cleared. The command can be found also in Edit Menu. 

• Copy, same as copy items button in the standard toolbar (shortcut keys are Ctrl+C or 
Ctrl+Ins). The selected channels and/or triggering variable are copied to the clipboard. The 
command can be found also in Edit Menu. 

• Paste, same as paste button in the standard toolbar (shortcut key is Ctrl+V or Shift+Ins). The 
items in the clipboard are pasted into free channels. The command can be found also in Edit 
Menu. 

• Delete, same as delete button in the standard toolbar (shortcut key is Del). The selected 
channels and/or triggering variable are cleared. The command can be found also in Edit 
Menu. 

• Change Format command (shortcut key is F3). Presents a dialog box, in which the user can 
temporarily change display format of the numerical values shown with the graph cursor of the 
selected channels. The command can be found also in View Menu. 

See Also: Context Menus 
Set Variable Submenu 
Axis Submenu 
Scaling Submenu 
Datalogger Menu 
Edit Menu 
View Menu 
Menu Bar 

5.9 Context Menu of Empty Trend Display 

The context menu appears at the cursor when you right-click the trend display pane while 
DriveWindow is not connected to an OPC Server, or if datalogger is displayed, but a datalogger is not 
available. 
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The menu contains the following commands. They can be found also in Graph Submenu, Open 
Submenu, and View Menu. 

• Open. Presents an Open dialog box for selecting the file containing the graph or graphs to be 
shown. Puts DriveWindow off-line and loads the graph(s) from the file. The command can be 
found also in Graph Submenu and Open Submenu, in which it is named Graph. 

• Graph Cursor. Presents a Graph Cursor dialog box, which allows the user to control, which 
numerical values are shown with the graph cursor and whether the values are shown scaled 
or not. The command can be found also in View Menu. 

• Preferences. Presents a Graph Preferences dialog box, which allows the user to control, how 
graphs are shown and printed. It can also be used to select, how scaling is shown and 
entered. The command can be found also in Graph Submenu. 

See Also: Context Menus 
Graph Submenu 
View Menu 
Menu Bar 

5.10 Context Menu of Monitor Display 

The context menu appears at the cursor when you right-click the trend display pane while monitor is 
displayed is shown and DriveWindow is connected to an OPC Server. 

 

The menu contains the following commands. They can be found also in various menus or submenus. 

• Open. Presents an Open dialog box for selecting the file containing the graph or graphs to be 
shown. Puts DriveWindow off-line and loads the graph(s) from the file. The command can be 
found also in Graph Submenu and Open Submenu, in which it is named Graph. 

• Save As. Presents a Save As dialog box for naming or selecting the file, into which the 
currently visible graph is saved. Saves the currently visible graph into the file. The command 
can be found also in Graph Submenu. 
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• Comment. Presents a File Comment dialog box for viewing and editing of the 
graph/workspace file comment. The command can be found also in Graph Submenu. 

• Print. Presents a Print Setup dialog box for selecting the printer and its settings.  Prints the 
graph to the selected printer. The command can be found also in Graph Submenu. 

• Export. Presents an Export Graph To File dialog box, which is a variant of a Save As dialog 
box, for naming or selecting the file, into which the graph is exported. Exports the graph into 
the file in numerical format. The command can be found also in Graph Submenu. 

• Copy Graph. Copies the graph into the clipboard in graphical format. The command can be 
found also in Edit menu. 

• Zoom In toggle, same as zoom in graph button in the standard toolbar (shortcut key is 
Ctrl+Shift+Z). Puts the trend display pane into zoom-in mode, which allows the user to select 
the zoom-in area. The command can be found also in View Menu. 

• Zoom Out command, same as zoom out graph button in the standard toolbar. Restores the 
trend settings to the values they had before last zoom-in was done. The command can be 
found also in View Menu. 

• Zoom Reset command, same as reset graph zoom button in the standard toolbar. Restores 
the trend settings to the values they had before the first zoom-in was done. The command 
can be found also in View Menu. 

• Graph Cursor. Presents a Graph Cursor dialog box, which allows the user to control, which 
numerical values are shown with the graph cursor and whether the values are shown scaled 
or not. The command can be found also in View Menu. 

• Start command or Continue command, if monitor is paused, same as start or continue 
monitoring button in the monitor toolbar (shortcut key is Ctrl+M). Starts or continues 
monitoring. The command can be found also in Monitor Menu. 

• Stop monitoring command, same as Stop button in the monitor toolbar (shortcut key is 
Ctrl+Shift+M). Stops monitoring. Monitor must be cleared before it can be started again. The 
command can be found also in Monitor Menu. 

• Pause command, same as pause monitoring button in the monitor toolbar (shortcut key is 
Ctrl+Shift+P). The monitored items are still measured, but the display freezes until monitoring 
is continued. The command can be found also in Monitor Menu. 

• Clear command, same as clear monitor button in the monitor toolbar. Resets the monitor. The 
command can be found also in Monitor Menu. 

• Adapt Y Axis command (shortcut key is Ctrl+Shift+Y). DriveWindow selects and sets proper 
y-axis minimum and maximum values of the corresponding graph at current zooming level, if 
any, for you. The command can be found also in Axis Submenu of the Monitor Menu. 

• Autoscale command (shortcut key is Ctrl+Shift+S). DriveWindow calculates and sets proper 
scaling of all or selected trends. The command can be found also in Scaling Submenu of the 
Monitor Menu. 

• Restore Defaults command. Restores monitor default settings. However, which settings are 
restored, depend on monitoring status. The command can be found also in Monitor Menu. 

• Preferences. Presents a Graph Preferences dialog box, which allows the user to control, how 
graphs are shown and printed. It can also be used to select, how scaling is shown and 
entered. The command can be found also in Graph Submenu. 
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See Also: Context Menus 
Graph Submenu 
Open Submenu 
Edit Menu 
View Menu 
Monitor Menu 
Axis Submenu 
Scaling Submenu 
Menu Bar 

5.11 Context Menu of Datalogger Display 

The context menu appears at the cursor when you right-click the trend display pane while datalogger is 
displayed is shown and DriveWindow is connected to an OPC Server and a datalogger is available 

 or 
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The menu contains the following commands. They can be found also in various menus or submenus. 

• Open. Presents an Open dialog box for selecting the file containing the graph or graphs to be 
shown. Puts DriveWindow off-line and loads the graph(s) from the file. The command can be 
found also in Graph Submenu and Open Submenu, in which it is named Graph. 

• Save As. Presents a Save As dialog box for naming or selecting the file, into which the 
currently visible graph is saved. Saves the currently visible graph into the file. The command 
can be found also in Graph Submenu. 

• Comment. Presents a File Comment dialog box for viewing and editing of the 
graph/workspace file comment. The command can be found also in Graph Submenu. 

• Datalogger 2 toggle or Next Datalogger, if the current drive has more than two dataloggers. 
Toggles the current datalogger selection in case the current drive has two dataloggers. Moves 
the current datalogger to the next datalogger (or first, if current is last) in case the current 
drive has more than two dataloggers. Current datalogger can also be selected from the 
browse tree pane by clicking the Datalogger in the browse tree. The command can be found 
also in Datalogger Menu. 

• Print. Presents a Print Setup dialog box for selecting the printer and its settings.  Prints the 
graph to the selected printer. The command can be found also in Graph Submenu. 

• Export. Presents an Export Graph To File dialog box, which is a variant of a Save As dialog 
box, for naming or selecting the file, into which the graph is exported. Exports the graph into 
the file in numerical format. The command can be found also in Graph Submenu. 

• Copy Graph. Copies the graph into the clipboard in graphical format. The command can be 
found also in Edit menu. 
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• Zoom In toggle, same as zoom in graph button in the standard toolbar (shortcut key is 
Ctrl+Shift+Z). Puts the trend display pane into zoom-in mode, which allows the user to select 
the zoom-in area. The command can be found also in View Menu. 

• Zoom Out command, same as zoom out graph button in the standard toolbar. Restores the 
trend settings to the values they had before last zoom-in was done. The command can be 
found also in View Menu. 

• Zoom Reset command, same as reset graph zoom button in the standard toolbar. Restores 
the trend settings to the values they had before the first zoom-in was done. The command 
can be found also in View Menu. 

• Graph Cursor. Presents a Graph Cursor dialog box, which allows the user to control, which 
numerical values are shown with the graph cursor and whether the values are shown scaled 
or not. The command can be found also in View Menu. 

• Upload command, same as upload datalogger button in the logger toolbar. Uploads values of 
the currently selected datalogger and displays them as trends in the trend display pane. The 
current datalogger settings are frozen, so that they show the uploaded values for the logger, 
even if the settings in the drive change. The command can be found also in Datalogger Menu. 

• Start, same as start datalogger button in the logger toolbar. Sends start command to the 
currently selected datalogger. The command can be found also in Datalogger Menu. 

• Stop command, same as stop datalogger button in the logger toolbar. Sends stop command 
to the currently selected datalogger. The command can be found also in Datalogger Menu. 

• Trig command, same as trig datalogger button in the logger toolbar. Sends trigger command 
(user trigged) to the currently selected datalogger. The command can be found also in 
Datalogger Menu. 

• Clear command, same as clear drive datalogger button in the logger toolbar. Sends clear 
command to the currently selected datalogger. The command can be found also in 
Datalogger Menu. 

• Clear Graph command, same as clear datalogger graph button in the logger toolbar. Clears 
the uploaded values of currently selected datalogger and the trends in the trend display pane. 
The settings for the datalogger are unfrozen. The command can be found also in Datalogger 
Menu. 

• Adapt Y Axis command (shortcut key is Ctrl+Shift+Y). DriveWindow selects and sets proper 
y-axis minimum and maximum values of the corresponding graph at current zooming level, if 
any, for you. The command can be found also in Axis Submenu of the Datalogger Menu. 

• Autoscale command (shortcut key is Ctrl+Shift+S). DriveWindow calculates and sets proper 
scaling of all or selected trends. The command can be found also in Scaling Submenu of the 
Datalogger Menu. 

• Restore Defaults command. Restores monitor default settings. However, which settings are 
restored, depend on monitoring status. The command can be found also in Datalogger Menu. 

• Preferences. Presents a Graph Preferences dialog box, which allows the user to control, how 
graphs are shown and printed. It can also be used to select, how scaling is shown and 
entered. The command can be found also in Graph Submenu. 

See Also: Context Menus 
Graph Submenu 
Open Submenu 
Edit Menu 
View Menu 
Datalogger Menu 
Axis Submenu 
Scaling Submenu 
Menu Bar 
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6. Submenus 
Submenus are additional lists of commands within a menu, context menu, or submenu selection. 

In DriveWindow the same or almost the same submenu can appear in several menus or context 
menus. 

The following is a list of the most common submenus: 

Workspace Submenu 
Parameters Submenu (several variants) 
System Software Submenu 
Graph Submenu 
Toolbars Submenu 
Item Set Submenu 
Set Variable Submenu 
Axis Submenu 
Scaling Submenu 
Trig Settings Submenu 
Open Submenu 

See Also: Menu Bar 
Context Menus 

6.1 Workspace Submenu 

Workspace is submenu of the File menu and contains commands for handling workspace. 

 

The menu contains the following commands: 

• Open (shortcut key is Ctrl+W). Presents an Open dialog box for selecting the file containing 
the workspace settings to be restored. Restores the workspace settings from the file. The 
same command is named Workspace in the Open Submenu. 

• Save As (shortcut key is Ctrl+Shift+W). Presents a Save As dialog box for naming or 
selecting the file, into which the workspace settings are saved. Saves the current workspace 
settings to the file. 

• Comment. Presents a File Comment dialog box for viewing and editing of the 
graph/workspace file comment. 

• Preferences. Presents a Workspace Preferences dialog box, which allows the user to control, 
how workspaces are saved and restored. It can also be used to select, whether all 
DriveWindow preferences are personal or common for all users of the computer. 

Workspace can be saved even when DriveWindow is not connected to an OPC Server. 

Opening a workspace restores, among other things, connection to the saved OPC Server. 
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See Also: File Menu 
Open Submenu 
What is Workspace 

6.2 Parameters Submenu 

Parameters submenu contains submenus and commands for handling parameters. 

There are three variants of the submenu depending on the menu, in which the submenu resides: 

• The File menu variant. 

 

• The context menu of Parameter File variant. 

 

• The context menu of Drive variant. 
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The menu may contain the following submenus and commands: 

• Open command (shortcut key is Ctrl+O). Presents an Open dialog box for selecting the file 
containing parameters. Opens the file so that the parameters are browsable in the browse 
tree pane. The same command is named Parameters in the Open Submenu. 

• Close command, same as Delete in the Edit menu or delete button in the standard toolbar, 
when the browse tree pane has focus and currently open parameter file is selected. Prompts 
to save the file, if there are unsaved changes. Closes the currently open parameter file. 

• Save As command (shortcut key is Ctrl+S). Presents a Save As dialog box for naming or 
selecting the file, into which the parameters are saved. Saves parameters of the drive or open 
parameter file currently selected in the browse tree pane. 

• Export submenu. Contains commands to export parameters of a single drive or parameter 
file, or parameters of all drives. 

• Export command. Same as Selected command in the Export Submenu. Presents an Export 
Selected to File dialog box, which is a variant of a Save As dialog box, for naming or selecting 
the file, into which the parameters are exported. Exports parameters of the drive or open 
parameter file, whichever is currently selected in the browse tree pane. 

• Print submenu. Contains commands to print parameters of a single drive or parameter file, or 
parameters of all drives. 

• Print command. Same as Selected command in the Print Submenu. After displaying a Print 
Comment dialog box, presents a Print dialog box for selecting the printer and its settings. 
Prints parameters of the selected drive or open parameter file. 

• Comment command. Presents a File Comment dialog box, which allows you to view and edit 
the comment in the currently open parameter file. 

• Compare command. Compares parameters of the drive or currently open parameter file, 
whichever is selected in the browse tree pane, with a parameter file. If not comparing a drive 
with the currently open parameter file, the parameter file is requested by presenting a 
Compare dialog box, which is similar to the Open dialog box. When comparison has been 
done, presents a Parameter Comparison dialog box, which contains the differences. It is 
possible to export the comparison results from the dialog box, too. 

• Download command (shortcut key is Ctrl+D). If not downloading parameters of a drive from 
the currently open parameter file, the parameter file is requested by presenting a Download 
dialog box, which is similar to the Open dialog box. Presents a Select Restore Type dialog 
box, which allows you to choose, whether user data, ID run results, or both, is to be 
downloaded. Downloads the parameters from the parameter file to the drive selected in the 
browse tree pane. 

See Also: File Menu 
Context Menu of Parameter File 
Context Menu of Drive 
Export Submenu  
Print Submenu 
Open Submenu 
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6.2.1 Export Submenu  

Export is submenu of Parameters, which is submenu of the File menu, and contains commands for 
exporting parameters. 

 

The menu contains the following commands: 

• Selected. Presents an Export Selected to File dialog box, which is a variant of a Save As 
dialog box, for naming or selecting the file, into which the parameters are exported. Exports 
parameters of the drive or open parameter file, whichever is currently selected in the browse 
tree pane. The same command is named Export in the Parameters Submenu in the context 
menus of Parameter File and Drive. 

• All Drives. Presents an Export All to File dialog box, which is a variant of a Save As dialog 
box, for naming or selecting the file, into which the parameters are exported. Exports 
parameters of all drives into the file. Note that parameters in a currently open parameter file 
are not included. 

See Also: Parameters Submenu 

6.2.2 Print Submenu  

Print is submenu of Parameters, which is submenu of the File menu, and contains commands for 
printing parameters. 
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The menu contains the following commands: 

• Selected. After displaying a Print Comment dialog box, presents a Print dialog box for 
selecting a printer and its settings. Prints parameters of the selected drive or open parameter 
file. The same command is named Print in the Parameters Submenu in the context menus of 
Parameter File and Drive. 

• All Drives. After displaying a Print Comment dialog box, presents a Print dialog box for 
selecting the printer and its settings. Prints parameters of all drives. Note that parameters in a 
currently open parameter file are not included. 

See Also: Parameters Submenu 

6.3 System Software Submenu 

System Software is submenu of the File menu and contains a submenu and commands for handling 
system software. 

 

The menu contains the following submenu and commands: 

• New submenu. Contains commands to create new packages. 
• Open command. Presents an Open dialog box for selecting a backup package or loading 

package file. Opens the file so that system software can be restored (backup package) or 
new system software can be downloaded (loading package). 

• Close command. Prompts to save the currently open package, if there are unsaved changes. 
Closes the currently open package. 

• Save command. If the currently open package is new and not yet saved, behaves like the 
Save As command. Saves the currently open package. 

• Save As command. Presents a Save As dialog box for naming or selecting the file, into which 
the currently open package is saved. Saves the currently open package. 

• Backup command. Connects to the OPC Server and presents a Select Drive dialog box, 
which allows multiple selection of drives. System software of the selected drives is uploaded 
into the currently open backup package. 

• Backup All command. Connects to the OPC Server and uploads system software of all drives 
into the currently open backup package. 

• Restore command. Connects to the OPC Server and presents Select Drive and Restore Drive 
dialog boxes. Downloads the selected system software from the currently open backup 
package to the selected drive. 
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• Download command. Connects to the OPC Server and presents Select Drive dialog box. 
Downloads system software with selected option from the currently open loading package to 
the selected drive. 

• Properties command. It is always disabled, because it is not implemented in the current 
DriveWindow. 

Note that if backup, restore, or download is to be done to a locally connected drive, it is not necessary 
(and even not recommended) to connect DriveWindow to the OPC Server in advance. 

Note! Because in restore and download contents of the drive may have totally been changed, an 
internal Network Disconnect and then Reconnect is made in DriveWindow, which changes state 
and contents of windows of DriveWindow. 

See Also: File Menu 
System Software 
How to Backup 
How to Restore 
How to Download 

6.3.1 New Submenu 

New is submenu of System Software, which is submenu of the File menu, and contains commands for 
creating new packages. 

 

The menu contains the following commands: 

• Backup Package. Creates a new empty backup package. 
• Loading Package. Creates a new empty loading package. This command is always disabled, 

because the functionality is not included in DriveWindow. 

If there is currently a package open, it is closed after prompting to save unsaved changes. 

See Also: System Software Submenu 
How to Backup 
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6.4 Graph Submenu 

Graph is submenu of the File menu and contains commands to print, copy, or export the graph 
currently shown in the trend display pane. 

 

The menu contains the following commands: 

• Open. Presents an Open dialog box for selecting the file containing the graph or graphs to be 
shown. Puts DriveWindow off-line and loads the graph(s) from the file. The same command is 
named Graph in the Open Submenu. 

• Save As. Presents a Save As dialog box for naming or selecting the file, into which the 
currently visible graph is saved. Saves the currently visible graph into the file. 

• Save All. Presents a Save As dialog box for naming or selecting the file, into which the 
currently all graphs are saved. Saves all graphs (monitor and uploaded dataloggers) into the 
file. 

• Print. Presents a Print Setup dialog box for selecting the printer and its settings.  Prints the 
graph to the selected printer. 

• Comment. Presents a File Comment dialog box for viewing and editing of the 
graph/workspace file comment. 

• Export. Presents an Export Graph To File dialog box, which is a variant of a Save As dialog 
box, for naming or selecting the file, into which the graph is exported. Exports the graph into 
the file in numerical format. 

• Copy, same as Copy Graph in the Edit menu. Copies the graph into the clipboard in graphical 
format. 

• Preferences. Presents a Graph Preferences dialog box, which allows the user to control, how 
graphs are shown and printed. It can also be used to select, how scaling is shown and 
entered. 

See Also: File Menu 
Open Submenu 
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6.5 Toolbars Submenu 

Toolbars is submenu of the View menu and contains toggles for showing or hiding toolbars. 

 

The menu contains toggles for showing or hiding the following toolbars: 

• Standard. 
• Logger. 
• Monitor. 
• DrivePanel. 

See Also: View Menu 

6.6 Configure Submenu 

Configure is submenu of the Network menu. It contains commands for configuring communication 
protocols. 

 

The menu contains the following commands: 

• DDCS/UDP. Presents a DDCS/UDP Configuration dialog box, which allows the user to 
configure the DDCS/UDP devices (NETA-21) to be used and parameters of the 
communication protocol. The command is enabled only if no OPC Server is connected. 

• SAP/http. Presents a SAP/http Configuration dialog box, which allows the user to configure 
the SAP/http devices (FENA-11, NETA-21) to be used and parameters of the communication 
protocol. The command is enabled only if no OPC Server is connected and the OPC Server 
DriveDA (included in Drive composer pro, not in DriveWindow) is installed. 

See Also: Network Menu 
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6.7 Item Set Submenu 

Item Set is a submenu, which allows users to work with item sets. It resides in the following menu or 
context menus as two slightly different variants: 

• The Desktop menu. 

 

• The context menu of Item Set. 

 

• The context menu of Faults and Events. 

 

The menu contains the following submenu and commands. 

• Add New submenu. Contains commands that allow a user to add a new item set. 
• Remove command. Requests confirmation and removes the item set, which is currently 

shown in the item sets pane.  
• Arrange command. Presents an Arrange dialog box, which allows the user to arrange (i.e., re-

order and remove) item sets. 
• Print command. Presents a Print Comment dialog box, which, before the printing is done, 

allows the user to add a print comment and to select, whether to print all items, templates, 
faults, and events in the currently shown item set, or just the selected ones. The command 
can be found also in context menu of Items. 
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• Restore Defaults command. Requests confirmation and restores the DriveWindow default 
item sets with their default settings. All other item sets are removed. 

• OPC Settings command. Presents an OPC Settings dialog box, which allows the user to view 
and change some OPC Server settings. Note that each item set has OPC settings of its own. 

• Properties command. Presents an Item Set Properties dialog box, which allows the user to 
view and change properties of the currently shown item set. 

Note that the browsed item set cannot be removed. 

Note! Changing OPC settings is discouraged because wrong settings can stop DriveWindow working 
properly without any visual clue. 

See Also: Monitor Menu 
Datalogger Menu 
Context Menu of Monitor Settings 
Context Menu of Datalogger Settings 
Setting and Removing Monitored Variables 
Setting and Removing Datalogger Variables 

6.7.1 Add New Submenu  

Add New is submenu of Item Set submenu, and contains commands for adding new item sets. 

 

Each of the commands in the submenu presents an Add New Item set dialog box, which allows user to 
change properties of the item set. The menu contains the following commands: 

• User Defined command. Adds an item set of type user defined. 
• All Parameters command. Adds an item set of type all parameters. 
• Faults command. Adds an item set of type faults. 
• Events command. Adds an item set of type events. 
• All Faults command. Adds an item set of type all faults. 
• All Events command. Adds an item set of type all event. 

See Also: Item Set Submenu 
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6.8 Set Variable Submenu 

Set Variable is a submenu that resides in the following menus or context menus: 

• The Monitor menu. 

 

• The Datalogger menu. 
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• The context menu of Monitor Settings. 

 

• The context menu of Datalogger Settings. 

 

The menu contains commands, which allow the user to view and change the item, which is monitored 
or logged by the current datalogger. 

• Channel 1, ... Channel 6. Presents user an Add Item to Monitor/Datalogger and Desktop 
dialog box (similar to the Add Item to Desktop dialog box presented by the Add New Item 
command in the Desktop menu). The item, OPC Address of which is given, is added both into 
the browsed item set and into the monitor or datalogger channel 1,...6. The item is named by 
the user. If name and OPC address are empty, the channel 1,...6 is cleared. 

Note that channels not available in the current datalogger are disabled (grayed). Note also that 
monitored items are locked in the browsed item set, while logged items are not. 

Note! Many drives require that if not all channels are logged, the channels logged must be the first 
ones. DriveWindow takes care about this by shifting logged items and their scaling values 
“upwards”, if necessary. It also allows adding of a new logged item to the first free channel only. 

Item name given by the user is used in the browsed item set and in the monitor settings. Datalogger 
settings do not use the name given by the user, but the name used by the drive. 
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See Also: Monitor Menu 
Datalogger Menu 
Context Menu of Monitor Settings 
Context Menu of Datalogger Settings 
Setting and Removing Monitored Variables 
Setting and Removing Datalogger Variables 

6.9 Axis Submenu 

Axis is a submenu that resides in the following menus or context menus: 

• The Monitor menu. 
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• The Datalogger menu. 

 

• The context menu of Monitor Settings. 
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• The context menu of Datalogger Settings. 

 

The menu contains commands, which allow the user to view and change current settings of monitor or 
datalogger axes. Datalogger changes concern just the current datalogger. 

• X Length command, same as double-clicking X Axis Length in monitor or datalogger settings. 
Presents an X Axis Length dialog box, where you can change the x-axis length of the 
corresponding graph at current zooming level, if any. 

• Y Axis Maximum command, same as double-clicking Y Axis Maximum in monitor or 
datalogger settings. Presents a Y Axis Maximum dialog box, where you can change the y-axis 
maximum value of the corresponding graph at current zooming level, if any. 

• Y Axis Minimum command, same as double-clicking Y Axis Minimum in monitor or datalogger 
settings. Presents a Y Axis Minimum dialog box, where you can change the y-axis minimum 
value of the corresponding graph at current zooming level, if any. 

• Adapt Y Axis command (shortcut key is Ctrl+Shift+Y). DriveWindow selects and sets proper 
y-axis minimum and maximum values of the corresponding graph at current zooming level, if 
any, for you. 

Note that zooming in, in addition to increasing zooming level, also changes settings of axes. The 
present values are saved, however, and restored, when zooming out. 

The trend display pane contains a short vertical scrollbar. Clicking the up or down arrow on it also 
changes y-axis maximum and minimum simultaneously. 

See Also: Monitor Menu 
Datalogger Menu 
Context Menu of Monitor Settings 
Context Menu of Datalogger Settings 
Common Trend Settings 
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6.10 Scaling Submenu 

Scaling is a submenu that resides in the following menus or context menus: 

• The Monitor menu. 
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• The Datalogger menu. 

 

• The context menu of Monitor Settings. 
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• The context menu of Datalogger Settings. 

 

The menu contains commands, which allow the user to view and change scaling values of the item, 
which is monitored or logged by the current datalogger. Datalogger changes concern just the current 
datalogger. 

• Channel 1, ... Channel 6, same as double-clicking 1,...6 or I,...VI in the settings. Presents user 
a Channel Scaling dialog box. Changes the coefficient and the offset, which are used to scale 
the measured value of the monitored or logged item before it is drawn in the trend display 
pane. 

• Autoscale command (shortcut key is Ctrl+Shift+S). DriveWindow calculates and sets proper 
scaling of all or selected trends. 

Note that channels not available in the current datalogger are disabled (grayed). 

The coefficient and offset are displayed in the settings pane as a formula in form coefficient * x + 
offset. 

The  channels to be autoscaled are selected in the trend settings pane. If no channel is selected, all 
measured and drawn channels are autoscaled. 

If none of the selected channels is measured and drawn or, in case of autoscaling the monitor, the 
monitor is running, the Autoscale command is disabled (grayed). 

See Also: Monitor Menu 
Datalogger Menu 
Context Menu of Monitor Settings 
Context Menu of Datalogger Settings 
Common Trend Settings 
Setting Scaling 
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6.11 Trig Settings Submenu 

Trig Settings is submenu of the Datalogger menu. 

Trig Settings is a submenu that resides in the following menus or context menus: 

• The Datalogger menu. 

 

• The context menu of Datalogger Settings. 
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The menu contains commands, which allow the user to view and change triggering settings of the 
current datalogger. 

• Pre-Trig (ms) command, same as double-clicking Pre-Trig in datalogger settings. Presents a 
Pre-Trig dialog box, where you can change the number of values kept in the current 
datalogger before the triggering event. The value is given and shown as time, but the 
datalogger actually uses a count. 

• Conditions command, same as double-clicking Trig Conditions in datalogger settings. 
Presents a Triggering Conditions dialog box, where you can view and change the conditions, 
which trigger the current datalogger. 

• Variable command, same as double-clicking Trig Variable in datalogger settings. Presents a 
Trig Variable dialog box, where you can view and change OPC address of the variable, which 
is used in triggering the current datalogger. Note that the OPC address is given without 
channel and node, and the name used by the drive, not the OPC address, is shown in the 
datalogger settings pane. 

• Level command, same as double-clicking Trig Level in datalogger settings. Presents a Trig 
Level dialog box, where you can view and change the triggering level, which is used in 
triggering the current datalogger. 

• Hysteresis command, same as double-clicking Trig Hysteresis in datalogger settings. 
Presents a Trig Hysteresis dialog box, where you can view and change hysteresis of the 
triggering level, which is used in triggering the current datalogger. 

See Also: Datalogger menu 
Context Menu of Datalogger Settings 
Setting Datalogger 

6.12 Open Submenu 

Open is a submenu of the context menu of Empty Browse Tree and contains commands for opening 
different types of files. 

 

The submenu contains the following commands: 

• Workspace (shortcut key is Ctrl+W). Same as Open command in the Workspace submenu. 
Presents an Open dialog box for selecting the file containing the workspace settings to be 
restored. Restores the workspace settings from the file. 

• Parameters (shortcut key is Ctrl+O). Same as Open command in the Parameters submenu. 
Presents an Open dialog box for selecting the file containing parameters. Opens the file so 
that the parameters are browsable in the browse tree pane. 

• Graph. Same as Open command in the Graph submenu and in the context menu of Empty 
Trend Display. Presents an Open dialog box for selecting the file containing the graph or 
graphs to be shown. Puts DriveWindow off-line and loads the graph(s) from the file. 

Opening a workspace restores, among other things, connection to the saved OPC Server. 

See Also: Context Menu of Empty Browse Tree 
Workspace Submenu 
Parameters Submenu 
Graph Submenu 
Context Menu of Empty Trend Display 
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7. Toolbars 

 

The toolbars provide quick mouse access to many tools used in DriveWindow. DriveWindow has the 
following toolbars: 

1. Standard toolbar 
2. Monitor toolbar 
3. Logger toolbar 
4. Drive panel toolbar  

Most of the toolbars are normally displayed across the top of the application window, below the menu 
bar. However, the drive panel toolbar is normally at the bottom of the window, above the status bar. 

Toolbars can be individually hidden or relocated by user. 

To display or hide the status bar, use the commands in the Toolbars submenu of the View menu. 

To relocate a toolbar, drag it to its new position. A toolbar can be docked to any side of the window, 
except the drive panel toolbar, which can be docked only to the top and bottom sides. 
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Any of the toolbars can also be left floating. Clicking the close button in the title bar of a floating toolbar 
hides the toolbar. It can be made visible again using a command in the Toolbars submenu of the View 
menu. 

 

When you point a button in a toolbar, a pop-up label called tooltips is shown. 

 

See Also: Overview 

7.1 Standard Toolbar 

 

The standard toolbar contains the following buttons: 

1. Status refresh on/off, same as Status Refresh in the File menu. Toggles the drive status 
display on-line/off-line in the browse tree pane. 

2. Cut items, same as Cut in the Edit menu (shortcut keys are Ctrl+X or Shift+Del). Action 
depends on the pane, which has the focus. If item set pane has focus, selected items or 
templates are first copied to the clipboard and then deleted from the pane. If the trend settings 
pane has focus, the selected channels and/or triggering variable are first copied to the 
clipboard and then cleared. 

3. Copy items, same as Copy in the Edit menu (shortcut keys are Ctrl+C or Ctrl+Ins). Action 
depends on the pane, which has the focus. If item set pane has focus, selected items or 
templates are copied to the clipboard. If the trend settings pane has focus, the selected 
channels and/or triggering variable are copied to the clipboard. 



User Interface 

2-52 DriveWindow 2 

4. Paste, same as Paste in the Edit menu (shortcut keys are Ctrl+V or Shift+Ins). Action 
depends on the pane, which has the focus. If an item set of type browsed, all parameters, or 
user defined in the item set pane has focus, items or templates are pasted from the clipboard. 
If the trend settings pane has focus, the items in the clipboard are pasted into free channels. If 
browse tree pane has focus, parameter values in the selected drive or open parameter file are 
changed by pasting the new values from the clipboard. However, if a drive is selected and a 
parameter file has copied into the clipboard by Windows Explorer, the parameters in the file 
are downloaded to the drive. 

5. Delete, same as Delete in the Edit menu (shortcut key is Del). Action depends on the pane, 
which has the focus. If browse tree pane has focus, deletes the selected parameter group or 
all parameters are deleted from the file. If an item set of type browsed, all parameters, or user 
defines in the item set pane has focus, selected items or templates are deleted from the item 
set. If the trend settings pane has focus, the selected channels and/or triggering variable are 
cleared. 

6. Zoom in graph, same as Zoom In in the View menu (shortcut key is Ctrl+Shift+Z). Puts the 
trend display pane into zoom-in mode, which allows the user to select the zoom-in area. 

7. Zoom out graph, same as Zoom Out in the View menu. Restores the trend settings to the 
values they had before last zoom-in was done. 

8. Reset graph zoom, same as Zoom Reset in the View menu. Restores the trend settings to the 
values they had before the first zoom-in was done. 

9. Add item, same as Add New Item in the Desktop menu (shortcut key is Ctrl+A). In the 
browsed item set presents an Add Item to Desktop dialog box and adds the item, OPC 
Address of which is given, into the item set. The item is named by the user. In user item sets 
presents an Add New Template dialog box and adds the template, properties of which are 
given, into the item set. The command can be found also in context menu of Item Set. 

a. Lock/unlock items, same as Lock/Unlock Items in the Desktop menu. The locking status of 
the selected items in the browsed item set is toggled. When an item is locked (pinned), it 
stays visible in the item set even if selection in the browse tree is changed. An unlocked item 
disappears from the item set when the selection changes. Note that monitoring also locks the 
items monitored. Unlocking an item does not remove it from the item set, but the next 
selection change in the browse tree pane does. 

b. Update items, same as Update Items in the Desktop menu. Values of the selected items in an 
item set are read and updated. If an item set of type faults, events, all faults, or all events is 
displayed in the item sets pane, the command concerns all faults or events of the item set. In 
this case the command is enabled only if there is nothing selected or only the description 
selected. 

c. Activate/deactivate items, same as Put Items Online/Offline in the Desktop menu. Toggles the 
on-line status of the items, which are selected in an item set on-line/off-line. Values of items, 
which are on-line, are periodically refreshed in the item set. 

d. Change value, same as Change Item Value in the Desktop menu, or double-clicking a 
writable item in an item set. Presents a dialog box, in which the user enters a new value for 
the item selected, and changes the value. 

See Also: Toolbars 

7.2 Monitor Toolbar 
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The monitor toolbar can be used to control monitoring instead of using the Monitor menu. Buttons in 
the monitor toolbar are enabled only if Monitor is selected in the trend settings pane. 

The toolbar contains the following buttons: 

1. Add monitored items, same as Add/Remove Items in the Monitor menu. Toggles the 
monitoring status of the selected items in the browsed item set. A monitored item is locked in 
the browsed item set. 

2. Start or continue monitoring, same as Start (or Continue, if monitor is paused) in the Monitor 
menu (shortcut key is Ctrl+M). Starts or continues monitoring. 

3. Stop monitoring, same as Stop in the Monitor menu (shortcut key is Ctrl+Shift+M). Stops 
monitoring. Monitor must be cleared before it can be started again. 

4. Pause monitoring, same as Pause in the Monitor menu (shortcut key is Ctrl+Shift+P). The 
monitored items are still measured, but the display freezes until monitoring is continued. 

5. Clear monitor, same as Clear in the Monitor menu. Resets the monitor. 

See Also: Toolbars 

7.3 Logger Toolbar 

 

The logger toolbar can be used to control datalogging instead of using the Datalogger menu. Buttons in 
the datalogger toolbar are enabled only if Datalogger is selected in the trend settings pane. 

The toolbar contains the following buttons: 

1. Add/remove datalogger items, same as Add/Remove Items in the Datalogger menu. Toggles 
the logging status of those selected items in the item set pane, which reside in the same drive 
as the current datalogger. A logged item is not locked in the browsed item set as monitored 
items are. The name of a logged item is taken from the drive, when it is displayed in the 
datalogger settings or in printings. 

2. Upload datalogger, same as Upload in the Datalogger menu. Uploads values of the currently 
selected datalogger and displays them as trends in the trend display pane. The current 
datalogger settings are frozen, so that they show the uploaded values for the logger, even if 
the settings in the drive change. 

3. Start datalogger, same as Start in the Datalogger menu. Sends start command to the 
currently selected datalogger. 

4. Stop datalogger, same as Stop in the Datalogger menu. Sends stop command to the currently 
selected datalogger. 

5. Trig datalogger, same as Trig in the Datalogger menu. Sends trigger command (user trigged) 
to the currently selected datalogger. 

6. Clear drive datalogger, same as Clear in the Datalogger menu. Sends clear command to the 
currently selected datalogger. 

7. Clear datalogger graph, same as Clear Graph in the Datalogger menu. Clears the uploaded 
values of currently selected datalogger and the trends in the trend display pane. The settings 
for the datalogger are unfrozen. 
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The controlled datalogger resides in the drive, which is selected from the browse tree pane. If the drive 
has two dataloggers, selection of the logger within the drive can be made either from the browse tree 
pane, or by toggling Datalogger 2 in the Datalogger menu or in the context menu of Datalogger 
Display. 

Note that Start, Stop, Trig, and Clear commands can be sent to the datalogger even if the uploaded 
values are not cleared. Thus it is possible to study previous results in DriveWindow while the 
datalogger in the drive has been started to collect data for the next case (with the same settings, 
however). 

See Also: Toolbars 

7.4 Drive Panel Toolbar 
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The drive panel toolbar can be used to control a drive instead of using the Drive menu. The toolbar 
contains the following fields and buttons: 

1. Status image of the drive, which is currently controlled by DriveWindow. 
2. Name and address of the drive, which is currently controlled by DriveWindow. 
3. Take/release control, same as Take Control (or Release Control, if control is taken) in the 

Drive menu (shortcut key is Alt+F2). Toggles the control status of the drive, which is selected 
from the browse tree pane. Note that it is possible to control at most one drive at a time. 

4. Clear faultlogger, same as Clear Faultlogger in the Drive menu. Sends fault logger clearing 
command to the currently selected drive. 

5. Reference value edit field, same as entering value after Change Item Value command in the 
Desktop menu, when the item Control.Reference of the currently controlled drive in an item 
set is selected. 

6. Current reference value, same as value of the item Satus.Reference of the currently 
controlled drive in an item set. 

7. Set reference, same as clicking the OK button when entering value after Change Item Value 
command in the Desktop menu, when the item Control.Reference of the currently controlled 
drive in an item set is selected. 

8. Start/end step, same as Step Start/Release in the Drive menu. Starts or ends a step in the 
reference value. 

9. Reset fault, same as Reset Fault in the Drive menu (shortcut key is Alt+F8). Sends fault reset 
command to the currently controlled drive. 

a. Start, same as Start in the Drive menu (shortcut key is Shift+F9). Sends start command to the 
currently controlled drive. 

b. Stop, same as Stop in the Drive menu (shortcut key is Shift+F10). Sends stop command to 
the currently controlled drive. 

c. Reverse, same as Reverse in the Drive menu (shortcut key is Ctrl+F5). Sends reverse 
command to the currently controlled AC drive. 

d. Forward, same as Forward in the Drive menu (shortcut key is Ctrl+F6). Sends forward 
command to the currently controlled AC drive. 

e. Coast stop, same as Coast Stop in the Drive menu (shortcut key is Ctrl+F4). Sends coast 
stop command to the currently controlled drive. 

f. Close contactor, same as On in the Drive menu (shortcut key is Ctrl+F5). Sends contactor 
close command to the currently controlled DC drive. 

g. Open contactor, same as Off in the Drive menu (shortcut key is Ctrl+F6). Sends contactor 
open command to the currently controlled DC drive. 

When no drive is under control, name and address field are empty and all other fields except 
Take/release control and clear faultlogger buttons are hidden. 
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No drive type has all commands available. If the drive under control does not have a command 
available, the corresponding button in the drive panel toolbar is hidden. 

 

AC and DC drives reuse some positions to show buttons for different commands, which do not exist in 
the other type of drive. The commands shown in the Drive menu are changed correspondingly. 

 

See Also: Toolbars 

8. Status Bar 

  

The status bar is located along the bottom of a window. It can be hidden by user. 

The status bar is displayed at the bottom of DriveWindow. To display or hide the status bar, use the 
Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items. It also shows messages that describe 
the actions of toolbar buttons. An explanation about a lengthy operation can also be shown while it is 
executed. 

The middle area of the status bar contains status image and name of the drive that is selected in the 
browse tree pane. Selection needs not to be at root but can be any of sub-branches of the drive. 

The right area of the status bar shows the status of keyboard CapsLock, NumLock, and ScrollLock. 
Empty means that the corresponding lock is off. 

See Also: Overview 
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9. Window Area 

 

The window area of DriveWindow is split by horizontal and vertical splitters into four panes: 

1. Browse tree pane 
2. Item sets pane 
3. Trend settings pane 
4. Trend display pane 

Panes can be resized by: 

5. Dragging the horizontal splitter up or down 
6. Dragging the vertical splitter left or right 
7. Dragging the splitter cross-point to a new position 

The browse tree pane and the browsed item set in the item sets pane are related. When you change 
selection in the browse tree, the previously displayed, unlocked items in the browsed item set are 
removed, and items corresponding the new browse tree selection (if any) are added. 

The item sets pane consist of several windows, one for each item set. However, only one of the item 
sets is visible at a time. Selection is done by clicking the tab of the item set in the item sets pane. 

The trend settings pane and the trend display pane both actually consist of two windows, one for 
monitor and one for dataloggers. However, if monitor is visible, datalogger is hidden, and vice versa. 
Selection is done by clicking either of the tabs in the trend settings pane. 

The trend display pane and the trend settings pane are related. The settings shown in the trend 
settings pane are those of the monitor or the datalogger shown in the trend display pane. 

The datalogger settings and display, which are shown, are those of the currently selected datalogger. 
The currently selected datalogger resides in the drive, which is selected from the browse tree pane. If 
the drive has two dataloggers, selection of the logger within the drive can be made either from the 
browse tree pane, or by toggling Datalogger 2 in the Datalogger menu. 

See Also: Overview 
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9.1 Browse Tree Pane 

The browse tree pane is the upper left pane within the window area. You can use it for following 
purposes: 

• To navigate within a drive. 
• To navigate within an open parameter file. 
• To select a drive, which is the object of some command, like taking control. 
• To select a datalogger, if the drive has more than one of them. 
• To change the drive of monitored items. 

A tree consists of branches shown in the browse tree pane, and items (leaves) of a branch, shown in 
the browsed item set. 

The top level name, within which current selection resides, is also shown within parentheses in the title 
bar. It is also shown in the status bar with the status image of the drive. 

On the top level, an open parameter file (the file name if preceded by “File:”) and all drives (if OPC 
Server has been connected) are shown. 

 

The image displayed in front of a drive shows the status of the drive. 

Image Status 

 Fault and (Forward) Direction 

 Fault and not (Forward) Direction 

 Not Running and Warning and (Forward) Direction 

 Not Running and Warning and not (Forward) Direction 

 Not Running and (Forward) Direction 

 Not Running and not (Forward) Direction 

 Running and Warning and (Forward) Direction 

 Running and Warning and not (Forward) Direction 

 Running and (Forward) Direction 

 Running and not (Forward) Direction 

 Otherwise (status display is off-line or status cannot be read, for 
example) 

The status image is also displayed in the status bar in front of the name, within which the current 
selection resides. If control of a drive is taken, the status image of the drive is shown in the drive panel 
toolbar in front of the name of it. 

To expand a collapsed branch or to collapse an expanded branch, double-click the branch. An 
expanded branch can be collapsed also by clicking the minus-sign on the left of the branch. If a plus-
sign is present on the left side of a collapsed branch, you can also expand it by clicking the plus-sign. 
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To select a branch, just click it. Only one branch at a time can be selected. Selection can also be 
changed by up and down arrows, when the browse tree pane has focus. Note that changing the 
selection also affects the browsed item set, which changes the items displayed. It may also change the 
top level name shown in parentheses in the title bar. 

Note! Parameter groups are shown in numerical, but other sub-branches within a branch are shown in 
alphabetical order. 

To select a drive, datalogger, or parameter file, it is not necessary to select its root, selection of any of 
its sub-branches will do. 

When the parameter file is selected, it can be object of the following commands: 

• Paste changes parameter values by pasting the new values from the clipboard. 
• Delete closes the file (root selected) or removes all parameters or a parameter group from the 

file (sub-branch selected). 
• Save As presents a Save As dialog box and saves the parameter file. 
• Export Selected presents an Export Selected to File dialog box (a variant of Save As dialog 

box), and exports the parameter file. 
• Print Selected presents a Print Comment dialog box, then presents a Print dialog box for 

selecting a printer and its settings, and finally prints parameters of the parameter file. 
• After displaying a Print Comment dialog box, presents a Print dialog box for selecting a printer 

and its settings. Prints parameters of the selected drive or open parameter file. The same 
command is named Print in the Parameters Submenu in the context menus of Parameter File 
and Drive. 

• Comment presents a File Comment dialog box for viewing and editing the comment part of 
the parameter file. 

• Compare compares the open parameter file with another parameter file. 

Additionally, parameter values can be changed by drag and drop by dropping the new values into the 
parameter file. 

When a drive is selected, it can be object of the following commands: 

• Paste changes parameter values of the drive by pasting the new values from the clipboard. 
However, if a parameter file has copied into the clipboard by Windows Explorer, the 
parameters in the file are downloaded to the drive. 

• Save As presents a Save As dialog box and saves parameters of the drive into a parameter 
file. 

• Export Selected presents an Export Selected to File dialog box (a variant of Save As dialog 
box), and exports parameters of the drive 

• Print Selected presents a Print Comment dialog box, then presents a Print dialog box for 
selecting a printer and its settings, and finally prints parameters of the drive. 

• Compare compares parameters of the drive with a parameter file. 
• Download downloads parameters from a parameter file to the drive. 
• Take/Release Control takes or releases control of the drive. 
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• Clear Faultlogger clears the fault logger of the drive. 
• Change Drive changes the drive of the selected (or all, if none selected) monitored items in 

the browsed item set. The new drive is the one selected in the browse tree pane. 

Additionally, parameter values in the drive can be changed by drag and drop by dropping the new 
values into the drive. 

The datalogger shown is also determined by the selection of a drive. If a drive has more than one 
datalogger, selection made in the browse tree pane also determines which one of the dataloggers is 
shown. While such a selection is made, it is not possible to select the datalogger from the Datalogger 
menu. 

 or 

 or  

 

See Also: Window Area 
Browsing Parameters and Signals 
Viewing Status of Drives 



User Interface 

DriveWindow 2 2-61 

9.2 Item Sets Pane 

The item sets pane is the upper right pane within the window area. It actually consists of several item 
sets, one of which is visible at a time: 

You can use the pane for several purposes: 

• To view and change item values in a drive or in an open parameter file. 
• To view contents of fault and event loggers in a user friendly way. 
• To add items to and remove items from the monitor or a datalogger. 
• To change the drive of monitored items. 
• To copy or cut items to the clipboard. 
• To drag and drop items to various targets or from various sources. 

Although there are several types of item sets, they can be divided into two main categories: 

• Those that list items. 
• Those that list faults or events. 

The following types of item sets belong to the first mentioned category: 

• Browsed. 
• All parameters. 
• User. 

The following types of item sets belong to the second category: 

• Faults. 
• Events. 
• All faults. 
• All events. 

When DriveWindow starts, it automatically creates some default item sets. Additional item sets you 
have to add by yourself. Of course, you can remove one or more of the default item sets. Note, 
however, that the browsed item set cannot be removed. 

You select the item set you want to see by clicking its tab at top of the pane. 

 

See Also: Window Area 

9.2.1 Item Sets of Item List Type 

The category of item sets that list items consist of the following types of item sets: 

• Browsed. 
• All parameters. 
• User. 
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They all have similar list of items in the item sets pane. 

Each line under the title displays one item. The display is divided into three columns: 

• Name, which consists of an icon that shows the status of the item, and a descriptive name. 
Note that the descriptive name is normally fetched from the drive or created by the OPC 
Server, but it is also possible to use a name of your own. 

• Value of the item (if the item is not read-protected). If quality of the value is not good, quality is 
shown with or instead of the value. 

• OPC Address of the item. Note that items in an open parameter file are shown with an OPC 
Address without channel and node. 

Note that user item sets may display a template instead of an item. About a template, encoded 
template properties are displayed in the Name and OPC Address columns. The Value column is 
empty. 

Note! Items are sorted by increasing order of channel, node, and item ID of the OPC Address. Group 
and parameter IDs are ordered numerically, other IDs are ordered alphabetically. 

You can change the width of a column by dragging the column separator in the title. 

 

The image displayed in front of a descriptive name shows the status of the item. 

All item sets in the category that list items may have the following images: 

Image Status 

 Off-line (and not locked) 

 On-line (and not locked), background of the value is also yellow 

The browsed item set may additionally have the following images: 

Image Status 

 Off-line and locked 

 On-line and locked, background of the value is also yellow 

 Monitored in channel 1 

 Monitored in channel 2 

 Monitored in channel 3 

 Monitored in channel 4 

 Monitored in channel 5 

 Monitored in channel 6 

Note that monitored items in the browsed item set are always locked, but the locking done by the user 
is separated from this lock. It means that when an item is removed from the monitor, it shows the 
locking status set by the user (either before or during monitoring). 
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Monitored items in the browsed item set can be put on-line, too. Background of the value is yellow, as 
all other types of on-line items. 

 

To select an item, just click its descriptive name. Several items can be selected. You can do multiple 
selection with the mouse as follows: 

• To select a range of items, click first the descriptive name of the item at the one end and then, 
with the Shift key down, click the descriptive name at the other end. 

• To change selection status of a single item at a time, keep the Ctrl key down when clicking 
the descriptive name of the item. 

When the item sets pane has focus, it is also possible to do selection by using the keyboard. 

• Up and down arrow keys move a single item selection up and down 
• To select or unselect a range, keep the Shift key down while repeat pressing the up or down 

arrow key. 
• To select or unselect individual items, keep the Ctrl key down while moving up or down with 

the up or down arrow key. Do the selection change by pressing spacebar with Ctrl down. 
• To select or unselect several items at a time, press Shift+PgUp or Shift+PgDn. 
• To select all items, press first the Home (or End) key and then, with Shift down, press the End 

(or Home) key. 

When one or more items are selected, they can be object of the following commands: 

• Cut first copies the selected items to the clipboard and then removes them from the item set. 
Monitored items in the browsed item set are not removed, however. 

• Copy copies the selected items to the clipboard. The fields are Tab separated and the order 
of the fields is changed, so that the value is the last. If the value is a vector, the elements are 
Tab separated, not comma separated, as they are in the item sets pane. 

• Delete removes the selected items from the item set. Monitored items in the browsed item set 
are not removed, however. 

• Change Format command in the View menu allows user to temporarily change display format 
of values in the dialog box, which is presented. 

• Add New Item uses, if only a single item is selected, the selected item as a template, when it 
presents the Add Item to Desktop dialog box. 

• Lock/Unlock Items toggles the locking status of the selected items. 
• Update Items reads and updates values of the selected items. 
• Put Items Online/Offline toggles the on-line status of the selected items on-line/off-line. 
• Change Item Value allows, if only a single item is selected, the selected item to be changed in 

the dialog box, which is presented. 
• Add/Remove Items in the Monitor menu toggles the monitoring status of the selected items. 

Note that the number of channels in the monitor is limited and DriveWindow ignores the 
excess items. 

• Change Drive in the Monitor menu changes the drive of the selected (or all, if none selected) 
monitored items. The new drive is the one selected in the browse tree pane. 

• Add/Remove Items in the Datalogger menu toggles the logging status of those selected 
items, which reside in the same drive as the current datalogger. Note that the number of 
channels in the a datalogger is limited and DriveWindow ignores the excess items. 
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• Set Variable uses, if only a single item is selected and the channel is empty, the selected item 
as a template, when it presents the Add Item to Monitor and Desktop dialog box. In the Add 
Item to Datalogger and Desktop dialog box there is an additional condition to be able to use 
the selected item as a template. The condition is that the item must reside in the same drive 
as the current datalogger. 

• Print in the Item Set submenu of the Desktop menu allows printing of just the selected items. 

Additionally, the selected items can be dragged to various dropping targets. 

See Also: Item Sets Pane 

9.2.2 Item Sets of Event or Fault List Type 

The category of item sets that list faults or events consists of the following types of item sets: 

• Faults. 
• Events. 
• All faults. 
• All events. 

They all have similar list of faults or events in the item sets pane. 

Each line under the title displays one fault or event in a fault or event logger. The display is divided into 
the following columns: 

• Description, which consists of an icon that shows the status and type of the fault or event, and 
a description of it. 

• Status of the fault or event (Active, Reset, Acknowledged, Not Acknowledged). 
• Type of the fault or event (Fault, Warning, Event). 
• Drive Time, which is time stamp made by the fault or event logger within the drive. It may be 

in system time or, if the drive control board has a real time clock, in real time. 
• PC Time, which is real time stamp calculated by DriveWindow from the system time stamp. 

DriveWindow cannot always do the calculation (the field is then empty) and, even if it can, it 
may take some time (40 seconds) while DriveWindow measures the frequency of the crystal 
on the drive control board. 

• Drive, which consist of the name of the drive and its address the same way as they are shown 
in the browse tree pane. 

Note! Faults and events are sorted by decreasing order of their occurrence, if possible. It means that 
the latest one is on the top line. 

You can change the width of a column by dragging the column separator in the title. 
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The image displayed in front of a description shows the status or type of the fault or event: 

Image Status 

 No events or faults. 

 Event or fault could not be read (possibly broken connection). 

 Unknown or uncertain status or type.  

 Status is reset or acknowledged. 

 Type is event (status is neither reset nor acknowledged). 

 Type is fault (status is neither reset nor acknowledged). 

 Type is warning (status is neither reset nor acknowledged). 

If the item set is put on-line (as it normally is), the background of the image on the first line is yellow as 
well as the background of the rest of the line. 

To select a fault or event, just click its descriptive name. Several faults and events can be selected. 
You can do multiple selection with the mouse as follows: 

• To select a range of faults and events, click first the descriptive name of the fault or event at 
the one end and then, with the Shift key down, click the descriptive name at the other end. 

• To change selection status of a single fault or event at a time, keep the Ctrl key down when 
clicking the descriptive name of the fault or event. 

When the item sets pane has focus, it is also possible to do selection by using the keyboard. 

• Up and down arrow keys move a single fault or event selection up and down 
• To select or unselect a range, keep the Shift key down while repeat pressing the up or down 

arrow key. 
• To select or unselect individual faults or events, keep the Ctrl key down while moving up or 

down with the up or down arrow key. Do the selection change by pressing spacebar with Ctrl 
down. 

• To select or unselect several faults and events at a time, press Shift+PgUp or Shift+PgDn. 
• To select all faults and events, press first the Home (or End) key and then, with Shift down, 

press the End (or Home) key. 

When one or more faults or events are selected, they can be object of the following commands: 

• Copy copies the selected faults and events to the clipboard. The fields are Tab separated. 
• Print in the Item Set submenu of the Desktop menu allows printing of just the selected faults 

and events. 

Additionally, the selected items can be dragged to various dropping targets. 

When none of the faults or events is selected or only the fault or event on the first line is selected, the 
following commands can be requested: 

• Update Items reads and updates all faults and events in the item set. 
• Put Items Online/Offline toggles the on-line status of all faults and events in the item set. 
• Print in the Item Set submenu of the Desktop menu prints of just the selected fault or event or 

all faults and events in the item set. 

Additionally, the selected faults and events can be dragged to dropping targets in other applications. 

See Also: Item Sets Pane 
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9.3 Trend Settings Pane 

The trend settings pane is the lower left pane within the window area. It actually consists of two 
settings, one of which is visible at a time: 

• Monitor settings. 
• Datalogger settings of the current datalogger. 

You select the settings you want to see by clicking the Monitor or Datalogger tab at top of the pane. 

 

Selection of the settings shown also affects the trend display pane. It shows the monitor, if monitor is 
selected, and the current datalogger, if datalogger is selected. 

You use the trend setting pane to view at a glance and quickly change monitor or datalogger settings. 
The same things can also be done by using commands in the Monitor and Datalogger menus. 

Each line under the title displays one setting. The display is divided into two columns: 

• Setting name, which consist of a setting specific icon, and the name of the setting. Note that a 
monitor or datalogger channel, when there is an item to be monitored or logged, contains the 
descriptive name of the monitored or logged item. 

• Value of the setting. 

You can change the width of the columns by dragging the column separator in the title. 

 

Double-clicking the name of a setting changes the value of the setting. If the setting is disabled, 
double-clicking beeps. Meaning of each setting is explained in monitor settings and datalogger 
settings. 

To select a setting, just click the name of it. Several settings can be selected. You can do multiple 
selection with the mouse as follows: 

• To select a range of settings, click first the name of the setting at the one end and then, with 
the Shift key down, click the name at the other end. 

• To change selection status of a single setting at a time, keep the Ctrl key down when clicking 
the name of the setting. 

When the trend settings pane has focus, it is also possible to do selection by using the keyboard. 

• Up and down arrow keys move a single setting selection up and down 
• To select or unselect a range, keep the Shift key down while repeat pressing the up or down 

arrow key. 
• To select or unselect individual settings, keep the Ctrl key down while moving up or down with 

the up or down arrow key. Do the selection change by pressing spacebar with Ctrl down. 
• To select or unselect several settings at a time, press Shift+PgUp or Shift+PgDn. 
• To select all settings, press first the Home (or End) key and then, with Shift down, press the 

End (or Home) key. 
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Selections can be used to remove monitored or logged items from the monitor or the current 
datalogger. Also the triggering variable can be removed by selection. Removal is done by Delete 
command. 

Autoscaling calculates proper scaling for those selected channels that are measured and drawn. By 
not selecting any of the channels has the same effect as selecting all of the channels. 

Note! Many drives require that if not all channels are logged, the channels logged must be the first 
ones. DriveWindow takes care about this by shifting logged items and their scaling values 
“upwards”, if necessary. It also allows adding of a new logged item to the first free channel only. 

See Also: Window Area 

9.3.1 Monitor Settings 

Monitor settings is one of the settings, which can be selected to be shown in the trend settings pane. 
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Monitor settings consist of the following: 

• Mode, same as Fast Mode toggle in the Monitor menu. Double-clicking the name of the 
setting toggles between fast and normal mode of monitoring. 

• Interval, same as Interval command in the Monitor menu. Double-clicking the name of the 
setting presents an Interval dialog box, where you can change the monitoring interval. 

• History Buffer, same as History Buffer command in the Monitor menu. Double-clicking the 
name of the setting presents a History Buffer dialog box, where you can change the size of 
the monitor history buffer, i.e., how much data is remembered by the monitor. 

• X Axis Length, same as X Length command in the Axis submenu of the Monitor menu. 
Double-clicking the name of the setting presents an X Axis Length dialog box, where you can 
change the x-axis length of the monitor graph at current zooming level, if any. 

• Y Axis Maximum, same as Y Axis Maximum command in the Axis submenu of the Monitor 
menu. Double-clicking the name of the setting presents a Y Axis Maximum dialog box, where 
you can change the y-axis maximum value of the monitor graph at current zooming level, if 
any. 

• Y Axis Minimum, same as Y Axis Minimum command in the Axis submenu of the Monitor 
menu. Double-clicking the name of the setting presents a Y Axis Minimum dialog box, where 
you can change the y-axis minimum value of the monitor graph at current zooming level, if 
any. 

• Channel 1, ... Channel 6, same as Channel 1, ... Channel 6 command in Scaling submenu of 
the Monitor menu. Depending on the scaling method selected in Graph Preferences, either 
the coefficient and offset, or values at y=0 and at y=100 are displayed in the value field of a 
setting. The coefficient and offset are displayed as a formula in form coefficient * x + offset. 
The values at y=0 and y=100 are displayed within brackets ([]), separated with comma. 
Double-clicking the name of a setting presents user a Channel Scaling dialog box. Changes 
the coefficient and the offset, which are used to scale the measured value of the monitored 
item before it is drawn in the trend display pane. 

Note that if a channel has an item to be monitored, the descriptive name of the item is shown as the 
name of the setting instead of Channel n. 

 

Note that if a setting is disabled, double-clicking of it beeps. 

To add, change, or remove monitored items, see Monitor menu. Paste command and drag and drop 
can also be used to add monitored items into free channels. 

Note that selections of the channel settings can also be used to remove monitored items from the 
monitor. Removal can be done by Delete command, Cut command, or moving by drag and drop. 

The trend display pane contains a short vertical scrollbar. Clicking the up or down arrow on it also 
changes Y Axis Maximum and Y Axis Minimum simultaneously. 

Y Axis Minimum and Y Axis Maximum also change simultaneously when y-axis is adapted. 

See Also: Trend Settings Pane 
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9.3.2 Datalogger Settings 

Datalogger settings is one of the settings, which can be selected to be shown in the trend settings 
pane. 

 

The current datalogger is selected by selecting the drive in the browse tree pane. If there are two 
dataloggers in the drive, the datalogger is further selected either by the Datalogger 2 toggle in the 
Datalogger menu or expanding the drive in the browse tree pane and doing the selection there. 

All other settings except X Axis Length, Y Axis Minimum, Y Axis Maximum, and scaling are actually 
kept in the drive. Thus they are preserved even when DriveWindow exits. 

When a datalogger is uploaded, the settings are frozen until the datalogger graph is cleared by Clear 
Graph command. However, if Status is put on-line by double-clicking it or toggling Status Refresh, 
Status displays current status instead of the uploaded status of the datalogger. Uploaded status is 
resumed by putting Status off-line. 

Note that it is possible to start the datalogger, while still viewing the uploaded datalogger. 
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Datalogger settings display settings of the current datalogger, and consist of the following: 

• Status shows the state of the datalogger. Double-clicking the name of the setting is same as 
Status Refresh toggle in the Datalogger menu. Double-clicking toggles it on-line/off-line. Also 
Triggered by is toggled, if current datalogger has not been uploaded. On-line status is 
indicated by yellow background of the value. 

• Trigged By shows the triggering reason. If the datalogger has not been uploaded, double-
clicking the name of the setting is same as double-clicking the Status setting. On-line status is 
indicated by yellow background of the value. 

• Interval, same as Interval command in the Datalogger menu. Double-clicking the name of the 
setting presents an Interval dialog box, where you can change the logging interval of the 
current datalogger. 

• Pre-Trig (ms), same as Pre-Trig (ms) command in the Trig Settings submenu. Double-
clicking the name of the setting presents a Pre-Trig dialog box, where you can change the 
number of values kept in the current datalogger before the triggering event. The value is given 
and shown as time, but the datalogger actually uses a count. 

• Trig Conditions, same as Conditions command in the Trig Settings submenu. Double-clicking 
the name of the setting presents a Triggering Conditions dialog box, where you can change 
the conditions, which trigger the current datalogger. 

• Trig Variable, same as Variable command in the Trig Settings submenu. Double-clicking the 
name of the setting presents a Trig Variable dialog box, where you can change OPC address 
of the variable, which is used in triggering the current datalogger. Note that the OPC address 
is given without channel and node, and the name used by the drive, not the OPC address, is 
shown in the value field. 

• Trig Level, same as Level command in the Trig Settings submenu. Double-clicking the name 
of the setting presents a Trig Level dialog box, where you can change the triggering level, 
which is used in triggering the current datalogger. 

• Trig Hysteresis, same as Hysteresis command in the Trig Settings submenu. Double-clicking 
the name of the setting presents a Trig Hysteresis dialog box, where you can change 
hysteresis of the triggering level, which is used in triggering the current datalogger. 

• X Axis Length, same as X Length command in the Axis submenu of the Datalogger menu. 
Double-clicking the name of the setting presents an X Axis Length dialog box, where you can 
change the x-axis length of the datalogger graph at current zooming level, if any. 

• Y Axis Maximum, same as Y Axis Maximum command in the Axis submenu of the Datalogger 
menu. Double-clicking the name of the setting presents a Y Axis Maximum dialog box, where 
you can change the y-axis maximum value of the datalogger graph at current zooming level, if 
any. 

• Y Axis Minimum, same as Y Axis Minimum command in the Axis submenu of the Datalogger 
menu. Double-clicking the name of the setting presents a Y Axis Minimum dialog box, where 
you can change the y-axis minimum value of the datalogger graph at current zooming level, if 
any. 

• Channel 1, ... Channel 6, same as Channel 1, ... Channel 6 command in Scaling submenu of 
the Datalogger menu. Depending on the scaling method selected in Graph Preferences, 
either the coefficient and offset, or values at y=0 and at y=100 are displayed in the value field 
of a setting. The coefficient and offset are displayed as a formula in form coefficient * x + 
offset. The values at y=0 and y=100 are displayed within brackets ([]), separated with comma. 
Double-clicking the name of a setting presents user a Channel Scaling dialog box. Changes 
the coefficient and the offset, which are used to scale the measured value of the logged item 
before it is drawn in the trend display pane. 
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Note that if a channel has an item to be logged, the descriptive name of the item is shown as the name 
of the setting instead of Channel n. The descriptive name is fetched from the drive, it is not the one 
given by the user. 

Note also that channels, which do not exist in the drive, show n/a as the name of the setting and the 
value (scaling) is empty. 

 

Note that if a setting is disabled, double-clicking it beeps. 

To add, change, or remove logged items from the current datalogger, see Datalogger menu. Paste 
command and drag and drop can also be used to add items into free channels. 

Note that selections of the channel settings can also be used to remove monitored items from the 
monitor. Removal can be done by Delete command, Cut command, or moving by drag and drop. 

Note that selections of the channel settings can also be used to remove logged items from the current 
datalogger. Also the triggering variable can be removed by selection. Removal can be done by Delete 
command, Cut command, or moving by drag and drop. 

Note! Many drives require that if not all channels are logged, the channels logged must be the first 
ones. DriveWindow takes care about this by shifting logged items and their scaling values 
“upwards”, if necessary. It also allows adding of a new logged item to the first free channel only. 

The trend display pane contains a short vertical scrollbar. Clicking the up or down arrow on it also 
changes Y Axis Maximum and Y Axis Minimum simultaneously. 

Y Axis Minimum and Y Axis Maximum also change simultaneously when y-axis is adapted. 
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Note that if no valid datalogger is selected (for example, an open parameter file is selected in the 
browse tree pane), n/a is displayed in all other value fields except the channels, which have n/a in the 
setting names and the values (scaling) are empty. The datalogger display in the trend display pane is 
empty, too. 
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If the current datalogger is not properly initialized, many of the value fields display n/a, all channels 
have n/a in their setting names and the values (scaling) are empty. The datalogger display in the trend 
display pane is empty, too. 

 

See Also: Trend Settings Pane 

9.4 Trend Display Pane 

The trend display pane is the lower right pane within the window area. It actually consists of two 
displays, one of which is visible at a time: 

• Monitor display. 
• Datalogger display of the current datalogger. 

They look and feel quite similar, so most of their features are explained here. 

You select the display you want to see by clicking the Monitor or Datalogger tab at top of the trend 
settings pane. 

 

Selection of the display shown also affects the trend settings pane. It shows the monitor settings, if 
monitor is selected, and the current datalogger settings, if datalogger is selected. 
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You use the trend display pane to view trends collected by the monitor or the current datalogger. 

 

The trend display pane contains the following: 

1. Title, which indicates, what is currently displayed (monitor or datalogger and which 
datalogger) 

2. X-axis (the time axis). Its length can be set by user in the trend settings pane and also 
changed by zooming. You can scroll x-axis horizontally, if there are more values collected 
than are displayed. While monitoring, the x-axis scrolls in real time after the right end has 
been reached. 

3. Y-axis. Minimum and maximum can be set by user in the trend settings pane and also 
changed by zooming. Minimum and maximum can also be changed by vertical scrolling. 

4. The measured or logged trends. 
5. Horizontal scroll bar, which is visible only when horizontal scrolling of the x-axis is possible. 
6. Vertical scroll buttons. You can scroll the y-axis upwards and downwards. 
7. X-axis label, always Time (s). 

Size of the horizontal scrolling step is dependent on the current x-axis. 

If you scroll horizontally by clicking the arrow buttons, scroll step is usually a fifth part of the length of 
the x-axis. If only a few values are displayed, the step can be smaller. 

If you scroll horizontally by clicking the shaft of the scroll bar, scroll step is usually equal to the length of 
the x-axis. 

Size of the vertical scrolling step is equal to the distance of two tick marks on the y-axis. Number of tick 
marks shown may vary depending on the current y-axis minimum and maximum. 
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If the Zoom In toggle in the View menu (or zoom in graph button in the standard toolbar) is not set, you 
can display a cursor by clicking the drawing area (area limited by the axes) in the trend display pane. 
Note that the cursor is also printed, if visible. 

 

Depending on, whether scaled or unscaled values are to be shown, the cursor is either a dotted 
(scaled values) or dashed (unscaled values) vertical line with the following numerical values: 

1. Time at the point of the cursor (written vertically). 
2. For each trend, value at the point of cursor, and the channel number within brackets (if there 

is more than one trend). 

The selection, whether to show scaled or unscaled values, can be made either by the Graph Cursor 
command in the View menu, or Graph Preferences command in the Graph submenu of the File menu. 

If you have set the cursor at a point, where the trends are near each other, the numerical values can 
overlap, and are not readable. In such cases, especially if you are going to print the graph, you can 
hide some of the values by unchecking them in the Graph Cursor dialog box shown by the Graph 
Cursor command in the View menu. 

 

You can move the cursor horizontally by dragging, or by clicking another point within the trend drawing 
area. You can hide it by clicking the trend display pane outside the drawing area (area outside the 
axes), or by changing to zoom in mode by toggling Zoom In in the View menu (or zoom in graph button 
in the standard toolbar). 
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If the Zoom In toggle in the View menu (or zoom in graph button in the standard toolbar) is set, you can 
zoom in by dragging the mouse in the trend display pane, so that at least some of the rectangle shown 
while dragging is inside the trend drawing area (area limited by the axes). 

 

Note that while the rectangle is shown, DriveWindow stays topmost on the screen. Only an application 
using the same feature (like Windows Task Manager) can overlay DriveWindow at that time. If it 
happens that such an application overlays the rectangle, behavior of the zoom operation can not be 
determined. 

The rectangular area is used to approximately determine new x-axis length and y-axis minimum and 
maximum in a new zooming level. The new values are made from the rectangle by rounding to a 
“smooth” value. The new values are also show in the trend settings pane. 

 

Note that it is possible that the rounded values of x-axis length and y-axis minimum and maximum are 
the same as before zooming. If that is the case, you can use the trend settings to change them. 

To restore back to the previous zooming level, select Zoom Out in the View menu (or zoom out graph 
button in the standard toolbar). 

To reset zooming back to the unzoomed level, select Zoom Reset in the View menu (or reset graph 
zoom button in the standard toolbar). 
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See Also: Window Area 

9.4.1 Monitor Display 

The monitor display is one of the displays shown in the trend display pane. 

You select the display by clicking the Monitor tab at top of the trend settings pane. 

 

Selection of the display shown also affects the trend settings pane. It shows the monitor settings, if 
monitor is selected. 

The monitor can be in the following states: 

• Cleared. You can change any of the settings in this state. Only a stopped monitor can be 
cleared. Exporting the graph is not possible (there are no values to export). No cursor can be 
shown. Zooming and horizontal scrolling are not possible. 

• Running. The trends are drawn in real time. No cursor can be shown. Zooming and horizontal 
scrolling are not possible. Saving, printing, copying, and exporting the graph is not possible. 

• Paused. Same as Stopped, but values are still collected, however not drawn, and you can 
later continue monitoring. Collected values are drawn, when you restore running state. You 
can also stop the monitor, in which case the values collected behind the scene are lost. 

• Stopped. Only mode, interval, and size of history buffer cannot be changed. Cursor can be 
shown. Zooming and horizontal scrolling are possible. You have to clear the monitor before 
running it again. Note that some changes (such as scaling) require redrawing all data in the 
history buffer, which can take a long time. 

You can scroll vertically and change x-axis length and y-axis minimum and maximum in all states. 

See Also: Trend Display Pane 
Monitor Menu 
Monitor Toolbar 
Monitor Settings 

9.4.2 Datalogger Display 

The datalogger display is one of the displays shown in the trend display pane. The display shows the 
current datalogger (see browse tree pane). The display is blank, if there is no current datalogger or the 
current datalogger is not initialized in the drive. 

You select the display by clicking the Datalogger tab at top of the trend settings pane. 

 

Selection of the display shown also affects the trend settings pane. It shows the datalogger settings of 
the current datalogger, if datalogger is selected. 

The title shown includes also the OPC Address of the datalogger. You can use it to verify that you are 
working with the proper datalogger. 
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Note that origin of the x-axis is the triggering moment. Thus negative time values represent time before 
triggering and positive after the triggering event. 

The datalogger display can be in two states: 

• Cleared. You can change any of the settings in this state, if the datalogger in the drive is not 
running. Note that you enter into this state by Clear Graph command (or clear datalogger 
graph in the datalogger toolbar). Normal Clear command (or clear drive datalogger in the 
datalogger toolbar) controls the datalogger residing in the drive. The datalogger settings are 
taken from the drive and changes are written to the drive. Exporting the graph is not possible 
(there are no values to export). No cursor can be shown. Zooming and horizontal scrolling are 
not possible. 

• Uploaded. The settings are frozen when the datalogger is uploaded. You can change x-axis 
length and y-axis minimum and maximum in this state, however. Scaling can be changed, 
too. Cursor can be shown. Zooming and horizontal scrolling are possible. You have to clear 
the datalogger graph before uploading it again. The Status setting can be toggled on-line/off-
line. When off-line, it shows the uploaded status, when on-line, it shows current status. 

Note that in both states it is possible to send commands to the datalogger, e.g., start it while still 
viewing the uploaded results. 

Note that there is a common window shared by all dataloggers. When the current datalogger is 
changed, the window is redrawn. The uploaded values and settings are cached in DriveWindow, so 
changing happens quickly. 

See Also: Trend Display Pane 
Datalogger Menu 
Logger Toolbar 
Datalogger Settings 

10. Scrollbars 
Scrollbars are displayed at the right and bottom edges of a document window. They are not visible if 
the document fits into the view. 

 

Parts of a scrollbar are: 

1. Scroll arrows 
2. Scrollbar shaft 
3. Scroll box (thumb) 

The scroll boxes inside the scrollbars indicate your vertical and horizontal location in the document. 
You can use the mouse to scroll to other parts of the document. 

When you click in a scrollbar shaft, the document scrolls a “page”. When you click in a scroll arrow, the 
document scrolls a "line" or “character”. You can also drag a scroll box (thumb) to set the scroll 
position. 

See Also: Overview 
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11. Common Dialogs 
Some commonly used dialog boxes are explained here: 

• File Comment dialog box for viewing, entering, and editing comments in files. 
• Open dialog box for opening files. 
• Print Setup dialog box for selecting and adjusting settings of the printer to be used. 
• Save As (and like) dialog box for saving files. 

11.1 File Comment Dialog 

The File Comment dialog box is used to view, enter, and edit comments in parameter, 
graph/workspace, and some export files. 

 

When the dialog box is shown while saving first time or exporting a file, the default comment set by 
DriveWindow is a time stamp consisting of current date and time. However, the default comment for 
graph/workspace files is empty. 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

When you are ready with your comment, press Enter or click the OK button. If you want to cancel the 
save or export operation, press Esc or click the Cancel button. 

See Also: How to Save Parameters 
How to Compare Parameters 
How to Export Parameters 
How to Save Workspace 
Viewing and Editing File Comment (Workspace) 
Saving Trends 
Viewing and Editing File Comment (Trends) 
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11.2 Open Dialog 

The Open dialog box is used to open various files in DriveWindow. 

 

The dialog box contains: 

1. Edit field to enter the filename. 
2. Drop-down list to select type of files listed in the list box of folders and files. 
3. Check field to open the file in read-only mode (not included in all Open dialog boxes). 
4. Button to do the opening or refreshing the list box of folders and files, if a wild card 

construction was entered into the File name field. Same as pressing the Enter key. 
5. Button to cancel the operation. Same as pressing the Esc key. 
6. List box containing list of folders and files in the current folder. Files shown are filtered by the 

selected Files of type, or a wild card construction in the File name field. Clicking a file name in 
the list box puts its name into the File name edit field. Double-clicking opens the file. 

7. Scrollbar for scrolling the list box, if needed. 
8. Drop-down list to browse and change the current folder, content of which is then shown in the 

list box. 
9. Button to change the current folder up one level. 
a. Button to create a new folder within the current folder. 
b. Button to move back to the previous folder. 
c. Button to select the way the content of the listbox is shown. 
d. Clicking the icon opens the System Menu. The icon may not exist in all operating systems. 

The Open dialog box can also be used as a mini explorer. The file selected in the list box can be 
renamed, deleted, copied, pasted, etc. the same way as in the Windows Explorer, by using shortcut 
keys, for example. 
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You can also right-click a file or folder name in the list box to get a context menu, from which you can 
select the Windows Explorer command to be executed. 

 

Right-clicking the background of the list box brings up another menu, which allows you to execute 
more Windows Explorer commands. 
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11.3 Print Setup Dialog 

The Print Setup dialog box is used to select and adjust settings of the printer to be used in printing 
graphs. 

 

In addition to be able to select the printer, paper size, orientation, and source, you can do printer 
dependent adjustments by clicking the Properties button. 

Note that when a graph is printed, it is automatically expanded to fill the printing area of the selected 
paper. If you want the print-out to look similar than it is displayed on your screen, paper orientation 
should be landscape. 
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11.4 Save As Dialog 

The Save As dialog box and its variants are used to name the file to be saved in various situations in 
DriveWindow. 

 

The dialog box contains: 

1. Title explaining the operation. 
2. Edit field to enter the filename to be used. 
3. Drop-down list to select type of files listed in the list box of folders and files. 
4. Button to do the opening or refreshing the list box of folders and files, if a wild card 

construction was entered into the File name field. Same as pressing the Enter key. 
5. Button to cancel the operation. Same as pressing the Esc key. 
6. List box containing list of folders and files in the current folder. Files shown are filtered by the 

selected Files of type, or a wild card construction in the File name field. Clicking a file name in 
the list box puts its name into the File name edit field. Double-clicking uses the name of the 
file double-clicked. 

7. Scrollbar for scrolling the list box, if needed. 
8. Drop-down list to browse and change the current folder, content of which is then shown in the 

list box. 
9. Button to change the current folder up one level. 
a. Button to create a new folder within the current folder. 
b. Button to move back to the previous folder. 
c. Button to select the way the content of the listbox is shown. 
d. Clicking the icon opens the System Menu. The icon may not exist in all operating systems 
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If the file already exists, confirmation about replacing it is asked. 

 

If you click the No button, the Save As dialog box is restored. 

If the file already exists and is read-only, you get a message that you cannot replace it. 

 

The Save As dialog box can also be used as a mini explorer. The file selected in the list box can be 
renamed, deleted, copied, pasted, etc. the same way as in the Windows Explorer, by using shortcut 
keys, for example. 

You can also right-click a file or folder name in the list box to get a context menu, from which you can 
select the Windows Explorer command to be executed. 
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Right-clicking the background of the list box brings up another menu, which allows you to execute 
more Windows Explorer commands. 

 

12. Shortcut Keys 
A shortcut key, also called hot key or accelerator key, is a keyboard key or key combination, which 
invokes a particular command. 

There are DriveWindow specific shortcut keys, which may have quite different meaning in other 
application programs, and common Windows shortcut keys, which have the same meaning in most 
applications adhering to Windows user interface recommendation. 

Note! Shortcut keys other than F1 do not work while a menu is dropped-down. 
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12.1 DriveWindow Specific Shortcuts 

The following are DriveWindow specific shortcut keys, which may have quite different meaning in other 
application programs. 

Shortcut Command.  

Ctrl+W Open command in the Workspace submenu of the File menu. Presents an Open 
dialog box for selecting the file containing the workspace settings to be restored. 
Restores the workspace settings from the file. 

Ctrl+Shift+W Save As command in the Workspace submenu of the File menu. Presents a Save 
As dialog box for naming or selecting the file, into which the workspace settings are 
saved. Saves the current workspace settings to the file. 

Ctrl+O Open command in the Parameters submenu of the File menu. Presents an Open 
dialog box for selecting the file containing parameters. Opens the file so that the 
parameters are browsable in the browse tree pane. 

Ctrl+S Save As command in the Parameters submenu of the File menu. Presents a Save 
As dialog box for naming or selecting the file, into which the parameters are saved. 
Saves parameters of the drive or open parameter file currently selected in the 
browse tree pane. 

Ctrl+D Download command in Parameters submenu of the File menu.If not downloading 
parameters of a drive from the currently open parameter file, the parameter file is 
requested by presenting a Download dialog box, which is similar to the Open dialog 
box. Presents a Select Restore Type dialog box, which allows you to choose, 
whether user data, ID run results, or both, is to be downloaded. Downloads the 
parameters from the parameter file to the drive selected in the browse tree pane. 

Ctrl+Shift+Z Zoom In toggle in the View menu, same as zoom in graph button in the standard 
toolbar. Puts the trend display pane into zoom-in mode, which allows the user to 
select the zoom-in area. 

Ctrl+N Network Servers command in the Network menu. Presents a Select OPC Server 
dialog box and connects to the selected server, which can also reside in a remote 
PC. 

Ctrl+Shift+N Disconnect Server command in the Network menu. Disconnects the currently 
connected OPC Server. 

Alt+F2 Take Control/Release Control command in the Drive menu, same as take/release 
control button in the Drive Panel toolbar. Toggles the control status of the drive, 
which is selected from the browse tree pane. Note that it is possible to control at 
most one drive at a time. Toggling the control status changes the menu text. 

Alt+F8 Reset Fault command in the Drive menu, same as reset fault button in the Drive 
Panel toolbar. Sends fault reset command to the currently controlled drive. 

Shift+F9 Start command in the Drive menu, same as start button in the Drive Panel toolbar. 
Sends start command to the currently controlled drive. 

Shift+F10 Stop command in the Drive menu, same as stop button in the Drive Panel toolbar. 
Sends stop command to the currently controlled drive. 

Ctrl+F5 Reverse or On command in the Drive menu, same as reverse or close contactor 
button in the Drive Panel toolbar. Sends reverse or contactor close command to the 
currently controlled AC or DC drive. 

Ctrl+F6 Forward or Off command in the Drive menu, same as forward or open contactor 
button in the Drive Panel toolbar. Sends forward or contactor open command to the 
currently controlled AC or DC drive. 
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Ctrl+F4 Coast Stop command in the Drive menu, same as coast stop button in the Drive 
Panel toolbar. Sends coast stop command to the currently controlled drive. 

Ctrl+A Add New Item command in the Desktop menu, same as add item button in the 
standard toolbar. In the browsed item set presents an Add Item to Desktop dialog 
box and adds the item, OPC Address of which is given, into the item set. The item 
is named by the user. In user item sets presents an Add New Template dialog box 
and adds the template, properties of which are given, into the item set. 

F3 Change Format command in the View menu. Presents a dialog box, in which the 
user can temporarily change display format of the values of the selected items in 
the item set, or numerical values shown with the graph cursor of the selected 
channels in the trend display pane. 

Ctrl+M Start command or Continue command, if monitor is paused, in the Monitor menu, 
same as start or continue monitoring button in the monitor toolbar. Starts or 
continues monitoring. 

Ctrl+Shift+M Stop monitoring command in the Monitor menu, same as Stop button in the monitor 
toolbar. Stops monitoring. Monitor must be cleared before it can be started again. 

Ctrl+Shift+P Pause command in the Monitor menu, same as pause monitoring button in the 
monitor toolbar. The monitored items are still measured, but the display freezes until 
monitoring is continued. 

Ctrl+Shift+S Autoscale command in the Scaling submenu of the Monitor and Datalogger menus. 
DriveWindow calculates and sets proper scaling of all or selected trends. 

Ctrl+Shift+Y Adapt Y Axis command in the Axis submenu of the Monitor and Datalogger menus. 
DriveWindow selects and sets proper y-axis minimum and maximum values of the 
corresponding graph at current zooming level, if any, for you. 

 

Note! Shortcut keys other than F1 do not work while a menu is dropped-down. 

The following common Window shortcuts are marked in the DriveWindow Edit menu. 

Shortcut Function.  

Ctrl+X Cuts the selected item(s) to the clipboard. 

Ctrl+C Copies the selected item(s) to the clipboard. 

Del Deletes the selected item(s).  

12.2 Some Common Windows Shortcuts 

The following are some common Windows shortcut keys, which have the same meanings in most 
applications adhering to Windows user interface recommendation. Note that not all of the shortcuts 
presented here work with DriveWindow. 

12.2.1 General Windows Keys 

Shortcut Function.  

F1 Displays Help information for the active object or the window as a whole.  

Shift+F1 Enters help mode. To display context-sensitive Help, move the question 
mark pointer to the object you want help on (such as a toolbar), and click. 

Windows key 
Ctrl+Esc 

Opens the Start menu located on the taskbar.  
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12.2.2 Task, Shutting Down, and Cancel 

Shortcut Function.  

Ctrl+Alt+Del Opens the Windows Security dialog box.  

Del Deletes the selected item(s). If the items are files, moves them to the 
Recycle Bin.  

Ctrl+X Cuts the selected item(s) to the clipboard. 

Ctrl+C 
Ctrl+Ins 

Copies the selected item(s) to the clipboard. 

Ctrl+V 
Shift+Ins 

Pastes the copied items(s) from the clipboard. 

Windows key+M Minimizes all open windows. 

Windows key+Shift+M Restores all windows minimized by Windows key+M. 

Windows key+E Opens the Windows Explorer. 

Windows key+F Opens the Find: All Files dialog box. 

Windows key+R Opens the Run dialog box. 

Windows key+Break Opens the System Properties dialog box. 

Windows key+Ctrl+F Opens the Find Computer dialog box. 

Application key 
Shift+F10 

Opens the shortcut menu for the active item (same as right-click). 

12.2.3 Desktop and Taskbar Navigation Keys   

Shortcut Function.  

Windows key+M Minimizes all open windows. 

Windows key+Shift+M Restores all windows minimized by Windows key+M. 

Arrow key Selects the adjacent icon or taskbar button in the direction of the arrow.  

Any printing character Selects the next icon with the specified name or initial letter  

Windows key 
Ctrl+Esc 

Opens the Start menu from the taskbar. Press Esc again to place the 
keyboard focus on the Start button.  

Windows key+Tab Cycles through the taskbar buttons.  

F2 Rename a selected item. A bold rectangle appears around the title 
creating a text box. Type the new name and press Enter. Press Esc to 
cancel. 

F3 Opens the Find: All files dialog box 
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12.2.4 Window Manipulation Keys   

Shortcut Function.  

Alt+F4 Closes the active application window. (This can also be opened from the 
Program menu of the active application.)  

Alt+Spacebar Opens the Program menu from the leftmost icon on the title bar of the 
active window. The Program menu typically contains the following 
commands: Restore, Move, Size, Minimize, Maximize and Close.  

Alt+Tab 
Alt+Shift+Tab 

Switches to the most recently used application window. To select an 
application from a list, continue to hold Alt down and press Tab more than 
once to move through the list. Add Shift to reverse direction through the 
list. 

Alt+Esc 
Alt+Shift+Esc 

Switches keyboard focus to next application window, including minimized 
windows on the taskbar. Press Esc more than once to switch through 
successive windows and add Shift to reverse the direction. 

Alt+Enter Switches an MS DOS-based application between full-screen and 
windowed modes.  

PrintScreen Copies an image of the screen to the clipboard.  

Alt+PrintScreen Copies an image of the active window to the clipboard.  

12.2.5 Document Windows Keys   

Shortcut Function.  

Ctrl+F4 Closes the active document window.  

Ctrl+F6 Switches to next document window in the active application. 

Ctrl+Shift+F6 Switches to previous document window in the active application. 

Alt+Hyphen Opens the Document menu from the leftmost icon on the title bar of the 
active document window. The Document menu typically contains the 
following commands: Restore, Move, Size, Minimize, Maximize and Close. 



User Interface 

2-90 DriveWindow 2 

12.2.6 Menu Commands   

Shortcut Function.  

Windows key 
Ctrl+Esc 

Opens the Start menu on the taskbar.  

Alt 
F10 

Activates the menu bar of the active window. The leftmost menu name is 
selected. Press F10 or Alt again to toggle the focus back to where it was 
previously.  

Left Arrow 
Right Arrow 

Moves the focus between menus on the menu bar in the direction of the 
arrow. If the original menu was open, the target menu will be opened and 
the focus on the first item.  

Up Arrow 
Down Arrow 

Opens the selected menu. Down Arrow selects the next command in the 
list. Up Arrow selects the previous command in the list.  

Enter Opens the selected menu when focus is on the menu title, but it activates 
a menu item when focus is on a menu item. If the selected menu item is 
unavailable, Enter closes the menu.  

Alt+Spacebar Opens the Program menu from the leftmost icon on the title bar of the 
active window. The Program menu typically contains the following 
commands: Restore, Move, Size, Minimize, Maximize and Close. 

Alt+Hyphen Opens the Document menu from the leftmost icon on the title bar of the 
active document window. The Document menu typically contains the 
following commands: Restore, Move, Size, Minimize, Maximize and Close.

Esc Closes an open menu and moves the focus back to the parent menu if 
there is one. Otherwise it returns the focus to the menu title. If the focus 
was already on the menu title, focus moves back to wherever it was 
before activating the menu bar. 

Alt+Any printing character Chooses the menu with the underlined character (access key) on the main 
menu bar. 

Any printing character Chooses the command with the underlined character (access key) on an 
open menu.  

Application key 
Shift+F10 

Opens the shortcut menu for the active item (same as right-click). 
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12.2.7 Text Navigation and Editing Keys   

Shortcut Function.  

Ins Toggles between overtype and insertion modes. (Edit controls only 
support insert mode.) 

Arrow key1) Moves the pointer one character in the direction of the Arrow key. If there 
is selected text, moves the pointer to the end of the selection and 
deselects the text.  

Home1) 
End1) 

Moves the pointer to the beginning or end of the current line.  

PgUp1) 
PgDn1) 

Moves the pointer up or down one screen or to the first or last line.  

Ctrl+Right1) 

Ctrl+Left1) 
Moves the pointer to the beginning of the next or previous word.  

Ctrl+Up1) 
Ctrl+Down1) 

Moves the pointer to the beginning of the preceding or next paragraph. 
(Not supported in edit controls.)  

Ctrl+Home1) 
Ctrl+End1) 

Moves the pointer to the beginning or the end of the document. (Not 
supported in edit controls.) 

Del Deletes the next character or the selected text.  

Backspace Deletes the previous character or the selected text.  

Ctrl+Z  
Alt+Backspace 

Undoes the last action.  

Ctrl+C 
Ctrl+Ins 

Copies selected text to clipboard.  

Ctrl+X 
Shift+Del 

Cuts the selected text to the clipboard.  

Ctrl+V 
Shift+Ins 

Pastes copied text from clipboard. 

1)Press Shift with the key to select blocks of text for editing. For example, press Shift+End to select text 
from the pointer to the end of the line. Shift toggles, in other words you can also use Shift+the above 
navigation keys to both select and deselect text. 
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12.2.7 Text Navigation and Editing Keys   

Shortcut Function.  

Ins Toggles between overtype and insertion modes. (Edit controls only 
support insert mode.) 

Arrow key1) Moves the pointer one character in the direction of the Arrow key. If there 
is selected text, moves the pointer to the end of the selection and 
deselects the text.  

Home1) 
End1) 

Moves the pointer to the beginning or end of the current line.  

PgUp1) 
PgDn1) 

Moves the pointer up or down one screen or to the first or last line.  

Ctrl+Right1) 

Ctrl+Left1) 
Moves the pointer to the beginning of the next or previous word.  

Ctrl+Up1) 
Ctrl+Down1) 

Moves the pointer to the beginning of the preceding or next paragraph. 
(Not supported in edit controls.)  

Ctrl+Home1) 
Ctrl+End1) 

Moves the pointer to the beginning or the end of the document. (Not 
supported in edit controls.) 

Del Deletes the next character or the selected text.  

Backspace Deletes the previous character or the selected text.  

Ctrl+Z  
Alt+Backspace 

Undoes the last action.  

Ctrl+C 
Ctrl+Ins 

Copies selected text to clipboard.  

Ctrl+X 
Shift+Del 

Cuts the selected text to the clipboard.  

Ctrl+V 
Shift+Ins 

Pastes copied text from clipboard. 

1)Press Shift with the key to select blocks of text for editing. For example, press Shift+End to select 
text from the pointer to the end of the line. Shift toggles, in other words you can also use Shift+the 
above navigation keys to both select and deselect text. 
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See Also: Workspace Submenu 

1. What is Workspace 
Workspace consists of user interface status, such as items shown in the browsed item set and their 
status. 

User can save current workspace status to a file and restore them later. 

Note that not all of the status are saved/restored. The following is a list of workspace status not 
saved/restored: 

• Drive control status. For safety reasons, control is never taken when restoring a workspace, 
even if control was taken, when workspace was saved. 

• A system software package is not automatically re-opened, when workspace is restored from 
a file. 
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Whether the following workspace information is saved and restored or not, depends on current 
workspace preferences: 

• Content and zooming levels of uploaded dataloggers. When workspace is restored from a file, 
and uploaded dataloggers are not restored, all datalogger contents in DriveWindow are 
cleared (as if Clear Graph command was executed for each of them). 

• Content, status, and zooming levels of a stopped, paused, or running monitor. When 
workspace is restored from a file, and monitor  data is not restored, monitor content is cleared 
(as if Clear command was executed). Note that even if monitor data is restored, monitor is 
stopped in case it was paused or running at the time the workspace was saved. 

Note that all other settings except Status on-line/off-line, X Axis Length, Y Axis Minimum, Y Axis 
Maximum, and scaling information of dataloggers are actually kept in the drives. Thus it is not possible 
to restore those other settings from a workspace file. They are preserved in the drives, however. 

Note! Workspace (.dww) and graph (.dwt) files can contain binary data. Never edit a workspace or 
graph file. Also, if you are copying such a file, use a binary copying program (use /b with COPY, 
for example). 

1.1.1 Saved Graphs 

Saved graphs are actually incomplete off-line workspaces, which contain just enough information to 
restore the graphs saved within them. 

Thus it is possible to open a graph file (.dwt) as a workspace, too. 

See Also: What are Preferences 

2. What are Preferences 
Preferences are settings, which allow the user to control various behaviours of DriveWindow. 

The following is a list of groups of preferences the user can set: 

• Workspace Preferences 
• Graph Preferences 
• Graph Cursor 
• Desktop Preferences 

The following groups of properties are similar to preferences, but they are saved only in a workspace: 

• Item Set Properties 
• Template Properties 

If you are working with a same computer and keep your preferences constant, you need not to be 
aware, what is saved in a workspace. 

However, if you restore a workspace made elsewhere, settings restored from the workspace may differ 
from your settings. They are in effect only while the workspace is open. When you restart DriveWindow 
or restore a workspace of your own, your preferences are effective again. 

Note that when a preference is restored from a workspace file, it is in effect only while the workspace is 
open. When you restart DriveWindow, the last preference settings that you made are effective again. 

Preferences can be either common for all users of a computer or personalized, i.e., separate for each 
user. The setting can be changed in Workspace Preferences. In Windows Vista, however, the 
common preferences affect only the current user because of the virtualization method used by Vista for 
better security. See the document DriveWindowUnderWinVista.pdf for further details about the 
virtualization. 
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Note that the selection, whether to use common or personalized preferences, is always personalized. It 
means that each user can separately select, whether she uses common preferences or preferences of 
her own. 

2.1.1 Common Preferences 

DriveWindow keeps common preferences and status information in common DW21.INI file in the 
DriveWare folder of ProgramData. 

Never edit this file because it may crash DriveWindow. However, you can delete the file, which causes 
DriveWindow to use default preferences. 

Because common preferences are kept in a single file, it is easy to copy the preferences to another 
computer just by copying the file. 

We recommend that you use common preferences instead of personalized whenever possible, 
especially if: 

• You are the only user of the computer or DriveWindow 
• All users are working on the same project 

2.1.2 Personalized Preferences 

DriveWindow keeps personalized preferences in the user specific DW21.INI file in the DriveWare 
folder under user specific AppData\Roaming. 

Never edit this file because it may crash DriveWindow. However, you can delete the file, which causes 
DriveWindow to use common preferences and sets personalized preferences to the default values. 

It is easy to copy the personalized preferences to another computer just by copying the file. 

We recommend that you use common preferences instead of personalized whenever possible. 
Consider using personalized preferences only if the computer and DriveWindow have several 
unrelated users (demo use, for example) and you operating system is not Windows Vista. 

See Also: What is Workspace 
Folder Locations 

3. Why to Use Workspaces 
The basic idea of using workspaces is to let you exit from DriveWindow and later easily to continue 
from that point (with some exceptions). In general, you can do it as follows: 

• Just before you exit, save your current settings into a workspace file. 
• Exit DriveWindow. 
• When you later restart DriveWindow, do not connect the OPC Server. 
• Open the workspace file you saved, and DriveWindow restores the settings, including 

connection to the OPC Server. 
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Instead of first starting DriveWindow and then opening the workspace file, you can in Windows 
Explorer, for example, double click the workspace file. DriveWindow starts and opens immediately the 
workspace. 

 

If you often interrupt your work and want to continue later from the point you left, you can set the 
preferences to automatically save and restore the workspace when DriveWindow exits and is started 
again. 

Instead of making user item sets, you can also use workspaces to make/restore settings of own during 
a DriveWindow session. For example, you may have several signals and parameters from different 
groups, which you want to see together in the browsed item set. If you have many of such groupings of 
your own, you can save each of you settings into a separate workspace file. Restoring of such a 
workspace during a session happens quickly because the OPC Server is not disconnected, if it is 
currently the same as the one saved into the workspace file. 

You can do it as follows: 

• Connect to the OPC Server as normal. 
• Browse the items you want to see and lock them into the browsed item set. If you wish, put 

them on-line. 
• Save the settings into a workspace file. 
• Repeat the two preceding steps for each of your favourite settings, but saving the settings into 

separate workspace file. 
• When you want restore a specific setting, open the corresponding workspace file. 

It is also possible to save the workspace for off-line viewing. This feature allows you to save data on 
site and view it later at the office, for example. 

The feature can be enabled in the Workspace Preferences. When the feature is enabled, the Save As 
dialog box contains a Save for Offline check field, checking of which writes off-line information into the 
workspace file. When such a workspace file is restored, DriveWindow goes off-line and fetches all data 
from the file. 

Note that saved graphs are actually incomplete off-line workspaces, which contain just enough 
information to restore the graphs saved within them. 
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4. How to Save Workspace 
If you are going to save the workspace for off-line viewing with data from a single drive, please select 
first the drive by clicking it in the browse tree pane. It is not necessary to select the root, however. 
Selection of any of its sub-branches will do. 

 

Select Save As command residing in the Workspace submenu of the File menu. 

 

A Save As dialog box is displayed. 

4.1.1 When the Save As dialog box is displayed: 

• From Save in, browse into the drive and directory, into which you want to save the workspace 
file 

• Enter the name of the workspace file into File name or, if you want to replace an existing file, 
click the filename you want to replace 

• Click Save and a file comment is requested 
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If, in Workspace Preferences, Save for Offline is enabled, a Save for Offlline check field is shown in 
the Save As dialog box. Please uncheck it, unless you want to save the workspace for off-line. 

 

If the file already exists, confirmation to replace it asked. 

 

4.1.2 Saving for Off-line 

If you checked the Save for Offline check field in the Save As dialog box, a Save for Offline dialog box 
is shown. Note that the check field is visible only if DriveWindow is connected to at least one drive. 

 

You have now the option to select: 

• What items to save (at least one group has to be selected) 
• Whether to save the items of all drives or of only the drive selected in the browse tree pane 
• Whether to include monitor and/or uploaded dataloggers 
• Whether to compress the workspace file or not 

You have also the option to cancel saving for off-line, in which case the Save As dialog box reappears. 

Note that it is possible to select saving of graphs of uploaded dataloggers only, if All is selected. 
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If you have made selections, which require a long time to execute (such as saving parameters of all 
drives), DriveWindow informs you about it by displaying a message box. 

 

If you click No, the Save for Offline dialog box reappears. 

4.1.3 When the File Comment dialog box is displayed: 

The comment field is empty by default. 

• Enter, add, edit, or accept the comment in the edit field 
• Click OK, and saving starts 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

See Also: Save As Dialog 
How to Restore Workspace  
What is Workspace 
Off-line Mode 
Workspace Preferences 
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5. Save Workspace on Exit 
When you are exiting DriveWindow, you do not have autosave enabled in workspace preferences, and 
you have made major changes into the item sets since you last saved the workspace, DriveWindow 
asks you, if you want to save your changes before exiting. 

 

If you click yes, normal workspace save sequence is started by displaying the Save As dialog with the 
exception that if you cancel the sequence, the question about saving is requested again. 

Adding, arranging, removing, or changing properties of an item set are considered to be such a major 
change in the workspace that cause DriveWindow to ask the question. 

See Also: How to Save Workspace 
What is Workspace 
Workspace Preferences 

6. How to Restore Workspace 
Instead of first starting DriveWindow and then opening the workspace file, you can in Windows 
Explorer, for example, double click the workspace file. DriveWindow starts and opens immediately the 
workspace. 
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Otherwise, if you are going to restore a workspace while starting up DriveWindow, you need not to 
connect the OPC Server. So, click Cancel, when the Select OPC Server dialog box is displayed. 

 

Now that DriveWindow is disconnected, you can restore your settings, including the OPC Server 
connection, by opening a workspace file. 

However, if the workspace was saved for off-line (or is a graph file), the connection is not restored. 
Instead, DriveWindow goes into off-line mode. 

If you want to restore settings from a workspace file during a DriveWindow session, just open the 
workspace file. 

See Also: How to Save Workspace 
What is Workspace 
Off-line Mode 

6.1 Opening a Workspace File 

To open a workspace file, select Open command from the Workspace submenu of the File menu, or 
press the Ctrl+W key. 

 

The same command is named Workspace in the context menu, which you get by clicking with the right 
mouse button on the browse tree pane when it is empty. 
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If you have made major changes into the item sets since you last saved the workspace, DriveWindow 
asks you, if you want to save your changes before restoring is done. At this moment you also have the 
option to cancel the restoring operation. 

 

Adding, arranging, removing, or changing properties of an item set are considered to be such a major 
change in the workspace. 

6.1.1 When the Open dialog box is displayed: 

• From Look in, browse into the drive and directory, in which the workspace file resides 
• Click the workspace file you want to open 
• Click Open and the workspace settings are restored 

 

Note! You can also enter the name of the workspace file into File name, with or without a directory 
path. 

Note! Do not open a workspace made for another drive configuration. Although the opening may 
succeed, the information shown can be misleading. Descriptive names of parameters, for 
example, are taken from the workspace file. They can be quite different from names in the drive, 
if drive types differ 
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If you have control taken, but the connection to the OPC Server does not change, DriveWindow 
prompts you about releasing control. 

 

If DriveWindow is currently on-line and the connected OPC Server changes, you are prompted about 
disconnecting the current OPC Server (and about releasing control, if control is taken). 

 

See Also: Open Dialog 
How to Restore Workspace 

6.2 Viewing and Editing the File Comment 

When you have opened a workspace file, you can view and edit the file comment that was saved with 
it. 

  

Note! Because a graph file is actually a special workspace file, you can view and edit the comment as 
a graph file comment, too. 
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A File Comment dialog box is presented. It shows the comment in its edit field. The comment text is 
selected, which means that if you just start typing, the previous text is replaced by your new comment. 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

When you are done with editing, click the OK button. Click the Cancel button, if you do not want to 
change the comment. 

See Also: How to Save Workspace 
Restoring Trends 

7. Off-line Mode 
Since version 2.10, DriveWindow can be used also off-line. A special OPC Server (OfflineOPC) makes 
this possible. It can save data about drives, when DriveWindow is on-line, and “simulate” drives using 
the saved data when DriveWindow is off-line. 

DriveWindow goes off-line when you either restore a workspace that was saved for off-line, or open a 
saved graph file (.dwt). Although you see the OfflineOPC special OPC Server in the Select OPC Server 
dialog box, you should never select it directly. 

In off-line mode the look and feel of DriveWindow are the same as if it was really connected to drives. 
However, some commands are disabled and possibly not all items are available. Also changing values 
of such items, which in a drive cause changes in other items (writing Control.Reference changes 
Status.Reference, for example), do not have similar effect when DriveWindow is off-line. 

You can differentiate between on-line and off-line mode by looking at the Network (OPC) server in the 
title bar of DriveWindow. In off-line mode, the server name is ABB.OfflineOPC, while in on-line mode it 
is ABB.SMP (or perhaps some other real OPC Server). 

  

You exit off-line mode by either disconnecting the OPC Server, or by opening a workspace that was 
not saved for off-line. 

See Also: How to Save Workspace 
How to Restore Workspace 
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8. Workspace Preferences 
You can change workspace preferences by selecting Preferences command in the Workspace 
submenu of the File menu. 

 

The Workspace Preferences tabbed dialog box is displayed. It has tabs for setting: 

• General Preferences 
• Workspace Save Preferences 
• Workspace Restore Preferences 
• Workspace Autosaving Preferences 

Any changes you made take effect when you click the OK button. However, if you change selection of 
common preferences to personalized, or vice versa, some settings require restarting of DriveWindow 
to take effect. 

No changes are made in case you click the Cancel button. 

See Also: What are Preferences 

8.1 General Preferences 

You can set general workspace preferences in the Workspace Preferences dialog box by selecting the 
General tab. 
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General preferences are: 

• Selection to use either common or personalized preferences. If you change the setting, we 
recommend that you restart DriveWindow. 

• Option to compress the graphical data when saving graphs or including graphs in a 
workspace file. This option does not affect saving a workspace for off-line, compression of 
which is controlled by the Save for Offline dialog box. 

• Option, whether to show the Save for Offline check field in the Save As dialog box, which is 
shown, when saving of the workspace is requested, or not. If the check field is not shown, 
saving for off-line is not possible. 

You should use compression with care. Compressing and expanding can take considerable time and 
may require large amount of disk space for temporal files. 

We recommend that you use compression only, if an otherwise very big workspace or graph file needs 
to be transported by electronic means. Also, if you need to have a big collection of workspace or graph 
files, you may consider use of compression. 

See Also: Workspace Preferences 

8.2 Workspace Save Preferences 

You can set workspace save preferences in the Workspace Preferences dialog box by selecting the 
Save tab. 

 

Save preferences are: 

• Option to save also monitored data with a workspace. 
• Option to save also data of uploaded dataloggers with a workspace. 

These options do not affect saving a workspace for off-line, behaviour of which is controlled by the 
Save for Offline dialog box. 

Restoring of saved monitor or uploaded datalogger data is selected separately. 

Saving of graphs with a workspace slows down the saving process and the resulting workspace file 
can be big. On the other hand, saving and restoring graphs with a workspace makes it easier to 
continue working, if DriveWindow requires restarting. 
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See Also: Workspace Preferences 
Workspace Restore Preferences 
Workspace Autosave Preferences 

8.3 Workspace Restore Preferences 

You can set workspace restore preferences in the Workspace Preferences dialog box by selecting the 
Restore tab. 

 

Restore preferences are: 

• Option to restore monitor in case monitor data is included in a workspace. 
• Option to restore uploaded dataloggers in case datalogger data is included in a workspace. 

Restoring of a monitor channel can be done only, if the monitored variable is found from the drive. 

Restoring of an uploaded datalogger can be done only, if the datalogger is found from the drive. 

Restoring of graphs from a workspace slows down the workspace restoring process. On the other 
hand, saving and restoring graphs with a workspace makes it easier to continue working, if 
DriveWindow requires restarting. 

See Also: Workspace Preferences 
Workspace Save Preferences 
Workspace Autosave Preferences 
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8.4 Workspace Autosave Preferences 

You can set workspace autosave preferences in the Workspace Preferences dialog box by selecting 
the AutoSave tab. 

 

Autosave preferences are: 

• Option to enable autosave. 
• Option to save and restore monitored data with the automatically saved workspace. 
• Option to save and restore data of uploaded dataloggers with the automatically saved 

workspace. 
• Option to select location of the automatically saved workspace (Windows temporal folder by 

default). 
• Option to select name of the automatically saved workspace (DW21AutoSave.dww by 

default). 

Restoring of a monitor channel can be done only, if the monitored variable is found from the drive. 

Restoring of an uploaded datalogger can be done only, if the datalogger is found from the drive. 

Enabled autosave means that DriveWindow automatically saves the workspace when it exits. When 
DriveWindow starts normally, the automatically saved workspace is restored. This makes it very easy 
to interrupt working and continue it later. However, autosave can make exiting and starting slow. 

Double clicking a DriveWindow file in the Windows Explorer (for example) by-passes automatic 
workspace restoring. In this case DriveWindow starts and opens the file that was double clicked. 

See Also: Workspace Preferences 
Workspace Save Preferences 
Workspace Restore Preferences 
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1. Definitions 
 

• Parameters and Signals 
• Faults and Events 
• Parameter File 
• Item Sets  
• Templates 

1.1 What are Parameters and Signals 

Strictly speaking, parameter and signals are items organised into parameter groups in a drive. Their 
OPC Addresses are of form: 

{channel}{node}Par.m.n 

where m is the group number and n is index within group. 

Except in some rare cases, DriveWindow handles all kinds of OPC items similarly, however. Thus, in a 
broad sense, all OPC items can be regarded as parameters or signals. So, in this documentation, 
when we speak about parameters and signals, we mean any OPC item, unless otherwise stated. 

Signals are read-only. Parameters can be written. Most of the parameters can be read as well, but, 
depending on the drive, there can exist write-only parameters. 

Parameter groups within drive can be pass code protected. In order to be able to browse them, you 
have to enter a proper value into a pass code parameter. 

User parameters are, loosely speaking, parameters and signals, which belong to non-pass code 
protected parameter groups 1-99. Actual user parameters depend on the drive. 

ID run result parameters depend on the drive and are usually pass code protected. 

1.2 What are Faults and Events 

Faults and events are entries in the fault and event loggers in a drive. Their OPC Addresses are of 
form: 

{channel}{node}FL.Ln, or 

{channel}{node}EL.Ln 

where n is a two-digit entry number starting from 00 (the latest fault or event). 

Although faults and events can be handled the same way as other items in DriveWindow, there are 
special item sets designed for them (in DriveWindow 2.20 or newer). 

The special item sets for faults and events make viewing of them much easier than browsing the fault 
or event logger. With some drives, DriveWindow is even possible to show time stamps in “real time”, 
even if the drive has no real time clock. 

Note that although all drives have an event logger, many drive types do not use it, i.e., it is always 
empty. 
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1.3 What is Parameter File 

A parameter file has filename extension DWP and it contains (in internal ASCII format) information 
about parameters and signals of a drive. 

Not all parameters of a drive are there. In addition of groups, which were not under pass code 
protection at save time, there are parameters required during download, Application Properties, and 
drive Properties without sub-branches. 

 

Note that because editing of a parameter file is possible, groups within Parameters (and even the 
Parameters sub-branch) can be removed by a user. 

Note also that DriveWindow 2 is able to read older parameter (*.DWP) files made by DriveWindow 1.x, 
if the drive family was ACS600. 

A parameter file is made by a specific command, which saves the parameters of the selected drive into 
the file. Also an open parameter file can be saved. 

A parameter file can be opened before you download it to a drive or compare it with a drive. It must be 
opened before you can edit it or compare it with another parameter file. An open parameter file can be 
saved, browsed, and values viewed and changed (except write-only parameters) the same way as if it 
was a drive. 

Note that instead of descriptive names of pass code protected parameters required by download, an 
artificial descriptive name is used in a parameter file. 

 

1.4 What are Item Sets 

An item set in DriveWindow (version 2.20 or newer) is a set of items (signals, parameters, faults, 
events), which can be viewed (listed) together in one of the views of the item sets pane. Each type of 
item set is displayed in a corresponding type of view. What items belong to an item set is defined by 
some rules. 

The item sets can be divided into two main types: 

• Any kind of OPC items 
• Faults and events 

By default, DriveWindow has three ready made item sets: 

• Browsed items 
• Control items 
• Faults 
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User can add and remove item sets. She can also change properties (the name, for example) of an 
item set. 

Control item set is actually a predefined user item set. By default it contains the same items as the 
Control Item Set of legacy versions of DriveWindow. In legacy versions those items were included in 
item list pane (now in browsed item set), when control was taken. 

Faults show contents of the fault logger of the drive selected in the browse tree pane. 

1.4.1 Item Sets for any kind of Items 

In DriveWindow there are three types of item sets belonging to the main category of any kind of OPC 
items: 

• Browsed items 
• All parameters 
• User defined items 

Browsed items are the same as the items in the item list pane of legacy versions of DriveWindow. That 
is, it contains items of the branch selected in the browse tree pane, and also locked and monitored 
items. 

Note that the browsed item set cannot be removed and there can be only one such an item set, so it 
cannot be added either. 

All parameters consist of all unprotected parameters and signals of the source drive. 

Note! We recommend no to use all parameters item set because of the potentially enormous 
communication traffic. Especially on-line item update will probably choke DriveWindow. 

User item sets consist of templates, which are actually rules that define, how each of the items is 
fetched and displayed. 

The predefined control item set is actually a user item set. Internally it has one additional feature, 
however. Workspaces containing it are backward compatible with Control Item Set of legacy versions 
of DriveWindow. It means that old versions of DriveWindow can read them from a workspace saved by 
a new version and vice versa. 

By default, the control item set contains of the following item templates (for compatibility with legacy 
versions of DriveWindow): 

Name OPC Address 

Last fault {}{}FL.00.Description 

Reference {}{}Control.Reference 

Reference (actual) {}{}Status.Reference 

1.4.2 Item Sets for Faults and Events 

In DriveWindow there are four types of item sets belonging to the main category of faults and events: 

• Faults of a single drive 
• Events of a single drive 
• Faults of all drives combined  
• Events of all drives combined 

There cannot be more than one item set of type faults of all drives and one item set of type events of 
all drives. 

Faults consist of the content of the fault logger and events consist of content of the event logger of a 
drive. 
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In the combined item sets, the items, about which DriveWindow is able to determine time stamps in 
“real time”, are ordered by time stamps. Thus it is easier to determine the main reason for a fault, 
which causes a chain reaction among multiple drives. 

The items belonging to an item set of type faults and events can be filtered so that only faults or events 
fulfilling the filtering criteria are included. 

See Also: What are Templates 

1.5 What are Templates 

A user item set is constructed by adding so called templates into it. 

Each template represents an item. Actually properties of a template make rules, which define the 
actual item shown and how it is shown in different situations. 

The properties of a template define: 

• OPC Address of the item, but without channel and node 
• Name displayed, unless the name is fetched from the drive and is available 
• Whether the name is fetched from the drive or not 
• How to determine the source drive (channel and node) 
• How to display the item in case it does not exist in the drive or source drive is currently 

undefined 
• How the value of the item is updated 
• The format to be used in displaying the value of the item 

Typically you do not define each of the properties separately for each template, however. Instead, you 
use defaults, which means that the properties of the item set are used. Then usually all items in the 
same user item set behave similarly. 

In most cases even many of the user item set properties are set to use defaults. For such properties 
the corresponding desktop preferences are used. It means that changing the desktop preferences 
immediately affects all item sets using default properties.  

See Also: What are Item Sets 

2. Opening a Parameter File 
Many operations require that you have a parameter file open. There can be most one parameter file 
open. Thus, if you already have a parameter file open, you have to close it first before opening a new 
one. 

Note that it is not required that DriveWindow is connected to an OPC Server, when you open a 
parameter file. 

Note that opening a parameter file does not prevent using the file in other applications. 

Restoring a workspace first closes the currently open parameter file, and then opens the parameter 
file, which was open at workspace save time, if the file exists. 
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If you do not have DriveWindow running, you can start DriveWindow by double clicking the name of a 
parameter file in Windows Explorer (for example). DriveWindow starts with the parameter file open. 

 

If you have DriveWindow running, but you are not connected to OPC Server, you can open a 
parameter file by copying it into the empty browse tree pane from Windows Explorer. Copying can be 
done by selecting Copy command in the Windows Explorer and, after clicking the empty browse tree 
pane, selecting the Paste command in the Edit menu of DriveWindow. 

  

Instead of copy and paste, you can also open a parameter file by dragging it from Windows Explorer 
into the empty browse tree pane. 

 

To open a parameter file within DriveWindow, select the Open command from the Parameters 
submenu of the File menu. 
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The same command can be found in the Parameters submenu of the context menu, which you get by 
clicking with the right mouse button on the non-empty browse tree pane. 

 

If you are not connected to OPC Server, the context menu looks different and the same command is 
now named Parameters in the Open submenu. 

 

When the Open dialog box is displayed: 

• From Look in, browse into the drive and directory, in which the parameter file resides 
• Click the parameter file you want to open 
• Click Open 

 

Note! You can also enter the name of the parameter file into File name, with or without a directory 
path. 

Note! You can limit the filenames displayed by entering a wildcard construct into File name and then 
clicking Open. 
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If the file could be opened, it will be shown above all drives at in the browse tree pane. 

 

If there is a problem in opening, you are informed about it. After clicking the OK button in the message, 
the open dialog is shown again (if you were opening the file by using the dialog). 

 

or 

 

 

See Also: Parameters Submenu 
Open Dialog 

 

3. Closing a Parameter File 
When you do not need a parameter file any more, you can close it. Also, you cannot open another 
parameter file before closing the currently open one. 

Note that disconnecting the OPC Server, which happens also internally during some operations, closes 
the parameter file, too. Closing DriveWindow and restoring a workspace also close the currently open 
parameter file. 



Parameters, Signals, and Faults 

DriveWindow 2 4-11 

There are two basic ways to close the parameter file. The first one is using the Close command in the 
Parameters submenu of the File menu. 

 

The same command can be found in the Parameters submenu of the context menu, which you get by 
clicking with the right mouse button on the browse tree pane. 

 

The other one is clicking the Delete button in the standard toolbar when focus is in the browse tree 
pane and the parameter file root is selected. 

 

Instead of clicking the Delete button, Delete command can be invoked also by pressing the Del key or 
using the Edit menu. 

 

The same command can be found in the context menu, which you get by clicking with the right mouse 
button on the parameter file root in the browse tree pane. 
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If you have made any changes into the parameter file, you are requested, whether to save the changes 
or not. 

 

If you click Yes, a parameter save sequence is started as if you had selected Save As from the 
Parameters submenu. 

See Also: Parameters Submenu 
Save As Dialog 

4. Working with Item Sets 
By using item sets and workspaces you can speed up considerably your frequently repeated tasks. 

You can add, edit, arrange, and remove item sets of several types. The most useful are so called user 
item sets and faults. 

Each item set has its own view in the item sets pane. An item set view can be selected by clicking its 
tab. 

 

DriveWindow has following types of item sets: 

• Browsed items, which is a built-in item set and cannot be removed. Its main purpose is to 
display the items of the currently selected branch in the browse tree pane. 

• All parameters, which contains all un-protected parameters of the source drive. Use of the all 
parameters item set is discouraged because of potential communication problems. 

• User items, which is an item set, content of which is defined by the user. 
• By default, there is a predefined user item set called Control, which contains some items of 

the drive, control of which is taken. It is backwards compatible with the Control Item Set of 
DriveWindow versions prior 2.20. It can be removed in case it is not needed. 

• Faults, which is used to view content of the fault logger of the source drive. By default, there is 
a predefined item set of this kind, source drive of which is the drive, branch of which is 
selected in the browse tree pane. 

• Events, which is used to view content of the event logger of the source drive. 
• All faults, which is used to view combined contents of fault loggers of all connected drives. 

There cannot be more than one of this kind of item sets. 
• All events, which is used to view combined contents of event loggers of all connected drives. 

There cannot be more than one of this kind of item sets. 
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You can add new item sets, view them, print them, arrange them (i.e., change their order), remove 
them, and change their properties (names shown in the tab, for example). You can copy and drag 
selected items of an item set. With some item sets you can add, paste, and drop new items into the 
item set. 

Item sets are saved and restored with workspaces. If you have made any changes in item sets and not 
saved the workspace, DriveWindow reminds you to save the workspace in case the changes might be 
lost. 

 

See Also: What are Item Sets 
What are Templates 

4.1 Restoring Default Item Sets 

Occasionally you may want to discard currently defined item sets and start over from the beginning. 
DriveWindow has a command for this purpose. 

Note that if DriveWindow is started without opening a workspace, it restores the default item sets. 

If you want to restore default item sets, select Restore Defaults command from the Item Set submenu 
of the Desktop menu. 
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If you have made major changes into the item sets since you last saved the workspace, DriveWindow 
asks you, if you want to save your changes before restoring is done. At this moment you also have the 
option to cancel the restoring operation. 

 

Restoring the default item sets first removes all item sets except the built-in browsed item set. The 
properties (name, update, item format, OPC settings) of the browsed item set are set to their default 
values. However, all items currently in the browsed item set stay intact. 

Secondly, DriveWindow creates two item sets called Control and Faults. Finally DriveWindow always 
shows the browsed item set. 

 

Faults is an item set containing all faults in the fault logger of the source drive. The source drive is 
defined by desktop preferences. The item set is put on-line and there is no filtering. OPC settings for 
the item set are set to their default values. 

The Control item set is actually a user item set with some templates in it. Its properties are set as 
follows: 

• Updating of items is set to Put On-Line. 
• Source drive is the one, control of which is taken. 
• Item names are fetched from the drive (if available). 
• Items not available are shown as hidden. 
• Other properties (format, OPC settings) are set to default. 

DriveWindow puts the following item templates into the control item set (for compatibility with legacy 
versions of DriveWindow): 

Name OPC Address 

Last fault {}{}FL.00.Description 

Reference {}{}Control.Reference 

Reference (actual) {}{}Status.Reference 

The control item set created by restoring defaults has an additional feature, which a normal user item 
set does not have. Workspaces containing it are backward compatible with Control Item Set of legacy 
versions of DriveWindow. It means that old versions of DriveWindow can read control items from a 
workspace saved by a new version and vice versa. 

See Also: What are Item Sets 
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4.2 Adding Item Sets 

Instead of having fixed item sets, DriveWindow allows you to add, remove, and arrange item sets as 
well as change their properties. 

The only fixed item set is Browsed items, which you cannot add or remove.  

You can add the following type of item sets: 

• All parameters, which contains all un-protected parameters of the source drive. Use of the all 
parameters item set is discouraged because of potential communication problems. 

• User items, which is an item set, content of which is defined by you. 
• Faults, which is used to view content of the fault logger of the source drive. By default, there is 

a predefined item set of this kind, source drive of which is the drive, branch of which is 
selected in the browse tree pane. 

• Events, which is used to view content of the event logger of the source drive. 
• All faults, which is used to view combined contents of fault loggers of all connected drives. 

There cannot be more than one of this kind of item sets. 
• All events, which is used to view combined contents of event loggers of all connected drives. 

There cannot be more than one of this kind of item sets. 

Adding an item set is done by selecting a command from the Add New submenu in the Item Set 
submenu of the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

Note that number of item sets is limited. After the limit has been reached, all commands in the Add 
New submenu will be disabled (grayed). All Faults or All Events in the submenu are disabled if the 
corresponding type of item set has already been added. 

When you add an item set, an Add New Item Set dialog is shown. It allows you to view and set 
properties of the item set to be added. 

The dialog box is actually the same as Item Set Properties dialog box - only the title differs. The 
properties can be viewed and changed also later. 



Parameters, Signals, and Faults 

4-16 DriveWindow 2 

Note that DriveWindow remembers the latest changes of most properties and suggests them when 
adding a new item set. It means that you should always check carefully all properties when adding an 
item set. 

The added item set appears rightmost in the item sets pane and its tab is selected. If you wish, you can 
arrange item sets into different order and, of course you can also remove the item set you added. 

Adding, arranging, removing, or changing properties of an item set is considered to be a major change 
in the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 

 

See Also: Changing Item Set Properties 
Restoring Default Item Sets 
Removing Item Sets 

4.2.1 Adding Browsed Item Set 

Browsed item set is a built-in item set and cannot be added or removed. However, you can change its 
properties and its position among item sets. 

The main purpose of browsed item set is to display the items of the currently selected branch in the 
browse tree pane. 

See Also: Adding Item Sets 
Changing Item Set Properties 

4.2.2 Adding User Item Set 

User item set allows you to group together items, which you often view or change together. You can 
define several item sets of your own. The configuration is saved with the workspace. 

A user item set consists of templates, which are actually rules that define, how each of the items is 
fetched and displayed. 

Constructing a user item set is done in two phases: 

• A user item set is added into the item sets pane. 
• Templates are added into the user item set. 

Note that the item set called Control is a user item set created by DriveWindow. It has an additional 
feature, however. Templates in it are backward compatible with items in Control Item Set of legacy 
versions of DriveWindow. 

Here we describe the phase of adding a user item set into the item sets pane. Adding of templates is 
described elsewhere. 
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Adding a user item set is done by selecting the User Defined command from the Add New submenu in 
the Item Set submenu of the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

An Add New Item Set dialog is shown. 
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Check and, if needed, change the properties of the item set and click OK. By clicking Cancel the add 
operation is cancelled. 

 

Note that you can view and change properties of the item set also after the addition. 

The new item set appears rightmost in the item sets pane and its tab is selected. 

 

If you wish, you can arrange item sets into different order and, of course you can also remove the item 
set you added. 

The user item set you created is empty. So, the next thing to do is to add templates into it. 

See Also: Adding Item Sets 
Changing Item Set Properties 
Using Templates 

4.2.3 Adding All Parameters Item Set 

All parameters item set allows you to view all unprotected parameters and signals of the source drive. 
You can define several such item sets. The configuration is saved with the workspace. 

Note! We recommend no to use all parameters item set because of the potentially enormous 
communication traffic. Especially on-line item update will probably choke DriveWindow. 
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Adding an all parameters item set is done by selecting the All Parameters command from the Add New 
submenu in the Item Set submenu of the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

An Add New Item Set dialog is shown. 
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Check and, if needed, change the properties of the item set. We recommend that you set the property 
Item Update always to “From Cache”. It means that the communication traffic is minimized by requiring 
you to request updates yourself. 

Finally click OK. By clicking Cancel the add operation is cancelled. 

 

Note that you can view and change properties of the item set also after the addition. 

The new item set appears rightmost in the item sets pane and its tab is selected. 

 

If you wish, you can arrange item sets into different order and, of course you can also remove the item 
set you added. 

See Also: Adding Item Sets 
Changing Item Set Properties 

4.2.4 Adding Faults or Events Item Set 

Faults and events item sets are quite similar, so they are described here together. 

The faults item set allows you to view the content of the fault logger of the source drive. 

The events item set allows you to view the content of the event logger of the source drive. 

If you wish, you can have several of these kinds of item sets. The configuration is saved with the 
workspace. 

Note that although all drives have an event logger, many drive types do not use it, i.e., it is always 
empty. 

Item sets of this kind have filtering properties, which make it possible to limit the number of faults or 
events in the item set. 

Note that the item set called Faults is a faults item set created by DriveWindow. 
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Adding a faults or events item set is done by selecting the Faults or Events command from the Add 
New submenu in the Item Set submenu of the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

An Add New Item Set dialog is shown. 
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Check and, if needed, change the properties of the item set. We recommend that you set the property 
Item Update to “Put On-Line”. It means that faults or events shown are always up to date. 

Finally click OK. By clicking Cancel the add operation is cancelled. 

 

Note that you can view and change properties of the item set also after the addition. 

The new item set appears rightmost in the item sets pane and its tab is selected. 

 

If you wish, you can arrange item sets into different order and, of course you can also remove the item 
set you added. 

See Also: What are Faults and Events 
Adding Item Sets 
Changing Item Set Properties 

4.2.5 Adding All Faults or All Events Item Set 

All faults and all events item sets are quite similar, so they are described here together. 

The all faults item set allows you to view the combined content of the fault loggers of all connected 
drives. You can have only one of this kind of item set. 

The all events item set allows you to view the combined content of the event loggers of all connected 
drives. You can have only one of this kind of item set. 

The configuration is saved with the workspace. 

Note that although all drives have an event logger, many drive types do not use it, i.e., it is always 
empty. 

These Item sets have filtering properties, which make it possible to limit the number of faults or events 
in the item set. 



Parameters, Signals, and Faults 

DriveWindow 2 4-23 

Adding an all faults or all events item set is done by selecting the All Faults or All Events command 
from the Add New submenu in the Item Set submenu of the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

An Add New Item Set dialog is shown. 
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Check and, if needed, change the properties of the item set. We recommend that you set the property 
Item Update to “Put On-Line”. It means that faults or events shown are always up to date. 

Finally click OK. By clicking Cancel the add operation is cancelled. 

 

Note that you can view and change properties of the item set also after the addition. 

The new item set appears rightmost in the item sets pane and its tab is selected. 

 

If you wish, you can arrange item sets into different order and, of course you can also remove the item 
set you added. 

See Also: What are Faults and Events 
Adding Item Sets 
Changing Item Set Properties 

4.3 Removing Item Sets 

Instead of having fixed item sets, DriveWindow allows you to add, remove, and arrange item sets as 
well as change their properties. 

The only fixed item set is Browsed items, which you cannot add or remove. 
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To remove the currently shown item set, select the Remove command from the Item Set submenu of 
the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

When you remove an item set, DriveWindow wants you to confirm the operation. 

 

You can also remove one or more item sets also when arranging them. 
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Adding, arranging, removing, or changing properties of an item set is considered to be a major change 
in the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 

 

See Also: Adding Item Sets 
Arranging Item Sets 
Restoring Default Item Sets 

4.4 Arranging Item Sets 

Instead of having fixed item sets, DriveWindow allows you to add, remove, and arrange item sets as 
well as change their properties. 

The only fixed item set is Browsed items, which you cannot add or remove. 

Arranging allows you to change the order of item sets. You can also remove one or more of the item 
sets while arranging them. 

To arrange the item sets, select the Arrange command from the Item Set submenu of the Desktop 
menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 
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DriveWindow displays the Arrange dialog box. The upmost item set in the Item Sets list is the leftmost 
one in the item sets pane. 

 

To change the position of an item set, select it from the list by clicking it. Then click the up or down 
arrow button to move it up or down in the list. 

 

If you wish to remove an item set, select it from the list by clicking it. Then click the Remove button. 
Note that the browsed item set cannot be removed. If you select it, the Remove button is disabled 
(grayed). 
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When you are finished, click the OK button. If you click the Cancel button, the operation is cancelled. 

 

If you removed any of the item sets, DriveWindow wants you to confirm the removal. If you respond by 
clicking No, the whole operation is cancelled. 

 

After the operation the item sets will be shown in the new order in the item sets pane without the item 
sets you removed. 

 

Adding, arranging, removing, or changing properties of an item set is considered to be a major change 
in the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 
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See Also: Adding Item Sets 
Removing Item Sets 
Restoring Default Item Sets 

4.5 Printing Item Sets 

Since version 2.20 of DriveWindow it is possible to print items shown in an item set. 

Note that printing of item sets is done with help of Internet Explorer version 6 (or newer) components. If 
you do not have proper components installed, item set printing command is disabled (grayed). 
However, it is possible to configure DriveWindow to “print” into a file. The generated XML-file can be 
printed later in another computer, in which DriveWindow is capable to print. 

Because Internet Explorer is used in printing of item sets, its settings affect DriveWindow printing, too. 

It is possible to print all items, templates, faults, or events in an item set or just the selected ones. 

4.5.1 Start 

To print items, templates, faults, or events currently shown in an item set: 

• In the item sets pane, select the tab of the item set. 
• If you want to print just some selected items, templates, faults, or events, select them first. If 

you want to print all items, templates, faults, or events in the item set, you do not need to 
change your selections. 

• Select the Print command from the Item Set submenu of the Desktop menu. 

 

The Print command is also included in the submenu of the context menu, which you get by clicking 
with the right mouse button on the item sets pane outside the name of an item. All selections are lost, 
however. 
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In item sets of type faults, events, all faults, and all events the clicking to get a similar context menu 
can be done anywhere within the item set. However, if you click outside the description field, all 
selections are lost. 

 

Note that clicking with the right mouse button on the description of an unselected fault or event 
unselects all selected faults and events, selects the clicked fault or event, and displays the context 
menu. 

The same Print command is also included in the context menu, which you get by clicking with the right 
mouse button on the name of one of the selected items or templates in an item set of type browsed, 
user, or all parameters. 

 

Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. 
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4.5.2 Printing to File 

If you have configured DriveWindow to “print” into a file, the Print Items to File dialog is shown.  

 

Enter whatever file name and click the Save button to continue. If you click the Cancel button, printing 
is cancelled. 

4.5.3 Comment 

DriveWindow displays the Print Comment dialog box. 

 

The comment field contains initially current date and time. Because the initial comment is selected, it is 
replaced by your comment in case you immediately start writing a comment of your own. 

If you wish your comment to consist of several lines, use the Ctrl+J key to start a new line. Note that 
Enter has the same effect as clicking the OK button. 

The Print range selection allows you to either print all or only the selected items, templates, faults, or 
events. If nothing is selected, the Selection option is disabled (grayed). 
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When you are ready, click the OK button. If you click Cancel, printing is cancelled. 

 

If you were “printing” to file, you are done. 

4.5.4 Print Dialog 

If you were not “printing” to a file, the Internet Explorer component displays a Print dialog box. 

You can, for example, select the printer to be used and change the printer settings such as paper 
orientation. Click the Print button to send the document to the printer. If you click Cancel, printing is 
cancelled. 

 

Note! The Print dialog is modeless, which means that you can continue doing other actions with 
DriveWindow while the dialog exists. However, we recommend that you finish with the dialog 
before continuing. Especially, quitting DriveWindow while the Print dialog still exists may cause 
complications that can be solved only by logging off. 
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4.5.5 Printing Result 

The Internet Explorer component uses most of the prevailing settings of Internet Explorer. For 
example, most of Page Setup settings are used. The Orientation setting is not used, however. You 
need to set it in Preferences of the Print dialog. 

 

If the background of the field names in your print is white, make sure that “Print background colors and 
images” is selected in Printing part of the Advanced Internet Options in Internet Explorer. You can find 
Internet Options in the Tools menu of Internet Explorer. 

4.5.6 Printing a Saved File 

If you want to print an XML-file created by DriveWindow when it was configured to “print” to file, start 
Internet Explorer. 

Note that you must have DriveWindow installed the same way in both computers, if printing is done in 
another computer. 

Open in Internet Explorer the XML-file saved by DriveWindow. 
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Internet Explorer shows contents of the file as it will be printed. 

 

Select the Print command from the File menu of Internet Explorer. 
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Internet Explorer displays the same Print dialog as DriveWindow does when not “printing” to file.  Make 
your selections and click the Print button to send the document to the printer. If you click Cancel, 
printing is cancelled. 

 

See Also: Viewing Parameters and Signals 
Viewing Faults and Events 
Copying Items to the Clipboard 
Dragging and Dropping Items 
Copying Faults and Events 
How to Print Parameters 

4.6 Changing Item Set Properties 

Instead of having fixed item sets, DriveWindow allows you to add, remove, and arrange item sets as 
well as change their properties. 

The only fixed item set is Browsed items, which you cannot add or remove. 

Properties of an item set control its behaviour. 

OPC settings of an item set can also be considered as properties of the item set, but you seldom need 
to view or change them. OPC Settings are explained in context of the OPC Server. 

Item set properties are shown and changed in dialog boxes. Each type of item set has properties of its 
own. So, contents of the dialog boxes depend on the type of the item set. 
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To view and change properties of the currently shown item set, select the Properties command from 
the Item Set submenu of the Desktop menu. 

 

The same submenu is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

DriveWindow displays the Item Set Properties dialog box. 
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The dialog box containing the properties is shown also when adding an item set. The dialog box title is 
then Add New Item Set. Otherwise the dialog box is exactly the same as the Item Set Properties dialog 
box.  

 

The dialog box may have the following tabs: 

• General (all item set types) 
• Source (all but browsed item set) 
• Format (browsed, all parameters, and user item sets) 
• Items (user item sets) 
• Show (faults, events, all faults, and all events) 

When you are finished, click the OK button. If you click the Cancel button, the operation is cancelled. 

 

Note that if you were adding a new item set, clicking Cancel means that adding is not done. If you were 
changing properties, clicking Cancel means just that any changes you requested are not made. 

Note also that DriveWindow remembers the latest changes of most properties and suggests them 
when adding a new item set. It means that you should always check carefully all properties when 
adding an item set. 
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Adding, arranging, removing, or changing properties of an item set is considered to be a major change 
in the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 

 

See Also: Adding Item Sets 
Desktop Preferences 
Changing Template Properties 

4.6.1 General Item Set Properties 

All types of item sets have the same General tab in their Item Set Properties dialog box. This tab 
contains general properties common for all types of item sets. 

 

Type tells the type of the item set. It cannot be changed. 

Name is the name shown in the tab of the item set in the item sets pane. You can change it to 
whatever you want as long as it fits into the edit field. Note that the name needs not to be unique. 
However, having the same name for more than one item set may be confusing. 
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Item Update allows you to select, how the items in the item set are updated. 

• Default means that the Item Update setting in Desktop Preferences is used for this item set. 
• From Cache means that the item values for this item set are fetched from the OPC Server 

cache. This option causes least communication traffic and is recommended for item sets of 
type all parameters. 

• From Device means that the item values are fetched from drives. This option causes least 
surprises, because after changes in the item set view you always see fresh values. The 
update command is seldom needed in this case. This option is recommended for item sets of 
types browsed and user. 

• Put On-Line means that the item values are put on-line. This option causes much 
communication traffic and we recommend that you use it sparingly. However, this option is the 
recommended setting for item sets of types faults, events, all faults, and all events. 

The default settings for browsed item set, when defaults are restored, are: 

• (Type: Browsed) 
• Name: Browsed 
• Item Update: Default 

The default settings for control item set, when defaults are restored, are: 

• (Type: User Defined) 
• Name: Control 
• Item Update: Put On-Line 

The default settings for faults item set, when defaults are restored, are: 

• (Type: Faults) 
• Name: Faults 
• Item Update: Put On-Line 

See Also: Changing Item Set Properties 
Desktop Preferences 
General Template Properties 

4.6.2 Item Set Source Properties 

Item sets of type user defined, all parameters, faults, and events have the same Source tab in their 
Item Set Properties dialog box. This tab defines the drive, from which the values of the items in the 
item set are fetched. 
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Note that the source drive for the browsed items is fixed to Selected, so the browsed item set does not 
have this tab in its Item Set Properties. 

Item sets of type all faults and all events do not have a specific source drive because they gather 
information about all drives that are connected. Thus they do not have this tab in their Item Set 
Properties. 

Source Drive allows you to select, from which drive the items in the item set are fetched. 

• Default means that the Source Drive setting in Desktop Preferences is used for this item set. 
• Fixed means that the item values for this item set are always fetched from the same drive. 

You have to specify the OPC Address of it by giving the channel (Ch) and node (Node) 
number of the drive. 

• In Ch you specify the channel number (0..9) part of the OPC Address. It is enabled (not 
grayed) only if the Source Drive is Fixed. 

• In Node you specify the node number (1..254) part of the OPC Address. It is enabled (not 
grayed) only if the Source Drive is Fixed. 

• Selected means that the item values for this item set are fetched from the drive selected in 
the browse tree pane, or relative to it (if you have Relative selected).  

• Controlled means that the item values for this item set are fetched from the drive, control of 
which has been taken, or relative to it (if you have Relative selected).  

• By selecting Relative you specify that the source drive is relative by Offset to the Fixed, 
Selected, or Controlled drive. The Relative property is disabled (grayed) in case Default is 
selected. 

• Offset specifies, how far the source drive is from the Fixed, Selected, or Controlled drive. It is 
disabled (grayed) if Relative is not selected or is disabled (grayed). 

Note that the Source Drive of user item sets can be overridden in the templates of the item set. So, the 
setting is used only for those templates, which use default in their Source Drive. 

Very seldom you have a reason to select the Relative property. 

The value of the Offset property is numeric. If it is positive, the source drive is determined by counting 
drives downwards in the browse tree pane from the Fixed, Selected, or Controlled drive. Negative 
value means counting upwards. An open parameter file is not considered to be a drive when counting 
is done. 

If Offset is zero it is handled as if Relative was not selected. 

An open parameter file is a special case. It can be a source “drive”, if  Source Drive is Selected and 
Relative is not selected (or Offset is zero). 

The default settings for control item set, when defaults are restored, are: 

• Source Drive: Controlled 
• Relative: Not selected 

The default settings for faults item set, when defaults are restored, are: 

• Source Drive: Selected 
• Relative: Not selected 

See Also: Changing Item Set Properties 
Desktop Preferences 
Template Source Properties 
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4.6.3 Item Set Format Properties 

Item set types of browsed, user defined, and all parameters have a Format tab in their Item Set 
Properties dialog box. This tab defines the format to be used in displaying the values of items in the 
item set, unless overridden by template properties or, temporally, by the Change Format command. 

Although the Format tab is similar for all mentioned item sets, only user item sets have all selection 
options enabled. 

 

Browsed and all parameters item sets have only a few selection options ever enabled. 

 

Format allows you to control, how all the values of the items in the item set are displayed (unless 
overridden). The property contains all the same options as in the Change Display Format dialog box, 
which is shown by the Change Format command. 

• Default means that the Use Panel Format setting in Desktop Preferences is used for this item 
set. 

• Normal means the classic DriveWindow format. 
• Other formats are self descriptive. 
• Decimals means number of decimal digits (0...8) to be displayed. It is enabled only when 

Fixed point or Exponent format is selected. 

The detailed description of different formats, i.e., how values are displayed in different formats, is 
explained in Viewing Parameters and Signals. 
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The default setting for browsed and control item sets, when defaults are restored, is: 

• Format: Default 

See Also: Changing Item Set Properties 
Desktop Preferences 
Template Format Properties 

4.6.4 Item Set Items Properties 

Only user item sets have the Items tab in their Item Set Properties dialog box. This tab defines, how 
the names of items are formed and what is displayed in case an item is not available.. 

 

Note that the properties in the Items tab can be overridden by corresponding properties in templates. 

Note also that the properties have no effect when templates are shown instead of items in the user 
item set view. 

Item Names allows you to specify, how the name of the item in the Name column of the item sets pane 
is displayed. 

• Default means that the Item Names setting in Desktop Preferences is used for this item set. 
• Fixed means that the Name properties of the templates are used. 
• Fetch from Drive means that the names of items are read from the drive. 

Reading the name of an item from the drive may not always be possible. If the name is not available, 
DriveWindow uses the OPC Address of the item as its name. 

N/A Items allows you to specify, how to display items that are not available in the current source drive. 

• Default means that the N/A Items setting in Desktop Preferences is used for this item set. 
• Hide means that not available items are not shown at all. 
• Show means that not available items are shown, but their values are shown as <Bad>. 
• Show as Template means that the template is shown if an item is not available. 

Note that the N/A Items does not affect displaying of those items, which are available. 

The default settings for control item set, when defaults are restored, are: 

• Item Names: Fetch from Drive 
• N/A Items: Hide 

See Also: Changing Item Set Properties 
Desktop Preferences 
Template Items Properties 
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4.6.5 Item Set Show Properties 

Only item sets of type faults, events, all faults, and all events have the Show tab in their Item Set 
Properties dialog box. This tab defines, how displaying of faults or events is filtered. 

There are minor differences between filtering of faults and events. The Status property of faults and all 
faults differ from Status property of events and all events. 

Status of faults and all faults have filtering options to show Active and Reset events, faults, and 
warnings in fault logger(s). 

 

Status of events and all events have filtering options to show Acknowledged and Not Acknowledged 
events, faults, and warnings in event logger(s). 

 

Status allows you to specify, in which kind of status a fault or event has to be to be displayed. 

• If Active is not selected, it means that if a fault or warning in the fault logger is active, it is not 
included in the item set and is not displayed. 

• If Reset is not selected, it means that if a fault or warning in the fault logger is reset, it is not 
included in the item set and is not displayed. 

• If Acknowledged is not selected, it means that if an event in the event logger is 
acknowledged, it is not included in the item set and is not displayed. 

• If Not Ackn is not selected, it means that if an event in the event logger is not acknowledged, 
it is not included in the item set and is not displayed. 
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If Only up to Reset is selected, the events, faults, and warnings, which happened in a drive before the 
newest with reset status, are not included in the item set and are not displayed. 

Type allows you to specify, which kind of events has to be to be displayed. 

• If Events is not selected, it means that no events are included in the item set and are not 
displayed. 

• If Faults is not selected, it means that no faults are included in the item set and are not 
displayed. 

• If Warnings is not selected, it means that no warnings are included in the item set and are not 
displayed. 

Note that although DriveOPC and DriveWindow are able to handle events in a fault logger and faults 
and warnings in an event logger, drives do not put events into the fault logger and faults and warnings 
into the event logger. 

Maximum defines the maximum number of event or fault logger items will be included in the item set. 

• Drive defines the maximum number of fault or event items per drive (1...100). 
• Total defines the total maximum number of fault or event items (1...204000). It is enabled only 

for item sets of type all faults and all events. 

If a maximum is reached, older events, faults, and warnings are not included in the item set and are 
not displayed. Note that if total maximum of all faults or all events is reached,  you have multiple drives, 
and DriveWindow is not able to calculate PC time of some of them, the fault or event items discarded 
may be undeterministic (their relative order in time is not known). 

The default settings for faults item set, when defaults are restored, are: 

• Active: Selected 
• Reset: Selected 
• Only up to Reset: Not selected 
• Events: Selected 
• Faults: Selected 
• Warnings: Selected 
• (Maximum per) Drive: 100 

See Also: Changing Item Set Properties 
Filtering Faults and Events 

5. Browsing Parameters and Signals 
To find parameters and signals of interest you use the browse tree pane while viewing the browsed 
item set in the item sets pane. Note that browsing an open parameter file is similar to browsing a drive. 

The parameters and signals are grouped under sub-branches. There can be several levels of sub-
branches. 
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When a sub-branch is selected (by clicking it), the parameters and signals belonging to the sub-branch 
(if any) are displayed in the browsed item set. Note that unlocked items in the browsed item set are 
removed from the set when selection in the browse tree pane is changed. 

 

Because of the limited size of the browse tree pane, it is possible that the root of the selected sub-
branch is not visible in the pane. However, the root of the selected branch or sub-branch is always 
shown within parentheses in the title bar. 

 

Note that the drive identified by the root is also the source drive for all item sets and templates that 
have their Source Drive property set to Selected (and not Relative). 

A branch or sub-branch can be expanded and collapsed by double clicking it or clicking the plus- or 
minus-sign in front of it. 

 

Sub-branches and items available depend on drive. Typically, a drive has the following first level sub-
brances: 

• Application consists of drive application program related items for expert use. Only the items 
under the sub-branch Properties may interest you. 

• Control contains drive control related items. You normally use the drive panel or the Drive 
menu instead of using these items directly. 

• Data logger or Data logger 1 and Data logger 2 contain datalogger related items. You 
normally use the datalogger settings in the trend settings pane or the Datalogger menu 
instead of using these items directly. Only if you want to put uploaded logged values 
numerically into the clipboard, you may use the Log n items under the Log sub-branch. 

• Event logger, although it exists, is currently not used by most of the drives. It is similar to the 
fault logger, except there is no control to clear it. You normally use the events or all events 
item sets instead of viewing them directly. 



Parameters, Signals, and Faults 

4-46 DriveWindow 2 

• Fault logger contains items, each of which is a slot in the drive fault logger. You normally use 
the faults or all faults item sets instead of viewing them directly the way described here. 
Log 00 is the newest fault. When a new fault happens, all faults are shifted upwards, and the 
new fault is put into Log 00. Note that if item values are cached (see Desktop Preferences), 
the faults shown in the item set can be old until you manually update them or they are on-line. 
In this case, selecting fault logger does not automatically upload the latest values but uses the 
cached values instead. 
Value of an item is a string describing the fault. If there is no fault in a fault logger slot, the 
string is empty. 
There is also a write-only item called Clear for clearing the fault logger. However, you normally 
use a button in the drive panel or a command in the Drive menu to do the clearing. 

• Memory consists of drive RAM and FPROM related items for expert use. 
• Parameters consist of sub-branches of drive parameter groups, which contains drive 

parameters and signals as items. This part of the browse tree is probably the one, with which 
you will work most. 
Note that pass code protected parameter groups are not shown (except in some transitional, 
pass code change situations). 

• Properties contain read-only items, which describe properties of the drive. 
• Status consists of read-only items, which show the drive status. The status is also encoded in 

the icon shown in front of the drive in the browse tree pane, if drive status display is on-line 
(see Status Refresh command). 
Value quality is shown as <Bad> in case the item has never been uploaded. 
Note that because all item values are cached, the values shown in the item set can be old 
until you manually update them or they are on-line. Selecting status does not automatically 
upload the latest values but uses the cached values instead. 

 

A parameter file contains fewer sub-branches: 

• Application consists of drive application program related items to be used in checking during 
parameter download. There is only the Properties sub-branch included, so it is more limited 
than Properties in a drive. 

• Parameters consist of sub-branches of drive parameter groups, which contains drive 
parameters and signals as items. You can remove the sub-branch or any of the groups under 
it in an open parameter file. 
Note that pass code protected parameter groups, which are possibly needed during 
download, are shown with artificial names. 

• Properties contain read-only items, which describe properties of the drive. They are used in 
checking during parameter download. There are no sub-branches included, so it is more 
limited than Properties in a drive. 

See Also: What are Parameters and Signals 
What is Parameter File 
Browse Tree Pane  
Item Sets Pane 
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5.1 Browsing with Pass Code Changes 

Parameter groups within drive can be pass code protected. In order to be able to browse them, you 
have to enter a proper value into a pass code parameter.  

 

A drive may accept several different pass code values, which remove protection of different drive 
parameter groups. The actual pass code values depend on drive type. The pass code shown here is 
just an example, not a real pass code value. A drive may also have other parameters, which control 
protection of the parameter groups. 

Note that removing protection of drive groups affect also to saving of parameters of a drive. 
Parameters, which are saved, are in parameter groups, which are not under pass code protection. In 
addition parameters required during download, Application Properties, and drive Properties without 
sub-branches, are saved. 

5.1.1 Unhiding 

To get the now non-protected parameter groups visible in the browse tree pane: 

• Collapse the parameter sub-branch by double-clicking Parameters, or by clicking the minus 
sign in front of it. 

• Expand by double-clicking the parameter sub-branch. Note that clicking the plus sign is not 
enough. You have to expand by double-clicking to get the new groups visible. 

   

Note that if you are connected to the drive through the DriveDA OPC server, unhiding does not work. 
Instead, you have to disconnect and  the OPC server. 
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5.1.2 Hiding 

The procedure to protect again the drive parameter groups, which you unprotected, depends on the 
type of the drive. 

 

If you still have a parameter group, which is now protected, visible in the browse tree pane, and you 
select it, your PC beeps. Also, the items belonging to the parameter group are not shown in the 
browsed and all parameters item sets. 

 

Note that if you in the browsed item set have locked items, which are now protected, they are still fully 
functional in the item set. 

Note also that hiding and unhiding have no effect on items in a user item set. 
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Hiding the now protected parameter groups in the browse tree pane is similar to unhiding: 

• Collapse the parameter sub-branch by double-clicking Parameters, or by clicking the minus 
sign in front of it. 

• Expand by double-clicking the parameter sub-branch. Note that clicking the plus sign is not 
enough. You have to expand by double-clicking to get the new groups visible. 

   

Note that if you connected to the drive through the DriveDA OPC server, hiding does not work. Instead, 
you have to disconnect and  the OPC server. 

See Also: Browsing Parameters and Signals 
Changing Parameters 
Browse Tree Pane 

6. Viewing Parameters and Signals 
Parameters and signals can be viewed in the browsed, user, and all parameter item sets in the item 
sets pane. To be able to view such an item set, you need to select the corresponding tab in the pane. 

 

Items (or possibly templates in a user item set) are shown. 
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In addition or instead of a value, the value field may contain other information: 

1. If the item is read-protected, instead of the value, <Read-protected> is shown. 
2. If quality of a value is bad, instead of the value, <Bad> is shown. Quality can be bad, if there is 

a communication failure or the drive is down, or the value is read from cache, but has never 
read from the drive. 

3. If the quality of a value is uncertain, in addition of the value, (uncertain) is shown. Quality can 
be uncertain, if the value has written to the drive, but not (yet) read back. The written value is 
then shown, but the quality is uncertain. The OPC Server may set quality to uncertain in case 
it is not possible to read some properties from a drive, but OPC Server has guessed the value 
of the property. 

4. If the quality of a value is good, the quality is not shown. 

Note that in a user defined item set templates may be shown instead of items. The value field of a 
template is always empty. 

Note that when control of a drive has been taken, the OPC Server frequently writes to Control.Local to 
keep a watchdog in the drive alive. The internal logic within the OPC Server is such that it causes the 
qualities of Control.Local and Status.Local be mostly uncertain, while control is taken. 

There can be the following types of values: 

3. Boolean values are shown as ON or OFF 
4. Real values always use period as decimal symbol, regardless of regional settings, when 

shown in the item sets pane. Real values exported as text use the decimal symbol defined in 
regional settings, however. 

5. Signed integer values are displayed in decimal. 
6 Strings. 
7. Enumerated values. If the value is within range defined for the set of the enumeration strings 

in the drive, the string corresponding the value is shown. If the value is not within the range, 
the value is shown as a decimal integer. The enumerated value can also be of Boolean type, 
in which case the normally shown ON and OFF are replaced by strings specified in the drive. 
Note that some drives may contain some enumerated type of values with huge amount of 
enumeration strings. If the amount of strings exceeds the limits of the DDCS protocol, such 
values are shown as decimal integers. 

8. Unsigned integer values are displayed in hexadecimal with lower case h appended. 
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By changing display format of the selected items or, depending on the properties, by changing 
template properties, item set properties, or desktop preferences you are able to see values also in the 
following formats: 

9. Operator panel binary format, which consists of 7-8 binary digits followed by lower case b. 
a. Binary format, which consist of 8-32 binary digits in 4 digit groups followed by lower case b. 

The groups are separated from each other and the appended b by a space. 
b. Fixed point format with user selectable number of decimals (0-8). 
c. Exponent format with user selectable number of decimals (0-8). 
d. Parameter pointer for adaptive programming. It consists of sign (+ or -), group (000-255), 

index (000-255), and bit number (00-31). Fields are separated from each other by a period. 
e. Constant for adaptive programming. It consists of upper case C followed by period, space, 

and the value of the constant (integer -32768...32767). 

 

To get the parameters and signals of interest into the browse item set, you browse in the browse tree 
pane. 

Note that viewing items in an open parameter file is similar to viewing a drive. 

You can select (and unselect) items by clicking them, optionally with Shift or Ctrl key down. Selecting 
all of the items can be done using the keyboard: when the item sets pane has focus, press Home and 
then Shift+End. 

When you are viewing parameters and signals in the item sets pane, you often do the following 
operations: 

• Lock and unlock items in the browsed item set. 
• Delete items from an item set in browsed or all parameters item sets. 
• Update item values. 
• Put items on-line and off-line. 
• Copy items to the clipboard. 
• Sometimes add items to the browsed item set. 
• Add or delete templates to/from a user item set. 
• Print items. 

See Also: What are Parameters and Signals 
What is Parameter File 
Browse Tree Pane 
Changing Display Format of Item Values 
Desktop Preferences 
Changing Item Set Properties 
Viewing and Editing Saved Parameters 
Viewing Item Properties 
Viewing Templates 
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6.1 Changing Display Format of Item Values 

Normally, values of items in the browsed, user, and all parameters item sets are displayed in the 
format system selected in desktop preferences, i.e., either in classic DriveWindow format or operator 
panel format. Note that operator panel format is available in new drive models only. By changing 
properties of an item set you can change this default for the item set. In user item sets, the default can 
even be overridden by a template by changing its properties. 

Note that display format of faults or events in an item set of type faults, events, all faults, or all events 
cannot be changed. Neither display format of templates can be changed by the method described 
here. 

A user can temporarily change display format of selected items in a browsed, user, or all parameters 
item set. The changed format temporally overrides the selection made elsewhere, but is valid only as 
long as the item stays in the item set. If the item is removed from the item set and then restored by 
selection changes in the browse tree pane, for example, the normal mechanism for displaying a value 
is used. The currently changed formats are saved and restored with a workspace, however. 

To make a temporal change in the display format of item values: 

• Select items, display format of which you want to change. Use Ctrl and Shift keys, if needed, 
in selection. 

• While input focus is still in the item sets pane, either press F3 key on the keyboard, or select 
the Change Format command in the View menu. 

 

The same Change Format command is included in the context menu, which you get by clicking with 
the right mouse button on the name of one of the selected items. 
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Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. Thus the operation concerns only the 
item clicked. 

The Change Display Format dialog box is displayed. 

 

Select a format and number of decimals (if applicable) and click OK. 

Now the values of the selected items in the item set are displayed in the new format. 

 

Note that only the display formats of the values change. The values remain the same. Updating a value 
(or if an item is on-line) of course changes the value, but it is then displayed in the changed format as 
long as the item stays in the item set 

Note also that if a value cannot be displayed in the selected format, it is displayed in classic 
DriveWindow format. However, the format selected elsewhere is overridden also in this case. 
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The possible display format selections are: 

1. The classic DriveWindow format. Select this in case operator panel format is selected 
elsewhere, but you want to see temporarily a value in the classic DriveWindow format. 

2. Fixed point format. Select this and enter number of decimal digits in case you want to see 
more decimal digits, for example. 

3. Exponent format. Select this and enter number of decimal digits in case a value is not zero 
but its absolute value is very small (<1E-3) or very big (>1E6). 

4. Decimal integer format. 
5. Hexadecimal format. 
6. Binary format. 
7. Adaptive programming format. Select this in case the drive does not have operator panel 

format available, but you know that the selected items are handled as adaptive programming 
values in the drive. 

8. The operator panel format. Select this in case operator panel format is not selected 
elsewhere, but you want to see temporarily a value in the operator panel format, and the drive 
supports it, too. 

See Also: Changing Display Format of Graph Cursor Values  
Viewing Parameters and Signals 
Desktop Preferences 
Item Set Format Properties 
Template Format Properties 
View Menu 

6.2 Locking and Unlocking Items 

Because unlocked items in the browsed item set are removed from the desktop when selection in the 
browse tree pane is changed, you often lock the interesting items into the browsed item set. 

Note that you can lock also items belonging to an open parameter file. Monitored items are always 
shown in the browsed item set and are automatically locked with similar mechanism. If you lock or 
unlock monitored items, their locking status is shown just when they are removed from the monitor. 

To lock/unlock items in the browsed item set: 

• In the item sets pane, select the Browsed tab. 
• Select items, locking status of which you want to change. 
• Either click the lock/unlock items button in the standard toolbar, or select the Lock/Unlock 

Items command in the Desktop menu. 

 or 
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The same Lock/Unlock Items command is included in the context menu, which you get by clicking with 
the right mouse button on the name of one of the selected items. 

 

Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. Thus the operation concerns only the 
item clicked. 

The icons in front of the selected items change to show the new locking status. 
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Now the locked items stay in the browsed item set even if you change selection in the browse tree 
pane. 

 

See Also: Viewing Parameters and Signals 
Desktop Menu 

6.3 Deleting Items from an Item Set 

If a browsed or all parameters item set becomes crowded, you may want to delete some of the items 
shown in the item set. 

Note that faults or events in an item set of type faults, events, all faults, or all events cannot by the 
method described here. 

By using the same method you can remove also items or templates from a user item set. The 
difference is that removing an item actually removes the template and the removal is permanent. 

Note that selection change in the browse tree pane removes all unlocked items from the browsed item 
set, too. 

Deleting items removes all the selected items from the item set, except the monitored ones from the 
browsed item set. Note that non-monitored, locked items are removed, too. 

Note that deleting items belonging to an open parameter file are deleted only from the item set, not 
from the file. A parameter group can be deleted from the browse tree pane, however, which also 
deletes it from the open parameter file. 

To remove items in an item set: 

• In the item sets pane, select the tab of the item set. 
• Select items, which you want to remove from the item set. 
• Either click the delete or cut items button in the standard toolbar, select the Delete or Cut 

command in the Edit menu, or press the Del or Ctrl+X key. 

 or  
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The same Delete and Cut commands are included in the context menu, which you get by clicking with 
the right mouse button on the name of one of the selected items. 

 

Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. Thus the operation concerns only the 
item clicked. 

Note! Because the delete operation is common for many panes, you must have focus in the item sets 
pane, otherwise deletion may delete something else. 

Moving items from an item set by using drag and drop also deletes them from the item set. 

If items or templates are to be deleted from a user item set, your confirmation is requested. 

 

The selected items are removed. If you used cut instead of delete, the items are first copied to the 
clipboard and then deleted. 
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Note that adding, deleting, or changing properties of templates is considered to be a major change in 
the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 

 

See Also: Viewing Parameters and Signals 
Edit Menu 

6.4 Updating Item Values 

Normally, the method of updating values of items in the browsed, user, and all parameters item sets is 
selected in desktop preferences, i.e., values are updated from cache, device, or are put on-line. By 
changing properties of an item set you can change this default for the item set. In user item sets, the 
default can even be overridden by a template by changing its properties. 

Note that updating method of faults or events in an item set of type faults, events, all faults, or all 
events is typically selected to put on-line in the item set properties. Their methods also concern all of 
the faults or events. It is not possible to put a single fault or event on-line. 

If you have items in a browsed, user, or all parameters item set, which are not on-line, and you have 
selected to use cached item values, such items show cached values. It means that a value shown can 
be very old. Note also that changing selection in the browse tree pane, which brings up items into item 
set, does not read the values from the drive in this case, but shows the cached values. 

Of course you can use another update setting or put items on-line, so that their values are constantly 
updated. However, these methods may cause too heavy communication load. Also you may have 
signals, values of which change quite infrequently. 

You have also the option to update selected items manually. Note that it is not possible to update items 
belonging to an open parameter file. 

To update items in an item set: 

• In the item sets pane, select the tab of the item set. 
• Select items, values of which you want to update. 
• Either click the update items button in the standard toolbar, or select the Update Items 

command in the Desktop menu. 

 or  
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The same Update Items command is included in the context menu, which you get by clicking with the 
right mouse button on the name of one of the selected items. 

 

Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. Thus the operation concerns only the 
item clicked. 

The values of the selected items are read from the drives, cached, and updated in the item set. 

 

Note that in item sets of type faults, events, all faults, and all events you can also request updating. 
However, the updating is enabled (not grayed) only if none or only the first one of the faults or events in 
the item set is selected. Updating updates all the faults or events in the item set. 

6.4.1 Hint 

If you want to update all items in an item set (or all items after and including an item), select by clicking 
the first item. Press then the Shift+End key to include the items after the selected one in the selection. 
Finally, click the update items button in the standard toolbar, for example. 

If you want to unselect after update, click outside the Name column in the item set. 

See Also: Viewing Parameters and Signals  
Desktop Menu 
Desktop Preferences 
General Item Set Properties 
General Template Properties 

6.5 Putting Items On-line and Off-line  

Many of the signals in the item sets are such that their values change frequently in the drives. You may 
want to see the values changed also in the item sets, so you want to put them on-line. If there is too 
much communication load, you may want to put some on-line items off-line. 
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Note that putting on-line or off-line faults or events in an item set of type faults, events, all faults, or all 
events concern all of the faults or events. It is not possible to put a single fault or event on-line or off-
line. 

Note that templates cannot be put on-line or off-line by the method described here. 

Note that Desktop Preferences contain a selection, which by default automatically puts all items in an 
item set on-line. By changing properties of an item set you can change this default for the item set. In 
user item sets, the default can even be overridden by a template by changing its properties. 

Note that also monitored items in the browsed item set can be put on-line, but it is not possible to put 
on-line items belonging to an open parameter file. 

To change the on-line status of items in an item set: 

• In the item sets pane, select the tab of the item set. 
• Select items, on-line status of which you want to change. If the item set is of type faults, 

events, all faults, or all events, remove all selections or select only the first fault or event. 
• Either click the activate/deactivate items or item sets button in the standard toolbar, or select 

the Online/Offline command in the Desktop menu. 

 or  

The same Online/Offline command is included in the context menu, which you get by clicking with the 
right mouse button on the name of one of the selected items. 

 

Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. Thus the operation concerns only the 
item clicked. 
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Colour of the icons in front of the selected items and background of the values changes to show the 
new on-line status. 

 

Items, which are on line, have yellow background in their values. The icons of on-line items are yellow, 
too, except if the item is also monitored. Icon of a monitored item is the same, whether the item is on-
line or off-line. 

Note that putting an item on-line does not lock it into the browsed item set. You have to do the locking 
separately. 

See Also: Viewing Parameters and Signals 
Desktop Menu 
Desktop Preferences 
General Item Set Properties 
General Template Properties 

6.6 Copying Items to the Clipboard 

Occasionally you may want to paste items into an item set,  trend settings, drive, or another 
application. To do so, you have to copy the items into the clipboard first. 

Note that although you can copy templates while they are displayed in a user item set, you can paste 
them only to a user item set and another application. Faults and events copied from a faults, events, all 
faults or all events item set can be pasted only into another application. 

To copy items in an item set to the clipboard: 

• In the item sets pane, select the tab of the item set. 
• Select items, which you want to copy or cut from the item set. 
• Either click the copy items or cut items button in the standard toolbar, select the Copy or Cut 

command in the Edit menu, or press the Ctrl+C or Ctrl+X key. 

 or  
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The same Copy and Cut commands are included in the context menu, which you get by clicking with 
the right mouse button on the name of one of the selected items. 

 

Note that clicking with the right mouse button on the name of an unselected item unselects all selected 
items, selects the clicked item, and displays the context menu. Thus the operation concerns only the 
item clicked. 

The selected items are copied to the clipboard and, if you executed cut, removed from the item set. In 
the clipboard, the items are in text format, one item in a line, fields of an item separated by tabs. If the 
value is a vector (dataloggers), the elements of the value are separated by tabs, too. 

Note that Cut removes only items that can be deleted. If none of the selected items can be deleted, Cut 
is disabled (grayed). 

Note that the order of fields in the clipboard is changed so that the value is the rightmost field. 

Note also that the decimal symbol is taken from the regional setting of your PC, and may not be a 
period. 

Because of the so called tab separated format used, it is easy to paste the items also into an external 
application, Word or Excel, for example. In Excel, the fields go automatically into separate cells. In 
Word you can make a table of the pasted items with a few clicks (select all pasted, Convert Text to 
Table and, optionally, Borders and Shading). 

 

Note! Because the cut operation is common for many panes, you must have focus in the item sets 
pane, otherwise cutting may delete something else. 
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If you are cutting items or templates from a user item set, your confirmation is requested. 

 

See Also: Viewing Parameters and Signals 
Edit Menu 
Dragging and Dropping Items 
Pasting Items from the Clipboard 
Printing Item Sets 

6.7 Pasting Items from the Clipboard 

Although there are other methods to add items into the browsed item set or templates into a user item 
set, one of the easiest way to do it is pasting of items from the clipboard. 

To be able to paste, you must have already have copied the items into the clipboard. Copying can be 
made from an item set of type browsed, user, or all parameters. Copying can also be made from items 
in trend settings, or even from another application as long as the text is formatted as if was copied 
from DriveWindow. 

There are some restrictions in pasting. 

• In the item sets pane you can paste only into item sets of type browsed and user. 
• You can paste only items into the browsed item set. 
• You can paste both items and templates into a user item set. However, new templates with 

properties set to default are always created of the items. 
• If some items to be pasted cannot be put into the item set, even if they are formally correct, 

DriveWindow beeps. Other items are still added, however. 

Note that the value fields of the items in the clipboard are ignored. Values are fetched from the OPC 
Server instead. 

To paste items from the clipboard into an item set: 

• In the item sets pane, select the tab of the item set. 
• Click the paste button in the standard toolbar, select the Paste command in the Edit menu, or 

press Ctrl+V key. 

 or  
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The same Paste command is included in the context menu, which you get by clicking with the right 
mouse button outside the name field in the item set. 

 

The items in the clipboard are added into the item set. 

 

Note that adding, deleting, or changing properties of templates is considered to be a major change in 
the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 

 

See Also: Viewing Parameters and Signals 
Edit Menu 
Copying Items to the Clipboard 
Dragging and Dropping Items 

6.8 Dragging and Dropping Items 

Dragging and dropping is similar to combined copy (or cut) and paste. An additional feature compared 
to pasting is that you can drop items into an item set, which is currently not visible, by dropping into the 
tab of the item set. 
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You can use an item set both as dragging source and dropping target. You can drag items, templates, 
faults, and events from an item set. You can drop items into browsed and user item sets. You can drop 
templates into a user item set. 

6.8.1 Dragging 

To drag items from an item set: 

• In the item sets pane, select the tab of the item set. 
• Select items, which you want to copy or move from the item set. 
• Press the left mouse button down on a selected item and keep the button down. 
• Move the cursor into the dropping target area. 

 

6.8.2 Dropping 

While dragging, dropping is done by releasing the left mouse button when the cursor is in the dropping 
target area. 

If you want to copy by dragging, check that there is a plus sign visible in the cursor before releasing the 
mouse button. If it is not visible, try pressing and holding down the Shift or Ctrl key. 

 

If you want to move by dragging, check that there is no plus sign visible in the cursor when releasing 
the mouse button. If there is a plus sign, try pressing and holding down the Shift or Ctrl key. Moving 
means that the items are deleted (if possible) from the drag source item set. 

 

If dropping is not possible into the current cursor position, the cursor turns into a forbidden sign. 
Releasing the mouse button cancels the drag and drop operation. 

 

Whether the operation copies or moves can be controlled by keyboard. The key to be kept down and 
meaning of it depends on the drop target application. 
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If you are trying to drop into DriveWindow, the operation is controlled as follows: 

• If the Shift key is down but Ctrl is up, moving is executed, if the drag source allows it. 
• If the Shift key is up or Ctrl is down, copy is executed. 

Other applications may have different rules. Word as the drop target, for example, does copying if Ctrl 
is kept down and moving otherwise. 

So, watch the cursor while dropping. 

Note that both the drag source and drop target may disallow moving. For example, it is not possible to 
move faults out of a faults item set, so the cursor always has the plus sign in it while dragging. Another 
example is that it is not possible to move items into a drive shown in the browse tree pane, but copying 
is allowed. 

6.8.3 Adding Items by Drag and Drop 

Although there are other methods to add items into the browsed item set or templates into a user item 
set, the easiest way to do it is dragging items from another item set. 

Dragging can be made from an item set of type browsed, user, or all parameters. Dragging can also be 
made from items in trend settings, or even from another application as long as the text is formatted as 
if copied from DriveWindow. 

There are some restrictions in dropping. 

• In the item sets pane you can drop only into item sets of type browsed and user. 
• You can drop only items into the browsed item set. 
• You can drop both items and templates into a user item set. However, new templates with 

properties set to default are always created out of the items. 
• If some items to be dropped cannot be put into the item set, even if they are formally correct, 

they are silently discarded. Other items are still added, however. 

Note that the value fields of the dragged items are ignored. Values are fetched from the OPC Server 
instead. 

To add items or templates into an item set of type browsed or user by dragging and dropping: 

• Make the dragging source visible. If you are dragging from the item sets pane, select the tab 
of the dragging source item set. 

• Select items or templates, which you want to copy or move from the item set. 
• Drag the selected items or templates over the tab of the dropping target item set. 
• If you are trying to move, hold the Shift key down. There should be no plus sign in the cursor. 

If you are trying to copy, do not keep the Shift key down. There should be a plus sign shown in 
the cursor. 

• Drop the items or templates by releasing the left mouse button. 
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The items or templates are added into the item set. 

 

Note that adding, deleting, or changing properties of templates is considered to be a major change in 
the workspace. It means that DriveWindow will notify you about unsaved workspace changes in 
operations that cause the workspace currently in use to be destroyed. 

 

See Also: Copying Items to the Clipboard 
Dragging and Dropping Items 

6.9 Adding Items to an Item Set 

The easiest way to add items into an item set of type browsed and user defined is to use copy and 
paste or drag and drop. 

However, some times you may encounter a situation, where you need to view a value of an item, which 
is not found by browsing. 

If the item is not found by browsing, you have to know its OPC address. It is not possible to put non-
existing items into the browsed item set. However, the item needs not to exist when adding a template, 
which defines the item, into a user item set. 

Note that although you can use an item in an open parameter file as a starting point when adding an 
item into the browsed item set, the added item must be known by the OPC Server and thus have a 
valid OPC address. 

Optionally, you can use an item already in the item set as a starting point, which you then edit. 

To use an item as a starting point, select a single item or template in the in the item set. 

Anyway, click the add item button in the standard toolbar, select the Add New Item command in the 
Desktop menu, or press the Ctrl+A key. 
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 or  

The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

6.9.1 Adding Templates 

If you are viewing a user item set, an Add New Template dialog is shown instead of the Add Item to 
Desktop dialog box. 

Adding of templates by using this method is explained elsewhere. 

6.9.2 Adding Items 

If you are viewing the browsed item set, an Add Item to Desktop dialog box is presented. If you had an 
item selected to be used as a starting point, both edit fields already have values, which you can edit. 
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If you did not have an item selected to be used as a starting point (or had multiple selections), 
DriveWindow suggests the same data that you entered last time, when you added an item to an item 
set. 

 

Anyway, after you have a descriptive name (of your own) in the Name edit field, and a proper OPC 
address in the other edit field, you can click the OK button (or Cancel, if you want to cancel the 
operation). Note that the descriptive name that you give, needs not to be unique. 

 

If the OPC address you gave is correct and the item exists, it is added into the browsed item set. Note 
that it is not locked and not on-line, even if the starting point had been locked and/or on-line. 

 

If the OPC address is wrong or the item does not exist, your PC beeps when you click OK, and the Add 
Item to Desktop dialog box stays. 

Note that Set Variable in the Monitor menu and in the Datalogger menu also, in addition to setting the 
item to be monitored or logged, adds the item to the browsed item set. Note that in case of a 
datalogger, the descriptive name is not put into the datalogger settings, but only into the browsed item 
set. 

Note also that because adding an item to the browsed item set changes the view, all item values are 
updated. How this is done, depends on the item set properties or Desktop Preferences. 

See Also: Viewing Parameters and Signals 
Desktop Menu 
Dragging and Dropping Items 
Pasting Items from the Clipboard 
Setting and Removing Monitored Variables 
Setting and Removing Datalogger Variables 
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6.10 Viewing Item Properties 

Viewing of item properties is mainly used for debugging purposes. The values and meaning of the 
properties should be of no interest to a normal user. 

Template properties are more important for a user. They are explained elsewhere. 

In item sets of types browsed, user, and all parameters it is possible to look at the properties of an 
item. 

To be able to view properties of an item in a user item set, you must be viewing items in a user item 
set. Also the item must exist in the current source drive of the item set. 

If you are going to use the Desktop menu, you need to have exactly one item selected. 

 

Select the Item Properties command in the Desktop menu. 

 

The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item, properties of which you want to view or change. 
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DriveWindow displays the Item Properties dialog box containing the properties. Click the Close button  
to finish viewing the properties. 

 

See Also: Viewing Parameters and Signals 
Viewing Templates 
Changing Template Properties 

7. Viewing Faults and Events 
Faults and events can be viewed in the all faults, all events, faults, and events item sets in the item 
sets pane. To be able to view such an item set, you need to select the corresponding tab in the pane. 

 

Faults or events of the item set are shown. 

 

DriveWindow is not always able to show the PC Time. It cannot be shown and the field is empty if any 
of the following is true: 

• The drive has a real time clock and it is used for stamping faults or events. In this case Drive 
Time contains the time stamp as calendar time. 

• A fault or event was happened before the last power-up of the drive. 
• The time stamps are not directly based on system time counter of the drive. 
• The system time counter is not available in the drive. 
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DriveWindow calculates the PC Time from the time stamp by using the system time counter of the 
drive and the computer clock as references. 

To increase accuracy, DriveWindow “measures” the frequency of the system time counter of the drive. 
The measurement takes some time (about 40 seconds), which means that the PC Times are not 
available within that measurement time when DriveWindow is connected to the OPC Server. 

Although the PC Time is shown with great resolution, its accuracy depends on, how long time has 
passed since the fault or event happened, and whether you were viewing the corresponding item set 
when it happened or not. 

If the item set containing the fault or event was visible and on-line at the time the fault or event 
happened, the error in PC Time is typically less than 0.03 ms. 

Otherwise the error is typically less than 200 ms for each hour passed before DriveWindow detects the 
fault or event. 

Because the crystals on drive control boards are usually much more stable than the crystal of your PC, 
the PC Time differences of faults or events in different drives do not change so much in time as the PC 
Time error does. So, it is usually possible to determine the order of faults or events in different drives 
even if some time has passed. 

Note that the faults and events are handled on some time level in the drive, which means that the time 
stamp accuracy is actually the cycle time of the handler. 

See Also: What are Faults and Events 
Viewing Parameters and Signals 
Adding Faults or Events Item Set 
Adding All Parameters Item Set 
Changing Item Set Properties 

7.1 Filtering Faults and Events 

Sometimes an item sets of type faults, events, all faults, and all events gets so crowded that it is 
difficult to read. DriveWindow allows you to reduce the amount of faults and events in those item sets 
by a method called filtering. Filtering is done by some special properties of the item set. 

Item sets of type faults, events, all faults, and all events have the Show tab in their Item Set Properties 
dialog box. This tab defines, how displaying of faults or events is filtered. 

There are minor differences between filtering of faults and events item sets. The Status property of 
faults and all faults item sets differ from Status property of events and all events item sets. 
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Status of faults and all faults item sets have filtering options to show Active and Reset events, faults, 
and warnings in fault logger(s). 

 

Status of events and all events item sets have filtering options to show Acknowledged and Not 
Acknowledged events, faults, and warnings in event logger(s). 

 

Status allows you to specify, in which kind of status a fault or event has to be to be included in the item 
set. 

If Only up to Reset is selected, the events, faults, and warnings, which happened in a drive before the 
newest with reset status, are not included in the item set. 

Type allows you to specify, which kind of events has to be to be included in the item set. 

Note that although DriveOPC and DriveWindow are able to handle events in a fault logger and faults 
and warnings in an event logger, drives do not put events into the fault logger and faults and warnings 
into the event logger. 
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Maximum defines the maximum number of event or fault logger items will be included in the item set. 

If a maximum is reached, older events, faults, and warnings are not included in the item set. 

For example, to show only the latest fault (if any) of each drive in the all faults item set, set Maximum 
(per) Drive to one. 

Note that if total maximum of all faults or all events is reached,  you have multiple drives, and 
DriveWindow is not able to calculate PC time of some of them, the faults or events discarded may be 
undeterministic (their relative order in time is not known). 

See Also: Viewing Faults and Events 
Changing Item Set Properties 
Item Set Show Properties 

7.2 Updating Faults and Events 

Normally the item sets of type faults, events, all faults, and all events are on-line. Thus no updating is 
needed. 

However, if you for some reason have put an item set off-line, you are still able to refresh the item set 
manually. 

Note that updating of item sets of type faults, events, all faults, and all events differs from updating 
values of items in item sets of type browsed, user, and all parameters, which only update the selected 
items. 

Faults and events in item sets of type faults, events, all faults, and all events are always fetched from 
the device, never from the cache of the OPC Server. Actually DriveWindow does not necessarily read 
all of them. It just checks the latest fault or event in the fault or event logger and, depending on the 
result, reads only faults and events it has not read yet. 

To update an item set of type faults, events, all faults, or all events: 

• In the item sets pane, select the tab of the item set. 
• Select just the first line by clicking its Description field, or unselect all by clicking outside the 

Description column. 
• Either click the update items button in the standard toolbar, or select the Update Items 

command in the Desktop menu. 

 or 
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The item set is updated. 

 

Note that the command is disabled (grayed), if you have selected any other line than the first one or if 
input focus in not in the item sets pane. 

See Also: Viewing Faults and Events 
Putting Faults and Events On-line and Off-line 
Updating Item Values 

7.3 Putting Faults and Events On-line and Off-line 

Normally the item sets of type faults, events, all faults, and all events are on-line. It means that the item 
set is automatically updated frequently. 

By changing properties of such an item set you can change this property of the item set. If you select 
Default for the Update property, then the corresponding selection in Desktop Preferences is used. 

However, note that faults and events in item sets of type faults, events, all faults, and all events are 
always fetched from the device, never from the cache of the OPC Server. Actually DriveWindow does 
not necessarily read all of them. It just checks the latest fault or event in the fault or event logger and, 
depending on the result, reads only faults and events it has not read yet. 

Sometime you may encounter a situation, where a drive generates a burst of faults or events. The item 
set is difficult to read during the burst because the item set is constantly changing. You can to put the 
item set (temporarily) off-line, so you can read the faults or events. 

To change (temporarily) the on-line status of an item set of type faults, events, all faults, or all events 

• In the item sets pane, select the tab of the item set. 
• Select just the first line by clicking its Description field, or unselect all by clicking outside the 

Description column. 
• Either click the activate/deactivate items or item sets button in the standard toolbar, or select 

the Online/Offline command in the Desktop menu. 

 or 
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The background colour of the first line of the item set changes to show the new on-line status. 

 

Item set, which is on-line, has yellow background on its first line. 

Note that the change is temporal for item sets of type faults and events. The on-line status is restored 
to the state selected in the item set properties when the source drive changes. For item sets of type all 
faults and all events you need to restore the on-line status yourself. 

See Also: Viewing Faults and Events 
Updating Faults and Events 
Putting Items On-line and Off-line 

7.4 Copying Faults and Events 

Occasionally you may want to paste faults or events into another application. To do so, you have to 
copy them into the clipboard first. You can also drag and drop them directly into another application. 

Copying of faults and events from an item set of type faults, events, all faults, or all events is similar to 
copying or dragging items from an item set of type browsed, user, or all parameters. 

Note that it is not possible to cut faults or events from an item set of type faults, events, all faults, or all 
events. 

Note that it is not possible to paste or drop faults or events into DriveWindow. 
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7.4.1 Copying 

To copy faults or events in an item set of type faults, events, all faults, or all events to the clipboard: 

• In the item sets pane, select the tab of the item set. 
• Select faults or events, which you want to copy from the item set. 
• Either click the copy items button in the standard toolbar, select the Copy command in the 

Edit menu, or press the Ctrl+C key. 

 or 

 

The same Copy command is included in the context menu, which you get by clicking with the right 
mouse button on the description field of one of the selected faults or events. 

 

Note that clicking with the right mouse button on the description field of an unselected fault or event 
unselects all selected faults and events, selects the clicked one, and displays the context menu. Thus 
the operation concerns only the fault or event clicked. 

The selected faults or events are copied to the clipboard. In the clipboard, faults and events are in text 
format, one fault or event in a line, fields separated by tabs. 

Note that the order of fields in the clipboard is not changed as it would be if you were copying items. 

Because of the so called tab separated format used, it is easy to paste the items also into an external 
application, Word or Excel, for example. In Excel, the fields go automatically into separate cells. In 
Word you can make a table of the pasted faults or events with a few clicks (select all pasted, Convert 
Text to Table and, optionally, Borders and Shading). 
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7.4.2 Dragging 

Dragging and dropping is similar to combined copy and paste. However, you can drop faults and 
events dragged from an item set of type faults, events, all faults, or all events only into another 
application. Also, you cannot move faults or events from such an item set by dragging. Just copying is 
possible. 

To drag faults or events from an item set of type faults, events, all faults: 

• In the item sets pane, select the tab of the item set. 
• Select faults or events, which you want to copy from the item set. 
• Press the left mouse button down on a selected fault or event and keep the button down. 
• Move the cursor into the dropping target area. 

 

See Also: Viewing Faults and Events 
Printing Item Sets 
Copying Items to the Clipboard 
Dragging and Dropping Items 

8. Changing Parameters 
Parameters are items, which are not write-protected, and can thus be changed. 

You can change parameter values in item sets of type browsed, user, and all parameters. 

While viewing an item in an item set, you cannot tell directly, whether it is write-protected or not. If you 
select a single item, and the change value button in the standard toolbar is disabled (grayed), the item 
is write-protected, i.e., it is a signal. 
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Also the Change Item Value command in the Desktop menu is disabled (grayed), when a single, write-
protected item is selected. 

 

The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item. It is disabled (grayed) in that menu, too. 

 

You can also check, whether an item is write-protected or not by double-clicking it. If your PC beeps, it 
is write-protected and cannot be changed. 

Another way is checking from item properties, whether the item is writable or not. 

Note that a drive can have parameters, which are used to prevent changing of other parameters. If 
such a change is prevented, you do not get any error message about changing such a value, but the 
value in the drive just does not change. 

Note that changing an item in an open parameter file is similar to changing an item in a drive. Changes 
made into an open parameter file are not saved until Save As command in the Parameters submenu of 
the File menu is executed. If there are unsaved changes in an open parameter file when you close the 
file, you are requested, whether to save the changes or not. 

You can select (and unselect) items in the item sets pane by clicking them, optionally with Shift or Ctrl 
key down. To be able to change the value of an item, you must have only that item selected. 
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To change value of an item, double-click the item. There are also other ways to start the value change: 

• Select the item, value of which you want to change. 
• Either click the change value button in the standard toolbar, or select the Change Item Value 

command in the Desktop menu. 

 or  

The Change Item Value command is also included in the context menu, which you get by clicking with 
the right mouse button on the item. 

 

A dialog box that has the descriptive name of the item in its title bar is presented. The type of the dialog 
box, and how to handle it, depends on the value type of the item. Note that if the item is not read-
protected, the current value of the item is shown in the edit field. It is also selected, so that if you start 
typing, the displayed value is immediately overwritten. 

A value type of string, or a numerical value without any limit information, presents a simple dialog box: 

 

If the item is used by DriveOPC to open a file (see Using Symbol Tables), the dialog box is similar, but 
has an additional browse button: 
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A numerical value with limit information presents a dialog box, which also shows the limits: 

 
Note that the limits are not used by DriveWindow but the drive. It depends on the drive, whether it 
rejects a value exceeding the limits, actually limits the value, or just accepts it. 

Entering a numerical value does not depend on the type of the value. Any numerical type can be 
entered a one of the following: 

• Decimal integer, optionally signed, 123, for example. 
• Hexadecimal integer preceded by 0x, 0x123A, for example, or followed by letter h, 123Ah, for 

example. Accepts both upper and lower case letters (A..F, H, X, a..f, h, x). 
• Binary integer followed by letter b, 1001 0001 b, for example. Accepts both upper and lower 

case letters (B, b) and can contain spaces. 
• Parameter pointer for adaptive programming, +.1.4.0, for example. It consists of sign (+ or -), 

group (0-255), index (0-255), and bit number (0-31). Fields are separated from each other by 
a period. Negative sign means inversion. 

• Constant for adaptive programming, C. 123, for example. It consists of letter C followed by 
period and the value of the constant. Accepts both upper and lower case letters (C, c). The 
value can be preceded by spaces. The value is an integer between -32768...32767. It can be 
entered as decimal, hexadecimal, or binary number as presented above.  

• Optionally signed real number ending with optional exponent, which is preceded by E or e. 
The exponent can be signed. Note that the decimal symbol is period regardless the regional 
settings. Examples: 1.2, -1.23E-3, 1e3. 

The value entered is converted to the value type of the item. Real numbers are rounded to integers, if 
needed. 

Note! Unsigned integers, which are shown as hexadecimal numbers, always require the 0x prefix or 
letter h postfix, if you want to enter them in hexadecimal. Thus, entering 123A is an error. 
Entering 123 is accepted, but will show 7B instead of 123, because it is regarded as decimal, 
not hexadecimal. You should enter 0x123 or 123h, if you want 123h (hexadecimal) to be shown. 

A Boolean value or an enumerated value presents a dialog box with a drop-down list. 

 

Note that if the current value is out of bounds, the edit field is shown empty. 
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To get the list of all acceptable values dropped, click the down arrow to the right of the edit field. There 
may also be a scrollbar in the drop-down list, with which you can scroll through all the alternatives. 

 

To select an alternative, click it. You can type you selection into the edit field, too, as far as you spell it 
exactly as it is shown in the drop-down list. 

Note that DriveWindow allows you to select only among the presented alternatives. It is not possible to 
change an enumerated parameter to have a value out of bounds in DriveWindow. An item can initially 
have such a value in a drive, however. 

Whatever kind of dialog box was shown, click the OK button, when you have the new value in the edit 
field. You can also click the Cancel button, if you want to cancel the operation. 

When you click the OK button, the value is checked either by DriveWindow, the OPC Server, or the 
drive. If any errors are found, even communication errors, you are informed about it: 

 

Clicking the OK button brings back the dialog box with the value you entered into the edit field. Now 
you can correct your value and try again, or cancel the operation. 
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If the new value was accepted by the drive, and the item is readable, the value is read back from the 
drive and updated in the item sets pane, even if the item is not on-line. Note that the value may not be 
the same that you entered, because it may have been limited by the drive or it has been rounded. 

  

Note that the drive may change the value, but not always fast enough. So the value shown in the item 
sets pane may be the one actually written, or the value set by the drive. If you want to be sure about 
the value actually in the drive and the item is off-line, update the item after you have changed it. 

  

  

Note that there may be some parameters in a drive, which do not care about the value written, but the 
write operation itself is meaningful. Such parameters are usually Boolean, write-only items. 

  

See Also: What are Parameters and Signals 
What is Parameter File 
How to Copy Parameters 
Browse Tree Pane  
Using Symbol Tables  
Desktop Menu 
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9. Using Templates 
Very often you notice that grouping of parameters and signals in a drive does not satisfy your needs. 
Since version 2.20 you can do your own “grouping” in DriveWindow by adding so called user item sets 
of your own. By using item sets and workspaces you can speed up considerably your frequently 
repeated tasks. 

A user item set is constructed by adding so called templates into it. 

Each template represents an item. Actually properties of a template make rules, which define the 
actual item shown and how it is shown in different situations. 

Because DriveWindow generates the channel and node number parts of the OPC Address for the item 
defined by a template, it is not possible to use in user item sets special items, which do not have both 
of them. 

In general you create a user item set as follows: 

• Make a plan and decide, which items to include, how will the source drive(s) be determined, 
are special display formats needed, other special property requirements, naming of items and 
the item set, etc. 

• Add the user item set. Check and change its properties. The properties are the defaults for 
the templates in the item set. So their values should be such that majority of the templates 
can use default properties. 

• If you are connected to a drive, have a parameter file open, or there is another item set, which 
has any of the items you need, you can copy by drag and drop (or copy and paste) them into 
the newly created item set. DriveWindow creates templates out of them. 

• While your new item set is displaying, you can also use the Add New Item command in the 
Desktop menu or, in the context menu, which you get by clicking with the right mouse button 
on the item sets pane outside the name of an item. DriveWindow creates a template with 
property values you specify. 

• All added by copying have their properties set to use defaults, i.e., values defined by the item 
set properties. If some of the templates need different behaviour, change properties of such 
templates. 

• Finally, disconnect and save you changes into a workspace. 

If you have need for several user item sets, repeat the procedure. Note that it is possible to arrange the 
item sets into any order you want. 

To use your item sets just open the workspace, into which you saved them. 

Viewing of user item sets is quite similar to viewing of browsed item set or all parameters item set. 
There are some differences, however: 

• Instead of viewing items represented by the templates, you can select to view the templates 
themselves. 

• You cannot lock or unlock items because they are in a sense always “locked”. 
• Deleting an item actually deletes the template and the deletion requires confirmation. 
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Adding, deleting, or changing properties of templates is considered to be a major change in the 
workspace. It means that DriveWindow will notify you about unsaved workspace changes in operations 
that cause the workspace currently in use to be destroyed. 

 

See Also: What are Templates 
What are Item Sets 
Working with Item Sets 

9.1 Adding and Deleting Templates 

Adding and deleting templates into/from a user item set is quite similar to adding and deleting items 
to/from the desktop of browsed and all parameters item set. The details of adding and deleting are 
thus not repeated here. 

Adding, deleting, or changing properties of templates is considered to be a major change in the 
workspace. It means that DriveWindow will notify you about unsaved workspace changes in operations 
that cause the workspace currently in use to be destroyed. 

 

9.1.1 Adding 

Templates can be added into a user item set by three methods: 

• Copying by dragging and dropping items or templates 
• Copying by pasting items or templates from the clipboard 
• Using Add New Item command 

Templates added by copying have all their properties set to use defaults, i.e., corresponding property 
values defined by the item set are in use. In this case you have to change the template property values 
separately if needed. 

Note that you can copy more than one item or template at a time. 



Parameters, Signals, and Faults 

4-86 DriveWindow 2 

When the Add New Item command is selected while a user item set is displaying, a template will be 
added instead of an item. 

 

The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

When you add a template by this method, an Add New Template dialog is shown instead of the Add 
Item to Desktop dialog, which would have been shown, if the browsed item set had been displayed. 
The dialog allows you to view and set properties of the template to be added. 

 

The dialog box is actually the same as Template Properties dialog box - only the title differs. The 
properties can be viewed and changed also later. 
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Note that DriveWindow remembers the latest changes of most properties and suggests them when 
adding a template. It means that you should always check carefully all the properties when adding a 
template. 

Note also that DriveWindow does not check the correctness of the ItemId property of the template. If 
there is an error, it just means that the item defined by the template is never available. 

Because DriveWindow generates the channel and node number parts of the OPC Address for the item 
defined by a template, it is not possible to use in user item sets special items, which do not have both 
of them. 

9.1.2 Deleting 

Templates are deleted the same way as items from the browse or all parameters item set. 

 

However, because the selected templates are deleted permanently, DriveWindow asks you to confirm 
the deletion in this case. 

 

See Also: Using Templates 
Changing Template Properties 
Pasting Items from the Clipboard 
Dragging and Dropping Items 



Parameters, Signals, and Faults 

4-88 DriveWindow 2 

9.2 Viewing Templates 

Normally you want to see the items defined by the templates in a user item set. However, occasionally 
you may want to see the templates instead. For example, to be able to change template properties you 
must have the template visible. 

9.2.1 Templates 

To see templates instead of items, select the Templates command from the View menu while a user 
item set is displaying. 

 

The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

Note that the Templates command is replaced by Items command in the menus if you already have 
templates visible instead of items. 

9.2.2 Items 

To see items instead of templates, select the Items command from the View menu while a user item 
set is displaying. 
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The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

Note that the Items command is replaced by Templates command in the menus if you already have 
items visible instead of templates. 

9.2.3 Interpretation 

The outlook of a template as shown in a user item set resembles the outlook of an item. However, the 
template displays some of the properties of the template. 

 

Content of the Name field depends on the value of the Item Names property of the template. 

• It is the same as the OPC Address field if Item Names has value Fetch from Drive (if 
available). 

• It contains the Name property of the template if Item Names has value Fixed. 
• It contains both the values mentioned above separated by a slash if Item Names has value 

Default. 

Value field is always empty. 

OPC Address field contains the ItemId property of the template prefixed to a coded source drive 
notation. 

The source drive notation consists of two pairs of curly braces (as a channel and node in the OPC 
Address of an item) and show the value of the Source Drive property of the template. 

The following notations are in use (n, m, and o are integers): 

Notation Meaning 

{}{} Default 

{n}{m} Fixed with Ch=n and Node=m, not Relative 

{n}{m+o} Fixed with Ch=n and Node=m, Relative with Offset=+o 

{n}{m-o} Fixed with Ch=n and Node=m, Relative with Offset=-o 

{s}{} Selected, not Relative 

{s}{+o} Selected, Relative with Offset=+o 

{s}{-o} Selected, Relative with Offset=-o 

{c}{} Controlled, not Relative 

{c}{+o} Controlled, Relative with Offset=+o 

{c}{-o} Controlled, Relative with Offset=-o 
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The Source Drive property can be changed in the Source tab of the Template Properties dialog. 

 

See Also: Using Templates 

9.3 Changing Template Properties 

Properties of a template make rules, which define the actual item shown and how it is shown in 
different situations. 

Templates added by copying have all their properties set to use defaults, i.e., corresponding property 
values of the item set are used. In this case you have to change the template property values 
separately if needed. 

To be able to view and change properties of a template, you must be viewing templates in a user item 
set. If you are going to use the Desktop menu, you need to have exactly one template selected. 

 

Select the Item Properties command from the Desktop menu. Note that the same command is used to 
view item properties when an item is selected instead of a template. 
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The same command is included in the context menu, which you get by clicking with the right mouse 
button on the template, properties of which you want to view or change. 

 

DriveWindow displays the Template Properties dialog box. 
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The dialog box containing the properties is shown also when adding a template by Add New Item 
command. The dialog box title is then Add New Template. Otherwise the dialog box is exactly the 
same as the Template Properties dialog box.  

 

The dialog box has the following tabs: 

• General 
• Source 
• Format 
• Items 

Note that the Item Set Properties of a user item set has exactly the same tabs and properties, except 
Type and Name in its General tab. Other properties have exactly the same meaning as Template 
Properties. 

When you are finished, click the OK button. If you click the Cancel button, the operation is cancelled. 

 

Note that if you were adding a new template with the Add New Template dialog, clicking Cancel means 
that adding is not done. If you were changing properties with the Template Properties dialog, clicking 
Cancel means just that any changes you requested are not made. 

Note also that DriveWindow remembers the latest changes of most properties and suggests them 
when adding a new template with the Add New Template dialog. It means that you should always 
check carefully all properties when adding a template by using the Add New Template dialog. 
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Adding, deleting, or changing properties of templates is considered to be a major change in the 
workspace. It means that DriveWindow will notify you about unsaved workspace changes in operations 
that cause the workspace currently in use to be destroyed. 

 

See Also: Using Templates 
Viewing Templates 
Changing Item Set Properties 
Desktop Preferences 

9.3.1 General Template Properties 

The General tab in the Template Properties dialog box contains general properties of the template. 

 

ItemId specifies the item without any source drive (channel or node). 

Note that DriveWindow does not check the correctness of ItemId. If there is an error, it just means that 
the item defined by the template is never available. 

Name is the item name to be shown in the Name column if the Item Names property has value Fixed 
(directly or as the result of evaluating Default). 

Item Update allows you to select, how the items in the item set are updated. 

• Default means that the Item Update setting in Item Set Properties is to be used for the item. 
• From Cache means that the value of the item is to be fetched from the OPC Server cache. 
• From Device means that the value of the item is to be fetched from a drive. 
• Put On-Line means that the item is to be put on-line. 
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Typically the value Default is used for the property. 

See Also: Changing Template Properties 
General Item Set Properties 
Desktop Preferences 

9.3.2 Template Source Properties 

The Source tab defines the drive, from which the value of the item defined by the template is fetched. 

 

Source Drive allows you to select, from which drive the item defined by the template is to be fetched. 

• Default means that the Source Drive setting in Item Set Properties is to be used for the item. 
• Fixed means that the item is always to be fetched from the same drive. You have to specify 

the OPC Address of it by giving the channel (Ch) and node (Node) number of the drive. 
• In Ch you specify the channel number (0..9) part of the OPC Address. It is enabled (not 

grayed) only if the Source Drive is Fixed. 
• In Node you specify the node number (1..254) part of the OPC Address. It is enabled (not 

grayed) only if the Source Drive is Fixed. 
• Selected means that the item is to be fetched from the drive selected in the browse tree pane, 

or relative to it (if you have Relative selected).  
• Controlled means that the item is to be fetched from the drive, control of which has been 

taken, or relative to it (if you have Relative selected).  
• By selecting Relative you specify that the source drive is relative by Offset to the Fixed, 

Selected, or Controlled drive. The Relative property is disabled (grayed) in case Default is 
selected. 

• Offset specifies, how far the source drive is from the Fixed, Selected, or Controlled drive. It is 
disabled (grayed) if Relative is not selected or is disabled (grayed). 

Typically the value Default is used for the property. 

The value of the Offset property is numeric. If it is positive, the source drive is determined by counting 
drives downwards in the browse tree pane from the Fixed, Selected, or Controlled drive. Negative 
value means counting upwards. An open parameter file is not considered to be a drive when counting 
is done. 

If Offset is zero it is handled as if Relative was not selected. 

An open parameter file is a special case. It can be a source “drive”, if  Source Drive is Selected and 
Relative is not selected (or Offset is zero). 
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9.3.3 Example 

An example of specifying Relative is a case multiple drives, where you have many master-follower 
pairs with node numbers organised, so that a master node number always precedes the follower 
without any intervening drive. 

You want to see the speed of both master and follower. 

Add twice the speed into the user item set. 

 

Specify the Source Drive for the speed of the master to be Selected but not Relative. 

 

Specify the Source Drive for the speed of the follower also to be Selected, but Relative with Offset +1. 

 

You can see the settings you made also in the templates as shown in the user item set. 
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To see items instead of templates, select the Items command from the View menu. 

 

Now, when you select any master in the browse tree pane, you see speeds of the adjacent drives in 
the user item set. 

 

See Also: Changing Template Properties 
Item Set Source Properties 
Desktop Preferences 

9.3.4 Template Format Properties 

The Format tab defines the format to be used in displaying value of the item defined by the template. 

Note that the format can be temporally changed by the Change Format command. 
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Format allows you to control, how the value of the item is to be displayed (unless overridden). The 
property contains all the same options as in the Change Display Format dialog box, which is shown by 
the Change Format command. 

• Default means that the Use Panel Format setting in Item Set Properties is to be used for the 
item. 

• Normal means the classic DriveWindow format. 
• Other formats are self descriptive. 
• Decimals means number of decimal digits (0...8) to be displayed. It is enabled only when 

Fixed point or Exponent format is selected. 

The detailed description of different formats, i.e., how values are displayed in different formats, is 
explained in Viewing Parameters and Signals. 

Typically the value Default is used for the property. 

See Also: Changing Template Properties 
Item Set Format Properties 
Desktop Preferences 

9.3.5 Template Items Properties 

The Items tab defines, how the name of the item defined by the template is formed and what is 
displayed in case the item is not available.. 

 

Note that the properties have no effect when templates are shown instead of items in the user item set 
view. 

Item Names allows you to specify, how the name of the item in the Name column of the item sets pane 
is to be displayed. 

• Default means that the Item Names setting in Item Set Properties is to be used for the item. 
• Fixed means that the Name property of the template is to be used. 
• Fetch from Drive means that the name of the item is to be read from the drive. 

Reading the name of an item from the drive may not always be possible. If the name is not available, 
DriveWindow uses the OPC Address of the item as its name. 
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Typically the value Default is used for the property. 

N/A Items allows you to specify, how to display the item, if it is not available in the current source drive. 

• Default means that the N/A Items setting in Item Set Properties is to be used for the item. 
• Hide means that the item is not shown at all in case it is not available. 
• Show means that the item is shown, if it is not available, but its value is to be shown as 

<Bad>. 
• Show as Template means that the template is shown if the item is not available. 

Note that the N/A Items does not affect displaying of the item, if it is available. 

Typically the value Default is used for the property. 

See Also: Changing Template Properties 
Item Set Items Properties 
Desktop Preferences 

10. How to Save Parameters 
With DriveWindow it is possible to save user and ID run result parameters of a drive into a file. The 
saved parameters can be edited, if required. 

Note that DriveWindow is not able to handle ID run result parameters of native DriveDA OPC server 
drives (AC880 family). Instead, all unhidden parameters are saved. 

Note that for safety reasons you cannot save parameters of any drive while control of some drive is 
taken. The command in the menu is disabled (grayed). 

You can use the saved parameters in: 

• Restoring user and/or ID run result parameters (after a system software version upgrade, for 
example). 

• Comparing with current parameters in a drive or with another parameter file. 
• Exporting the same way as parameters of a drive are exported. 

Note that in addition of read/write parameters, information about signals (read-only) and write-only 
parameters are saved, too. 

Not all parameters of a drive are saved, however. In addition of groups, which are not under pass code 
protection at save time, there are also parameters required during download, Application Properties, 
and drive Properties without sub-branches. 

Note that you need not to decide, whether you need the saved parameters to restore user or ID run 
result parameters. You make the decision at restoring time. 

To save parameters of a drive, click with the right mouse button the drive (or a sub-branch within it) in 
the browse tree pane and then select the Save As command from the Parameters submenu of the 
context menu. Or, if you are more accustomed to use normal menus, select (click) the drive (or a sub-
branch within it) and then select the Save As command from the Parameters submenu in the File 
menu. 

 or 
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Note that to select a drive or an open parameter file, it is not necessary to select its root, selection of 
any of its sub-branches will do.  

You can also use the Save As shortcut key Ctrl+S. 

Saving of an open parameter file is similar to saving parameters of a drive. Instead of right-clicking or 
selecting a drive in the browse tree pane, you right-click or select the open parameter file. 

 

A Save As dialog box is displayed. 

10.1.1 When the Save As dialog box is displayed: 

• From Save in, browse into the drive and directory, into which you want to save the parameters 
• Enter the name of the parameter file into File name or, if you want to replace an existing file, 

click the filename you want to replace 
• Click Save and a file comment is requested 
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If the file already exists, confirmation to replace it asked when you click Save. 

 

10.1.2 When the File Comment dialog box is displayed: 

There is a time stamp in the edit field as a default comment. It is selected, which means that if you just 
start typing, it is replaced by your comment. 

• Enter, add, edit, or accept the comment in the edit field 
• Click OK, and saving starts 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

10.1.3 While the parameters are uploaded 

If you are saving parameters of a drive, uploading of them takes for a while. The cursor turns to hour-
glass and the status bar informs you about uploading. 

 

10.1.4 Name of the saved open parameter file changes 

If you are saving parameters of an open parameter file using another name, the name of the file shown 
in the browse tree pane is changed to the new name you used in saving. 
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See Also: What are Parameters and Signals 
What is Parameter File 
Browse Tree Pane 
Opening a Parameter File 
Closing a Parameter File 
How to Print Parameters 
How to Export Parameters 

10.2 Viewing and Editing Saved Parameters 

Viewing and changing items in an open parameter file is similar to viewing and changing items of a 
drive. 

There are differences, however: 

• You cannot change a write-only parameter in an open parameter file. 
• Checking of the changed values in an open parameter file is minimal. No limiting is done, for 

example. The value is checked at download time by the drive. So changing values in a 
parameter file is discouraged. 

• There is no pass code protection in an open parameter file. All items saved into the parameter 
file are also shown. 

• You can delete a parameter group or even the Parameters sub-branch from an open 
parameter file. 

• You can edit the comment in an open parameter file, too. There is no such thing as a 
comment in a drive. 

• The changes made into an open parameter file are not saved automatically. You have to ask 
saving of them explicitly. 

• Saving of unsaved changes is also requested, when you close the open parameter file. 

To be able to view and edit a parameter file, you must first open it. 

When you have a parameter file open, you can view and change items within it almost as if it was a 
drive. 

We recommend that you always click Cancel in the value change dialog box, if you did not actually 
change the value. Otherwise, the open parameter file may be marked changed (because of rounding), 
and a save request is made, when the file is closed. 

We recommend that you close the open parameter file when you do not need it any more. 

10.2.1 Viewing and Editing the Comment 

You can also view and edit the comment within the open parameter file by selecting Comment from the 
Parameters submenu or from the context menu, which you get by clicking with the right mouse button 
on open parameter file (or a sub-branch within it) in the browse tree pane. 

  or 
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A File Comment dialog box is presented. It shows the comment in its edit field. The comment text is 
selected, which means that if you just start typing, the previous text is replaced by your new comment. 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

When you are done with editing, click the OK button. Click the Cancel button, if you do not want to 
change the comment. 

10.2.2 Deleting Parameter Groups 

To delete a parameter group or the total Parameters sub-branch from an open parameter file, select 
the group (or Parameters), which you want to delete, in the browse tree pane. While focus is still in the 
browse tree pane, click the delete button in the standard toolbar. 
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Instead of clicking the delete button in the standard toolbar, delete can be invoked also by pressing the 
Del key, using the Edit menu, or using the context menu, which you get by clicking with the right mouse 
button on the parameter group sub-branch within an open parameter file in the browse tree pane. 

 or  

The selected parameter group or the Parameters sub-branch disappears from the browse tree pane. 
The change is saved when you ask saving of the open parameter file. Saving of unsaved changes is 
also requested, when the parameter file is closed. 

 

Note that if you have the parameter file root selected, delete is same as closing the open parameter 
file. If focus is not in the browse tree pane, action of the delete depends on the pane, which has the 
focus, but no parameter group or the Parameters sub-branch is deleted. 

See Also: What are Parameters and Signals 
What is Parameter File 
How to Save Parameters 
Opening a Parameter File 
Browsing Parameters and Signals  
Viewing Parameters and Signals 
Changing Parameters 
Closing a Parameter File 

11. How to Restore Parameters 
You can restore user and/or ID run result parameters of a drive from a saved parameter file. 

However, DriveWindow is not able to handle ID run result parameters of native DriveDA OPC server 
drives (AC880 family). Instead, all parameters are restored, which in most cases fails. Thus we do not 
recommend using DriveWindow to restore parameters of ACS880 family of drives. 

Note that for safety reasons you cannot restore parameters of any drive while control of some drive is 
taken. The command in the menu is disabled (grayed). 
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Note that since version 2.11 DriveWindow tries to restore also parameters, type of which were read-
only when uploaded. If such a parameter is still read-only in the drive when downloaded, the value is 
not changed. 

Note also that unless specially specified for the kind of drive in question, user parameters of string type 
are not restored. 

Note! Parameter download causes heavy DDCS communication traffic. To avoid potential failures, we 
recommend that you stop all on-line activity (status refresh, monitoring, no items on-line, control 
not taken) in DriveWindow when you download parameters. 

It is good practice to do parameter comparison after restoring parameters to verify that restoring really 
was successful. 

If you have a parameter file open, parameters are restored from it. Otherwise the parameter file to be 
used is requested. If you are pasting or dropping a parameter file, it does not matter, whether you have 
another parameter file open or not. 

11.1.1 Restoring from an Open Parameter File 

To restore the parameters from open parameter file: 

• Make sure, you have a full backup of the drive(s) available. The backup may be required, if 
something goes wrong, when restoring the parameters. 

• If drive contains application macros, the selected macro must be the same in the file and in 
the drive. 

• If any of the parameters is write protected by a parameter lock, open the lock and reconnect 
DriveWindow. 

• Select the Download command in the Parameters submenu of the context menu, which you 
get by clicking with the right mouse button on the drive (or a sub-branch within it) in the 
browse tree pane. 
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Instead of using the context menu you can also: 

• Select (click) the drive, parameters of which you want to restore, in the browse tree pane. 
• Select the Download command from the Parameters submenu in the File menu (or press 

Ctrl+D). 

  

11.1.2 Restoring from a Requested Parameter File 

To restore the parameters from a parameter file in case there is no parameter file open: 

• Make sure, you have a full backup of the drive(s) available. The backup may be required, if 
something goes wrong, when restoring the parameters. 

• If drive contains application macros, verify that the selected macro is the same in the file and 
in the drive. 

• If any of the parameters is write protected by a parameter lock, open the lock and reconnect 
DriveWindow. 

• Select the Download command in the Parameters submenu of the context menu, which you 
get by clicking with the right mouse button on the drive (or a sub-branch within it) in the 
browse tree pane. 
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• A Download dialog box similar to an Open dialog box is shown. Using the dialog box, select 
the parameter file containing parameters to be restored. 

 

Instead of using the context menu you can also: 

• Select (click) the drive, parameters of which you want to restore, in the browse tree pane. 
• Select the Download command from the Parameters submenu in the File menu (or press 

Ctrl+D). 
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11.1.3 Restoring by Pasting 

To restore the parameters from a parameter file by copying it in Windows Explorer and pasting it into a 
drive: 

• Make sure, you have a full backup of the drive(s) available. The backup may be required, if 
something goes wrong, when restoring the parameters. 

• If drive contains application macros, verify that the selected macro is the same in the file and 
in the drive. 

• If any of the parameters is write protected by a parameter lock, open the lock and reconnect 
DriveWindow. 

• In Windows Explorer, browse the parameter file and copy it to clipboard. 

  

• In DriveWIndow, select the Paste command from the context menu, which you get by clicking 
with the right mouse button on the drive (or a sub-branch within it) in the browse tree pane. 

  

Instead of using the context menu you can also: 

• Select (click) the drive, parameters of which you want to restore, in the browse tree pane. 
• Click the paste button in the standard toolbar, select the Paste command in the Edit menu, or 

press Ctrl+V key. 
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 or  

• DriveWindow requests your confirmation. Click the Yes button. 

 

11.1.4 Restoring by Drag and Drop 

To restore the parameters from a parameter file by dragging it from Windows Explorer and dropping it 
into a drive: 

• Make sure, you have a full backup of the drive(s) available. The backup may be required, if 
something goes wrong, when restoring the parameters. 

• If drive contains application macros, verify that the selected macro is the same in the file and 
in the drive. 

• If any of the parameters is write protected by a parameter lock, open the lock and reconnect 
DriveWindow. 

• In Windows Explorer, browse the parameter file. 
• Click the parameter file and drag it with the mouse button down upon the drive (or a sub-

branch within it) in the browse tree pane of DriveWindow. 
• Drop the parameter file by releasing the mouse button. 
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• DriveWindow requests your confirmation. Click the Yes button. 

 

11.1.5 Version Check 

DriveWindow first checks version compatibility. If any differences are found in Properties, Application 
Properties, or in some, drive kind dependent parameters, a message box is presented. It warns you 
about consequences of version incompatibilities and allows you to cancel downloading by answering 
No. 

 

11.1.6 Restore Type Selection 

If the versions match, or if you decided to proceed with version conflicts, a Select Restore Type dialog 
box is presented. 

Note that DriveWindow is not able to handle ID run result parameters of native DriveDA OPC server 
drives (AC880 family). Instead, all parameters are restored, which in most cases fails. Thus we do not 
recommend using DriveWindow to restore parameters of ACS880 family of drives. No Select Restore 
Type dialog box is presented for ACS880 family of drives. 

Now it is time to decide, whether you want to download user parameters, ID run result parameters, or 
both. You do the selection by clicking the proper check fields in the dialog box 
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Note that if the parameter file does not contain all ID run result parameters (you have possibly deleted 
some of them), the corresponding check field is disabled (grayed). 

When you have done your selection, click the OK button. You have also the option to cancel 
downloading by clicking the Cancel button. Note that the OK button does not accept mouse clicks if 
neither of the check fields is selected. 

11.1.7 Confirmation 

Finally, a confirmation is requested. 

 

Click Yes to continue, click No to cancel downloading. 

11.1.8 Downloading 

Downloading of the parameters takes for a while. The cursor turns to hour-glass and the status bar 
informs you about downloading. 

 

After parameters have been downloaded, you are requested, whether to force them into the FLASH 
memory or not. Forcing guarantees that the downloaded parameters persist even if the drive is 
promptly restarted. Typically you click Yes. If you know your drive well and want to save a few minutes 
of your time, you can skip forcing by clicking No. 
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If you asked DriveWindow to request the drive to force the parameters into the FLASH memory, the 
cursor stays turned to hour-glass and the status bar informs you about writing to FLASH memory. 

 

If forcing for some reason fails, DriveWindow informs you about it. You have then the option to retry 
forcing if you wish. 

 

Note that if you have requested forcing and it fails, DriveWindow does not ask you about restarting the 
drive. If you want to restart the drive in such a case, we recommend that you either exit from 
DriveWindow, or disconnect the drive at node address one, or the drive to be restarted, from the DDCS 
network. Then restart the drive manually by power off/on. 

11.1.9 Restarting the Drive 

When the downloading has been done successfully, you are asked, whether to restart the drive or not. 

Restarting a drive is usually not needed in case you restored only the user parameters. If ID run result 
parameters were restored, restarting of the drive is usually recommended. However, this can be drive 
dependent, so consult the drive documentation. 

 

Note! Restarting a drive does an internal disconnecting and reconnecting of the OPC Server. This 
means that monitor and dataloggers are cleared, all items are removed from the browsed item 
set, the parameter file is closed, browse tree pane is collapsed, etc. 

Restarting of the drive takes for a while. The cursor turns to hour-glass and the status bar informs you 
about restarting. 
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Your DDCS network may be configured against recommendations and has a drive at node address 
one. Node address one is reserved for spare parts. 

In this case, if you are restoring parameters of a drive at another node, restarting of the drive cannot be 
done. You will get, instead of requesting restarting of the drive, a message box telling about this. 

 

If you want to restart the drive in such a case, we recommend that you either exit from DriveWindow, 
or disconnect the drive at node address one, or the drive to be restarted, from the DDCS network. 
Then restart the drive manually by power off/on. 

11.1.10 How Errors are Shown 

If any errors (communication errors, for example) are encountered during the parameter download, a 
message box containing a list of errors is presented. 

 

After you have acknowledged by clicking the OK button, a warning is shown, too. 
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If your parameter file does not contain any parameters (you have deleted the Parameters sub-branch, 
for example), you get a message box after the Select Restore Type dialog box. 

 

If the node address changes, when DriveWindow restarts the drive, you will probably get an error 
message, which tells you that restarting failed. 

 

If, after you click the OK button, the drive re-appears in the browse tree pane at the new node address, 
you may ignore the message. It is shown, because DriveWindow does not know about the node 
address change before re-connecting the OPC Server. Thus it tries to verify success of restarting from 
the wrong node address. 

See Also: What are Parameters and Signals 
What is Parameter File 
How to Save Parameters 
How to Compare Parameters 
Opening a Parameter File 
Closing a Parameter File 

12. How to Print Parameters 
Since version 2.20 of DriveWindow it is possible to print parameters of drives and open parameter 
files. 

Note that printing of parameters is done with help of Internet Explorer version 6 (or newer) 
components. If you do not have proper components installed, parameter printing commands are 
disabled (grayed). However, it is possible to configure DriveWindow to “print” into a file. The generated 
XML-file can be printed later in another computer, in which DriveWindow is capable to print. 

Because Internet Explorer is used in printing of parameters, its settings affect DriveWindow printing, 
too. 

Note that for safety reasons you cannot print parameters of any drive while control of some drive is 
taken. The commands in the menus are disabled (grayed). 
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Note that instead of printing of parameters of drives or open parameter files, it is also possible to print 
item sets. 

The following can be printed: 

• Parameters in an open parameter file. 
• Parameters in a selected drive. 
• Parameters of all drives. 
• Parameter differences shown in a Parameter Comparison dialog box. 

Not all parameters and signals of a drive or a parameter file are printed, however. Parameters and 
signals under pass code protection are not printed. About other items than drive parameters, only 
Application Properties and drive Properties without sub-branches are included. The parameters in an 
open parameter file, which were under pass code protection during saving the drive, are not included, 
either. 

Note that the Name item of drive Properties is printed into the title part of a drive. 

12.1.1 Configuring printing format 

The selection of Use Panel Format (if available) in Desktop Preferences affects also the format of the 
printed parameter values other than parameter differences. Note that the operator panel format is only 
available in new drives. Thus the selection concerns only those drives. 

 

The Internet Explorer component uses most of the prevailing settings of Internet Explorer. For 
example, most of Page Setup settings are used. The Orientation setting is not used, however. You 
need to set it in Preferences of the Print dialog. 

We recommend that “Print background colors and images” is selected in Printing part of the Advanced 
Internet Options in Internet Explorer. You can find Internet Options in the Tools menu of Internet 
Explorer. 
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12.1.2 To print parameters in an open parameter file 

In the browse tree pane, click with the right mouse button the open parameter file (or a sub-branch 
within it) and then select the Print command in the Parameters submenu of the context menu. Or, if 
you are more accustomed to use normal menus, select (click) the open parameter file (or a sub-branch 
within it) and then select the Selected command from the Print submenu of the Parameters submenu 
in the File menu. 

  or 

  

12.1.3 To print parameters in a drive 

In the browse tree pane, click with the right mouse button the drive (or a sub-branch within it), then 
select the Print command in the Parameters submenu of the context menu. Or, if you are more 
accustomed to use normal menus, select (click) the drive (or a sub-branch within it), then select the 
Selected command from the Print submenu of the Parameters submenu in the File menu. 

 or 
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12.1.4 To print parameters of all drives 

Select the All Drives command in the Print submenu of the Parameters submenu in the File menu. 

 

Note that even if you have a parameter file open, it is not printed with drives. 

12.1.5 To print parameter differences 

When you are viewing the differences in a Parameter Comparison dialog box, click the Print button. 
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12.1.6 If Printing to File 

If you have configured DriveWindow to “print” into a file, the Print Parameters to File or the similar Print 
Differences to File dialog is shown 

Enter a file name and click the Save button to continue. 

 

12.1.7 When the Print Comment dialog box is displayed 

There is a time stamp in the edit field as a default comment. It is selected, which means that if you just 
start typing, it is replaced by your comment. 

• Enter, add, edit, or accept the comment in the edit field 
• Click OK 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

If you wish your comment to consist of several lines, use the Ctrl+J key to start a new line. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc key 
is same than clicking the Cancel button. 
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12.1.8 While the parameters are uploaded 

If you are printing parameters of a drive, uploading of them takes for a while. The cursor turns to hour-
glass and the status bar informs you about printing. 

 

12.1.9 When the Print dialog box is displayed 

If you were not “printing” to a file, the Internet Explorer component displays a Print dialog box. 

You can, for example, select the printer to be used and change the printer settings such as paper 
orientation. Click the Print button to send the document to the printer. If you click Cancel, printing is 
cancelled. 

 

Note! The Print dialog is modeless, which means that you can continue doing other actions with 
DriveWindow while the dialog exists. However, we recommend that you finish with the dialog 
before continuing. Especially, quitting DriveWindow while the Print dialog still exists may cause 
complications that can be solved only by logging off. 

12.1.10 Printing a Saved File 

Printing an XML-file created by DriveWindow when it was configured to “print” to file is done by using 
Internet Explorer. 

Note that you must have DriveWindow installed the same way in both computers, if printing is done in 
another computer. 
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Open in Internet Explorer the XML-file saved by DriveWindow. 
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Internet Explorer shows contents of the file as it will be printed. Select the Print command from the File 
menu of Internet Explorer. 
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Internet Explorer displays the same Print dialog as DriveWindow does when not “printing” to file. Make 
your selections and click the Print button to send the document to the printer. If you click Cancel, 
printing is cancelled. 

 

See Also: What are Parameters and Signals 
How to Save Parameters 
How to Compare Parameters 
How to Export Parameters 
Desktop Preferences 
Printing Item Sets 

13. How to Copy Parameters 
Since version 2.20 of DriveWindow it is possible to copy values of parameters to drives and to open 
parameter files. 

Note that the usual method of changing parameters is to give a new value to a single parameter at a 
time. 

There are two methods to do the copying: 

• Copying the values to the clipboard and pasting them to a drive or to an open parameter file. 
• Dragging the values and dropping them to a drive or to an open parameter file. 

Note that it is not possible to copy values directly from a drive or an open parameter file to another 
drive or an open parameter file. You must have the values available in an item set or perhaps in 
another application. 
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Note that at least one of the items that are being copied must have a value. If not, copying to a drive or 
to an open parameter file is not possible. Paste command for the browse tree pane is disabled 
(grayed). If dragging, the cursor turns into a forbidden sign in the browse tree pane. 

13.1.1 To paste parameter values 

Before you can paste you must have copied the parameters into the clipboard. 

In the browse tree pane, click with the right mouse button the drive or the open parameter file (or a 
sub-branch within it) and then select the Paste command from the context menu. 

  or 

 

Or, if you are more accustomed to use toolbars or normal menus, select (click) the drive or the open 
parameter file (or a sub-branch within it) and then either click the paste button in standard toolbar or 
select the Paste command from the Edit menu. 

 

 or  

You can also use the normal Windows paste shortcut key Ctrl+V. 

13.1.2 To drop parameter values 

To be able to copy parameter values by dropping, you must be dragging them from a valid dragging 
source, i.e., items in an item set or perhaps in an external application like Word.  
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To drop the parameter values, drag the cursor over the drive or the open parameter file (or a sub-
branch within them) in the browse tree pane. Check that there is a plus sign visible in the cursor before 
releasing the mouse button. 

 

Note that it is not possible to move values to a drive or an open parameter file. 

If dropping is not possible  the cursor turns into a forbidden sign above the drive or the open parameter 
file (or a sub-branch within them) in the browse tree pane. Releasing the mouse button cancels the 
drag and drop operation. 

 

13.1.3 Confirmation request 

DriveWindow requests you to confirm writing of the values to the drive or to the open parameter file. 
Click the Yes button if you are sure you want to write the values. 

 

13.1.4 Error messages 

After you have confirmed the writing, DriveWindow tries to write the values to the drive or to the open 
parameter file. It skips all items that do not have a value. If writing of any other item fails because of 
being write protected or does not exist, for example, DriveWindow beeps and shows you an error 
message. 

If all items (having a value) were written without errors, DriveWindow does not show any message. 
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If some but not all items could be written, DriveWindow shows you a message. Note that DriveWindow 
does not tell you, writing of which items failed.  

 

If none of the items could be written, DriveWindow shows you a message about it. 

 

See Also: What are Parameters and Signals 
How to Restore Parameters 
How to Compare Parameters 

14. How to Compare Parameters 
It is possible to compare restorable parameters, read/write parameters, Properties, and Application 
Properties in a parameter file with the parameters in a drive or in another parameter file. 

Note that for safety reasons you cannot compare parameters of any drive while control of some drive is 
taken. The command in the menu is disabled (grayed) in this case when a drive is selected in the 
browse tree pane. 

Note that signals are not compared, unless they actually are write protected restorable parameters. 

If you have a parameter file open, parameters in it are compared with parameters in the selected drive. 
Otherwise, and also in case you want to compare two parameter files, the parameter file to be used is 
requested. 
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14.1.1 Comparing a Drive with the Open Parameter File 

To compare the parameters in an open parameter file with parameters in a drive: 

• Select the Compare command in the Parameters submenu of the context menu, which you 
get by clicking with the right mouse button on the drive (or a sub-branch within it) in the 
browse tree pane. 

  

Instead of using the context menu you can also: 

• Select (click) the drive in the browse tree pane. 
• Select the Compare command from the Parameters submenu in the File menu. 

  

DriveWindow uploads the required parameters from the drive. Uploading of them takes for a while. The 
cursor turns to hour-glass and the status bar informs you about uploading. 
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14.1.2 Comparing a Drive with a Requested Parameter File 

To compare the parameters in a parameter file with parameters in a drive in case there is no 
parameter file open: 

• Select the Compare command in the Parameters submenu of the context menu, which you 
get by clicking with the right mouse button on the drive (or a sub-branch within it) in the 
browse tree pane. 

  

Instead of using the context menu you can also: 

• Select (click) the drive in the browse tree pane. 
• Select the Compare command from the Parameters submenu in the File menu. 
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• A Compare dialog box similar to an Open dialog box is shown. Using the dialog box, select 
the parameter file containing parameters to be compared with the parameters in the drive. 

 

DriveWindow uploads the required parameters from the drive. Uploading of them takes for a while. The 
cursor turns to hour-glass and the status bar informs you about uploading. 

 

14.1.3 Comparing two Parameter Files 

To compare the parameters in a parameter file with parameters in an open parameter file: 

• Open the parameter file (unless it is already open). 
• Select the Compare command in the Parameters submenu of the context menu, which you 

get by clicking with the right mouse button on the parameter file (or a sub-branch within it) in 
the browse tree pane. 
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Instead of using the context menu you can also: 

• Select (click) the drive in the browse tree pane. 
• Select the Compare command from the Parameters submenu in the File menu. 

  

• A Compare dialog box similar to an Open dialog box is shown. Using the dialog box, select 
the parameter file containing parameters to be compared with the parameters in the open 
parameter file. 

 

14.1.4 Comparison Results 

The comparison results are presented in a Parameter Comparison dialog box. Note that parameters, 
which exist in the drive but not in the parameter file, are excluded from comparison. 
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If there are no differences, it is reported in the Note column on the first line. 

 

14.1.5 Printing 

If you want to print the parameter comparison results, click the Print button at the lower right corner, 
and the comparison results are printed. 

 

14.1.6 Exporting 

If you want to export the parameter comparison results into a file, click the Export button at the lower 
right corner, and the comparison results are exported to a file. 

 

14.1.7 Closing 

When you are finished with the Parameter Comparison dialog box and want to close it, either click the 
Close button at the lower right corner, click the close button in the title bar, or press Alt+F4. 

  

14.1.8 Viewing 

If all of the differences cannot be shown, there is a vertical scrollbar at the right side. Use it to scroll the 
list, so you can see more differences. 
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If there is a long line that cannot be totally shown, there is a horizontal scrollbar at the bottom. Use it to 
scroll the list horizontally, so you can see the end of the long lines. 

 

You can also adjust the width of a column, if you wish, by dragging the column separator in the title. 

 

Note that the descriptive name in the Name column is taken from the drive (or from the open 
parameter file, if two parameter files are compared), unless the parameter does not exist in the drive 
(or in the open parameter file, if two parameter files are compared). If the parameter does not exist in 
the drive (or in the open parameter file, if two parameter files are compared), the descriptive name is 
taken from the (requested) file. 

Note also that the descriptive names are not compared. So, if the values of a parameter are equal, but 
the descriptive names are different, no difference is reported about the parameter. Thus you can easily 
compare files and drives with different language selection. 

Title of the second column shows the name of the drive (or the name of the open parameter file 
preceded by text “File: “, if two parameter files are compared). 

Title of the third column shows the name of the (requested) file preceded by text “File: “. 

The columns contain the parameter value in the drive (or in the open parameter file, if two parameter 
files are compared) and in the (requested) file respectively. Note that a period is used as decimal 
symbol regardless of the regional settings. 
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The Note column contains additional information about the difference, such as: 

• Does not exist in drive. The parameter in the parameter file does not exist in the drive. 
• Does not exist in file (file name). The parameter in the other parameter file does not exist in 

the file indicated. 
• Datatypes differ. The datatype in the parameter file is not the same as in the drive. 
• Enumerations differ. The ranges of enumeration in the parameter file and in the drive are not 

the same. It could mean that the number of enumeration strings differs or the enumerations 
start from different values. Note that the enumeration strings themselves are not compared. 

• Difference less than display format accuracy. The values differ so little that the values shown 
are equal in the second and third column. 

• Illegal enumerated value. Something went wrong when converting an enumerated value (this 
note should never be shown). 

• No differences found. This note is presented only, if all compared parameters are equal. It is 
then the only message in the dialog box. 

Note that the export file is not exactly equal to the content of the dialog box. The exported values have 
much greater accuracy, use the decimal symbol defined in the regional settings, and there should be 
no note about difference less than display accuracy. 

See Also: What are Parameters and Signals 
What is Parameter File 
How to Save Parameters 
Opening a Parameter File 
Closing a Parameter File 
How to Print Parameters 
How to Export Parameters 

15. How to Export Parameters 
Exporting of parameters means making them available for other applications. 

Note that for safety reasons you cannot export parameters of any drive while control of some drive is 
taken. The commands in the menus are disabled (grayed). 

The simplest form of exporting of parameters is copying (or cutting) selected items in the item sets 
pane to the clipboard. You can then paste the copied items into another application, as long as the 
application supports pasting of text. If the other application supports drag and drop, the items can also 
be copied by dragging into the other application. 

In addition to support copying of items, DriveWindow has the capability of exporting parameters to a 
file. 

The following can be exported to a file: 

• Parameters in an open parameter file. 
• Parameters in a selected drive. 
• Parameters of all drives. 
• Parameter differences shown in a Parameter Comparison dialog box. 
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Not all parameters and signals of a drive or a parameter file are exported, however. Parameters and 
signals under pass code protection are not exported. If text format is used in exporting, write-only 
parameters not exported.  About other items than drive parameters, only Application Properties, and 
drive Properties without sub-branches are included. The parameters in an open parameter file, which 
were under pass code protection during saving the drive, are not included, either. 

You can export in two formats: 

• Text format 
• XML Format 

If you export in text format, the exported file has filename extension TXT. It contains (in ASCII format) 
basic information about parameters and signals in so called tab separated format. 

If you export in XML format, the exported file has filename extension XML. It contains almost all 
information about parameters and signals in Extensible Markup Language format. 

Note that an exported file is not meant for humans to read. Because it is for other applications, the 
accuracy of values is very big. Note also that the decimal symbol defined in the regional settings is 
used in text format files. So, extra care is required in exchanging such exported files with other 
countries. 

The tab separated format is understood by many applications, by Word and Excel, for example, and 
can be easily imported in such kind of applications. 

15.1.1 To export parameters in an open parameter file 

In the browse tree pane, click with the right mouse button the open parameter file (or a sub-branch 
within it) and then select the Export command in the Parameters submenu of the context menu. Or, if 
you are more accustomed to use normal menus, select (click) the open parameter file (or a sub-branch 
within it) and then select the Selected command from the Export submenu of the Parameters submenu 
in the File menu. 

  or 
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15.1.2 To export parameters in a drive 

In the browse tree pane, click with the right mouse button the drive (or a sub-branch within it), then 
select the Export command in the Parameters submenu of the context menu. Or, if you are more 
accustomed to use normal menus, select (click) the drive (or a sub-branch within it), then select the 
Selected command from the Export submenu of the Parameters submenu in the File menu. 

 or 

  

15.1.3 To export parameters of all drives 

Select the All Drives command in the Export submenu of the Parameters submenu in the File menu. 

 

Note that even if you have a parameter file open, it is not exported with drives. 

15.1.4 To export parameter differences 

When you are viewing the differences in a Parameter Comparison dialog box, click the Export button. 
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15.1.5 When the Export dialog box is displayed: 

The dialog boxes shown in different exports differ only by the text shown in the title bar. 

 

 

 

• From Save as type, select the export format. 

 

• From Save in, browse into the drive and directory, into which you want to export the 
parameters or the differences. 

• Enter the name of the export file into File name or, if you want to replace an existing file, click 
the filename you want to replace. 

• Click Save and a file comment is requested. 

If the file already exists, confirmation to replace it asked when you click Save. 

 

15.1.6 When the File Comment dialog box is displayed: 

There is a time stamp in the edit field as a default comment. It is selected, which means that if you just 
start typing, it is replaced by your comment. 
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• Enter, add, edit, or accept the comment in the edit field 
• Click OK, and exporting starts 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

If you are exporting in XML format and you wish your comment to consist of several lines, use the 
Ctrl+J key to start a new line. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

15.1.7 While the parameters are uploaded 

If you are exporting parameters of a drive, uploading of them takes for a while. The cursor turns to 
hour-glass and the status bar informs you about exporting. 

 

15.1.8 Example of exported parameters of a drive 

In this example the text format is used in exporting. 

Note that content of the exported file is similar, when all of the drives or an open parameter file is 
exported. 

The file identification tag and the comment are the first two lines. 

The name of the drive or the parameter file has an empty line above and below it. 

If all drives are exported, they appear in the file sequentially. 
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The following shows the beginning of the file, when it has been imported to Word, and converted to a 
table. Borders have been added, too. 

 

15.1.9 Example of exported parameter differences 

The following shows the beginning of the file, when it has been imported to Word, and converted to a 
table. Borders have been added, too. 

 

See Also: What are Parameters and Signals 
How to Save Parameters 
How to Print Parameters 
What is Parameter File 
Opening a Parameter File 
Closing a Parameter File 
How to Compare Parameters 
Handling of Exported Files 
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16. How to Do System Software Version Upgrade 
Version upgrade is installing new version of system software into an already commissioned drive so 
that re-entering of parameter values is avoided. 

Note that DriveWindow is not able to handle system software of native DriveDA OPC server drives 
(AC880 family). So, you cannot use DriveWindow to upgrade system software of ACS880 family of 
drives. 

Version upgrade is possible only, if the new system software version is compatible with the old one, 
i.e., the parameters required to be set during commissioning have the same group and index values, 
and their values have the same scaling. If there are just minor differences (new parameters, for 
example), upgrading can still be done, but manual adjustment of parameters are required after 
upgrading. 

16.1.1 Preparing 

Although not absolutely necessary, we recommend that you take full backup of all drives to be 
upgraded, unless you have them already available. The backup may be required, if something goes 
wrong during the upgrade. 

However, saving of parameters of all drives to be upgraded, is required. 

Depending on the DDCS network configuration and the tool you are going to use to download the new 
system software, you may be need to make reconnections in the DDCS network. 

• If the download tool is not DriveWindow and it supports only point-to-point connection, you 
have to connect the drive to be upgraded directly to you PC. 

• If you are going to use DriveWindow in downloading, it may be that your DDCS network has 
been configured against recommendations, and has a drive at node address one (node 
address one is reserved for spare parts). If you are going to upgrade a drive other than the 
one with node address one, either disconnect the drive with node address one from the 
network, or power it down (assuming it is behind a branching unit). 

• If you are going to use DriveWindow in downloading, and node address on is not in use, no 
hardware changes are needed. 

16.1.2 Downloading System Software 

If you are not using DriveWindow in downloading the new system software, quit DriveWindow. 

If you use DriveWindow in downloading (you have a DriveWindow loading package), you should stop 
all on-line activity (status refresh, monitoring, no items on-line, control not taken) before downloading 
system software. 

16.1.3 Restoring Parameters 

When system software has been downloaded, the drive is normally found at node address one with all 
parameters set to default values. 

If you used other tool than DriveWindow in downloading system software, start DriveWindow. 

If drive contains application macros, verify that the selected macro is the same in the saved parameter 
file and in the drive. Change it in the drive, if needed. 

Download the saved parameters. Whether to download also the ID run result parameters or not, 
depends on the level of compatibility of the system software versions. 

If the drive originally was at some other node address than one, it will usually be at its original address 
just after restarting it. If restarting is not done when DriveWindow is requesting it, is required to re-
identify the network. Re-identifying is done by disconnecting and re-connecting the OPC Server. 
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If the node address changes, when DriveWindow restarts the drive, you will probably get an error 
message, which tells you that restarting failed. 

 

If, after you click the OK button, the drive re-appears in the browse tree pane at the new node address, 
you may ignore the message. It is shown, because DriveWindow does not know about the node 
address change before re-connecting the OPC Server. Thus it tries to verify success of restarting from 
the wrong node address. 

16.1.4 Finishing 

We recommend that you take full backup of all drives, which were upgraded, so that replacing a 
damaged control board with a spare part is made easy. 

Note that instead of creating a new backup package, you have the option to use the old backup 
package, and only replace the upgraded drives within it. 

See Also: What are Parameters and Signals 
How to Save Parameters 
How to Restore Parameters 
How to Compare Parameters 
What is Parameter File 
What is System Software 
What is a Backup Package 
What is a Loading Package 
How to Backup 
How to Download 

17. Desktop Preferences 
With desktop preferences you can control some behaviour of DriveWindow display. Note that most of 
the settings are just defaults for item set properties. They can thus be overridden by an item set by not 
using the default selection there. 

However, by using defaults in item sets, where appropriate, you can quickly change some behaviour of 
all such item sets. Otherwise you would need to change the property for all such item sets separately. 
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You can set desktop preferences by selecting Preferences command in the Desktop menu. 

 

The same command is included in the context menu, which you get by clicking with the right mouse 
button on the item sets pane outside the name of an item. 

 

The Desktop Preferences dialog box is displayed. 

 

The selection Item Update in Desktop preferences specifies, how to update the values shown in the 
item sets pane, when the item sets pane changes. The setting is actually a default value and can be 
overridden by the corresponding property in each item set. 

The causes of changes are various, but the most common is making a selection change in the browse 
tree pane while browsing parameters and signals. 
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You have to select one of the options: 

• The item values are fetched from the OPC Server cache. This option causes least 
communication traffic and is recommended, if you are doing fast monitoring, for example. 
However, the item values shown can be very old. 

• The item values are fetched from drives (default option). This option causes least surprises, 
because after changes in the item sets pane you always see fresh values. The update 
command is seldom needed in this case. Note that also values of locked items are updated. 

• The item values are put on-line. This option causes much communication traffic and we 
recommend that you use it sparingly. 

Desktop preferences also allow you to display and print item values (drive parameters) in the same 
format as the operator panel of the drive shows them. The selection also affects the unscaled values 
shown with the graph cursor in the trend display pane and printing of parameters of a drive or all 
drives. 

Unfortunately, the operator panel format is only available in new drives. However, the user can 
temporarily override the display format of selected items (see Changing Display Format of Item 
Values) or graph cursor values (see Changing Display Format of Graph Cursor Values). Each of the 
templates in a user defined item set can permanently specify to use a specific format, too. 

For item sets, the setting is actually a default value and can be overridden by the corresponding 
property in each item set that uses it. 

The selection Status Refresh concerns refreshing of the status of the drive displayed as images in the 
browse tree pane when status refreshing is on. The options are: 

• Only the status image of the selected drive is refreshed. Note that the same image is also 
shown in the status bar. Use this option if there is huge number of drives, in which case 
refreshing status of all of them could cause too heavy communication load. 

• Status images of all drives are refreshed. This is the option normally used. 

Note that the status image of the drive, control of which is taken, is always refreshed - both in the 
browse tree pane and in the drive panel toolbar - even when status refreshing is off. 

Note that although status refresh setting made in desktop preferences is preserved between 
DriveWindow sessions, it is also saved and restored with the workspace. However, the value restored 
from a workspace file is in effect only while the workspace is open. When you restart DriveWindow, the 
last status refresh setting that you made in desktop preferences is effective again. 

The selection Item Names allows you to specify, how the name of the item in the Name column of user 
defined item sets is displayed. The setting is a default value and can be overridden by the 
corresponding property in each user defined item set. 

• Fixed means that the Name properties of the templates are used. 
• Fetch from Drive means that the names of items are read from the drive. 

Reading the name of an item from the drive may not always be possible. If the name is not available, 
DriveWindow uses the OPC Address of the item as its name. 
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The selection Source Drive allows you to select, from which drive the items in the item sets are 
fetched. The setting is actually a default value and can be overridden by the corresponding property in 
each item set that uses it. 

• Fixed means that the item values are always fetched from the same drive. You have to 
specify the OPC Address of it by giving the channel (Ch) and node (Node) number of the 
drive. 

• In Ch you specify the channel number (0..9) part of the OPC Address. It is enabled (not 
grayed) only if the Source Drive is Fixed. 

• In Node you specify the node number (1..254) part of the OPC Address. It is enabled (not 
grayed) only if the Source Drive is Fixed. 

• Selected means that the item values are fetched from the drive selected in the browse tree 
pane, or relative to it (if you have Relative selected).  

• Controlled means that the item values are fetched from the drive, control of which has been 
taken, or relative to it (if you have Relative selected).  

• By selecting Relative you specify that the source drive is relative by Offset to the Fixed, 
Selected, or Controlled drive. 

• Offset specifies, how far the source drive is from the Fixed, Selected, or Controlled drive. It is 
disabled (grayed) if Relative is not selected or is disabled (grayed). 

Note that the source drive for the browsed items is fixed to Selected, so the browsed item set does not 
have this property in its Item Set Properties. Item sets of type all faults and all events do not have a 
specific source drive because they gather information about all drives that are connected. 

Very seldom you have a reason to select the Relative property. 

The value of the Offset property is numeric. If it is positive, the source drive is determined by counting 
drives downwards in the browse tree pane from the Fixed, Selected, or Controlled drive. Negative 
value means counting upwards. An open parameter file is not considered to be a drive when counting 
is done. 

If Offset is zero it is handled as if Relative was not selected. 

The selection N/A Items allows you to specify for user defined item sets, how to display items that are 
not available in the current source drive. The setting is a default value and can be overridden by the 
corresponding property in each user defined item set. 

• Hide means that not available items are not shown at all. 
• Show means that not available items are shown, but their values are shown as <Bad>. 
• Show as Template means that the template is shown if an item is not available. 

Note that the selection does not affect displaying of those items, which are available. 

See Also: What are Preferences 
Changing Item Set Properties 
Changing Template Properties 
Changing Display Format of Item Values 
Changing Display Format of Graph Cursor Values 
Viewing Status of Drives 
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Note! Controlling a drive may cause personal injury or physical damage. You should have physical 
access to the drive, and you must be sure that the drive and the electromechanical system are 
clear to control (you can see the system, for example). Controlling a drive remotely may require 
extra precautions and is discouraged. 

With DriveWindow you can control drives principally in two ways: 

• Browsing and using the raw control items. 
• Using the Drive menu and/or the drive panel toolbar. 

We recommend that you do not mix the ways, but use exclusively either. For example, if you take 
control using the Drive menu, context menu of drive, or drive panel toolbar, do not use the raw items to 
control the drive. 

To be able to control a drive by DriveWindow, the drive has to be configured such a way that it is 
possible. Also, the operator panel of the drive must not have the control taken, i.e., REM must have 
been selected instead of LOC. 

See Also: Drive Menu 
Drive Panel Toolbar 
Viewing Status of Drives 
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1. Controlling by Raw Control Items 
You can control any drive by browsing the Control sub-tree in the browse tree pane and writing the 
control items in the browsed item set, for example. 

 

When you are controlling a drive this way, DriveWindow acts blindly - it just does what you ask it to do. 
So, you must have intimate knowledge about the drive. 

Note that the actual values of Boolean write-only controls are usually not used. So, it does not matter, 
whether you write ON or OFF to the Control.Start. The mere writing starts the drive, if it is in proper 
status. 

All checking is done by the drive. If the drive rejects the control you wrote, you get an error message. 

 

It may also be that the drive accepts the control you wrote, but discards it silently. 

Most new drives have a watchdog associated with external control. If you are going to control such a 
drive with the raw control items, you should put Control.Local on-line, lock it to be sure it stays on-line, 
and write ON into it. The procedure described takes control of the drive and keeps on the “heartbeat”. 
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Note that because DriveOPC keeps the “heartbeat” on by internally writing to Control.Local, the ON 
value is usually shown with quality uncertain. 

To clear the fault logger of a drive, browse the Control sub-tree of Fault logger in the browse tree pane 
and write into the Clear item in the browsed item set. 

 

You need not to have taken control when clearing the fault logger. The value you write, does not 
matter. The mere writing clears the fault logger. 

See Also: Controlling Drives 
Browsing Parameters and Signals 
Changing Parameters 

 

2. Taking and Releasing Control 
Except clearing a fault logger, you need to have control taken of a drive, before you can control (i.e., 
send commands like start and stop) it. 

You can control one drive at a time when using the Drive menu and/or the drive panel toolbar. It means 
that you have to release currently taken control, if you want to control another drive. 

If you have no control taken, you are able to clear the fault logger of any drive. If you have taken control 
of a drive, DriveWindow allows you to clear the fault logger of the controlled drive only, so that there will 
be no misunderstanding about the fault logger cleared. 

For safety reasons, commands that may cause heavy communication traffic, are disabled while control 
is taken. Because of heavy communication traffic, the watchdog in the drive could go off thus causing a 
panel loss. 

In the Parameters submenu of the File menu the following commands are disabled (grayed) while 
control of a drive is taken: 

• Save As. 
• Selected in the Export submenu. 
• All Drives in the Export submenu. 
• Export in the context menu of drive variant. 
• Selected in the Print submenu. 
• All Drives in the Print submenu. 
• Print in the context menu of drive variant. 
• Compare, unless an open parameter file is selected. 
• Download. 
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In the System Software submenu of the File menu the following commands are disabled (grayed) while 
control of a drive is taken: 

• Backup. 
• Backup All. 
• Restore. 
• Download. 

See Also: Controlling Drives 
Take Control 
Commanding a Drive 
Release Control 

2.1 Take Control 

Note! Controlling a drive may cause personal injury or physical damage. You should have physical 
access to the drive, and you must be sure that the drive and the electromechanical system are 
clear to control (you can see the system, for example). Controlling a drive remotely may require 
extra precautions and is discouraged. 

For safety reasons, commands that may cause heavy communication traffic, are disabled while control 
is taken. Because of heavy communication traffic, the watchdog in the drive could go off thus causing a 
panel loss. 

If you are currently controlling another drive, you have to release it first. DriveWindow allows you to 
control just one drive at a time (unless you use the raw control items). 

To take control of a drive, select first the drive by clicking it in the browse tree pane. It is not necessary 
to select its root, however. Selection of any of its sub-branches will do. 

 

Then either, click the take/release control button in the drive panel toolbar, select the Take Control 
command in the Drive menu, or press Alt+F2. 

  

The Take Control command can also be found in the context menu, which you get by clicking with the 
right mouse button the drive (or a sub-branch within it) in the browse tree pane. 
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If control could be taken successfully, status image and name of the drive, field for entering the 
reference value, and command buttons are shown in the drive panel toolbar. 

 

The status image of the drive in the browse tree pane will be refreshed even if drive status refreshing is 
off. 

 

Also, control commands in the Drive menu are enabled, and the Take Control command has toggled to 
Release Control. 

 

If the drive under control does not have a command available, the corresponding button in the drive 
panel toolbar is hidden, and in the Drive menu it is disabled (grayed). 

AC and DC drives reuse some positions to show buttons for different commands, which do not exist in 
the other type of drive. The commands shown in the Drive menu are changed correspondingly. 

By default, the items in the control item set are shown and put on-line. 
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2.1.1 Losing control 

If the watchdog in the drive goes off for some reason, or there is a communication failure, your PC 
beeps and control is automatically released. The fault logger usually logs a PANEL LOSS fault in such 
a case. 

 

2.1.2 Disabled operations 

To minimize the probability of losing control, some operations, which may cause heavy communication 
load, are disabled, while control is taken. 

For example, the following operations are disabled: 

• Saving, comparing, exporting, printing, and downloading of drive parameters. 
• Uploading, restoring, and downloading system software. 

See Also: Controlling Drives 
Taking and Releasing Control 
Commanding a Drive 
Release Control 

2.2 Release Control 

When you do not need to control a drive any more, you should release the control. 

Before releasing control, we recommend, if possible, to set the reference value to zero and stop the 
drive. 

To release control of a drive, select first the drive by clicking it in the browse tree pane. It is not 
necessary to select its root, however. Selection of any of its sub-branches will do. 

 

Then either, click the take/release control button in the drive panel toolbar, select the Release Control 
command in the Drive menu, or press Alt+F2. 
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The Release Control command can also be found in the context menu, which you get by clicking with 
the right mouse button the drive (or a sub-branch within it) in the browse tree pane. 

 

If control could be released successfully, the drive panel toolbar is cleared. 

 

Also, control commands in the Drive menu are disabled (grayed), and the Release Control command 
has toggled to Take Control. 

 

By default, the items in the control item set are hidden and put off-line. 

 

2.2.1 Automatic release of control 

Control is automatically released when you: 

• Disconnect the OPC Server. 
• Restore a workspace. 
• Close DriveWindow. 
• Log off or shut down the Windows operating system. 
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Since DriveWindow version 2.11 you have to confirm the automatic releasing of control, e.g.: 

 

Note that if you cancel releasing of control when logging off or shutting down the Windows operating 
system, logging off or shutting down in cancelled, but there may be applications, which are not properly 
prepared for such a situation, and may become unstable up to the end of the session. 

See Also: Controlling Drives 
Taking and Releasing Control 
Take Control 

3. Clearing Fault Logger 
To be able to clear fault logger of a drive depends on, whether you have taken control of some drive or 
not: 

• If you have taken control of a drive, you can clear the fault logger of that drive only (unless 
using the raw control items). 

• If you have not taken control of any drive, you can clear fault logger of any selected drive. 

To clear the fault logger of a drive, select first the drive by clicking it in the browse tree pane. It is not 
necessary to select its root, however. Selection of any of its sub-branches will do. 

 

Then either, click the clear fault logger button in the drive panel toolbar, or select the Clear Faultlogger 
command in the Drive menu. 
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The Clear Faultlogger command can also be found in the context menu, which you get by clicking with 
the right mouse button the drive (or a sub-branch within it) in the browse tree pane. 

 

Note that a fault logger can also be cleared by using the raw control items. 

By default, the item set of faults shows the empty fault logger. 

 

However, if you were viewing the fault logger in the browsed item set, for example, and the items are 
off-line, no change happens in the item set, when the fault logger is cleared. 

 

If you were not viewing the fault logger in the browsed item set, but you have viewed it some time 
earlier, and the item set properties are set to use cache when there are changes in the item sets pane, 
all fault logger items are shown with quality uncertain after clearing the fault logger, if you select to view 
them. 

 

The quality is uncertain because the DriveOPC has cleared the items in its cache, but it is not known 
for certain that they are also cleared in the drive. 
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If the item set properties are set to use cache when there are changes in the item sets pane, the fault 
logger items stay uncertain, until you update them (or put them on-line). When you update them, the 
values currently in the drive are shown in the item set. 

 

See Also: Controlling Drives 
Taking and Releasing Control 
Viewing Parameters and Signals 

4. Commanding a Drive 
You must have taken control of a drive, before you can send commands to it. You can have control 
taken of one drive at a time only. 

Note that you can send commands to a drive by using the raw control items, too. However, we do not 
recommend mixing use of drive panel toolbar and/or the Drive menu (or shortcut keys) with the use of 
raw control items. 

After you are done with the drive, you should release control. 

You can send the following commands to a drive when you have control taken: 

• Release control. 
• Clear fault logger. 
• Set reference value (drive panel toolbar only). 
• Step. 
• Reset fault. 
• Start. 
• Stop. 
• Reverse (AC drives). 
• Forward (AC drives). 
• Coast stop. 
• Close contactor (DC drives). 
• Open contactor (DC drives). 

Note that step, although it behaves like a command, is actually created by DriveWindow. If step 
settings are such that no step can be given, the button in the drive panel toolbar is hidden and in the 
Drive menu it is disabled (grayed). 

If the drive under control does not have a command available, the corresponding button in the drive 
panel toolbar is hidden, and in the Drive menu it is disabled (grayed). 

AC and DC drives reuse some positions to show buttons for different commands, which do not exist in 
the other type of drive. The commands shown in the Drive menu (and meaning of the shortcut keys) 
are changed correspondingly. 
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Note that releasing control and clearing fault logger are enabled only, if the controlled drive (or some of 
its sub-branch) is selected in the browse tree pane, when you have control taken. 

4.1.1 Setting the reference 

The reference value cannot be set through the Drive menu. 

Note that the current reference value is shown below the reference value edit field always when control 
is taken. 

To set reference, enter the reference value into the reference value edit field in the drive panel toolbar, 
and either click the set reference button or press the Enter key. 

  

The reference value edit field is cleared when the value is sent to the drive and the current reference 
value is updated. 

 

While entering the value, you can use many the normal Windows shortcut and editing keys like the 
arrow keys, Home, End, etc. Keys, with or without Ctrl and/or Shift key down. Note that one of the not 
functional editing keys is Del. 

Note that DriveWindow does not check any limits of the value entered. Limit checking is done by the 
drive. It may be that the drive rejects the value, in which case you PC beeps. It may also be that the 
drive accepts the value, but silently limits it. 

If the value you entered is not numeric, DriveWindow beeps, and you may edit the value. 

 

Before releasing control, we recommend setting the reference to zero, if possible. 

4.1.2 Drive panel toolbar 

When you have control taken, you can give commands using the drive panel toolbar by just clicking the 
corresponding button on it, if the button is visible and enabled (not grayed). 
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Note that the take/release control and the clear fault logger buttons are functional even when control is 
not taken. However, when you have control taken, they are enabled only, if the controlled drive (or 
some of its sub-branch) is selected in the browse tree pane. 

4.1.3 Drive menu 

When you have control taken, you can give commands using the Drive menu by selecting the 
corresponding command in it, if the command is enabled (not grayed). 

  

For DC drives, Off opens the contactor and On closes the contactor. 

Note that the Take Control and the Clear Faultlogger commands are enabled even when control is not 
taken. However, when you have control taken, they are enabled only, if the controlled drive (or some of 
its sub-branch) is selected in the browse tree pane. 

The Take Control/Release Control and Clear Faultlogger commands can also be found in the context 
menu, which you get by clicking with the right mouse button the drive (or a sub-branch within it) in the 
browse tree pane. 
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4.1.4 Shortcut keys 

Some commands in the Drive menu can be given also using shortcut keys. You can use them when 
you control taken. 

The following commands have a shortcut key: 

• Release control: Alt+F2. 
• Reset fault: Alt+F8. 
• Start: Shift+F9. 
• Stop: Shift+F10. 
• Reverse (AC drives): Ctrl+F5. 
• Forward (AC drives): Ctrl+F6. 
• Coast stop: Ctrl+F4. 
• Close contactor (DC drives): Ctrl+F5 (On). 
• Open contactor (DC drives): Ctrl+F6 (Off). 

Note that when you have control taken, Alt+F2 releases control only, if the controlled drive (or some of 
its sub-branch) is selected in the browse tree pane. 

Note that when control is not taken, Alt+F2 takes control. 

Note! Shortcut keys other than F1 do not work while a menu is dropped-down. 

See Also: Controlling Drives 
Taking and Releasing Control 
How to Use Step Function 
Viewing Parameters and Signals 

5. How to Use Step Function 
When tuning a drive, you often need to make step changes into the reference to see, how the drive 
reacts. DriveWindow helps you in this by allowing you to make a step in the reference by a single 
command. 

You can define the step to be positive or negative. You can also define that the step is reset 
automatically after the time you specify. 

To be able to use the step function, you have to: 

• Define the step in Step Settings dialog box. 
• Have control of the drive taken. 
• Start a step by a command. 
• Optionally reset an active step. 

Note that an active step is automatically reset when control of the drive is released. An active step is 
also reset, if you change the reference value by using the drive panel toolbar, or define a new step with 
the Step Settings dialog. 

See Also: Commanding a Drive 
Step Settings 
Taking and Releasing Control 
Using Step 
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5.1 Step Settings 

Step settings consist of: 

• Direction (positive/negative) and size of the step. 
• Automatic or manual resetting. 
• Duration of the step in case it is automatically reset. 

Step settings can be changed even if you are not connected to an OPC Server. 

Step settings are preserved between DriveWindow sessions. They are also saved and restored with 
the workspace. However, values restored from a workspace file are in effect only while the workspace 
is open. When you restart DriveWindow, the last step settings that you made are effective again. 

To set step settings: 

 

A Step Settings dialog box is displayed: 

 

After you have specified your step, click the OK button. If a step is active at that time, it is reset 
immediately. If you want to cancel the operation, click the Cancel button. 

Note that if you selected manual reset, DriveWindow sets duration to zero, which is the internal mean 
to tell that manual reset is used. 
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If you set an illegal value into size or duration, a message box similar to the following is displayed. 

 

After you clicked OK, the illegal value is highlighted in the Step Settings dialog box and you have the 
opportunity to edit it. 

 

Note that setting step size to zero effectively means disabling the step function. In this case the Step 
Start command in the Drive menu is disabled (grayed) and the Start/End Step button in the drive panel 
toolbar is not shown at all. 

 

 

See Also: How to Use Step Function 
Using Step 
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5.2 Using Step 

When you have control taken of a drive and have made proper step settings, you can start a step and 
reset an active step. 

5.2.1 Start Step 

You start a step by Step Start command in the Drive menu or by clicking the Start/End Step button in 
the drive panel toolbar. 

 

 

5.2.2 Reset Step 

You reset an active step by Step Reset command in the Drive menu or by clicking the Start/End Step 
button in the drive panel toolbar. 
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Note that if you have selected the option to use an automatically reset step, the step is reset after the 
duration you have specified. 

Note also that an active step is automatically reset when control of the drive is released. An active step 
is also reset, if you change the reference value by using the drive panel toolbar, or define a new step 
with the Step Settings dialog. 

5.2.3 Step Status 

Whether a step is active or reset, can be seen by looking at the Drive menu. 

If the menu shows the Step Start command, step function is in reset state. 

 

If the menu shows a Step Reset command (Manual Reset configured) or a Step End command 
(Automatic Reset configured), step function is in active state. 

 or  

The shape of the Start/End button in the drive panel toolbar also includes information about the step 
function: 
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Image Means 

 
Positive, automatically reset step in reset state. Clicking the button 
starts the step. 

 
Negative, automatically reset step in reset state. Clicking the button 
starts the step. 

 
Positive step, which requires manual reset, in reset state. Clicking 
the button starts the step. 

 
Negative step, which requires manual reset, in reset state. Clicking 
the button starts the step. 

 
Positive, automatically reset step in active state. Clicking the button 
prematurely resets of the step. 

 
Negative, automatically reset step in active state. Clicking the 
button prematurely resets of the step. 

 
Positive step, which requires manual reset, in active state. Clicking 
the button resets the step. 

 
Negative step, which requires manual reset, in active state. 
Clicking the button resets the step. 

See Also: How to Use Step Function 
Step Settings 

6. Viewing Status of Drives 
You can browse the Status sub-branch of a drive to view its items in the browsed item set. To be sure 
that the values shown are up-to-date, you should update them, if they are not on-line. 

 

If you have selected refreshing of status of all drives in desktop preferences, you can see status of all 
drives at a glance in the browse tree pane by observing the images in front of the drives. 



Controlling Drives 

DriveWindow 2 5-19 

 

However, refreshing of the status images in the browse tree pane can also be off-line. You can toggle 
the status images on-line/off-line either by clicking the status refresh on/off button in the standard 
toolbar, or toggling Status Refresh in the File menu. 

  

Note that refreshing status of the drive, control of which has been taken, is always on-line. 

If you have in desktop preferences selected the option to refresh the status of the selected drive only, 
you can check status of a drive just by clicking it in the browse tree pane while status images are on-
line. It is not necessary to select its root, however. Selection of any of its sub-branches will do. 

Note that although status refresh setting made in desktop preferences is preserved between 
DriveWindow sessions, it is also saved and restored with the workspace. However, the value restored 
from a workspace file is in effect only while the workspace is open. When you restart DriveWindow, the 
last status refresh setting that you made in desktop preferences is effective again. 

The status image of the selected drive is displayed also in the status bar. 
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The image displayed in front of a drive shows the status of the drive as follows: 

Image Status 

 Fault and (Forward) Direction 

 Fault and not (Forward) Direction 

 Not Running and Warning and (Forward) Direction 

 Not Running and Warning and not (Forward) Direction 

 Not Running and (Forward) Direction 

 Not Running and not (Forward) Direction 

 Running and Warning and (Forward) Direction 

 Running and Warning and not (Forward) Direction 

 Running and (Forward) Direction 

 Running and not (Forward) Direction 

 Otherwise (status display is off-line or status cannot be read, for 
example) 

See Also: Browse Tree Pane 
Browsing Parameters and Signals  
Viewing Parameters and Signals 
Desktop Preferences 
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1. Monitor and Dataloggers 
DriveWindow can show and control two kinds of trends: 

• Monitor 
• Datalogger 

The lower two panes in DriveWindow window area are reserved for setting and displaying trends. 

The lower left pane, trend settings pane, is used to display and change settings. 

The lower right pane, trend display pane, is used to display the trends in graphical format. 

The panes are shared by the monitor and the dataloggers. The trend settings pane contains two tabs, 
which you use to select, whether to show, change, and control the monitor or the currently selected 
datalogger. 

 

When you have selected the monitor, datalogger settings and trends are hidden and its controls are 
disabled. 
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When you have selected the datalogger, monitor settings and trend are hidden and its controls are 
disabled. 

 

The datalogger panes are shared by all dataloggers. The current datalogger is selected by selecting 
the drive in the browse tree pane. If the drive has two dataloggers, the drive datalogger is selected 
either in the browse tree pane, from the Datalogger menu, or from the context menu of Datalogger 
Display. 

 or  or 

 

If the drive has more than two dataloggers, the drive datalogger is selected the similar way as in the 
case of two dataloggers. However, a menu shows Next Datalogger instead of Datalogger 2. Clicking of 
Next Datalogger moves the drive datalogger selection to the next datalogger. Note that the next 
datalogger of the last one is the first datalogger. 

 or  

Note that all datalogger settings and displays are datalogger specific. So, when you change a 
datalogger setting, for example, it concerns the currently selected datalogger only. Settings of all other 
dataloggers are preserved. 

You can verify the currently selected datalogger from the OPC address shown in the title in the 
datalogger display pane. If a drive more than one dataloggers, DL1, DL2, etc. in the title indicate, which 
of the loggers is shown. 
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In addition to viewing the trends, you can also print and export trends. 

1.1.1 Monitor 

Monitor runs and collects data in your PC. Collecting is done by reading cyclically the monitored items 
from the drives. The items can reside in different drives. 

The values are drawn in the monitor display pane in real time, when the monitor is running. 

If you pause the monitor, updating of the monitor display pane is ceased, but the values are still 
collected in the background. The values collected during pause are drawn, when you command the 
monitor to continue. 

Note! Windows is not a real-time operating system. It means that, in practice, even if the 
measurements are done cyclically, they are not done with equal time intervals. Load caused by 
drives in Windows kernel may cause interrupts in measurements, order of which are hundreds 
of milliseconds. 

The measured values are time stamped by DriveOPC. The graphical drawing package, however, is 
able to do the drawing only, if the measurement interval is assumed to be constant. Thus, the drawn 
points are actually estimated from measured values. How the estimation is done depends on the 
monitor visualization method selected in graph preferences. 

1.1.2 Dataloggers 

Dataloggers reside in drives. Data is collected by the drive. 

Collecting can be stopped by either a specific stop command or by a triggering condition becoming true 
in the drive. 

All other datalogger settings than those affecting the datalogger display (x-axis length, y minimum and 
maximum, scaling) are preserved in the drive. They are preserved in the drive even when it has no 
power. 

However, when a datalogger is uploaded, the current settings in DriveWindow are frozen, so the 
settings show the settings of the uploaded trend. 

It is not possible to view datalogger trends in real-time. 

1.1.3 Settings 

Before you start monitoring or a datalogger, you usually have to make changes to their settings, such 
as channels to monitor or log, measuring interval, etc. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

Some of the common settings, which affect the displaying of the trends, you can change also after 
starting. 

Most settings are entered by using a dialog box with one or more edit fields. When the dialog box is 
presented, the fields contain present values of the settings to be changed. One of them is selected, so 
that if you start typing, the displayed value is immediately overwritten. 

If the value can be negative, it can optionally be preceded by a plus sign. 

Real values can be given value as an integer, too. A real number can end with an optional exponent, 
which is preceded by E or e. The exponent can be signed. Note that the decimal symbol in real 
numbers is period regardless the regional settings. Examples: 1.2, -1.23E-3, 1e3. 
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While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button and pressing the Enter key is same as clicking the OK 
button. 

If a value is invalid, when you click the OK button, an error message is displayed. You have to 
acknowledge the error message and edit the invalid value or cancel the operation. 

Although the possibility of running out of (virtual) memory is greatest when you are setting size of the 
monitor history buffer or the monitoring interval, it is, in theory, possible while changing any of the 
settings. The setting you are changing is accepted, but the combination of settings cannot be used by 
DriveWindow. 

When you run out of memory, you get an error message: 

 

The trend display pane is cleared. You have to change some of the settings to get rid of the out-of-
memory condition. 

1.1.4 Controlling 

The monitor can be controlled by starting, pausing, continuing, stopping, and clearing it. 

A datalogger can be controlled by starting, stopping, triggering, clearing, and uploading it. The 
uploaded graph can be cleared, too. 

1.1.5 Graph Preferences 

You have several options to control the outlook of graphs. 

The drawing points can be connected in various ways. 

You can control, how scaling is shown and entered. 

Displaying of the graph cursor has some options. 

The method of estimating the drawing points from measured values in the monitor can be changed. 

Screen and color printer trend colors can be changed. Line style of trends can be changed, separately 
for the screen, black and white printer, and color printer. 

1.1.6 Viewing 

Viewing of the monitor and datalogger trends is quite similar. 

You can scroll horizontally and vertically. You can zoom inwards, outwards, and reset zooming. You 
can examine the trends using a graph cursor. 

You can temporarily change display format of selected graph cursor numerical values. 

You can also change settings like x-axis length, y minimum and maximum, and scaling (dataloggers 
only) while viewing a trend. 
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1.1.7 Saving and Restoring 

Since version 2.10 of DriveWindow, trends can be saved and restored. 

1.1.8 Printing and Exporting 

Both monitor and datalogger trends can be printed, copied to clipboard, and exported (in numerical text 
format). 

See Also: Window Area 
Browse Tree Pane 
Trend Settings Pane 
Trend Display Pane 

2. Common Trend Settings 
The monitor and the loggers have the following common settings, which affect the displaying of the 
corresponding trends: 

• X-axis length (in seconds) 
• Y-axis minimum and maximum 
• Y-axis adaptation, which is actually just another way to change y-axis minimum and maximum 
• Scaling of different channels 

With some exceptions, all of these can be changed at any time: 

• Y-axis can be adapted only when a trend is drawn in the trend display pane. 
• Scaling of different channels of a monitor channel cannot be changed while the monitor is 

running. 

Note! Changing of the scaling of a monitor channel requires that the monitor trends are redrawn from 
the beginning. If you have lot of monitored data, this can take a long time. 

The common settings are saved into and restored from a workspace. 

See Also: Monitor and Dataloggers 
Trend Settings Pane 
Monitor Menu  
Datalogger Menu 
Restoring Default Settings 

2.1 Setting X-Axis Length 

You can set x-axis length of the monitor or a datalogger at any time. 

Note that zooming usually also changes x-axis length. 

X-axis length of a datalogger can also change automatically when the datalogger is uploaded. If the x-
axis length is bigger than size of the datalogger channel buffer, if it is less than the interval, or if it is not 
multiple of the interval, x-axis length is automatically set to the size of the datalogger channel buffer. 

Note that if a datalogger has never been uploaded, DriveWindow does not know for sure the size of a 
datalogger channel buffer. Thus DriveWindow does not do any checking about the x-axis length, until it 
knows more about the datalogger. 

When size of the datalogger channel buffer is known, DriveWindow does not accept improper setting 
of x-axis length. However, when the datalogger interval is changed, x-axis length is not checked, and 
thus may have an improper value. In such cases, uploading of the datalogger automatically sets the x-
axis length. 
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Note that changing x-axis length affects only the current zooming level. Zooming outwards or zooming 
reset restores the previous or basic level x-axis setting. 

To change x-axis length, either double-click the X Axis Length (s) field in the trend settings pane, or 
select X Length command in the Axis submenu, which can be found in the Monitor, context menu of 
Monitor Settings, Datalogger menu, and context menu of Datalogger Settings. 

 or

  

An X Axis Length (s) dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (real) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

 

The new value is shown in the trend settings pane, and the x-axis in the trend display pane is updated, 
too. 

 

There are restrictions about the x-axis length: 

• The value must be greater than zero. 
• The value must be multiple of the interval. For example, if interval is 10 ms, x-axis length 

1.001 s is invalid. 
• X-axis length of the monitor must not be bigger than the history buffer. 
• X-axis length of the monitor cannot exceed 32700 * interval. 
• X-axis length of a datalogger must not be bigger than the size of the channel buffer in 

seconds. If the datalogger has never been uploaded, size of the buffer is not known, and x-
axis length is not compared with it. However, when the datalogger is uploaded, x-axis length 
is reduced automatically, if it is too big. 
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Some of the error messages ask, if you want DriveWindow to find a proper value for you. 

 

 

If you click the Yes button, the value in the dialog box is changed from the value you entered to a value 
suggested by DriveWindow. 

 

 

 

So, you still have the opportunity to edit the value (or cancel the operation). 
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If you have entered x-axis of the monitor, and it is bigger than the history buffer, you have the option to 
enlarge the history buffer size to be equal to the x-axis. 

 

If you click Yes, your x-axis value is accepted, but the history buffer is changed, too. 

See Also: Common Trend Settings 
Restoring Default Settings 
Monitor and Dataloggers 
Trend Settings Pane 
Axis Submenu 

2.2 Setting Y Minimum and Maximum 

You can set y-axis minimum and y-axis maximum of the monitor or a datalogger at any time. 

However, if you already have a trend shown in the trend display pane, you do not need to set y-axis 
minimum yourself. Instead you can adapt y-axis, which means that DriveWindow selects and sets 
proper minimum and maximum for you. 

Note that zooming usually also changes y-axis minimum and/or maximum. 

Y-axis minimum and/or maximum of a datalogger can also change automatically when the datalogger 
is uploaded. If any of the uploaded values after scaling is smaller than the setting of y minimum, or 
bigger than setting of y maximum, y minimum and/or maximum is adjusted to the smallest/biggest 
value uploaded. 

Note that changing y-axis minimum or maximum affects only the current zooming level. Zooming 
outwards or zooming reset restores the previous or basic level y-axis settings 
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Y-axis minimum and maximum can be changed by scrolling, too. However, to be able to scroll, you 
need to have an OPC Server connected. Scrolling is done by using the short vertical scrollbar at the 
lower left corner in the trend display pane. Scrolling adds or subtracts the distance between two tick 
marks to or from both y minimum and maximum. 

.  

Note that the effect of scrolling is not always reversible. When signs of y-axis minimum and maximum 
differ before scrolling, but are the same after scrolling, the number of tick marks, and also the distance 
between two of them, may change. 

To change y-axis maximum or minimum, either double-click the Y Axis Maximum or Y Axis Minimum 
field in the trend settings pane, or select Y-Axis Maximum or Y-Axis Minimum command in the Axis 
submenu, which can be found in the Monitor, context menu of Monitor Settings, Datalogger menu, and 
context menu of Datalogger Settings. 

 or 

 

A Y Axis Maximum or Y Axis Minimum dialog box is presented with the present value shown in its edit 
field. 
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Edit or enter a new (real) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

  

The new value is shown in the trend settings pane, and the y-axis maximum or y-axis minimum in the 
trend display pane is updated, too. 

 

There are restrictions about the y-axis minimum and y-axis maximum: 

• Y-axis maximum must be greater than minimum. 
• Absolute value of y-axis minimum and maximum must not exceed 

3.40282356779733642751e+038. 
• If y-axis minimum and maximum have same signs, their first 8 significant decimal digits must 

not be equal. 

If the value is invalid, an error message is displayed, when you click the OK button. You have to 
acknowledge the error message and edit the invalid value or cancel the operation. 

 

 

See Also: Common Trend Settings  
Restoring Default Settings 
Monitor and Dataloggers 
Trend Settings Pane 
Monitor Menu  
Axis Submenu 
Adapting Y Axis 
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2.3 Adapting Y Axis 

Note that if you have several measured channels that have values with vastly differing magnitudes, 
automatic scaling may show better results than adapting y-axis. 

If you already have a trend shown in the trend display pane, you can let DriveWindow to select and set 
proper y-axis minimum and maximum for you. 

 

Note that the settings concern only the current zooming level. 

To let DriveWindow to select and set y-axis minimum and maximum, either select the Adapt Y-Axis 
command in the Axis submenu, which can be found in the Monitor, context menu of Monitor Settings, 
Datalogger menu, and context menu of Datalogger Settings, or press Ctrl+Shift+Y. 

 

DriveWindow immediately selects and sets proper y-axis minimum and maximum for you. The y-axis 
maximum and minimum in the trend display pane are updated. 
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The new minimum and maximum are shown in the trend settings pane, too. 

 

If you have no trend shown in the trend display pane, the command is disabled (grayed). Pressing 
Ctrl+Shift+Y has no effect in this case. 

Otherwise, if DriveWindow, for some rare reason, is not able to do the selection, it beeps, and y-axis 
minimum and maximum are not changed. 

The selection is done so that all points within the time defined by current x-axis are visible. 

DriveWindow uses two selection methods: 

• The search method: Values for y-axis minimum and maximum are searched so that the 
numerical values at the tick marks of the y-axis are nicely rounded. This is the method used 
normally. 

• The quick method: Y-axis minimum and maximum are simply calculated from the minimum 
and maximum trend points within the time defined by current x-axis. Values at the tick marks 
of the y-axis are not nicely rounded. This method is used only by monitor trends while the 
monitor is running, the monitoring interval is less than or equal to 2500 ms, and x-axis length 
is less than or equal to 12.5 seconds. 

See Also: Common Trend Settings  
Automatic Scaling 
Monitor and Dataloggers 
Trend Settings Pane 
Axis Submenu 
Setting Y Minimum and Maximum 
 

2.4 Setting Scaling 

Scaling of monitor or datalogger channels makes is possible to draw values with largely different 
ranges into the trend display pane, so that they are all visible and still have good resolution. 

Instead of scaling manually, you have also the option to let DriveWindow to calculate proper scaling for 
you by automatic scaling. 

Depending on the scaling method selected in graph preferences, you have the option to display and 
enter scaling either as coefficient and offset or as values at y=100 and y=0. 

For example, if you want to analyze speed, which you assume to vary 1490...1510 rpm, and frequency 
varying 49..51 Hz with great accuracy. If you have y-axis minimum -100 and maximum 100, you can 
set (scaling method is coefficient and offset): 

• For speed, coefficient to 10 and offset to -15000. Then 1490 is shown -100 and 1510 is 
shown +100. 

• For frequency, coefficient to 100 and offset to -5000. Then 49 is shown -100 and 51 is shown 
+100. 

If scaling method is values at y=100 and y=0, you can set: 

• For speed, value at y=100 to 1510 and value at y=0 to 1500. Then 1490 is shown -100 and 
1510 is shown +100. 

• For frequency, value at y=100 to 51 and value at y=0 to 50. Then 49 is shown -100 and 51 is 
shown +100. 
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Note! Changing of the scaling of a monitor channel requires that the monitor trends are redrawn from 
the beginning. If you have lot of monitored data, this can take a long time. 

Note that scaling can be set before setting the variable to be monitored or logged. However, scaling of 
a non-existing channel of a datalogger cannot be set. If the Setting column of a channel in the 
datalogger settings pane contains n/a, the channel does not exist in the drive. 

To change scaling of a channel, either double-click the Setting field of the channel in the trend settings 
pane, or select the channel from the Scaling submenu, which can be found in the Monitor, context 
menu of Monitor Settings, Datalogger menu, and context menu of Datalogger Settings. 

 or 

  (or)  

OA Channel Scaling dialog box is presented with the present scaling values shown in its edit fields. 

 (or)  

Edit or enter a new (real) values into Coefficient and/or Offset fields and click OK. If you want to cancel 
the operation, click the Cancel button. 

 (or)  
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The new values are shown in the trend settings pane. If you changed scaling of a datalogger channel 
and the datalogger has been uploaded, the trends in the datalogger display pane are immediately 
redrawn with the new settings. 

 (or)  

There are restrictions about the Coefficient and the Offset: 

• Absolute value of Coefficient and Offset must not exceed 1.7976931348623158e+308. 

There are restrictions about the values at y=100 and y=0 as well: 

• Absolute value of them must not exceed 3.4028235677973364e+038. 
• Absolute value of their difference must not exceed 3.4028235677973364e+036. 
• Absolute value of their difference must not be less than 2.93873596534e-037. 

If the value is invalid, an error message is displayed, when you click the OK button. You have to 
acknowledge the error message and edit the invalid value or cancel the operation. 

 

 

See Also: Common Trend Settings 
Automatic Scaling 
Restoring Default Settings 
Monitor and Dataloggers 
Trend Settings Pane 
Scaling Submenu 

2.5 Automatic Scaling 

Instead of scaling of monitor or datalogger channels manually, you can ask DriveWindow to calculate 
proper scaling for you. 

If you have only one measured channel or all the measured channels have values about the same 
magnitude, adapting of y-axis may show better results than automatic scaling. 
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When using automatic scaling, y-axis minimum and maximum usually should have their default values 
(-100 and +100) or values 0 and +100, before automatic scaling is applied. The defaults can be 
restored by a single menu command. 

The calculations are based on only the values within currently shown x-axis. Values not within currently 
shown x-axis are not considered. Note that it is not possible to autoscale channels, which are not 
measured. 

You can autoscale all channels or select the individual channels to be autoscaled. 

Note! Changing of the scaling of a monitor channel requires that the monitor trends are redrawn from 
the beginning. If you have lot of monitored data, this can take a long time. 

Note! Automatic scaling inverts Boolean values so that  true (-1) is shown upper than false (0). 

The Autoscale command in the Scaling submenu in the Monitor menu and in the context menu of 
Monitor Settings is disabled (grayed) if monitor is not selected in the trend settings pane, monitor is 
cleared or running, or you have selected a not measured channel in the trend settings pane. 

The Autoscale command in the Scaling submenu in the Datalogger menu and in the context menu of 
Datalogger Settings is disabled (grayed) if datalogger is not selected in the trend settings pane, 
datalogger is not uploaded, or you have selected a not measured channel in the trend settings pane. 

If DriveWindow, for some rare reason, is not able to calculate proper scaling, it beeps, and no changes 
in scaling is done. 

Note that datalogger trends saved with DriveWindow version 2.11 or older cannot be autoscaled when 
restored. 

2.5.1 Automatic Scaling of All Channels 

To autoscale all channels, first check that there are no channels selected in the trend settings pane. 
Then either select the Autoscale command in the Scaling submenu, which can be found in the Monitor, 
context menu of Monitor Settings, Datalogger menu, and context menu of Datalogger Settings, or 
press Ctrl+Shift+S. 
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2.5.2 Automatic Scaling of Selected Channels 

To autoscale just some of the channels, first select channels to be autoscaled in the trend settings 
pane. Then either select the Autoscale command in the Scaling submenu, which can be found in the 
Monitor, context menu of Monitor Settings, Datalogger menu, and context menu of Datalogger 
Settings, or press Ctrl+Shift+S. 

 

 

See Also: Common Trend Settings 
Setting Scaling 
Adapting Y Axis 
Restoring Default Settings 
Monitor and Dataloggers 
Trend Settings Pane 
Scaling Submenu 

2.6 Restoring Default Settings 

It is possible to restore default settings of the monitor or a datalogger by a single command. 

Note that the settings restored depend on the current monitoring or datalogger upload status. The 
measured channels or datalogger settings residing in the drive are never changed. 

To restore default settings, select the Restore Defaults command in the Scaling submenu, which can 
be found in the Monitor, context menu of Monitor Settings, Datalogger menu, and context menu of 
Datalogger Settings. 

 

2.6.1 Restored Monitor Settings 

The Restore Defaults command in the Monitor menu and in the context menu of Monitor Settings is 
disabled (grayed) if monitor is not selected in the trend settings pane or monitor is running. 
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If monitor is cleared, the following settings are restored to their default values: 

• X-axis length 
• Y-axis minimum and maximum 
• Scaling 
• Monitoring mode 
• Monitoring interval 
• History buffer size 
• Zooming is reset 

If monitor is stopped or paused, the following settings are restored to their default values: 

• Y-axis minimum and maximum 
• Scaling 
• Zooming is reset 

Note! Changing of the scaling of a monitor channel requires that the monitor trends are redrawn from 
the beginning. If you have lot of monitored data, this can take a long time. 

If monitor is running, only the following settings are restored to their default values: 

• Y-axis minimum and maximum 

2.6.2 Restored Datalogger Settings 

The Restore Defaults command in the Datalogger menu and in the context menu of Datalogger 
Settings is disabled (grayed) if datalogger is not selected in the trend settings pane, there is no drive, 
or the drive selected in the browse tree pane has no datalogger. 

If the datalogger graph is cleared, the following settings are restored to their default values: 

• X-axis length 
• Y-axis minimum and maximum 
• Scaling 
• Zooming is reset 

If the datalogger has been uploaded (and is not empty), the following settings are restored to their 
default values: 

• Y-axis minimum and maximum 
• Scaling 
• Zooming is reset 

See Also: Common Trend Settings 
Monitor and Dataloggers 
Trend Settings Pane 
Monitor Menu 
Context menu of Monitor Settings 
Datalogger Menu 
Context menu of Datalogger Settings 
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3. Setting Monitor 
Before you can do any monitor settings, you need to have the monitor selected instead of the 
dataloggers. You do the selection by clicking the Monitor tab in the trend settings pane. 

 

In addition to the common settings (x-axis length, y-axis minimum and maximum, adaptation of y-axis, 
scaling of channels) for monitor and dataloggers, the monitor has the following settings: 

• Mode (fast or normal) 
• Interval in milliseconds 
• History buffer size in seconds 

• Variables to be monitored 

None of these settings can be changed unless the monitor is cleared. 

The common settings can be changed any time. 

Note! Changing of the scaling of a monitor channel requires that the monitor trends are redrawn from 
the beginning. If you have lot of monitored data, this can take a long time. 

All monitor settings are saved into and restored from a workspace. Note, however, that the restored 
items must exist at restore time. If not, they cannot be restored, and the corresponding channels are 
left empty. 

See Also: Monitor and Dataloggers 
Trend Settings Pane 
Monitor Settings 
Monitor Menu 
Context Menu of Monitor Settings 

3.1 Setting Monitoring Mode 

You can change the monitoring mode only when the monitor is cleared. 

There are two modes of monitoring: 

• Normal mode 
• Fast Mode 

In normal mode you are able, in principle, to monitor any kind of item. The minimum interval in this 
mode is 10 ms. Normal mode is the mode you will almost always use. 

In fast mode you can monitor only drive parameters and signals of type real or integer. The minimum 
interval in this mode is 1 ms. You should avoid using this mode, because it may hang-up you PC 
and/or cause panel losses in drives. 

Note! Windows is not a real-time operating system. It means that, in practice, even if the 
measurements are done cyclically, they are not done with equal time intervals. Load caused by 
drives in Windows kernel may cause interrupts in measurements, order of which is hundreds of 
milliseconds. These interrupts can hide the phenomena you are trying to monitor, especially 
when your monitoring interval is small. 

Note that if you have set the monitoring interval to less than 10 ms, you cannot change mode from fast 
to normal. You have to first set interval greater or equal to 10 ms, and then you can change the mode 
to normal. 
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To change monitoring mode: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• Either double-click the Mode field in the monitor settings pane, or toggle Fast Mode in the 

Monitor menu or in the context menu of Monitor Settings. 

 

 or  

The new value of the mode is shown in the monitor settings pane. If the mode is fast, it is also marked 
in the Monitor menu. 

 

If it is not possible to change the mode (monitor is not cleared, or interval is less the 10 ms in fast 
mode), your PC beeps, when you double-click the Mode field. Fast Mode in the Monitor menu is 
disabled (grayed), too. 

See Also: Common Trend Settings 
Restoring Default Settings 
Setting Monitor 
Monitor and Dataloggers 
Monitor Settings 
Monitor Menu 
Context Menu of Monitor Settings 

3.2 Setting Monitoring Interval 

Monitoring interval is actually the x-axis drawing resolution. It is also used as a cycle time of 
measurements, if possible. 

If a measurement cycle takes longer than the monitoring interval, some measurements are 
unavoidably dropped. This can happen, when kernel level device drivers are using the processor, for 
example. Because the measurements are time stamped, the x-axis in the monitor display pane still 
shows real time, however. The drawn values are estimated from measured values. How the estimation 
is done depends on the monitor visualization method selected in graph preferences. 

You can change the monitoring interval only when the monitor is cleared. 

Note that x-axis length and the history buffer size (in milliseconds) must be multiple of the interval. 
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To change the monitoring interval: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• Either double-click the Interval (ms) field in the monitor settings pane, or select the Interval 

command in the Monitor menu or in the context menu of Monitor Settings. 

 

 or  

An Interval (ms) dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (integer) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

 

The new value is shown in the monitor settings pane. 

 

There are restrictions about the interval: 

• The value must be an integer greater than zero. 
• The value cannot be bigger than the current x-axis length in milliseconds. 
• If monitoring mode is normal, the value must be at least 10. 
• The value must not be too small related to x-axis length, i.e., x-axis length in milliseconds 

divided by the value must not exceed 32700. 
• X-axis length in milliseconds must be multiple of the value. For example, if x-axis length is 1 

second, interval 3 ms is not acceptable. You must then either fix the x-axis length or use 
another interval. 
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If the value is invalid, an error message is displayed, when you click the OK button. You have to 
acknowledge the error message and edit the invalid value or cancel the operation. 

 

 

If the monitoring mode is normal and you have entered a value less than 10, an error message is 
displayed, when you click the OK button. You have to acknowledge the error message change the 
value to at least 10 or cancel the operation. 
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If you have entered value that is not acceptable because of the current x-axis length and/or history 
buffer size, you have the option to fix the x-axis length and/or the history buffer size. 

 

 

If you click Yes, your interval is accepted, but the x-axis length and/or history buffer size is changed, 
too. 

See Also: Common Trend Settings 
Restoring Default Settings 
Setting Monitor  
Monitor and Dataloggers 
Monitor Settings 
Monitor Menu 
Context Menu of Monitor Settings 

3.3 Setting History Buffer Size 

The monitor collects data into a history buffer. History buffer makes it possible to have more data 
collected than fits on the screen. The data in the history buffer can be scrolled in the monitor display 
pane when the monitor is paused or stopped. 

 

When the history buffer fills, the oldest data is disregarded. 

You can change the history buffer size only when the monitor is cleared. 

Note that the history buffer size must be multiple of the interval. 
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To change the history buffer size: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• Either double-click the History Buffer (s) field in the monitor settings pane, or select the 

History Buffer command in the Monitor menu or in the context menu of Monitor Settings. 

 

 or  

A History Buffer (s) dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (real) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

 

The new value is shown in the monitor settings pane. 

 

There are restrictions about the history buffer: 

• The value in milliseconds must be at least as big as the interval. 
• The value must not exceed 2147483647 ms (almost 25 days). 
• The value cannot be less than the current x-axis length. 
• The value must be multiple of the interval. For example, if interval is 3 ms, history buffer size 

10 s is invalid. 
• If the history buffer size is big and the interval is small, you may run out of virtual memory. 
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If the value is invalid, an error message is displayed, when you click the OK button. You have to 
acknowledge the error message and edit the invalid value or cancel the operation. 

 

 

Some of the error messages ask, if you want DriveWindow to find a proper value for you. 
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If you click the Yes button, the value in the dialog box is changed from the value you entered to a value 
suggested by DriveWindow. 

 

 

 

So, you still have the opportunity to edit the value (or cancel the operation). 

If you have entered a value, which is less than the x-axis length, you have the option to reduce the x-
axis length to be equal to the history buffer size. 

 

If you click Yes, your history buffer size is accepted, but the x-axis length is changed, too. 

See Also: Common Trend Settings 
Restoring Default Settings 
Setting Monitor  
Monitor and Dataloggers 
Monitor Settings 
Monitor Menu 
Context Menu of Monitor Settings 
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3.4 Setting and Removing Monitored Variables 

You can set, add, and remove variables to be monitored only when the monitor is cleared. Also 
changing the drive of monitored variables requires the monitor to be cleared. 

In principle, you can monitor any item as long as it is not read-protected, if you use the normal mode. 
Fast mode is more restrictive. 

The monitored variables can reside in different drives. 

However, all monitored values are converted into real by DriveOPC. It means that it is not meaningful 
to monitor string type of values, because in general, they cannot be converted to a real number. 

If you are monitoring other types of variables than real or integer: 

• Enumerated values are collected as integers or Booleans. They are not converted to 
enumeration strings when monitored. 

• Boolean value false is converted to 0 and true to -1. 
• Vector or array types of variables cannot be monitored. 

There are several ways to add and remove variables to be monitored. 

3.4.1 Adding and removing items selected in the item sets pane 

Typically you add and remove monitored items by using the browsed item set. Adding can be done 
also from all parameters and user defined item sets. 

To use an item set in adding items not yet monitored and removing items now monitored in the 
browsed item set, you need to have the items shown in the item set, and then: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• Select items, which you want to add to or remove from the monitor, in the browsed item set, 

or select items, which you want to add to the monitor in an all parameters or user defined item 
set. 

• While focus in the item set, either click the add monitored items button in the monitor toolbar, 
or select the Add/Remove Items command in the Monitor menu. 

 

 or  
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If you are viewing the browsed item set, the numeric images showing the channel number in front of 
the now monitored items disappear, and such an image appears in front of the items, which were 
added into the monitor. 

 

If you are viewing an item set of type all parameters or user defined, there is no change in the item set. 
However, the items added to the monitor are also added to the browsed item set with numeric images 
showing the channel number in front of them. 

The descriptive names of the removed items disappear from the channels in the monitor settings pane, 
and such names of the added items appear in the settings. The descriptive name is the one shown in 
the item sets pane, which is not necessarily the same as in the drive. 

 

Note that the removal is done first, then the addition. The first free channel is used in addition. If there 
are more variables to add than there are free channels left after removal, the extra items are not 
added. 

The monitored items are internally locked in the browsed item set until they are removed from the 
monitor. Removing an item from the monitor does not remove the item from the browsed item set, it 
just unlocks the internal lock. If the item is not also locked by the user, it disappears from the browsed 
item set, when there is a selection change in the browse tree pane. 

3.4.2 Adding items from the clipboard 

If you have copied items to the clipboard, you can paste them into free monitor channels. 

To paste items from the clipboard into free monitor channels: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• While focus is in the monitor settings pane, click the paste button in the standard toolbar, 

select the Paste command in the Edit menu or in the context menu of Monitor Settings, or 
press the Ctrl+V key. 

 



Trends 

6-30 DriveWindow 2 

 or  

The items pasted to the monitor are also added to the browsed item set with numeric images showing 
the channel number in front of them. 

 

The descriptive names of the pasted items appear in the settings. The descriptive name is the one of 
the item copied to the clipboard, which is not necessarily the same as in the drive. 

 

The first free channel is used in pasting. If there are more variables to paste than there are free 
channels, the extra items are not added. Note that the Paste command is disabled (grayed) if there is 
no free channel. 

The monitored items are internally locked in the browsed item set until they are removed from the 
monitor. 

3.4.3 Adding items by using drag and drop 

You can also use drag and drop in adding items into free monitor channels. The drag source can even 
be an external drag enabled application, which has the items available in the form, which DriveWindow 
uses in copying items into the clipboard. 

To drag and drop items from a drag source (such as browsed item set) into free monitor channels: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
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• Select items, which you want to add, in the browsed item set, for example. 

 

• Press the left mouse button down on a selected item and keep the button down. 
• Move the cursor into the monitor settings pane. 
• If you want to copy by dragging, check that there is a plus sign visible in the cursor before 

releasing the mouse button.  

 
• If you want to move by dragging, hold the Shift key down and check that there is no plus sign 

visible in the cursor when releasing the mouse button. 

 
The items dropped to the monitor are also added to the browsed item set with numeric images 
showing the channel number in front of them. 

 

The descriptive names of the dropped items appear in the settings. The descriptive name is the one of 
the item dragged, which is not necessarily the same as in the drive. 

 



Trends 

6-32 DriveWindow 2 

The first free channel is used in dropping. If there are more variables to drop than there are free 
channels, the extra items are not added. If there is no free channel, the cursor turns into a forbidden 
sign in the monitor settings pane while dragging. 

 

The monitored items are internally locked in the browsed item set until they are removed from the 
monitor. 

3.4.4 Removing items selected in the monitor settings pane 

If you want to, you can remove items from the monitor also by using the monitor settings pane. 

To remove items currently in monitor: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• Select channels, which you want to remove from the monitor, in the monitor settings pane. 

Use Ctrl and Shift keys, if needed, in selection. 
• While focus is in the monitor settings pane, click the delete or cut items button in the standard 

toolbar, select the Delete or Cut command in the Edit menu or in the context menu of Monitor 
Settings, or press the Del or Ctrl+X key. 

  

 or  

Note that you can also remove the selected channels by moving them with drag and drop. The 
operation is similar to moving items by drag and drop in item sets.  

The numeric images showing the channel numbers in front of the removed monitored items disappear. 
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Also, the descriptive names of the removed items disappear from the channels in the monitor settings 
pane. 

 

The side effect of using the Cut command, cut items button, or the Ctrl+X key is that the items are 
copied to the clipboard before they are removed. Cutting is similar to cutting items from an item set, 
except the value fields of the items in the clipboard are empty. 

Removing an item from the monitor does not remove the item from the browsed item set. It just 
unlocks the internal lock. If the item is not also locked by the user, it disappears from the browsed item 
set, when there is a selection change in the browse tree pane. 

3.4.5 Setting and removing the variable of a channel 

It is possible to set an item simultaneously to the browsed item set and into a monitor channel. The 
same feature can be used also to change the monitored variable and remove it. 

You probably seldom use this feature. 

Note that you have to be viewing an item set of type browsed, all parameters, or user in the item sets 
pane. Otherwise the commands described here are disabled (grayed). 

If you are setting an empty channel, you can use an item as a base in setting. To do so, select a single 
item in the item set. 

 

Anyway, if not yet selected, select the Monitor tab in the trend settings pane, and select the channel 
you want to set from the Set Variable submenu in the Monitor menu or context menu of Monitor 
Settings. 
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An Add Item to Monitor and Desktop dialog box is presented. If you are setting an empty channel and 
had an item selected to be used as a base, both edit fields already have values, which you can edit. 

 

If you are setting an empty channel, but you have no item selected to be used as a base (or had 
multiple selections), the fields are filled with the values last accepted by adding an item into an item 
set. In case the last accepted values were empty (request for removing an item), you have to fill the 
edit fields yourself. 

 

If the channel you are setting is not empty, the current settings are in the edit fields. 
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Anyway, after you have a descriptive name (of your own) in the Name edit field, and a proper OPC 
address in the other edit field, you can click the OK button (or Cancel, if you want to cancel the 
operation). Note that the descriptive name that you give, needs not to be unique. 

 

If the OPC address you gave is correct and the item exists, it is added into the browsed item set and to 
the monitor channel, which you are setting. Note that it is internally locked, because it is monitored, but 
not on-line, even if the base used had been on-line. The descriptive name of the item is also shown in 
the channel field of the monitor settings. The previous item, if there was one, is removed. 

 

 

Note that the removed item still stays unlocked (unless you have locked it also yourself) in the browsed 
item set. 

If the OPC address is wrong or the item does not exist, your PC beeps when you click OK, and the Add 
Item to Monitor and Desktop dialog box stays. 
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However, if you clear both edit fields, it is not an error, but any monitored variable already in the 
channel you are setting is removed from the monitor (but stays unlocked in the browsed item set). 

 

  

Note that the removed item still stays unlocked (unless you have locked it also yourself) in the item set. 

3.4.6 Changing the drive of monitored variables 

Note that to be able to change the drive of monitored variables you need to have the monitor cleared. 

 or  

Changing the drive is done by using the browse tree pane and, if not all channels are to be changed, 
also the browsed item set. 

To change the drive: 

• If not yet selected, select the Monitor tab in the trend settings pane. 
• In the browsed item set, select the monitored items, drive of which you want to change. If you 

want change the drive of all monitored items, you can also leave them all unselected. Note 
that if you are viewing some other item set than the browsed item set in the item sets pane, 
drive of all monitored items are always changed, even if there is a selection made in the 
hidden browsed item set. 

• In the browse tree pane, select the new drive by clicking it. It is not necessary to select its 
root, however. Selection of any of its sub-branches will do. 

• Finally, select the Change Drive command in the Monitor menu or in the context menu of 
Monitor Settings. 
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The drive of the selected channels (or all channels, if nothing was selected) change. 

 

Note that even if you use the context menu of the Monitor Setting, the operation uses the selections 
made in the browsed item set, not in the Monitor Settings. 

Note that the descriptive names of the items may also change because they are either fetched from 
the drive or, if not available, artificially re-constructed. 

Note also that your selection can contain items, which already reside in the new drive. They remain as 
if they were unselected. If all selected items reside in the new drive, the Change Drive command in the 
menus is disabled (grayed). 

If the new drive does not contain some of the items to be changed, no changes are made. 
DriveWindow just beeps in such a case. 

The on-line and locking states of the changed items do not change. 

See Also: Common Trend Settings 
Setting Monitor 
Monitor and Dataloggers 
Monitor Settings 
Monitor Menu 
Context Menu of Monitor Settings 
Adding Items to an Item Set 
Edit Menu 
Browse Tree Pane 

4. Setting Datalogger 
Before you can do any datalogger settings, you need to have dataloggers selected instead of the 
monitor. Also, you have to select the datalogger, settings of which you want to change or view. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 
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In addition to the common settings (x-axis length, y-axis minimum and maximum, adaptation of y-axis, 
scaling of channels) for monitor and dataloggers, a datalogger has the following settings: 

• Datalogger status display on-line/off-line 
• Interval 
• Pre-triggering time in milliseconds 

• Triggering conditions 

• Triggering variable 

• Triggering level 

• Triggering hysteresis 

• Variables to be logged 

Note that only the datalogger status display on-line/off-line can be changed at any time. None of the 
others can be changed unless the datalogger graph is cleared, and the datalogger in the drive is not 
running. 

The common settings can be changed any time. 

Except the common settings and the datalogger status refresh, all settings are actually kept in the 
drive. They are also items, which can be browsed, viewed and changed as any other items. However, if 
you are going to use the upper level datalogger handling functionality in DriveWindow, you should not 
use the raw items. 

4.1.1 Selecting dataloggers instead of the monitor 

You select dataloggers instead of the monitor by clicking the Datalogger tab in the trend settings pane. 

 

4.1.2 Selecting the datalogger 

If the drive has only one datalogger, it is enough just to select the drive in the browse tree pane. 

 

Note that to select a drive, it is not necessary to select its root, selection of any of its sub-branches will 
do. 

If the drive has two dataloggers, the current drive datalogger has to be selected, too. Selection can be 
done either using the browse tree pane or by toggling the Datalogger 2 toggle in the Datalogger menu 
or in the context menu of Datalogger Display after the drive has been selected from the browse tree 
pane. 

 or  or 
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If the drive has more than two dataloggers, the drive datalogger is selected the similar way as in the 
case of two dataloggers. However, a menu shows Next Datalogger instead of Datalogger 2. Clicking of 
Next Datalogger moves the drive datalogger selection to the next datalogger. Note that the next 
datalogger of the last one is the first datalogger. 

 or  

You can verify the currently selected datalogger from the OPC address shown in the title in the 
datalogger display pane. If a drive more than one dataloggers, DL1, DL2, etc. in the title indicate, which 
of the loggers is selected. 

 

Note that to select the datalogger within a drive using the browse tree pane, it is not necessary to 
select the Datalogger n sub-branch, selection of any of its sub-branches will do. While selection is 
made using the browse tree pane, it is not possible to select the datalogger from the Datalogger menu 
or from the context menu of Datalogger Display 

See Also: Monitor and Dataloggers 
Browse Tree Pane 
Trend Settings Pane 
Datalogger Settings  
Datalogger Menu  
Context Menu of Datalogger Display 

4.2 Setting Datalogger Status Refresh 

Datalogger status is displayed in the datalogger settings pane. The status consists of two fields: 

• Status 
• Triggered by 

You can change the status refresh of a datalogger any time. This setting is not in the drive datalogger 
but in DriveWindow. It is also saved into and restored from a workspace. 

When the datalogger graph is cleared, both of the fields are put on-line/ off-line. 

When you have uploaded the datalogger, the Triggered by field is frozen to show the condition at 
uploading time. It stays off-line until you clear the graph. 

The Status field can be put on-line even if the datalogger has been uploaded. If you change status off-
line in this case, the display returns to show the status as it was at upload time. 

Note that controlling the datalogger may automatically change the on-line/off-line status, too. 

Before changing the on-line/off-line datalogger status display, you need to have dataloggers selected 
instead of the monitor, and also the datalogger selected. 
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To change the on-line/off-line datalogger status display, either double-click the Status or Triggered by 
field in the datalogger settings pane, or toggle Status Refresh in the Datalogger menu or in the context 
menu of Datalogger Settings. 

 

 or  

Note that if the datalogger graph is not cleared, you cannot change the status by clicking the Triggered 
by field (your PC beeps). 

The on-line status is shown with yellow background of the values in Status and Triggered by fields. If 
the datalogger graph is not cleared, only the Status field can be on-line. 

 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings  
Datalogger Menu 
Context Menu of Datalogger Settings 

4.3 Setting Datalogger Interval 

Datalogger interval is the measurement interval used by the drive datalogger. The setting is kept in the 
drive, not in DriveWindow. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

The interval cannot be changed unless the datalogger graph is cleared, and the datalogger in the drive 
is not running. 

Unit of the interval varies depending on the drive. The unit is usually millisecond, but there are drives, 
in which the unit is 0.1 ms. The proper unit is shown in the datalogger settings pane. 

Before a changing datalogger interval, you need to have dataloggers selected instead of the monitor, 
and also the datalogger selected. 

To change the datalogger interval, either double-click the Interval field in the datalogger settings pane, 
or select the Interval command in the Datalogger menu or in the context menu of Datalogger Settings. 

 or  
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An Interval dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (integer) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

 

The new value is written to the drive and, if the drive accepts it, is shown in the datalogger settings 
pane. 

 

In addition to possible restrictions set by the drive, DriveWindow enforces some restrictions about the 
interval: 

• The value must be an integer greater than zero. 
• The pre-trigger time, when converted to the same unit as the interval, must be multiple of the 

value. For example, if the pre-trigger time is 1 second, interval 3 ms is not acceptable. You 
must then either fix the pre-trigger time or use another interval. 

Note that x-axis length (in interval unit) must not be less than the interval and must be multiple of the 
interval. When setting the interval, x-axis length is not checked, and may have an improper value as 
result of changing the interval. 

However, when the datalogger is uploaded, x-axis length is changed automatically, if the x-axis length 
is bigger than size of the datalogger channel buffer, if it is less than the interval, or if it is not multiple of 
the interval. In these cases, x-axis length is set to the size of the datalogger channel buffer. 
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If the interval value you entered is invalid, an error message is displayed, when you click the OK 
button. You have to acknowledge the error message and edit the invalid value or cancel the operation. 

 

 

If you have entered a value, which causes the pre-trigger time (in interval unit) not to be multiple of the 
value, you have the option to allow DriveWindow to find and set the nearest proper value for the pre-
trigger time. 

 

If you click Yes, your interval is accepted, but the pre-trigger time is changed, too. 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings 
Datalogger Menu  
Context Menu of Datalogger Settings 

4.4 Setting Pre-Trigger Time 

Datalogger pre-trigger time is actually saved as number of measurements in the drive. It tells the drive 
datalogger, how many measurements are to be kept in the datalogger channel buffers before the 
triggering moment. The setting is kept in the drive, and DriveWindow converts it to time by multiplying 
the count by the interval. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 
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The pre-trigger time cannot be changed unless the datalogger graph is cleared, and the datalogger in 
the drive is not running. 

Unit of the pre-trigger time is always milliseconds, even if the interval unit may vary depending on the 
drive. 

Before changing a datalogger pre-trigger time, you need to have dataloggers selected instead of the 
monitor, and also the datalogger selected. 

To change the datalogger pre-trigger time, either double-click the Pre-Trig (ms) field in the datalogger 
settings pane, or select the Pre-Trig (ms) command in the Trig Settings submenu of the Datalogger 
menu or context menu of Datalogger Settings. 

 or  

A Pre-Trig (ms) dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (real) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

 

The new value is written to the drive and, if the drive accepts it, is shown in the datalogger settings 
pane. 

 

In addition to possible restrictions set by the drive, DriveWindow enforces some restrictions about the 
interval: 

• The value, when converted to the interval unit, must no exceed 2147483647. 
• The value when converted to the interval unit, must be multiple of the interval. For example, if 

the interval is 3 ms, the pre-trigger time 1 second is not acceptable. You must then either fix 
the interval or use another pre-trigger time. 
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If the pre-trigger time value you entered is invalid, an error message is displayed, when you click the 
OK button. You have to acknowledge the error message and edit the invalid value or cancel the 
operation. 

 

 

Some of the error messages ask, if you want DriveWindow to find a proper value for you. 
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If you click the Yes button, the value in the dialog box is changed from the value you entered to a value 
suggested by DriveWindow. 

 

 

 

So, you still have the opportunity to edit the value (or cancel the operation). 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings 
Datalogger Menu  
Context Menu of Datalogger Settings 

4.5 Setting Trigger Conditions 

Trigger conditions tell the drive datalogger, when to trigger the datalogger. The setting is kept in the 
drive, not in DriveWindow. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

The trigger conditions cannot be changed unless the datalogger graph is cleared, and the datalogger in 
the drive is not running. 

Not all drives support all the trigger conditions. Trigger conditions not supported by a drive are disabled 
(grayed). 

Note the although many drives advertise support for enabling/disabling user triggering, they actually 
never disable it. 
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Before changing trigger conditions, you need to have dataloggers selected instead of the monitor, and 
also the datalogger selected. 

To change the datalogger trigger conditions, either double-click the Trig Conditions field in the 
datalogger settings pane, or select the Conditions command in the Trig Settings submenu of the 
Datalogger menu or context menu of Datalogger Settings. 

 or  

A Triggering Conditions dialog box is presented with the present settings selected. 

 

Change the settings by selecting and unselecting the conditions, and click OK. If you want to cancel 
the operation, click the Cancel button. 
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The new settings are written to the drive and, if the drive accepts them, they shown in the datalogger 
settings pane. 

 

Note that Falling Edge of level triggering is shown as Level only. 

If, for some reason, the value could not be written to the drive or the drive did not accept it, an error 
message is displayed, when you click the OK button. You have to acknowledge the error message and 
the Triggering Conditions dialog box is presented again with your settings. You can now retry or cancel 
the operation. 

 

 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings 
Trig Settings Submenu 

4.6 Setting Trigger Variable 

Trigger variable tells the drive datalogger, which of the drive signals or parameters to use as the trigger 
variable in case of level triggering. The setting is kept in the drive, not in DriveWindow. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

Note that you can set the trigger variable even if level triggering is not enabled in the trigger conditions. 
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The trigger variable cannot be changed unless the datalogger graph is cleared, and the datalogger in 
the drive is not running. 

Before changing the trigger variable, you need to have dataloggers selected instead of the monitor, 
and also the datalogger selected. 

To change the datalogger trigger variable, either double-click the Trig Variable field in the datalogger 
settings pane, or select the Variable command in the Trig Settings submenu of the Datalogger menu or 
context menu of Datalogger Settings. 

 or  

A Trig Variable dialog box is presented with the present trigger variable value (if any) shown in its edit 
field. 

 

Edit or enter a new trigger variable and click OK. The trigger variable is given as an OPC address 
without the channel and node. If you want to cancel the operation, click the Cancel button. 

 

The new value is written to the drive and, if the drive accepts it, the descriptive name of the variable is 
shown in the datalogger settings pane. 
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If, for some reason, the value could not be written to the drive or the drive did not accept it, an error 
message is displayed, when you click the OK button. You have to acknowledge the error message and 
the Trig Variable dialog box is presented again with your setting. You can now retry or cancel the 
operation. 

 

 

4.6.1 Removing trigger variable 

Note that removing the trigger variable may affect also other settings, especially trigger level and 
trigger hysteresis, in the drive. 

The trigger variable can be removed by clearing the edit field in the Trig Variable dialog box. 
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The trigger variable can also be removed also: 

• Select the Trig Variable field in the datalogger settings pane. 
• While focus is in the datalogger settings pane, click the delete or cut items button in the 

standard toolbar, select the Delete or Cut command in the Edit menu or in the context menu 
of Datalogger Settings, or press the Del or Ctrl+X key. 

 

 or  

Note that you can also remove the trigger variable by moving it with drag and drop. The operation is 
similar to moving items by drag and drop in item sets.  

The side effect of using the Cut command, cut items button, or the Ctrl+X key is that the item is copied 
to the clipboard before it is removed. Cutting is similar to cutting items from an item set, except the 
value field of the item in the clipboard is empty. 

Be careful not to unintentionally remove logged variables with these methods. If some of the channels 
are selected as well, the logged variables from those channels are also removed. 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings 
Trig Settings Submenu 
Datalogger Menu 
Edit Menu  
Context Menu of Datalogger Settings 
Standard Toolbar 
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4.7 Setting Trigger Level 

Trigger level tells the drive datalogger, what level to use in level triggering. The setting is kept in the 
drive, not in DriveWindow. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

Note that you can set the trigger level even if level triggering is not enabled in the trigger conditions. 
However, if there is no trigger variable, trigger level cannot be set. 

The trigger level cannot be changed unless the datalogger graph is cleared, and the datalogger in the 
drive is not running. 

Note that removing the trigger variable may affect also the trigger level setting in the drive. 

Before changing the trigger level, you need to have dataloggers selected instead of the monitor, and 
also the datalogger selected. 

To change the datalogger trigger level, either double-click the Trig Level field in the datalogger settings 
pane, or select the Level command in the Trig Settings submenu of the Datalogger menu or context 
menu of Datalogger Settings. 

 or  

A Trig Level dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (real) value and click OK. If you want to cancel the operation, click the Cancel 
button. 
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The new value is written to the drive and, if the drive accepts it, is shown in the datalogger settings 
pane. 

 

If, for some reason, the value could not be written to the drive or the drive did not accept it, an error 
message is displayed, when you click the OK button. You have to acknowledge the error message and 
the Trig Level dialog box is presented again with your setting. You can now retry or cancel the 
operation. 

 

 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings 
Trig Settings Submenu 

4.8 Setting Trigger Hysteresis 

Trigger hysteresis tells the drive datalogger, how big hysteresis to use in level triggering. The setting is 
kept in the drive, not in DriveWindow. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

Note that you can set the trigger hysteresis even if level triggering is not enabled in the trigger 
conditions. However, if there is no trigger variable, trigger hysteresis cannot be set. 

The trigger hysteresis cannot be changed unless the datalogger graph is cleared, and the datalogger in 
the drive is not running. 

Note that removing the trigger variable may affect also the trigger hysteresis setting in the drive. 

Before changing the trigger hysteresis, you need to have dataloggers selected instead of the monitor, 
and also the datalogger selected. 
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To change the datalogger trigger hysteresis, either double-click the Trig Hysteresis field in the 
datalogger settings pane, or select the Hysteresis command in the Trig Settings submenu of the 
Datalogger menu or context menu of Datalogger Settings. 

 or  

A Trig Hysteresis dialog box is presented with the present value shown in its edit field. 

 

Edit or enter a new (real) value and click OK. If you want to cancel the operation, click the Cancel 
button. 

 

The new value is written to the drive and, if the drive accepts it, is shown in the datalogger settings 
pane. 

 



Trends 

6-54 DriveWindow 2 

If, for some reason, the value could not be written to the drive or the drive did not accept it, an error 
message is displayed, when you click the OK button. You have to acknowledge the error message and 
the Trig Hysteresis dialog box is presented again with your setting. You can now retry or cancel the 
operation. 

 

 

See Also: Common Trend Settings 
Setting Datalogger  
Monitor and Dataloggers 
Datalogger Settings 
Trig Settings Submenu 

4.9 Setting and Removing Datalogger Variables 

Datalogger variables are drive parameters and signals, which are logged by the drive datalogger. 

Note that you cannot use DriveWindow to change datalogger settings of native DriveDA OPC server 
drives (AC880 family). You are only able to control dataloggers of ACS880 family of drives and change 
common settings. Also only six channels can be shown although there may be more channels in the 
drive. 

Datalogger variables must reside in the same drive as the datalogger. What kind of parameters and 
signals can be logged, is determined by the drive. 

Datalogger variables cannot be changed unless the datalogger graph is cleared and the datalogger in 
the drive is not running. 

Note that many drives do not allow a condition, in which if no signal or parameter is set to be logged. 
Some drives may behave oddly and show some garbage, if no signal or parameter is set to be logged. 
Others may show that the datalogger is not initialised. DriveWindow does not prevent you from 
removing all variables, but be prepared for surprises, if you do that. 

Also, many dataloggers do not allow non-logged channels between logged channels. DriveWindow 
takes care of this by “shifting up” logged variables and their scaling values into new channels, when 
you clear a channel, which is not the last in use. The unused channels are kept last by DriveWindow. 

All logged values are uploaded as real numbers. 

Before changing the datalogger variables, you need to have dataloggers selected instead of the 
monitor, and also the datalogger selected. 

There are several ways to add and remove variables to be logged. 
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4.9.1 Adding and removing items selected in the item sets pane 

Typically you add and sometimes remove logged items by using item sets of type browsed, all 
parameters, or user defined. 

To use an item set in adding items not yet logged and removing items now logged, you need to have 
the items shown in the item set, and then: 

• You need to have proper datalogger selected and shown. 
• Select parameters and signals, which you want to add to or remove from the datalogger, in 

the item set. They must reside in the same drive as the datalogger. 
• While focus in the item set, either click the add/remove datalogger items button in the logger 

toolbar, or select the Add/Remove Items command in the Datalogger menu. 

 or  

Note that the OPC address is used to identify the parameter or signal, not the descriptive name shown 
in the item set, when determining, if the item is already logged or not. 

The images in front of the items in the item set do not change. 

The descriptive names of the removed items disappear from the channels in the datalogger settings 
pane, and such names of the added items appear in the settings. The descriptive name is possibly not 
the same as shown in the item set, because it is always fetched from the drive. 

 

Note that the removal is done first, then the addition. When removing, the variables and their scaling 
values are “shifted up”, if necessary, so that all free channels are last. The free channels are used in 
addition. If there are more variables to add than there are free channels left after removal, the extra 
items are not added. Also such selected items, which cannot be logged by the datalogger, are not 
added. 

The items added are neither locked nor added into the browsed item set (as monitored items are). 
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4.9.2 Adding items from the clipboard 

If you have copied items to the clipboard, you can paste them into free datalogger channels. 

To paste items from the clipboard into free datalogger channels: 

• You need to have proper datalogger selected and shown. 
• While focus is in the datalogger settings pane, click the paste button in the standard toolbar, 

select the Paste command in the Edit menu or in the context menu of Datalogger Settings, or 
press the Ctrl+V key. 

 or  

The descriptive names of the pasted items appear in the settings. The descriptive name is possibly not 
the same as the item in the clipboard, because it is always fetched from the drive. 

 

The free channels are used in pasting. If there are more variables to paste than there are free 
channels, the extra items are not pasted. Also such items, which cannot be logged by the datalogger, 
are not pasted. 

Note that the Paste command is disabled (grayed) if there is no free channel. 

The items pasted are neither locked nor added into the browsed item set (as monitored items are). 

4.9.3 Adding items by using drag and drop 

You can also use drag and drop in adding items into free datalogger channels. The drag source can 
even be an external drag enabled application, which has the items available in the form, which 
DriveWindow uses in copying items into the clipboard. 

To drag and drop items from a drag source (such as browsed item set) into free datalogger channels: 

• You need to have proper datalogger selected and shown. 
• Select items, which you want to add, in the browsed item set, for example. 
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• Press the left mouse button down on a selected item and keep the button down. 
• Move the cursor into the datalogger settings pane. 
• If you want to copy by dragging, check that there is a plus sign visible in the cursor before 

releasing the mouse button.  

 
• If you want to move by dragging, hold the Shift key down and check that there is no plus sign 

visible in the cursor when releasing the mouse button. 

 
The descriptive names of the dropped items appear in the settings. The descriptive name is possibly 
not the same as the item in the drag source, because it is always fetched from the drive. 

 

The free channels are used in dropping. If there are more variables to drop than there are free 
channels, the extra items are not dropped. Also such items, which cannot be logged by the datalogger, 
are not dropped. If there is no free channel, the cursor turns into a forbidden sign in the datalogger 
settings pane while dragging. 

 

The items added are neither locked nor added into the browsed item set (as monitored items are). 
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4.9.4 Removing items selected in the datalogger settings pane 

The easiest way to remove items from a datalogger is using the datalogger settings pane. 

To remove items currently in a datalogger: 

• You need to have the datalogger selected and shown. 
• Select channels, which you want to remove from the datalogger, in the datalogger settings 

pane. Use Ctrl and Shift keys, if needed, in selection. 
• While focus is in the datalogger settings pane, click the delete or cut items button in the 

standard toolbar, select the Delete or Cut command in the Edit menu or in the context menu 
of Datalogger Settings, or press the Del or Ctrl+X key. 

 

 or  

Note that you can also remove the selected channels by moving them with drag and drop. The 
operation is similar to moving items by drag and drop in item sets.  

The descriptive names of the removed items disappear from the channels in the datalogger settings 
pane and the variables with their scaling values are “shifted up”, if needed. 

 

The side effect of using the Cut command, cut items button, or the Ctrl+X key is that the items are 
copied to the clipboard before they are removed. Cutting is similar to cutting items from an item set, 
except the value fields of the items in the clipboard are empty. 

4.9.5 Setting and removing the variable of a channel 

It is possible to set an item simultaneously into the browsed item set and into a datalogger channel. 
The same feature can be used also to change the logged variable and remove it. 

You probably seldom use this feature. 

Note that if you are setting an empty channel, it is possible to set only the one with the lowest channel 
number. 
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If you are setting an empty channel, you can use a parameter or signal, which resides in the same 
drive as the datalogger, as a base in setting. To do so, select a single item in the item set. 

 

Anyway, you need to have the datalogger selected and shown. Also you need to have an item set of 
type browsed, all parameters, or user defined visible in the item sets pane. 

Select the channel you want to set from the Set Variable submenu of the Datalogger menu or context 
menu of Datalogger Settings. 

 

An Add Item to datalogger and Desktop dialog box is presented. If you are setting an empty channel 
and had a valid item selected to be used as a base, both edit fields already have values, which you can 
edit. 

 

If you are setting an empty channel, but you have no item selected to be used as a template (or had 
multiple selections), the fields are filled with the values last accepted by adding an item into an item 
set. In case the last accepted values were empty (request for removing an item), you have to fill the 
edit fields yourself. However, DriveWindow sets some prefixes for you in such a case. 
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If the channel you are setting is not empty, the current settings are in the edit fields. 

 

Anyway, after you have a descriptive name (of your own) in the Name edit field, and a proper OPC 
address in the other edit field, you can click the OK button (or Cancel, if you want to cancel the 
operation). Note that the descriptive name that you give, needs not to be unique. 

 

If the OPC address you gave is correct and the item exists, it is added into the browsed item set and to 
the datalogger channel you are setting. The descriptive name you gave is shown in the browsed item 
set, but the descriptive name, which will appear in the datalogger settings pane is fetched from the 
drive. The previous item, if there was one, is removed from the datalogger. 

 

 

If the OPC address is formally correct, but the drive does not accept it, your PC beeps when you click 
OK, and the variable is not set. 

If the OPC address is formally correct, but the item does not exist, your PC beeps when you click OK, 
and the Add Item to Monitor and Desktop dialog box stays. 
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If the OPC address is not valid, an error message is displayed, when you click the OK button. You 
have to acknowledge the error message and edit the invalid OPC address or cancel the operation. 

 

 

However, if you clear both edit fields, it is not an error, but any logged variable already in the channel 
you are setting is removed from the datalogger. The descriptive name of the removed item disappears 
from the channel in the datalogger settings pane, and the variables with their scaling values are 
“shifted up”, if needed. 
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See Also: Common Trend Settings 
Setting Datalogger 
Monitor and Dataloggers 
Datalogger Settings 
Datalogger Menu 
Context Menu of Datalogger Settings  
Adding Items to an Item Set 
Edit Menu 

5. Controlling Monitor 
Before you can control the monitor, you need to have the monitor selected instead of the dataloggers. 
You do the selection by clicking the Monitor tab in the trend settings pane. 

 

Note that to be able to control the monitor, you need to have at least one item monitored. 

Note also that most of the monitor settings can be done only if the monitor has been cleared. 

The monitor can be: 

• Started 
• Paused 
• Continued 

• Stopped 

• Cleared 

Status of the monitor is not saved into a workspace, unless monitor data is also saved with it. When 
monitor data is restored with the workspace is restored, the monitor is always stopped (or cleared, if it 
was cleared while saving). The monitor settings are always restored from the workspace. 

Note also that disconnecting the OPC Server, either explicitly or internally by DriveWindow in some 
operations when restarting a drive, stops and clears the monitor. In addition, all monitored items are 
removed from the monitor. None of the other settings are changed, however. 

5.1.1 Start Monitor 

The monitor can be started only if it is cleared. 

To start the monitor, either click the start or continue monitoring button in the monitor toolbar, select 
the Start command in the Monitor menu or in the context menu of Monitor Display, or press Ctrl+M. 

 or  

Note that the start or continue monitoring button, the Start/Continue command position in a menu, and 
the shortcut key Ctrl+M, are shared by starting and continuing the monitor. 
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The backgrounds of the monitored items in the monitor settings pane turn yellow. Also, stop and pause 
are enabled, but start and clear are disabled. 

 

Note that if your monitoring mode is Fast, it may be that some of the monitored items cannot be 
monitored. The backgrounds of such items in the monitor settings pane do not change to yellow. 

The monitor starts running and the monitored item values are drawn in real time in the monitor display 
pane. 

In the running state it is possible to change the axis settings, but scrolling the x-axis and zooming 
cannot be done. 

Note that viewing dataloggers and minimizing DriveWindow do not interrupt monitoring. It is still 
running, and the monitor display pane is up to date, when you return to view it. 

You may get one or more of the following warnings when starting the monitor. You have the option not 
to start monitoring by clicking the No button. 
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5.1.2 Pause Monitor 

The monitor can be paused only if it is running. 

To pause the monitor, either click the pause monitoring button in the monitor toolbar, select the Pause 
command in the Monitor menu or in the context menu of Monitor Display, or press Ctrl+Shift+P. 

 or  

The backgrounds of the monitored items in the monitor settings pane stay yellow. Also, continue and 
stop are enabled, but pause and clear are disabled. 

Pause causes the monitor to stop updating the monitor display pane, but still continue collecting 
monitored item values into a hidden history buffer. The monitor display pane can be viewed (scrolled, 
zoomed, etc.) as if the monitor was stopped, when the monitor is paused. 

The data collected into the hidden history buffer is drawn, when monitoring is continued. If the monitor 
is stopped, however, the hidden history buffer is disregarded. 

5.1.3 Continue Monitor 

The monitor can be continued only if it is paused. 

To continue the monitor, either click the start or continue monitoring button in the monitor toolbar, 
select the Continue command in the Monitor menu or in the context menu of Monitor Display, or press 
Ctrl+M. 

 or  

Note that the start or continue monitoring button, the Start/Continue command position in the menu, 
and the shortcut key Ctrl+M, are shared by starting and continuing the monitor. 

The backgrounds of the monitored items in the monitor settings pane stay yellow. Also, stop and pause 
are enabled, but start and clear are disabled. 

Continue causes the monitor to draw the hidden history buffer collected during the pause. The monitor 
resumes and the monitored item values are drawn in real time in the monitor display pane. 
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The data in the hidden history buffer is drawn, when monitoring is continued. If the monitor is stopped, 
however, the hidden history buffer is disregarded. 

Note that if the hidden history buffer was filled during the pause, the oldest values in it have been 
disregarded, and the monitor display pane is totally redrawn. 

You may get the following warning when continuing the monitor, if you have changed the x-axis length. 
You have the option not to continue monitoring by clicking the No button. 

 

5.1.4 Stop Monitor 

The monitor can be stopped only if it is running or paused. 

To stop the monitor, either click the stop monitoring button in the monitor toolbar, select the Stop 
command in the Monitor menu or in the context menu of Monitor Display, or press Ctrl+Shift+M. 

 or  

The backgrounds of the monitored items in the monitor settings pane are not yellow any more. Also, 
clear is enabled, but start, stop, and pause are disabled. 

 

Stop causes the monitor to stop monitoring, i.e., updating the monitor display pane and collecting 
monitored item values are ceased. The monitor display pane can now be viewed scrolled, zoomed, etc. 
Monitoring cannot be continued, only cleared. 

Note that disconnecting the OPC Server, either explicitly or internally by DriveWindow in some 
operations when restarting a drive, stops and clears the monitor. 

5.1.5 Clear Monitor 

The monitor can be cleared only if it is stopped. 
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To clear the monitor, either click the clear monitor button in the monitor toolbar, or select the Clear 
command in the Monitor menu or in the context menu of Monitor Display. 

 or  

Clear clears the trends in the monitor display pane. Also, zooming is reset. The monitor settings are 
not changed, however. 

Note that most of the monitor settings can be done only if the monitor has been cleared. 

Note also that disconnecting the OPC Server, either explicitly or internally by DriveWindow in some 
operations when restarting a drive, stops and clears the monitor. 

See Also: Monitor and Dataloggers 
Monitor Menu 
Context Menu of Monitor Display 
Monitor Toolbar 
Trend Settings Pane 
Monitor Settings 

6. Controlling Datalogger 
Before controlling a datalogger, you need to have dataloggers selected instead of the monitor, and also 
the datalogger selected. 

Controlling of a datalogger depends much on the drive, because the datalogger actually is in the drive. 

Note that many drives do not allow controlling of a datalogger, if no signal or parameter is set to be 
logged. Some drives may behave oddly and show some garbage, if no signal or parameter is set to be 
logged. 

Note also that most of the datalogger settings can be done only if the datalogger is not running. Also, 
DriveWindow does not allow changing of many settings if the datalogger graph is not cleared after 
uploading. 

The actual datalogger commands are also items, which can be browsed, viewed, and changed as any 
other items. However, if you are going to use the upper level datalogger handling functionality in 
DriveWindow, you should not use the raw items. 

A drive datalogger can be: 

• Started 
• Stopped 
• Triggered 

• Cleared 

• Uploaded 

In addition, an uploaded datalogger graph can be cleared. 

Note that drive datalogger commands can be given even after the datalogger is uploaded. Thus it is 
possible to restart a datalogger while still viewing the previous results in DriveWindow. 

The datalogger status and cause of trigger can be seen in the datalogger settings pane. Their display 
can be put on-line and off-line. Some datalogger commands automatically set their display status on-
line or off-line. The on-line/off-line status is saved into and restored from a workspace. 
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When a workspace is restored in current version of DriveWindow, all datalogger graphs are cleared. 

Note also that disconnecting and reconnecting the OPC Server, either explicitly or internally by 
DriveWindow in some operations when restarting a drive, clears all datalogger graphs. In addition, all 
datalogger settings not kept in drives are restored to their default values. 

6.1.1 Start Datalogger 

A datalogger can be started if it is not running and is initialised. 

To start the current datalogger, either click the start datalogger button in the logger toolbar, or select 
the Start command in the Datalogger menu or in the context menu of Datalogger Display. 

 or  

When the datalogger is running, stop and trigger are enabled, but start and upload are disabled. Clear 
is always enabled. Datalogger status field in the datalogger settings pane is also put on-line 
(background turns yellow). 

The datalogger starts running and collects data, until it stops either because of a trigger condition 
happened, or it is commanded to stop. 

Note that you are not able to change those datalogger settings, which are kept in the drive, while the 
datalogger is running. 

If, for some reason, the drive does not accept the datalogger starting command, your PC beeps. 

6.1.2 Stop Datalogger 

A datalogger can be stopped, if it is running. 

To start the current datalogger, either click the stop datalogger button in the logger toolbar, or select 
the Stop command in the Datalogger menu or in the context menu of Datalogger Display. 

 or  

When the datalogger is stopped, start and upload are enabled, but stop and trigger are disabled. Clear 
is always enabled. Datalogger status field in the datalogger settings pane is also put off-line 
(background is no more yellow). 

The datalogger stops running and collecting data. The data collected thus far can be uploaded and 
viewed in DriveWindow. 
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Note that you are now able to change all datalogger settings, even those, which are kept in the drive, 
and cannot be changed, while the datalogger is running. Note that changing datalogger settings, which 
are kept in the drive, clears the datalogger in the drive. 

If, for some reason, the drive does not accept the datalogger stopping command, your PC beeps. 

6.1.3 Trigger Datalogger 

If a datalogger is running, it can be triggered by the user. 

To trigger the current datalogger, either click the start datalogger button in the logger toolbar, or select 
the Start command in the Datalogger menu or in the context menu of Datalogger Display. 

 or  

When the datalogger is triggered, trigger is disabled, stop stays enabled, and start and upload stay 
disabled. Clear is always enabled. Datalogger is still running, but its status (if on-line) shows also that 
the datalogger has been triggered. 

You have thus the option to stop the datalogger before it is filled. 

The datalogger stops automatically, after the proper amount of values has been collected after the 
trigger. Its status then shows filled (if on-line). Trigger stays disabled, stop is disabled, but start and 
upload are enabled. Clear is always enabled. 

When the datalogger is no more running, the data collected can be uploaded and viewed in 
DriveWindow. 

Note that when the datalogger has stopped, you are able to change all datalogger settings, even those, 
which are kept in the drive, and cannot be changed, while the datalogger is running. Note that 
changing datalogger settings, which are kept in the drive, clears the datalogger in the drive. 

If, for some reason, the drive does not accept the datalogger triggering command, your PC beeps. 

6.1.4 Clear Datalogger 

You can send the datalogger clearing command to a drive at any time. Most of the drives do not need 
the datalogger to be cleared, because in them starting a datalogger also clears it.  

To clear the current datalogger, either click the clear drive datalogger button in the logger toolbar, or 
select the Clear command in the Datalogger menu or in the context menu of Datalogger Display. 

 or  
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Note that clearing the drive datalogger does not affect the already uploaded values shown in the 
datalogger display pane. You have to clear the uploaded datalogger graph separately. 

If, for some reason, the drive does not accept the datalogger triggering command, your PC beeps. 

6.1.5 Upload Datalogger 

A datalogger can be uploaded, if it is not running and is initialised. 

Uploading means that the drive datalogger content is read and cached by DriveOPC, and 
DriveWindow shows the selected, uploaded datalogger content in the datalogger display pane. When 
datalogger selection is changed, the values are read from DriveOPC cache, not from the drive. 

To upload the current datalogger, either click the upload datalogger button in the logger toolbar, or 
select the Upload command in the Datalogger menu or in the context menu of Datalogger Display. 

 or  

When upload is executed, upload is disabled, graph clear is enabled, and other controls do not change 
their enable status. Datalogger status field in the datalogger settings pane is also put off-line 
(background is no more yellow). The data collected in the datalogger is uploaded and is shown in the 
datalogger display pane. 

However, if there is no data in the datalogger, an error message is shown, and uploading is aborted. 

 

When the datalogger is uploaded, the current datalogger settings (except the common settings) in 
DriveWindow are frozen, so the settings show the settings of the uploaded trend. 

It is not possible to change datalogger setting other than the common settings while a datalogger is 
uploaded and shown in the datalogger settings pane. You have to clear the datalogger graph to be able 
to change the settings again. 

When you have uploaded the datalogger, the Triggered by field in the datalogger settings pane is 
frozen to show the condition at uploading time. It stays off-line until you clear the datalogger graph. The 
status field in the datalogger settings pane shows the status at upload time, if it is put off-line, and 
current status in the drive, if it is put on-line. 

If the setting of x-axis length is improper (too short or long, or not multiple of the interval), uploading of 
the datalogger automatically sets the x-axis length. 
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Y-axis minimum and/or maximum of a datalogger can also change automatically when the datalogger 
is uploaded. If any of the uploaded values after scaling is smaller than the setting of y minimum, or 
bigger than setting of y maximum, y minimum and/or maximum is adjusted to the smallest/biggest 
value uploaded. 

Note! You need to have good knowledge of the behaviour of the drive datalogger. Some very old 
drives may crash, if you try to upload the datalogger again before it has new data. 

There are several drives, which do not give all the data with the first upload (actually one less than their 
channel buffer size). In such cases, the triggering point (origin of the x-axis) is slightly wrong (one 
measurement interval). Uploading a second time usually gives all the data. 

6.1.6 Clear Datalogger Graph 

When you are finished with viewing an uploaded datalogger in DriveWindow, you can clear the 
datalogger graph. Clearing the graph enables you to change datalogger settings, if the datalogger is 
not running. 

If you have not started or cleared the drive datalogger, you can (in most drives) view the data again by 
uploading it. 

To clear the current datalogger graph, either click the clear datalogger graph button in the logger 
toolbar, or select the Clear Graph command in the Datalogger menu or in the context menu of 
Datalogger Display. 

 or  

When clear graph is executed, clear graph is disabled and, if the datalogger is not running, upload is 
enabled 

See Also: Monitor and Dataloggers 
Datalogger Menu 
Context Menu of Datalogger Display 
Logger Toolbar 
Trend Settings Pane 
Datalogger Settings 
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7. Graph Preferences 
Graph preferences are user selectable options, which affect displaying of trends. There is also an 
option, which allows the user to select, how scaling is entered and displayed. 

Graph preferences can be changed even if the OPC Server is not connected. However, they cannot be 
changed while the monitor is running. You have to pause the monitor before you can change graph 
preferences. 

Note that graph preferences are not saved and restored with a workspace. 

You can change graph preferences by selecting Preferences command in the Graph submenu of the 
File menu or in the context menus of Monitor Display or Datalogger Display. 

 or  

The Graph Preferences tabbed dialog box is displayed. It has tabs for setting: 

• Miscellaneous Graph Preferences 
• Screen Colors and Line Styles 
• Printer Line Styles 
• Color Printer Colors and Line Styles 
• Monitor Visualization Method 

Any changes you made take effect when you click the OK button. 

No changes are made in case you click the Cancel button. 

See Also: What are Preferences 
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7.1 Miscellaneous Graph Preferences 

You can set miscellaneous graph preferences in the Graph Preferences dialog box by selecting the 
Misc tab. Miscellaneous graph preferences concern both monitor and dataloggers. 

 

Miscellaneous graph preferences are: 

• Connection method, i.e., how to draw lines connecting adjacent drawing points. 
• Scaling method to be used. You have the option to display and enter scaling either as 

coefficient and offset or as values at y=100 and y=0. 
• Whether to show scaled or unscaled values with the graph cursor. The selection can also be 

made in the Graph Cursor dialog box shown by the Graph Cursor command in the View 
menu. 

7.1.1 Connection Method 

We recommend that you use the linear connection method in case the trends are of analog signals. 

If the signals are digital and you want to see the changes as vertical lines, you can use either the 
leading or lagging step as connection method. 

Note! Changing of the connection method requires that all the trends are redrawn from the beginning. 
If you have lot of monitored data, this can take a long time. 

7.1.2 Scaling Method 

The scaling method option does not affect drawing of the trends. It just affects the way the scales are 
displayed and entered. Changing of the method does not change the actual scaling. 
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If your scaling method is Coefficient and Offset, the coefficients and offsets are displayed as a formula 
in form coefficient * x + offset in the trend settings pane. Also the values in the Channel Scaling dialog 
box are shown and entered as coefficient and offset. 

  

If your scaling method is Values at 100 and 0, the values at y=0 and y=100 are displayed within 
brackets ([]), separated with comma in the trend settings pane. Also the values in the Channel Scaling 
dialog box are shown and entered as values at y=100 and at y=0. 

  

Note that internally DriveWindow always handles the scaling as coefficient and offset. 

7.1.3 Cursor Values 

The cursor values option does not affect drawing of the trends. It just affects the line style and the way 
numerical values are displayed with the graph cursor. 

The selection can also be made in the Graph Cursor dialog box shown by the Graph Cursor command 
in the View menu. 
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Line style of the graph cursor is dotted, if scaled values are shown. 

 

Line style of the graph cursor is dashed, if unscaled values are shown. 

 

See Also: Graph Preferences 
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7.2 Screen Colors and Line Styles 

You can set colors and line styles of trends shown on the screen by selecting the Screen tab in the 
Graph Preferences dialog box. Selection of screen colors and line styles concern both monitor and 
dataloggers. 

 

You can restore the default settings into the dialog box by clicking the Default button. Note that it just 
shows the default settings. Any changes you made in the Graph Preferences dialog box take effect 
when you click the OK button. 

Note that changing screen colors or line styles does not require redrawing of the trends. Thus it is a 
quick operation. 

7.2.1 Line Style 

You can see all the line styles by clicking the drop-down button of one of channels. 
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You select a line style by clicking it in the drop-down list. 

By selecting line style None for a channel, you can hide the channel from the trend display pane. Its 
value is still shown with the graph cursor, however, unless you hide it to by unselecting it in the Graph 
Cursor dialog box. 

7.2.2 Color 

You can see all the colors by clicking the drop-down button of one of channels and then scrolling with 
the vertical scroll bar. 

 

You select a color by clicking it in the drop-down list. 

All colors that the graphical drawing package can use are present. Note that some color/background 
combinations may not be seen properly. 

See Also: Graph Preferences 
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7.3 Printer Line Styles 

You can set line styles of trends printed by a black and white printer by selecting the Printer tab in the 
Graph Preferences dialog box. Selection of black and white printer line styles concern both monitor 
and dataloggers. 

 

You can restore the default settings into the dialog box by clicking the Default button. Note that it just 
shows the default settings. Any changes you made in the Graph Preferences dialog box take effect 
when you click the OK button. 

Note that the settings are in effect only when you have unchecked the Print in Color check field in the 
Edit Graph Titles (shown when you start printing a graph). 
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7.3.1 Line Style 

You can see all the line styles by clicking the drop-down button of one of channels. 

 

You select a line style by clicking it in the drop-down list. 

By selecting line style None for a channel, you can hide the channel from the trend display pane. Its 
value is still shown with the graph cursor, however, unless you hide it to by unselecting it in the Graph 
Cursor dialog box. 

See Also: Graph Preferences 

7.4 Color Printer Colors and Line Styles 

You can set colors and line styles of trends printed by a color printer by selecting the Color Printer tab 
in the Graph Preferences dialog box. Selection of color printer colors and line styles concern both 
monitor and dataloggers. 
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You can restore the default settings into the dialog box by clicking the Default button. Note that it just 
shows the default settings. Any changes you made in the Graph Preferences dialog box take effect 
when you click the OK button. 

Note that the settings are in effect only when you have checked the Print in Color check field in the Edit 
Graph Titles (shown when you start printing a graph). 

 

7.4.1 Line Style 

You can see all the line styles by clicking the drop-down button of one of channels. 
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You select a line style by clicking it in the drop-down list. 

By selecting line style None for a channel, you can hide the channel from the trend display pane. Its 
value is still shown with the graph cursor, however, unless you hide it to by unselecting it in the Graph 
Cursor dialog box. 

7.4.2 Color 

You can see all the colors by clicking the drop-down button of one of channels and then scrolling with 
the vertical scroll bar. 

 

You select a color by clicking it in the drop-down list. 

All colors that the graphical drawing package can use are present. Note that some color/background 
combinations may not be seen properly when printed. 

See Also: Graph Preferences 
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7.5 Monitor Visualization Method 

You can select, how the drawing points of monitor channels are deducted from the measured values, 
by selecting the Monitor tab in the Graph Preferences dialog box. Selection of monitor visualization 
method concerns only the monitor. You can select the method for analog and digital signals separately. 

 

Monitor visualization methods are: 

• Interpolation. A drawing point is calculated by linear interpolation. 
• Nearest. Value of a drawing point is the nearest measured value. 
• Leading. Value of a drawing point is the next measured value. 
• Lagging. Value of a drawing point is the previous measured value. 

We recommend that you select interpolation for analog signals. You should also use the linear 
connection method. 

For digital signals you should not use interpolation. Typically, you use the Nearest method for them. 

Note! Changing of the visualization method requires that the monitor trends are redrawn from the 
beginning. If you have lot of monitored data, this can take a long time. 

See Also: Graph Preferences 

8. Viewing Trends 
Trends of the monitor and dataloggers are displayed in the trend display pane. 
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Although the trends are quite similar and there is not much difference in viewing them, there are some 
differences, which are good to know. 

• Monitor data is collected in your computer by DriveWindow, but dataloggers collect data in 
drives. 

• Timing of measurements is much better in dataloggers. Interval is actually considered to be 
constant. Monitor measurement timing, however, varies because of load caused by the 
operating system kernel and high priority programs. For this reason, monitored values are 
time stamped, and the drawn values are estimated from measured values. How the 
estimation is done depends on the monitor visualization method selected in graph 
preferences. 

• Moment of starting the monitor is the X-axis origin in monitoring. In dataloggers, x-axis origin 
is the triggering moment, which means that values collected before the triggering moment are 
shown having negative time value. 

• Monitor trends are drawn and updated even when the monitor is running, but datalogger 
trends have to be uploaded, when a datalogger is not running. 

• Size of a datalogger channel buffer is fixed. You can set the size of the history buffer of the 
monitor yourself. Its size is in practice limited by the amount of (virtual) virtual memory in your 
PC. Thus, the monitor usually contains much more data than a datalogger. 

Note! Changing of the scaling of a monitor channel requires that the monitor trends are redrawn from 
the beginning. If you have lot of monitored data, this can take a long time. 

If you are examining phenomena happening in sub-second level, we recommend that you use a 
datalogger, if possible. Slower phenomena can be traced using the monitor. 

When you are viewing the trends, you can: 

• Change the common settings, which affect the display 
• Change graph preferences, which affect the outlook of the trends shown 
• Scroll 
• Zoom 
• Use the graph cursor 

8.1.1 Graph Preferences 

Graph Preferences allow you to change outlook (colors, line styles, etc.) of the trends. Please see 
Graph Preferences for details. 

8.1.2 Selecting Monitor or Datalogger 

The trend display pane is shared. You select, whether to look at monitor trends or datalogger trends by 
clicking the Monitor or the Datalogger tab in the trend settings pane. 

 

If you want to display a datalogger, you have to select it, too. If the drive has only one datalogger, it is 
enough just to select the drive in the browse tree pane. 
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Note that to select a drive, it is not necessary to select its root, selection of any of its sub-branches will 
do. 

If the drive has two dataloggers, the datalogger within the drive has to be selected, too. Selection can 
be done either using the browse tree pane or by toggling the Datalogger 2 toggle in the Datalogger 
menu or in the context menu of Datalogger Display after the drive has been selected from the browse 
tree pane. 

 or  or 

 

If the drive has more than two dataloggers, the drive datalogger is selected the similar way as in the 
case of two dataloggers. However, a menu shows Next Datalogger instead of Datalogger 2. Clicking of 
Next Datalogger moves the drive datalogger selection to the next datalogger. Note that the next 
datalogger of the last one is the first datalogger. 

 or  

You can verify the currently selected datalogger from the OPC address shown in the title in the 
datalogger display pane. If a drive more than one dataloggers, DL1, DL2, etc. in the title indicate, which 
of the loggers is selected. 

 

Note that to select the datalogger within a drive using the browse tree pane, it is not necessary to 
select the Datalogger n sub-branch, selection of any of its sub-branches will do. While selection is 
made using the browse tree pane, it is not possible to select the datalogger from the Datalogger menu 
or from the context menu of Datalogger Display 

8.1.3 Zooming Levels 

If zooming is enabled, you are able to zoom in when viewing the trends. Zoom in is not limited to one 
level. You can zoom in further, even if you have already zoomed. In practice, there is no limit on the 
number of zooming levels. 
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The behaviour of a zooming level is such that any changes you make in x-axis length, y-axis minimum, 
y-axis maximum, or scrolling position, affect the current zooming level only. When you zoom in, current 
values are saved in the current zooming level, and a new zooming level is created. When zooming out, 
the values are restored. 

 

Note that by changing settings of x-axis length, y-axis minimum, and/or y-axis maximum, it is possible 
that current zooming level shows a bigger area than its parent level, although originally it was smaller. 

See Also: Monitor and Dataloggers 
Browse Tree Pane  
Trend Settings Pane 
Trend Display Pane 
Common Trend Settings 
Graph Preferences  
Printing Trends 
Adapting Y Axis 

8.2 Scrolling Trends 

You can scroll trends horizontally and vertically. Scrolling is done using the scrollbars in the trend 
display pane. 

The vertical scrollbar is always there. However, to be able to scroll, you need to have an OPC Server 
connected. The horizontal scrollbar is visible only when horizontal scrolling is possible. 

8.2.1 Vertical scrolling 

Vertical scrolling actually changes y-axis minimum and maximum simultaneously. Their values are also 
shown in the trend settings pane. 
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Scrolling is done by using the short vertical scrollbar at the lower left corner in the trend display pane. 
Scrolling adds or subtracts the distance between two tick marks to or from both y minimum and 
maximum. 

.  

  

Note that the effect of scrolling is not always reversible. When signs of y-axis minimum and maximum 
differ before scrolling, but are the same after scrolling, the number of tick marks, and also the distance 
between two of them, may change. 

8.2.2 Horizontal scrolling 

Amount of data collected by the monitor or a datalogger can be bigger than can be shown with the 
current setting of the x-axis length. Horizontal scrolling makes it possible the view also values not 
currently shown. 

 

Horizontal scrolling does not change the length of the x-axis. The horizontal scrollbar is visible only, 
when scrolling is possible. 

In the monitor, horizontal scrolling is possible only when the monitor is stopped or paused. 

Scrolling is done by using the horizontal scrollbar at the lower part in the trend display pane. 

The amount of scrolling depends on the length of the x-axis or the distance between the tick marks. 
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If you scroll by clicking a scroll arrow at the end of the scrollbar, the amount the x-axis position is sifted 
is the distance between two tick marks 

 

 

In some extreme cases, however, the amount of shifting may be the size of the interval. 

If you scroll by clicking the scrollbar shaft, the amount the x-axis position is sifted is the x-axis length. 

 

 

Of course, you can also scroll by dragging the scroll box (thumb). 
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See Also: Viewing Trends 
Zooming Trends 
Monitor and Dataloggers 
Trend Settings Pane 
Trend Display Pane 
Common Trend Settings 

8.3 Zooming Trends 

When viewing the trends, you can zoom inwards, outwards, and reset zooming to the base level. 

In the monitor, zooming is possible only when the monitor is stopped or paused. When a paused 
monitor is continued, zooming is automatically reset to the base level. 

8.3.1 Zooming In 

Zooming in saves current x-axis length, y-axis minimum and maximum, and x-axis scroll position into 
current zooming level, and creates a new one. 

 

X-axis length, y-axis minimum and maximum, and x-axis scroll position usually change. Value changes 
also affect the trend settings pane. 

To be able to zoom in, you need to have the zoom in/graph cursor toggle in zoom in state. You can 
check or change the toggle either from the standard toolbar (zoom in graph button must be down) or 
from the View menu or from the context menus of Monitor Display or Datalogger Display (Zoom In 
toggle must be marked). You can change the toggle also by pressing the Ctrl+Shift+Z key. 

 or 
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Zoom in is done by dragging the mouse in the trend display pane, so that at least some of the 
rectangle shown while dragging is inside the trend drawing area (area limited by the axes). 

 

Note that while the rectangle is shown, DriveWindow stays topmost on the screen. Only an application 
using the same feature (like Windows Task Manager) can overlay DriveWindow at that time. If it 
happens that such an application overlays the rectangle, behavior of the zoom operation can not be 
determined. 

When you release the mouse button, the rectangular area is used to approximately determine new x-
axis length and y-axis minimum and maximum in a new zooming level. The new values are made from 
the rectangle by rounding to a “smooth” value. The new values are also show in the trend settings 
pane. 

 

Note that it is possible that the rounded values of x-axis length and y-axis minimum and maximum are 
the same as before zooming. If that is the case, you can use the trend settings to change them. 
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8.3.2 Zooming Out 

Zooming out destroys the current zooming level and restores x-axis length, y-axis minimum and 
maximum, and x-axis scroll position from the previous level. 

 

X-axis length and y-axis minimum and maximum value changes also affect the trend setting pane. 

To zoom out, either click the zoom out graph button in the standard toolbar, or select the Zoom Out 
command in the View menu or in the context menus of Monitor Display or Datalogger Display. Note 
that you cannot zoom out, if you are already at the base zooming level. 

 or 

 

Note that state of the zoom in/graph cursor toggle does not affect zoom out. 

8.3.3 Zooming Reset 

Zooming reset destroys all other zooming levels than the base zooming level and restores x-axis 
length, y-axis minimum and maximum, and x-axis scroll position from the base level. 

 

X-axis length and y-axis minimum and maximum value changes also affect the trend setting pane. 
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To reset zooming, either click the reset graph zoom button in the standard toolbar, or select the Zoom 
Reset command in the View menu or in the context menus of Monitor Display or Datalogger Display. 
Note that you cannot reset zooming, if you are already at the base zooming level. 

 or 

 

Note that state of the zoom in/graph cursor toggle does not affect zoom reset. 

See Also: Viewing Trends 
View Menu 
Context Menu of Monitor Display 
Context Menu of Datalogger Display 
Scrolling Trends 
Using Graph Cursor 
Monitor and Dataloggers 
Trend Settings Pane 
Trend Display Pane 
Common Trend Settings 
Restoring Default Settings 
Adapting Y Axis 

8.4 Using Graph Cursor 

When viewing the trends, you have the option to show a graph cursor in the trend display pane. 

In the monitor, the graph cursor can be shown only when the monitor is stopped or paused. When a 
paused monitor is continued, the cursor disappears automatically. 

To be able to have the graph cursor visible, you must not have the zoom in/graph cursor toggle in 
zoom in state. You can check or change the toggle either from the standard toolbar (zoom in graph 
button must be up) or from the View menu or from the context menus of Monitor Display or Datalogger 
Display (Zoom In toggle must not be marked). You can change the toggle also by pressing the 
Ctrl+Shift+Z key. 

 or 
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You can display the graph cursor by clicking the drawing area (area limited by the axes) in the trend 
display pane. Note that the cursor is also printed, if visible. 

 

The cursor is a vertical line with the following numerical values: 

• Time at the point of the cursor (written vertically). 
• For each trend, value at the point of cursor, and the channel number within brackets (if there 

is more than one trend). 

If unscaled values are displayed, the display formats of the values depend on desktop preferences 
selected. However, display formats of selected channels can be (temporarily) changed. 

Line style of the cursor is dotted, if the numerical values are shown as scaled. 
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Line style of the cursor is dashed, if the numerical values are shown as unscaled. 

 

To select the scaling type of numerical values and individually hide or show a numerical value by the 
Graph Cursor, select the Graph Cursor command in the View menu or in the context menus of Monitor 
Display or Datalogger Display. 

 

The Graph Cursor dialog box is shown. Select proper settings and click OK. You can try the effect of 
the settings without closing the dialog box by clicking the Apply button. 

 



Trends 

DriveWindow 2 6-93 

 

Note that the scaling type of graph cursor numerical values can also be selected in graph preferences. 

The feature is useful, if you have the graph cursor at a point, where the trends are near each other, 
and the numerical values are overlapping, and are thus not readable. 

You can move the cursor horizontally by dragging, or by clicking another point within the trend drawing 
area. 

The graph cursor can be hidden by clicking the trend display pane outside the drawing area (area 
outside the axes), or by changing to zoom in mode by toggling Zoom In in the View menu or clicking 
the zoom in graph button in the standard toolbar. 

If quality of a monitored value for some reason is bad, the cursor shows its value as (negative) 
indefinite. 

 

If a monitor or datalogger value after scaling overflows (does not fit into a four byte real number), the 
scaled cursor shows its value as (positive or negative) infinite. 
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If a monitor value cannot be converted to real (you are trying to monitor a string type of value, for 
example), the cursor shows its value as (negative) not-a-number. 

 

See Also: Viewing Trends 
View Menu 
Context Menu of Monitor Display 
Context Menu of Datalogger Display 
Monitor and Dataloggers 
Trend Settings Pane 
Trend Display Pane 
Common Trend Settings 

8.5 Graph Cursor Options 

If you want to change graph cursor options, please select the Graph Cursor command of the View 
menu. We recommend that you make the graph cursor visible in the trend display pane before starting 
the command. 

 

The Graph Cursor dialog box is shown. 
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8.5.1 Buttons 

The Graph Cursor dialog box contains the following buttons: 

• OK: The current settings are applied and the dialog box is closed. 
• Cancel: The dialog box is closed. 
• Apply: The current settings are applied. 

The Apply button is useful in finding proper settings because you can see the effects. If you have the 
graph cursor visible in the trend display pane, Apply shows the effect, but you can still change the 
settings. 

8.5.2 Showing or Hiding Numerical Values 

The Graph Cursor dialog box contains check fields for showing or hiding the following numerical values 
with the graph cursor: 

• Time. Shows or hides the x-axis value at the top end of the graph cursor. 
• Channel 1, ... Channel 6. Shows or hides a numerical value at the trend of monitor or 

datalogger channel 1, ... 6. 

 

8.5.3 Scaled or Unscaled Numerical Values 

The Graph Cursor dialog box contains also the Cursor Values option. It affects the line style and the 
way numerical values are displayed with the graph cursor. 

The selection can also be made in the Graph Preferences dialog box shown by the Preferences 
command in the Graph submenu of the File menu. 
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Line style of the graph cursor is dotted, if the numerical values are shown as scaled. 

 

Line style of the graph cursor is dashed, if the numerical values are shown as unscaled. 

 

If unscaled values are displayed, the display formats of the values depend on desktop preferences 
selected. However, display formats of selected channels can be (temporarily) changed. 

Note that the graph cursor is also printed and copied to the clipboard. 

See Also: Using Graph Cursor  
Graph Preferences 
Changing Display Format of Graph Cursor Values 
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8.6 Changing Display Format of Graph Cursor Values 

Normally, unscaled numerical values shown with he graph cursor in the trend display pane are 
displayed in the format system selected in desktop preferences, i.e., either in classic DriveWindow 
format or operator panel format. Note that operator panel format is available in new drive models only. 
Scaled numerical values are always shown in classic DriveWindow format. 

However, a user can temporarily change display format of selected channels. The changed format 
overrides any selection made in desktop preferences, but is valid only as long as the measured or 
logged variable of the channel is not changed. If a measured item is removed from the monitor or from 
a datalogger and then restored, for example, the normal mechanism for displaying the value is used. 
The currently changed formats are saved and restored with a workspace, however. 

Before changing of display format make sure that the graph cursor values are shown unscaled. 

  

To change display format of unscaled graph cursor values in the trend display pane: 

• Select channels, display format of which you want to change. Use Ctrl and Shift keys, if 
needed, in selection. 

• Select the Change Format command in the context menu of Monitor Settings or Datalogger 
Settings. 
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Instead of using a context menu, you can: 

• While input focus is still in the trend settings pane, either press F3 key on the keyboard, or 
select the Change Format command in the View menu. 

 

The Change Display Format dialog box is displayed. 

 

Select a format and number of decimals (if applicable) and click OK. 
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Now the graph cursor values of the selected channels in the trend display pane are displayed in the 
new format. 

 

Note that the operator panel display format of some parameters in some drives may not agree with the 
type of the value used by the drive in communication. The type of the value used in communications is 
also used in drawing a trend. Thus the graph cursor value shown may not agree with the value drawn. 
Typically the graph cursor value may show a negative value, but the value drawn is a big positive 
value. The reason is that the unsigned value given by the drive is asked to be displayed as a signed 
graph cursor value. 

Note that if a value cannot be displayed in the selected format, it is displayed in classic DriveWindow 
format. However, the panel format usage selection in desktop preferences is overridden also in this 
case. 

The possible display format selections are: 

1. The classic DriveWindow format. Select this in case operator panel format is selected in 
desktop preferences, but you want to see a value in the classic DriveWindow format. 

2. Fixed point format. Select this and enter number of decimal digits in case you want to see 
more decimal digits, for example. 

3. Exponent format. Select this and enter number of decimal digits in case a value is not zero 
but its absolute value is very small (<1E-3) or very big (>1E6). 

4 Decimal integer format. 
5. Hexadecimal format. 
6. Binary format. 
7. Adaptive programming format. Select this in case the drive does not have operator panel 

format available, but you know that the drawn items are handled as adaptive programming 
values in the drive. 

8. The operator panel format. Select this in case operator panel format is not selected in desktop 
preferences, but you want to see a value in the operator panel format, and the drive supports 
it, too. 
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See Also: Changing Display Format of Item Values 
Desktop Preferences 
Graph Cursor Options 
Miscellaneous Graph Preferences 

8.7 Trends of Analog vs Digital Signals 

If you want to optimise the outlook of trends, you should use different graph preferences for analog and 
digital signals. 

8.7.1 Analog Signals 

Analog signals are best shown with linear connection method. 
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Visualization method of monitored analog signals should be interpolation. 

 

A trend of an analog signal looks with digital signal settings like the following: 
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But with analog signal settings it looks like: 

 

8.7.2 Digital Signals 

Digital signals are best shown with other than linear connection method. 
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Visualization method of monitored digital signals should be other than interpolation (usually Nearest). 

 

A trend of a digital signal looks with analog signal settings like the following: 
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But with digital signal settings it looks like: 

 

See Also: Graph Preferences 

9. Saving Trends 
Since version 2.10 of DriveWindow, it is possible to save trends into a file. 

There are actually several ways to save trends: 

• With proper settings in workspace preferences, monitor and/or uploaded dataloggers can be 
saved with a workspace. 

• If a workspace is saved for off-line, you have the option to include also monitor and/or 
uploaded dataloggers. 

• The currently displayed trend can be saved into a graph (.dwt) file. 
• All trends (monitor and uploaded dataloggers) can be saved into a graph (.dwt) file. 

We explain here saving of trends into a graph file. See How to Save Workspace and Workspace 
Preferences for saving trends with a workspace. 

The saved trends can be restored and viewed off-line. 

Saved trends are actually incomplete off-line workspaces, which contain just enough information to 
restore the graphs saved within them. Thus it is possible to open a graph (.dwt) file as a workspace, 
too. 

Note! Workspace (.dww) and graph (.dwt) files can contain binary data. Never edit a workspace or 
graph file. Also, if you are copying such a file, use a binary copying program (use /b with COPY, 
for example). 

Note that trends can be compressed when they are saved into a graph file. The option to compress 
trends concerns both saving trends with a workspace and into a graph file. You select to option to use 
compression in General Preferences of workspace preferences. 

You should use compression with care. Compressing and expanding can take considerable time and 
may require large amount of disk space for temporal files. 

We recommend that you use compression only, if an otherwise very big workspace or graph file needs 
to be transported by electronic means. Also, if you need to have a big collection of workspace or graph 
files, you may consider use of compression. 
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To save the currently shown trend, select Save As command residing in the Graph submenu of the File 
menu or in the context menus of Monitor Display or Datalogger Display. The command is disabled 
(grayed) if there is no trend shown in the trend display pane. 

 or  

If you want to save all trends, i.e., monitor and all uploaded dataloggers, select Save All command 
residing in the Graph submenu of the File menu. The command is disabled (grayed) if no trend exists. 

 

Anyway, a Save As dialog box is displayed. 

9.1.1 When the Save As dialog box is displayed: 

• From Save in, browse into the drive and directory, into which you want to save the graph file 
• Enter the name of the graph file into File name or, if you want to replace an existing file, click 

the filename you want to replace 
• Click Save and a file comment is requested 
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If the file already exists, confirmation to replace it is asked. 

 

9.1.2 When the File Comment dialog box is displayed: 

The comment field is empty by default. 

• Enter, add, edit, or accept the comment in the edit field 
• Click OK, and saving starts 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

See Also: Save As Dialog 
Restoring Trends  
How to Save Workspace 
Workspace Preferences 

10. Restoring Trends 
If monitor and/or uploaded dataloggers are saved with a workspace, they are restored with the 
workspace with proper settings of workspace preferences. 

However, we explain here restoring of trends from a graph (.dwt) file. See How to Restore Workspace 
and Workspace Preferences for restoring trends saved with a workspace. 

Saved trends are actually incomplete off-line workspaces, which contain just enough information to 
restore the graphs saved within them. Thus it is possible to open a graph (.dwt) file as a workspace, 
too. 

Note! Workspace (.dww) and graph (.dwt) files can contain binary data. Never edit a workspace or 
graph file. Also, if you are copying such a file, use a binary copying program (use /b with COPY, 
for example). 
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The restored trends can be viewed as if they were just collected. However, if the trends are restored 
from a graph file or from a workspace saved for off-line, DriveWindow goes off-line. 

Instead of first starting DriveWindow and then opening the graph file, you can in Windows Explorer, for 
example, double click the graph file. DriveWindow starts in off-line mode and opens immediately the 
trends saved in it. 

 

Otherwise, if you are going to restore trends from a graph while starting up DriveWindow, you need not 
to connect the OPC Server. So, click Cancel, when the Select OPC Server dialog box is displayed. 

 

Now that DriveWindow is disconnected, you can go off-line and restore your trends by opening a graph 
file. 

If you want to go off-line and restore trends from a graph file during a DriveWindow session, just open 
the graph (.dwt) file. 

See Also: Opening a Graph File  
Saving Trends 
How to Restore Workspace  
Workspace Preferences 
Off-line Mode 
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10.1 Opening a Graph File 

To open a graph file, select Open command residing in the Graph submenu of the File menu or in the 
context menus of Monitor Display or Datalogger Display. 

 or  

The same command is named Graph in the Open submenu in the context menu of Empty Browse 
Tree. 

 

10.1.1 When the Open dialog box is displayed: 

• From Look in, browse into the drive and directory, in which the graph file resides 
• Click the graph file you want to open 
• Click Open and DriveWindow goes off-line and restores the trend or trends from the graph file 

 

Note! You can also enter the name of the graph file into File name, with or without a directory path. 
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If DriveWindow is currently on-line, you are prompted about disconnecting the OPC Server (and about 
releasing control, if control is taken). 

 

See Also: Open Dialog 
Restoring Trends 

10.2 Viewing and Editing the File Comment 

When you have opened a graph file, you can view and edit the file comment that was saved with it. 

Select Comment command residing in the Graph submenu of the File menu or in the context menus of 
Monitor Display or Datalogger Display. 

 or   

Note! Because a graph file is actually a special workspace file, you can view and edit the comment as 
a workspace file comment, too. 

A File Comment dialog box is presented. It shows the comment in its edit field. The comment text is 
selected, which means that if you just start typing, the previous text is replaced by your new comment. 

 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 
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While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

When you are done with editing, click the OK button. Click the Cancel button, if you do not want to 
change the comment. 

See Also: Saving Trends 
How to Restore Workspace 

11. Printing Trends 
If you have a printer available, you are able to print the trends currently displayed in the trend display 
pane. Printing of a running monitor is not possible, however. 

Note that printing of trends is done by the graphical drawing package and is separate of all other 
printing within DriveWindow. 

11.1.1 Printing without a printer 

If you do not have a printer connected, but you have a printer driver installed, which allows you to print 
to a file, you can print to files. Later, when you have the printer connected, you can copy the files to the 
printer. For example, in DOS prompt, give command: 

Copy C:\Temp\MyPrint.prn/b LPT1: 

If you do not have a printer driver, or your printer driver is not able to print to a file, we recommend that 
you install Adobe Acrobat PDF Printer (included in Adobe Acrobat), which allows you to print to a file in 
PDF format. Some other printer driver with such kind of feature will also do the job. 

11.1.2 Preferences for printing 

In graph preferences you can control outlook of the printed trends. You can change colors of the trends 
(color printer only) and line styles. 

The preferences are separate for color and black-and-white printer. 

11.1.3 Printing 

Note that printing of a running monitor is not possible. 

If you have the graph cursor visible, it is printed, too. The scrollbars are not printed. 

To print the trends currently displayed in the trend display pane, select the Print command in the Graph 
submenu of the File menu or in the context menus of Monitor Display or Datalogger Display. 

 or  
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A Print Setup dialog box is presented. Now you can select the printer, paper size, orientation, and 
source. You can also do printer dependent adjustments by clicking the Properties button. 

 

Note that when a graph is printed, it is automatically expanded to fill the printing area of the selected 
paper. If your printer supports A4 and A3, for example, doubling the size of the paper from A4 to A3 
magnifies the printout to double, too. 

You probably want the print-out to look the same as it is displayed on your screen. So, you should set 
the paper orientation to landscape. 

Note that if you click the Cancel button, it does not cancel printing. Instead, any setup changes you 
made are discarded. The effect is the same as if you had clicked OK without making any setup 
changes. 

An Edit Graph Titles dialog box is presented next. 

 

If you have a black and white printer, please uncheck the Print in Color check field. 

If you have a color printer, please check the Print in Color check field. 

DriveWindow has filled the edit fields with its default values. If you wish, you can edit your own titles (or 
comments) into the edit fields of the dialog box. They will be located at the upper part of the print-out. 
When you are ready, click OK. If you want to cancel printing, click the Cancel button. 
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A dialog box, which also allows you to cancel the printing, is shown while DriveWindow is printing. 

 

In addition of the trends, the print-out contains the titles at the upper part, and explanations about the 
variables, how they are drawn, and their scaling in the lower part. 

 

See Also: Graph Preferences 
Viewing Trends 
File Menu 
Graph Submenu 
Context Menu of Monitor Display 
Context Menu of Datalogger Display 
Using Graph Cursor 
Monitor and Dataloggers 
Exporting Trends 
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12. Exporting Trends 
Exporting of trends means making them available for other applications. When you do the exporting, 
the trends exported are those currently displayed in the trend display pane. 

The simplest form of exporting the currently shown trends is copying of them to the clipboard. You can 
then paste the copied trends into another application, as long as the application supports pasting of 
graphics. 

In addition to support of copying trends to the clipboard, DriveWindow has the capability of exporting 
trends to a file. 

See Also: Viewing Trends 
Printing Trends  
Monitor and Dataloggers 
Copying Trends to the Clipboard 
Exporting Trends to a File 
Copying Items to the Clipboard 
How to Export Parameters 

12.1 Copying Trends to the Clipboard 

Occasionally you may want to paste trends into another application. To do so, you have to copy the 
trends into the clipboard first. 

To copy the trends currently displayed in the trend display pane to the clipboard, either select the Copy 
Graph command in the Edit menu or in the context menu of Monitor Display or Datalogger Display, or 
select the Copy command in the Graph submenu in the File menu. 

 or  or 

 

The currently displayed graph is copied to the clipboard. In the clipboard, the items are in picture 
format. 
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If you have an application, which understands the picture format, you can easily paste the items into 
such an application (Paint, Word, or Excel, for example). 

 

See Also: Exporting Trends 
Graph Submenu 
Edit Menu 
Exporting Trends to a File 
Copying Items to the Clipboard 
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12.2 Exporting Trends to a File 

The exported file has filename extension TXT. It contains (in ASCII format) information about currently 
shown trends in so called tab separated format. 

Note that an exported file is not meant for humans to read. Because it is for other applications, the 
accuracy of values is very big. Note also that the decimal symbol defined in the regional settings is 
used. So, extra care is required in exchanging exported files with other countries. 

The tab separated format is understood by many applications, by Word and Excel, for example, and 
can be easily imported in such kind of applications. 

Note that trends cannot be exported in XML-format. 

To export the currently shown trends to a file, select the Export command in the Graph submenu in the 
File menu or in the context menu of Monitor Display or Datalogger Display. 

 or  

An Export Graph to File is presented. 
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When the dialog box is displayed: 

• From Save in, browse into the drive and directory, into which you want to export the currently 
shown trends. 

• Enter the name of the export file into File name or, if you want to replace an existing file, click 
the filename you want to replace 

• Click Save and an Export Graph dialog box is presented. 

If the file already exists, confirmation to replace it asked, when you click Save. 

 

The Export Graph dialog box allows you to select: 

• Which of the channels to export. Note that channels not monitored or logged are grayed. 
• How many samples to export. 
• Whether to export the raw samples or shown points. 

In addition, you can edit or add a comment. 
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If you select first or last, an additional Samples field is shown. 

 

If you select range, two additional fields (From and To) are shown. 

 

Note that selecting all or visible also changes the Samples, From, and To fields to corresponding (all or 
visible) number of samples and to starting and ending point, although the fields are not shown. 

Also, changing measured/shown changes the Samples field, whether it is visible or not. 

So, it is better to edit the Samples or From and To fields after selecting the first/last/range and 
measured/shown. 

Note that the comment actually consists of one line, although it automatically wraps and scrolls within 
the edit field. Pressing the Enter key is actually the same as clicking the OK button. 

While editing, you can use the normal Windows shortcut and editing keys like the arrow keys, Home, 
End, Del, etc. keys, with or without Ctrl and/or Shift key down. Note, however, that pressing the Esc 
key is same than clicking the Cancel button. 

When you are ready, click OK. If you want to cancel the operation, click the Cancel button. 
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12.2.1 Examples of exported trends 

Note that contents of the exported files are quite similar, whether the monitor or a datalogger is 
exported. Exporting the monitor as measured differs most from the others, because the time stamp is 
exported for each sample of each exported channel. 

The following shows exporting of two monitor channels as measured. 
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When imported (opened) into Excel and adjusting widths of channels, the result is: 

 

The first two lines contain the file identification tag and the comment. 

The next two lines show the selections made in the Export Graph dialog box. An empty line separates 
them from the seven lines containing monitor settings other than monitored variables, but including the 
time at x-axis origin. 

The channel settings follow an empty line. After them there is an empty line and a title line. 

The rest contains the time stamps and unscaled monitored values. Note that the time stamps are 
relative to the x-axis origin. 
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The following shows exporting of the same two monitor channels as shown. 
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When imported (opened) into Excel and adjusting widths of channels, the result is: 

 

The beginning of the file contains the same information as in case the export was done as measured. 

The end part, however, does not include time stamps, but there is a common time for all channel 
values. The values are scaled, too. 
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The following shows exporting of the two datalogger channels as measured. 
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When imported (opened) into Excel and adjusting widths of channels, the result is: 

 

The beginning of the file contains the similar information as in case the monitor export was done as 
shown. 

There are differences, however. The file identification tag contains also the OPC address of the 
datalogger. There is no x-axis origin time. 

Because the values are as measured, they are unscaled. The only difference between a datalogger 
exported as measured and as shown is that the values in the previous case are unscaled, but in the 
latter they are scaled. 
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See Also: Exporting Trends 
Graph Submenu 
Context Menu of Monitor Display 
Context Menu of Datalogger Display 
Copying Trends to the Clipboard 
Handling of Exported Files 
How to Export Parameters 
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1. What is OPC Server 
An OPC Server is a software module, which implements OPC data access specification made by OPC 
Foundation (www.opcfoundation.org). OPC stands for “OLE for Process Control”. 

In principle, DriveWindow is able to act as a user interface for any OPC Server. 

However, DriveWindow contains many drive dependent features, which require that the OPC Server is 
DriveOPC. DriveOPC is included in the installation of DriveWindow. When you install DriveWindow, 
you get also DriveOPC installed. 

 

DriveOPC can be used also remotely through DCOM. DriveWindow has the ability to connect to a 
remote OPC Server, too. 

 

Internally, DriveWindow (since version 2.10) uses another OPC Server, OfflineOPC. It is used for 
saving graphs and workspaces for off-line as well as restoring graphs or simulating drives. 

There can be two versions of an OPC Server: 

• In-process server, which is a DLL. It can be used only locally. 
• Local server, which is an EXE. It is used at the remote end, but can also be used locally. 

Normally, DriveWindow uses locally the in-process server. There is only an in-process version of 
OfflineOPC. 

The OPC Server is not statically connected. The connection must be requested by the user. The user 
must also select the Server and the PC, which to connect. However, a user should never connect 
directly to OfflineOPC. 

Disconnecting is usually also requested by the user. 

Note that you can use DriveWindow as a remote client even if you do not have DDCS hardware 
installed locally. 

See Also: DriveOPC 
OfflineOPC 
Off-line Mode 
Off-line Connection 

2. Connecting to OPC Server 
Most operations done in DriveWindow require that you have connected to an OPC Server. Although, in 
principle, DriveWindow is able to act as a user interface for any OPC Server, it is required that the 
OPC Server is DriveOPC. 
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Note that you are able to open a parameter file and work with it without a connection to an OPC 
Server. 

Note also that when you are saving and restoring a workspace, connection is restored, too. Currently 
connected OPC Server is disconnected, if needed. Opening a graph file or a workspace saved for off-
line connects to OfflineOPC instead of a real OPC Server. 

Note that some DriveWindow operations require restarting of a drive. Restarting a drive initiated by 
DriveWindow does an internal disconnecting and reconnecting of the OPC Server. 

You are asked to connect to an OPC Server when DriveWindow is starting, unless you started 
DriveWindow by double clicking a file in NT Explorer (for example). 

If you are going to restore a workspace, click the Cancel button, and then open the workspace. 

If you are going to handle system software through the local DriveOPC, we recommend that you do not 
connect, but click the Cancel button 

If you are not connected to an OPC Server, you can request to be connected by selecting Network 
Servers from the Network menu or by pressing Ctrl+N. 

 

The same command can be found in the context menu, which you get by clicking with the right mouse 
button on the browse tree pane when it is empty and you are not yet connected. 

 

Note that if you already have connected to an OPC Server, you have to disconnect the current server 
first. 

Never connect directly to OfflineOPC. 

A Select OPC Server dialog box is presented: 
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If there are several OPC Servers listed, select ABB.SMP by clicking it. 

How to proceed, depends on, whether you want to connect to the local or a remote OPC Server. 

 

See Also: What is OPC Server 
Connecting to DDCS Network 
Local Connection 
Remote Connection 

2.1 Local Connection 

If you want to connect locally, select ABB.SMP by clicking it, and click the OK button, when the Select 
OPC Server dialog box is presented: 

 

Note that depending on your operating system and how it is configured, it may also be possible to 
connect to the local server (EXE) “remotely”. Typically, connecting remotely to \\localhost or 127.0.0.1, 
actually connects to the local server in the same PC. 

Connecting takes for a while, because DriveOPC identifies the DDCS network. The cursor turns to 
hour-glass and the status bar informs you about connecting. 

 

If you do not have DDCS hardware installed in your local PC, the communication library gives you an 
error message. 
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However, connection to the DriveOPC is established also in this case, but, of course, you cannot see 
any drives. So, you need to disconnect the OPC Server before trying a new connection. 

Since version 2.01 of DriveWindow (version 2.02 of DriveOPC), if another application program is 
already using the DDCS hardware, the communication library gives you an error message. 

 

In older versions, or if DriveOPC is configured to be used remotely, no message is shown. Connection 
to the DriveOPC is established, however, but you cannot see any drives. So, you need to disconnect 
the OPC Server before trying a new connection. 

Anyway, the current OPC Server without any PC indication is shown in the title bar: 

 

See Also: Connecting to OPC Server 
Remote Connection 

2.2 Remote Connection 

Because of security risks involved in DCOM, we do not recommend using DriveOPC remotely. 

If you want to connect remotely, select ABB.SMP by clicking it, when the Select OPC Server dialog box 
is presented. 

Mark the check field “From a Remote PC” by clicking it. 

Enter the fully qualified domain name, the IP address, or the UNC name of the remote computer into 
the edit field, and click the OK button: 
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Note that depending on your operating system and how it is configured, it may also be possible to 
connect to the local server (EXE) “remotely”. Typically, connecting remotely to \\localhost or 127.0.0.1, 
actually connects to the local server in the same PC. 

Connecting takes for a while, because of establishing the DCOM and because DriveOPC identifies the 
DDCS network (unless it is already running because of another client). The cursor turns to hour-glass 
and the status bar informs you about connecting. 

 

If the remote computer does not exist, it is down, or it is not configured properly for remote use (RPC 
service has not been started), you will get an error message. 

 

If you are not allowed to access the remote computer, you will get an error message. 

 

On-line features require that the remote computer connects to your computer. If your computer 
protection does not allow the remote to connect, DriveWindow is able to connect, but the on-line 
features do not function. Indication of this is that you get several times a message box telling that the 
remote computer cannot use on-line features (one message box for each on-line feature). 

 

If you click No to any of the messages, DriveWindow stops immediately trying to connect and stays off-
line. 
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If connecting succeeded, the current OPC Server with the remote PC indication is shown in the title 
bar: 

 

 

 

However, note that connection is made even if the remote OPC Server is not able to use the 
communication hardware (it is currently used by some other application, for example). DriveWindow 
just does not show any drives in such a case. 

See Also: Connecting to OPC Server 
Local Connection 

2.3 Off-line Connection 

Since version 2.10, DriveWindow is able to work also off-line by the help of OfflineOPC. 

You never connect directly to OfflineOPC. DriveWindow goes off-line when you either restore a 
workspace that was saved for off-line, or open a saved graph file (.dwt). 

In off-line mode the look and feel of DriveWindow are the same as if it was really connected to drives. 

You can differentiate between on-line and off-line mode by looking at the Network (OPC) server in the 
title bar of DriveWindow. In off-line mode, the server name is ABB.OfflineOPC, while in on-line mode it 
is ABB.SMP (or perhaps some other real OPC Server). 

  

You exit off-line mode by either disconnecting the OPC Server, or by opening a workspace that was 
not saved for off-line. 

See Also: What is OPC Server 
OfflineOPC 
Off-line Mode 

 

 

3. Information about OPC Server 
If you want information about the currently connected OPC Server, select Network Server Status from 
the Network menu. 
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An OPC Server Status dialog box is presented. 

 

Information of special interest to you might be, whether the in-process server (DLL) or local server 
(EXE) is in use. You can also see version and build numbers. 

Click the OK button to close the dialog box. 

See Also: What is OPC Server 
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4. Viewing and Changing OPC Settings 
The OPC settings of the on-line items or faults and events of the currently shown item set can be 
viewed and changed. Each item set has settings of its own. 

Actually OPC settings can be regarded as properties of the item set. However, you seldom need to 
make any changes to them, so they are presented separately in DriveWindow. 

Note that that each item set has an OPC group of its own. To keep the communication traffic low, only 
the group of the currently displayed item set is made active. 

Note that the changes you make are saved/restored with a workspace. 

We discourage you to make any changes. Only if you are connected to a remote OPC Server with a 
relatively slow network, and/or you want to have a huge amount of items on-line in an item set, you can 
use bigger update rate than the normal (local: 1 s, remote: 3 s) for that item set. 

Note that there are also other groups in the OPC Server used by DriveWindow. However, you are not 
able to view and change their settings. 

To view or change the OPC settings of the currently displayed item set, select the OPC Settings 
command from the Item Set submenu of the Desktop menu. 

 

An OPC Settings dialog box is presented. 

 

If the OPC Server is DriveOPC, the values Deadband, Time Bias, and LCID are not used, although 
accepted, by the server. 

Note! Do not uncheck the Active field. If you do, updating of the on-line values ceases, because the 
thread doing the reading in the OPC Server stops. 

In practice, the only field you may change is Update Rate. 
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If you did not make any changes, click the Cancel button. 

Clicking the OK button writes the new values to the OPC Server and closes the dialog box. 

Clicking the Apply button writes the values to OPC Server without closing the dialog box. 

Note that you cannot cancel the values already written by clicking Apply. Actually, clicking first Apply 
and then Cancel has the same effect as clicking OK. 

See Also: What is OPC Server 

5. Disconnecting OPC Server 
Note that you do not need to disconnect the OPC Server in case you are opening a graph (.dwt) file or 
a workspace (.dww) file. DriveWindow does it automatically, if required, before connecting to a new 
OPC Server. 

To disconnect the currently connected OPC Server, select Disconnect Server from the Network menu 
or by pressing Ctrl+Shift+N. 

 

The same command can be found in the context menu, which you get by clicking with the right mouse 
button on the browse tree pane when it is empty while you are connected, i.e., there is no drive and you 
do not have a parameter file open. 

 

If you have control taken, you need to confirm releasing of control. 
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After successful disconnection, <Disconnected> is shown in the title bar: 

 

Side effects of disconnecting are: 

• Control is released. 
• The monitor is stopped and cleared. All channels are removed from the monitor. 
• No status refresh in the browse tree pane. 
• No status refresh of dataloggers. 
• All uploaded dataloggers are cleared. All those settings, which are not preserved in a drive, 

are set to their default values. 
• Open parameter file is closed. Note that a request for saving unchanged changes may be 

shown. 
• The browse tree pane is cleared. 
• The item sets are cleared. Note that all locked items are unlocked and there will be no item 

on-line. However, templates in user item sets are not deleted. 

Note that disconnecting does not close an open backup or loading package. 
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Note that some DriveWindow operations require restarting of a drive. Restarting a drive initiated by 
DriveWindow does an internal disconnecting and reconnecting of the OPC Server. The side effects of 
disconnecting are still valid, but re-connecting brings back the drives into the browse tree pane. Their 
order and possibly node addresses may have changed, however. Also, all drive sub-branches will be 
collapsed. 
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5.1.1 Automatic disconnecting of the OPC Server 

The OPC Server is automatically disconnected when you: 

• Open a graph file, which puts DriveWindow off-line. 
• Restore a workspace, which was not connected to the currently connected OPC Server. 
• Close DriveWindow. 
• Log off or shut down Windows operating system. 
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Since DriveWindow version 2.11 you have to confirm the automatic disconnection in the two first 
cases, e.g.: 

 

See Also: What is OPC Server 
Connecting to OPC Server 

6. Using DriveDA 
DriveDA is another OPC Server designed to handle ACS880 family of drives. It is not included in 
DriveWindow, however. You need to install a DriveWare product (such as Drive composer pro) that 
contains it before you can use it with DriveWindow. 

In addition to be able to connect natively to ACS880 family of drives, DriveDA can connect to another 
OPC Server. All devices of such an OPC Server are seen by the client program as devices of DriveDA. 

 

This feature allows you to operate with a mixture of ACS800 and ACS880 families of drives in 
DriveWindow. However, DriveWindow has only a basic support for ACS880 family of drives. There are 
several features missing or not working. 
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If DriveDA is installed, you see it listed in the Select OPC Server dialog box when selecting the OPC 
Server to connect to. If you want to connect to DriveDA, select ABB.DriveDA instead of ABB.SMP. 

 

If you have ACS880 family of drives only and you have no DDCS communication hardware in your PC, 
you may get tired about the message complaining about it each time you connect to DriveDA. 

 

There are two ways to get rid of this message. 

If you occasionally need to connect to an ACS800 family of drive, we recommend that you add or edit 
[OPC] section in the file dwc_def.ini: 

[OPC] 
Remote=1 

The file is located in: 

• Documents and Settings\All Users\Application Data\DriveWare (WinXP), or 
• Program Data\DriveWare (WinVista/7/8) 
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If you never (or seldom) need to connect to an ACS800 family of drive, we recommend that you advice 
DriveDA not to connect to DriveOPC at all by setting Count=1 in the [Servers] section of the file 
DriveDA.ini: 

[Servers] 
Parallel=1 
Count=1 
[Servers.0] 
Name=ABB.DriveDA 
ParallelChannels=1 
[Servers.1] 
Name=ABB.SMP 

The file is located in: 

• Documents and Settings\All Users\Application Data\DriveWare (WinXP), or 
• Program Data\DriveWare (WinVista/7/8) 

See Also: Connecting to OPC Server 

7. Configuring DDCS/UDP 
DriveWindow 2.40 (actually DriveOPC 2.10 included in it) supports a new DDCS/UDP protocol, which 
allows the DDCS fibre optic network to be connected to the PC over Ethernet network. It requires a 
device supporting the protocol, such as NETA-21. 
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7.1.1 Enabling NETA-21 DDCS Gateway 

Factory settings of NETA-21 have the DDCS gateway disabled in NETA-21. To be able to use 
DDCS/UDP, the gateway has to be enabled. To do that you use a web browser to connect to the 
NETA-21 IP address. You need to know a user name and password to get logged in. Then navigate to 
Settings -> Device interfaces, select DDCS tab and click Settings. 

 

Interface settings dialog box is displayed. Select Enable from Ethernet GW, click Save and finally log 
out. 

 

7.1.2 Configuring DDCS/UDP 

DDCS/UDP configuration information is kept in dwc_NETA.ini file, which resides in: 

• Documents and Settings\All Users\Application Data\DriveWare (WinXP), or 
• Program Data\DriveWare (WinVista/7/8) 

The DDCS/UDP Configuration dialog boxes actually implement a special INI-file editor. 
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Configuring is done by selecting DDCS/UDP from the Configuration submenu of the Network menu. 
Note that the DDCS/UDP command is grayed if you are connected to an OPC Server. Configuring can 
only be done while OPC Server is disconneced. 

 

The DDCS/UDP Configuration dialog box is opened and you can choose the configuration to work with. 
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7.1.3 Configurations 

You can have several readymade configurations (for different sites, for example), but only one of them 
is in use when you connect to DriveOPC. 

With the exception of the Default configuration, you can add, rename, and delete configurations of your 
own.  All configurations can be edited and copied to a new. You can select to operation either from the 
Edit menu or the context menu, which is shown when you right click Current configuration drop down 
list. 

 or 

 

Note that you can delete the selected Current configuration also by hitting the Del key. 

 A configuration can contain any combination of the following methods of connecting to DDCS/UDP 
devices: 

• A list of fixed IPs (not in the Default configuration). 
• Devices near, i.e., all devices in the local Ethernet segment (searched by broadcast). 
• Intranet devices, i.e., all devices in the same subnet as the PC (searched by broadcast). 
• A list of remote subnets identified by an IP address and subnet mask (not in the Default 

configuration). 

Actually a fixed IP is a special case of remote subnet having the subnet mask 255.255.255.255. 
However, you can specify a fixed channel number for it, which is not possible in other methods. 

In practise you use only configurations that have just fixed IPs. The methods using broadcast could be 
used in training or other conditions having DDCS/UDP devices, IP addresses of which change 
frequently. 
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7.1.4 Testing a Configuration 

To test the selected Current configuration, click the Test button. If the button is grayed, you either have 
an old version of DriveOPC (actually its communication library) or some other application is currently 
using the communication library. 

 

A dialog box containing a list of DDCS/UDP devices found by the selected Current configuration is 
displayed. Note that the test does not check that there are drives in the DDCS network of the device. 
So it is possible that although there are DDCS/UDP devices found, no drive is found when 
DriveWindow is connected to DriveOPC. 

 

If the test does not find any DDCS/UDP devices, instead of a dialog box a message box is shown. 
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7.1.5 Saving Changes 

To save any changes made into the DDCS/UDP configurations, click the OK button in the DDCS/UDP 
Configuration dialog box. 

 

7.1.6 Editing a Configuration 

Typically, you seldom edit the Default configuration. 

To edit a configuration, first select it as the Current configuration and then select Properties from the 
Edit or context menu. 

 or 
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The configuration Settings dialog box is displayed. 

 

Typically default values, i.e., values defined in the Default configuration, are used. The important 
exception is that DDCS/UDP Communication is enabled because it is usually disabled by default. 

Not all of the settings are shown in the dialog box. Settings for searching DDCS/UDP devices near or 
intranet devices, settings for each fixed IP and remote subnets listed in FixedIPs / Remote Subnets are 
presented in separate dialog boxes. 
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7.1.7 Settings for Devices Near or Intranet Devices 

To edit settings for searching DDCS/UDP devices near or intranet devices, click the Near Devices or 
Intranet Devices button in the Communication group of the dialog box for Settings of a configuration. 

 

The Search Devices Near or Search Intranet Devices Settings dialog box for the configuration is 
displayed. The dialog boxes differ only by the title. 
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7.1.8 Settings for Fixed IPs or Remote Subnets 

To edit settings for a Fixed IP or a Remote Subnet, either select it by clicking it in the Fixed IPs / 
Remote Subnets list in the dialog box for Settings of a configuration and then select the Properties 
command from the Edit menu, or right click it in the Fixed IPs / Remote Subnets list and select 
Properties command from the context menu displayed. 

 

or   

The Fixed IP / Remote Subnet Settings dialog box for the configuration is displayed. 
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7.1.9 Adding and Deleting Fixed IPs or Remote Subnets 

Commands for adding and deleting a Fixed IP or a Remote Subnet can be found in the Edit menu of 
the dialog box for Settings of a configuration and in the context menu, which is displayed if you right 
click the Fixed IPs / Remote Subnets listing in the dialog box. 

  or   

Note that you can delete the selected Fixed IP or Remote Subnet also by hitting the Del key. 

Note also that if there is no entry in the Fixed IPs / Remote Subnets list or no entry is selected, all other 
commands than New are grayed in the menu. 

 

7.1.10 Adding and Deleting Fixed IPs by Finding Devices 

Note that the Find operation works only if the (default) UDP port 61332 is free and not blocked by the 
firewall. Any changes for the port settings made in the DDCS/UDP configurations are not used in 
finding the DDCS/UDP devices. 

To find IP addresses of DDCS/UDP devices near or intranet devices, click the Near Devices or Intranet 
Devices button in the Find group of the dialog box for Settings of a configuration. 
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The Devices Found dialog box is displayed. 

 

On the left side you have a list of DDCS/UDP devices found that are not included in the selected 
Current configuration. On the right side you have a list of DDCS/UDP devices found that are included 
in the selected Current configuration. 

Note that a DDCS/UDP device included in the selected Current configuration that is not found is not 
displayed in either of the lists. So you can manipulate here only the devices found. 
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Now you can: 

• Add all found devices not yet included by clicking the >> button 
• Delete all found devices currently included by clicking the << button 
• Add selected devices not yet included by selecting them by clicking (with Ctrl or Shift key 

down) in the Exclude list and then clicking the > button. 
• Delete selected devices currently included by selecting them by clicking (with Ctrl or Shift key 

down) in the Include list and then clicking the > button. 

For example: 
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Finally click OK to get back to the dialog box for Settings of a configuration. 

 

The changes can now be seen in the Fixed IPs / Remote Subnets list. 
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7.1.11 Typical Workflow 

When you come to a site having NETA-21 devices in an Ethernet segment already configured to have 
the DDCS gateway enabled, your workflow may be as explained here. 

The first thing is to put the NETA-21 devices on and wait 3-5 minutes to get them up and running. 

Then start DriveWindow, but do not connect to an OPC Server. 

 

Select DDCS/UDP from Configure submenu of the Network menu. 

 

Select New from the Edit menu in the DDCS/UDP Configuration dialog box. 
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Enter a name for the new configuration that you can easily associate with the site and click OK. 
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In the Settings for the new configuration dialog box enable DDCS/UDP Communication. Make other 
setting changes common for all or many of the DDCS/UDP devices in this configuration (like the node 
numbers and presence of a branching unit in the DDCS/UDP device DDCS network). Instead of 
adding each IP manually, they can be added by clicking Find Near Devices. 

 

The order of changing the settings and adding the IP addresses is immaterial. 
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In the Devices Found dialog box select the devices you want to connect to with the new configuration. 
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Click OK. 
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If a DDCS/UDP device requires specific settings deviating from the common settings for the new 
configuration, right click its IP address in the Fixed IPs / Remote Subnets list in the Settings for the new 
configuration dialog box and select Properties. You can use the Edit menu as well. 

 

Change the settings you want to (like use a specific channel number and state that there is, or may be, 
a branching unit in the DDCS network of this DDCS/UDP device if the configuration common setting 
states that in general there a no branching units). Finally, click OK. 
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In the settings for the new configuration Settings dialog box click OK when you are done. 
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In the DDCS/UDP Configuration dialog box click OK to save the new configuration and set it as Current 
configuration. 

 

Select Network Servers from the Network menu (or press Ctrl+N). 

 

Select ABB.SMP from  the Select OPC Server dialog box and click OK. 
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Now you see the drives connected to the DDCS/UDP devices in the browse tree pane. 

 

If you want to see the device type used for connecting to a DDCS network and the IP address of the 
device (if it has one),  browse to Properties -> Communication in the browse tree pane and look at the 
browsed item set in the item sets pane. 

 

See Also: DDCS/UDP Settings 
Connecting to OPC Server 
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7.2 DDCS/UDP Settings 

Note that if a DDCS/UDP setting contains an invalid value the OK button in the dialog box is grayed. 

 

Communication group  

 

It contains: 

• DDCS/UDP group, which is used to enable or disable DDCS/UDP communication for the 
selected Current configuration. Typically, DDCS/UDP communication is disabled by default. 

• Buttons (Near Devices and Intranet Devices) for settings of the broadcast search methods. 
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UDP Port group  

 

It contains: 

• Number, which is the PC UDP port number used for DDCS/UDP communication. The port 
defined must not be blocked by the firewall of the PC. Note that if the default port 61332 is 
blocked, the Find functionality of the configuration dialog boxes does not work because Find 
always uses port 61332. 

• Selection, which allows searching and using a free port in case the defined port number is 
reserved by another application at connection time. The search range is 49152...65535. It 
means that none of the ports in the range must be blocked by the firewall of the PC.  

Device Busy group  

 

When connection to a NETA-21 is made, it takes time before it enters into the DDCS gateway mode. 
The Device Busy group defines settings for this wait: 

• Wait Timeout is the maximum time that the PC waits for a NETA-21 going to the gateway 
mode. 

• Poll Interval defines how often the PC checks the busy status of a NETA-21 while it is going to 
the DDCS gateway mode.  
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Device Mastership group  

 

Only one application can use the DDCS network of a DDCS/UDP device at a time. The client requests 
mastership of the device. Only the client having mastership can use the DDCS network. All others are 
rejected by the device. However, if there is no DDCS traffic for a specified time, the device 
automatically releases the mastership. 

The Device Mastership group defines settings for this behaviour: 

• Watchdog Timeout is the time that the DDCS/UDP device waits before it automatically 
releases the mastership when DDCS traffic ceases. 

• Force means that the connecting client gets the mastership even if another client already has 
it.  It means the other client can no more communicate through the DDCS network. Typically 
you use forcing in a case where a client has crashed and not freed its mastership. 

Remote Subnet Size group  

 

Size of a remote subnet is 2z, where z is number of zero bits in the Remote Mask. Because remote 
subnet devices are searched by querying each IP address in the subnet specified by IP and Remote 
Subnet, start-up time may be very long for large subnets. A Remote Subnet is skipped at connection 
time if its size exceeds the limits defined in the Remote Subnet Size group. 

The group contains: 

• Maximum defines the maximum size of a remote subnet. 
• Absolute maximum is used instead in case it is less than Maximum. 
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Search Devices group  

 

The group defines, whether the broadcast methods are used to search DDCS/UDP devices at 
connection time or not. Typically you never use both of them. 

The group contains: 

• Near means that local Ethernet segment UDP broadcast (IP=255.255.255.255, RFC 919) is 
used. 

• Intranet means that the PC subnet UDP broadcast (IP=IP or not subnet mask, RFC 922) is 
used. Note that if the PC belongs to several subnets, all of them are broadcasted. 
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Device Request group  

   

The group defines parameters for querying presence of DDCS/UDP devices. If you have trouble to 
connect to DDCS/UDP devices, you can try to increase Tries and/or Response Wait. The drawback is 
that connect and possibly disconnect times will increase. 

The group contains: 

• Tries defines how many times a broadcast message is sent if a broadcast method is used 
and maximum number of tries an IP address is queried. 

• Response Wait is the time (broadcast methods) or maximum time (IP address) a response to 
a query is waited for. 

• Parallel Requests is the number of query messages sent before starting to wait responses. 
• Mute Time is used in broadcast queries to prevent already found DDCS/UDP devices causing 

unnecessary responses while further broadcast queries are still made. 
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DDCS Read Timeout group  

 

The group defines timeouts for various DDCS read messages. 

If you have trouble to find the drives in the DDCS network connected to the DDCS/UDP device when 
the DDCS/UDP device is found (Test button in DDCS/UDP Configuration dialog box), you can try to 
increase Identify timeout. The drawback is that connect time will increase. By delimiting number of 
nodes in the DDCS Nodes group you can compensate the increase. 

Note that Status and Data timeouts can be prolonged considerably without slowing down the 
communication speed because they actually take effect just when an UDP message is lost. If you have 
problems with system software backup/restore you can try to increase the Data read timeout. 

The group contains: 

• Status defines the timeout for DDCS/UDP device DDCS register read. 
• Date defines the timeout for getting response from a drive in the DDCS network. 
• Identify tells the maximum time to wait a response from a drive in the DDCS network when 

querying its presence. Note that the timeout for all devices can be prolonged by 
recshorttimeout_ms in the [DWC_DDCS] section of the file dwc_def.ini. 
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DDCS Nodes group  

 

The group defines the node numbers of drives and whether there is a branching unit in the DDCS 
network of the DDCS/UDP device. These settings are used for shortening the start-up time in case you 
have detailed knowledge about the DDCS networks. Typically presence of all node numbers (1...254) 
in a DDCS network is queried and the presence of branching units is assumed by default. The group 
contains: 

• Node List is a comma separated list of nodes or node ranges of drive node numbers, 
presence of which are queried. A range -n means 1-n and n- means n-254. 

• Branching Unit can be used to specify that there are no branching units in the DDCS network 
of the DDCS/UDP device. 

Device Addresses group  

   

The group defines the IP address (Fixed IP) or an IP address and subnet mask (Remote Subnet). 

Fixed IP is actually a special case of a Remote Subnet with Remote Mask 255.255.255.255. You can 
specify a fixed Channel Number for a Fixed IP, however, which you cannot do for other kind of Remote 
Subnets. 

Channel Numbers specified must not overlap. Note that channel numbers of NDPA-02 and RUSB-02 
devices present are always numbered continuously starting from zero. A device specification having an 
overlapping Channel Number is disregarded at connection time. 



OPC Server 

DriveWindow 2 7-45 

Note also that if you connect through DriveDA OPC server, the channel numbers of all DriveOPC 
devices are shifted after the last channel number of the native DriveDA channels. 

The group contains: 

• IP Address defines the IP address (Fixed IP) or one of the IP addresses of a Remote Subnet. 
• Remote Mask is used to specify, whether the group defines a Fixed IP or a Remote Subnet. 

In case of the Remote Subnet the subnet mask has to be given (default is 255.255.255.255, 
which falls back to Fixed IP). 

• Channel Number can specify a fixed channel number (possibly shifted in case of DriveDA 
OPC server) for a Fixed IP. Negative value (-1) means automatic numbering (Auto). 

See Also: Configuring DDCS/UDP 
Connecting to OPC Server 
Using DriveDA 

8. Configuring SAP/http 
If DriveDA is installed (not included in DriveWindow), DriveWindow 2.40 is able to configure DriveDA 
communication as well. 

Most of the configuration concerns the SAP/http protocol, but you can configure the use of COM-ports 
that DriveDA tries to use for RS-485 communication. 
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8.1.1 Enabling NETA-21 Panel Gateway 

Factory settings of NETA-21 have the panel gateway disabled in NETA-21. To be able to use SAP/http, 
the gateway has to be enabled. To do that you use a web browser to connect to the NETA-21 IP 
address. You need to know a user name and password to get logged in. Then navigate to Settings -> 
Device interfaces, select PNL tab and click Settings. 

 

Interface settings dialog box is displayed. Cable check should be enabled whether the panel gateway is 
enabled or not. Select Enable from Ethernet GW, click Save and finally log out. 

 

8.1.2 Configuring SAP/http 

SAP/http configuration information is kept in dac_ETH.ini file, which resides in: 

• Documents and Settings\All Users\Application Data\DriveWare (WinXP), or 
• Program Data\DriveWare (WinVista/7/8) 

The SAP/http Configuration dialog boxes actually implement a special INI-file editor. 
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Configuring is done by selecting SAP/http from the Configuration submenu of the Network menu. Note 
that the SAP/http command is grayed if you are connected to an OPC Server or if you do not have 
DriveDA installed. Configuring can only be done while OPC Server is disconnected. 

 

The SAP/http Configuration dialog box is opened and you can choose the configuration to work with. 
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8.1.3 Configurations 

You can have several readymade configurations (for different sites, for example), but only one of them 
is in use when you connect to DriveDA. 

With the exception of the Default configuration, you can add, rename, and delete configurations of your 
own.  All configurations can be edited and copied to a new. You can select to operation either from the 
Edit menu or the context menu, which is shown when you right click Current configuration drop down 
list. 

 or 

 

Note that you can delete the selected Current configuration also by hitting the Del key. 

 A configuration can contain any combination of the following methods of connecting to SAP/http 
devices: 

• A list of fixed IPs (not in the Default configuration). 
• Devices near, i.e., all devices in the local Ethernet segment (searched by broadcast). 
• Intranet devices, i.e., all devices in the same subnet as the PC (searched by broadcast). 

In Addition you can configure the use of COM-ports that DriveDA tries to use for RS-485 
communication. 

In practise you use only configurations that have just fixed IPs. The other methods using broadcast 
could be used in training or other conditions having SAP/http devices, IP addresses of which change 
frequently. 
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8.1.4 Testing a Configuration 

To test the selected Current configuration, click the Test button. If the button is grayed, you probably 
have an old version of DriveDA (actually its communication module) installed. 

 

A dialog box containing a list of COM-ports and SAP/http devices found by the selected Current 
configuration is displayed. Note that the test does not check that there are drives in the RS-485 
networks of a NETA-21. So it is possible that although there are SAP/http devices found, no drive is 
found when DriveWindow is connected to DriveDA. Note also that NETA-21 devices are found even if 
its panel gateway is disabled. However, no drive can be found when DriveWindow connects to 
DriveDA. 

 

If the test does not find any COM-ports or SAP/http devices, instead of a dialog box a message box is 
shown. 
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8.1.5 Saving Changes 

To save any changes made into the SAP/http configurations, click the OK button in the SAP/http 
Configuration dialog box. 

 

8.1.6 Editing a Configuration 

Typically, you seldom edit the Default configuration. 

To edit a configuration, first select it as the Current configuration and then select Properties from the 
Edit or context menu. 

 or 
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The configuration Settings dialog box is displayed. 

 

Typically default values, i.e., values defined in the Default configuration, are used. An exception is that 
SAP/http Communication may require enabling because it may be disabled by default. 

Not all of the settings are shown in the dialog box. Settings for each fixed IP listed in FixedIPs are 
presented in a separate dialog box. 
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8.1.7 Settings for Fixed IPs 

To edit settings for a Fixed IP, either select it by clicking it in the Fixed IPs list in the dialog box for 
Settings of a configuration and then select the Properties command from the Edit menu, or right click it 
in the Fixed IPs list and select Properties command from the context menu displayed. 

 

or   

The Fixed IP Settings dialog box for the configuration is displayed. 
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8.1.8 Adding and Deleting Fixed IPs 

Commands for adding and deleting a Fixed IP can be found in the Edit menu of the dialog box for 
Settings of a configuration and in the context menu, which is displayed if you right click the Fixed IPs 
listing in the dialog box. 

 or   

Note that you can delete the selected Fixed IP also by hitting the Del key. 

Note also that if there is no entry in the Fixed IPs list or no entry is selected, all other commands than 
New are grayed in the menu. 

 

8.1.9 Adding and Deleting Fixed IPs by Finding Devices 

Note that the Find operation works only if the UDP port 24576 is free and not blocked by the firewall. 

To find IP addresses of SAP/http devices near or intranet devices, click the Near Devices or Intranet 
Devices button in the Find group of the dialog box for Settings of a configuration. 

 



OPC Server 

7-54 DriveWindow 2 

The Devices Found dialog box is displayed. 

 

On the left side you have a list of SAP/http devices found that are not included in the selected Current 
configuration. On the right side you have a list of SAP/http devices found that are included in the 
selected Current configuration. 

Note that a SAP/http device included in the selected Current configuration that is not found is not 
displayed in either of the lists. So you can manipulate here only the devices found. 
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Now you can: 

• Add all found devices not yet included by clicking the >> button 
• Delete all found devices currently included by clicking the << button 
• Add selected devices not yet included by selecting them by clicking (with Ctrl or Shift key 

down) in the Exclude list and then clicking the > button. 
• Delete selected devices currently included by selecting them by clicking (with Ctrl or Shift key 

down) in the Include list and then clicking the > button. 

For example: 
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Finally click OK to get back to the dialog box for Settings of a configuration. 
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The changes can now be seen in the Fixed IPs list. 

 

Note that if a new NETA-21 is added, both of its RS-485 buses are included and the channels are not 
shown in the Fixed IPs list. When DriveDA connection is made, DriveDA  connects automatically to 
both buses, i.e., two channels are reserved. 

8.1.10 Typical Workflow 

When you come to a site having SAP/http devices in an Ethernet segment, your workflow may be as 
explained here. 

Note that until you connect to the DriveDA OPC server, it is not necessary to have the panel gateway 
of NETA-21 enabled. 

The first thing is to put the SAP/http devices on and wait 3-5 minutes to get them up and running. 

Then start DriveWindow, but do not connect to an OPC Server. 

 

Select SAP/http from Configure submenu of the Network menu. 
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Select New from the Edit menu in the SAP/http Configuration dialog box. 

 

Enter a name for the new configuration that you can easily associate with the site and click OK. 
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In the Settings for the new configuration dialog box enable SAP/http Communication. Make other 
setting changes common for all or many of the SAP/http devices in this configuration. Instead of adding 
each IP manually, they can be added by clicking Find Near Devices. 

 

The order of changing the settings and adding the IP addresses is immaterial. 
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In the Devices Found dialog box select the devices you want to connect to with the new configuration. 

 



OPC Server 

DriveWindow 2 7-61 

Click OK. 
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If a SAP/http device requires specific settings deviating from the common settings for the new 
configuration, right click its IP address in the Fixed IPs list in the Settings for the new configuration 
dialog box and select Properties. You can use the Edit menu as well. 

 

Change the settings you want to (like use one panel bus only of a NETA-21, use a specific channel 
number, or use the device anyway if it does respond to presence querying at the time you connect to 
the DriveDA OPC server). Finally, click OK. 
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In the settings for the new configuration Settings dialog box click OK when you are done. 

 

In the SAP/http Configuration dialog box click OK to save the new configuration and set it as Current 
configuration. 
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Select Network Servers from the Network menu (or press Ctrl+N). 

 

Select ABB.DriveDA from  the Select OPC Server dialog box and click OK. 

 

Now you see the drives connected to the SAP/http devices in the browse tree pane. 
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If you want to see the information about the device used for connecting to a drive,  browse to 
Properties -> Communication in the browse tree pane and look at the browsed item set in the item sets 
pane. 

 

Note that if you have specified in the Current configuration of SAP/http that presence of the SAP/http 
device is not checked at all or, if it did not respond to presence queries but you have specified that it is 
used anyway, other information than the URL is not available. 

 

See Also: SAP/http Settings 
Connecting to OPC Server 
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8.2 SAP/http Settings 

Note that if a SAP/http setting contains an invalid value the OK button in the dialog box is grayed. 

 

Communication group  

 

The group contains a SAP/http group, which is used to enable or disable SAP/http communication for 
the selected Current configuration. It may be that SAP/http communication is disabled by default. 
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Device Request group  

 

The group defines parameters for querying presence of SAP/http devices. If you have trouble to 
connect to SAP/http devices, you can try to increase Tries and/or Response Wait. The drawback is 
that connect and possibly disconnect times will increase. 

The group contains: 

• Tries defines how many times a broadcast message is sent if a broadcast method is used 
and maximum number of tries an IP address is queried. 

• Response Wait is the time (broadcast methods) or maximum time (IP address) a response to 
a query is waited for. 

• Try Cycle Time is the time between query messages sent. Note that Denial of Service 
prevention in SAP/http devices does not allow responding to queries coming within 2 seconds 
of receiving the previous query. 

COM Ports group  

 

Your PC may have very many COM ports, most of which are not used for communicating with SAP 
devices. Trying to find drives from all of them slows down start-up considerably. 

In COM Ports group you can specify, which COM ports are not used for SAP communication: 

• Disable All specifies that no COM port is used for SAP communication. It means that only 
SAP/http Ethernet communication is used. 

• Disable Ports is a comma separated list of COM port numbers or number ranges which are 
not used for SAP communication. A range -n means 0-n and n- means n-4294967295. 
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Search Devices group  

 

The group defines, whether the broadcast methods are used to search SAP/http devices at connection 
time or not. Typically you never use both of them. 

The group contains: 

• Near means that local Ethernet segment UDP broadcast (IP=255.255.255.255, RFC 919) is 
used. 

• Intranet means that the PC subnet UDP broadcast (IP=IP or not subnet mask, RFC 922) is 
used. Note that if the PC belongs to several subnets, all of them are broadcasted. 

Device group  

 

The group defines the IP address (Fixed IP) of a SAP/http device. 

Channel Numbers specified must not overlap. A device specification having an overlapping Channel 
Number is disregarded at connection time. 
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Note that the channel numbers of all DriveOPC devices (if any) are shifted after the last channel 
number of the native DriveDA channels. 

The group contains: 

• IP Address defines the IP address (Fixed IP). 
• No Check in the Presence group specifies that the presence of the device is not queried at 

start-up. Although it may speed up the start-up, most of the Communication Properties is not 
available. 

• Use Anyway in the Presence group specifies that the presence of the device is queried at 
start-up but, if it does not respond, it is used anyway. If the device does not respond to 
presence queries, most of the Communication Properties is not available. 

• Channel Number can specify a fixed channel number for a Fixed IP. Negative value (-1) 
means automatic numbering (Auto). 

Protocol group  

 

The group contains NETA-21 specific settings. 

Note that if both NETA-21 panel buses are in use, the device is either shown twice in Fixed IPs list with 
/1 and /2 appended. However, if Find is used for adding IP addresses, it is shown just once but without 
an appended bus number. A NETA-21 without an appended bus number means actually two channels, 
.i.e., both buses are in use. 

Note also that if both NETA-21 panel buses are in use, you cannot specify a fixed Channel Number for 
the device. If you want to do that, you should specify the same device IP twice, one for each of the 
panel buses. 

The group contains: 

• NETA specifies, whether the SAP/http device is NETA-21 or not. 
• NETA Channels specifies which of the panel buses of the NETA-21 is used. Also both of 

them can be used. 

See Also: Configuring SAP/http 
Connecting to OPC Server 
Using DriveDA 
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See Also: System Software Submenu 

1. Definitions 
• System Software 
• Backup Package 
• Loading Package 

1.1 What is System Software 

System Software consists of all the persistent "files" that are saved in the flash prom of the AMC board, 
the boot program excluded. 

Typically System Software files can be divided into: 

• Operating System and Motor Controller files 
• Panel Handling file 
• Block Library file 
• Application Task files 
• Parameter files 
• Language files 
• Version Information and other text files 

When the board is reset, the boot program reads the operating system from FPROM, which then reads 
all other required files into RAM. 

Note that DriveWindow is not able to handle system software of native DriveDA OPC server drives 
(AC880 family). 

 

1.2 What is a Backup Package 

Backup Package is similar to a Loading Package. It is a single PC-file usually with filename extension 
BPG. A single Backup Package can contain backups of zero, one, or more AMC boards. Content of 
the PC-file is compressed and encrypted. 

Logically, all backed up System Software "files" uploaded from an AMC board are collected within a 
"folder" inside the package file. Name of the "folder" is the same as was given to the drive but 
appended with communication channel and node numbers, both within curly braces. 

The same "folder" name, it is, the same drive, can appear only once within a Backup Package. So, it is 
not possible to backup the same drive more than once in a Backup Package. 

A Backup Package can be opened, saved, saved with a new name, closed, and a new Backup 
Package can be created. Backup and restore commands can be done only if a Backup Package is 
open. 

A Backup Package has attributes called Properties, which the user can view and edit (user interface 
for them is not implemented yet). 

One of the properties is a password, which can be enabled and must be entered at package creation 
time. It is currently not possible to change or disable the password unless the Backup Package is 
empty. 

See Also: What is a Loading Package 
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1.3 What is a Loading Package 

Loading Package is similar to a Backup Package. It is a single PC-file usually with filename extension 
LPG. A single Loading Package can contain system software for several different types of AMC boards 
with different options. Content of the PC-file is compressed and encrypted. 

Logically, Loading Package contains System Software "files" collected within several "folders" and 
subfolders inside the package file. In addition to System Software "files", there are different "control 
files", "source files", "parameter setting files", and other "auxiliary files" that are used in the option 
selection, type code resolution, and download process. 

A Loading Package can be opened, saved, saved with a new name, closed, and a new Loading 
Package can be created. To create a new Loading Package, making changes into an existing one, and 
saving requires a special license to be entered into DriveWindow, however (not yet implemented). 
Downloading command can be done only if a Loading Package is open. 

A Loading Package has attributes called Properties, which the user can view and edit (user interface 
for them is not implemented yet). Editing requires the special license that allows changing a loading 
package. 

One of the properties is a password, which can be enabled and must be entered at package creation 
time. It is currently not possible to change or disable the password unless the Loading Package is 
empty. 

See Also: What is a Backup Package 

 

2. Connecting to DDCS Network 
If you have connected DriveWindow to the DDCS Network (OPC Server) before starting a Backup, 
Restore, or Download operation, it is also the network (OPC Server) used in those operations. 

If, however, you do not have a connection to a DDCS Network before starting a Backup, Restore, or 
Download operation, connection is automatically made to the local DDCS Network (OPC Server 
ABB.SMP (DriveOPC) in the local PC). 

It is recommended that during Backup, Restore, or Download there is no extra traffic in the network. It 
can be done by stopping all monitoring and putting DriveWindow offline. If you are using the local 
DDCS Network, it can be also done by disconnecting DriveWindow from the network. 

If DriveWindow is connected to the DDCS Network, there is an internal disconnect/reconnect done 
after Restore or Download operation because those operations may totally change the identity of some 
Drive. 

Note that DriveWindow is not able to handle system software of native DriveDA OPC server drives 
(AC880 family). However, system software of ACS800 family of drives connected to DriveOPC through 
DriveDA can be handled. 

3. How to Backup 
Backing up means saving the contents of one or more Drive FPROMs into a single backup file called 
Backup Package. It is also possible to add or replace backed up FPROMs within an existing Backup 
Package. 

Note that DriveWindow is not able to handle system software of native DriveDA OPC server drives 
(AC880 family). 

Note that for safety reasons you cannot backup any drive while control of some drive is taken. The 
commands in the menu are disabled (grayed). 
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Before it is possible to do backup, you must have a Backup Package open. 

To backup you: 

• Create a new or open an existing Backup Package 
• Backup all Drives or select the Drives to be backed up 
• Wait while backup is executing 
• Save the Backup Package 
• Close the Backup Package 

Note! Node address 1 is reserved for spare parts. If your drive network has a drive at node address 1, 
restoring a backup to drives at other node addresses is not possible, unless you disconnect 
node 1 before you try to restore. 

See Also: How to Restore 
System Software Submenu 
Handling of Spare Parts 

3.1 To create a new Backup Package: 

 

3.2 To open an existing Backup Package: 
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3.2.1 When the Open dialog box is displayed: 

• Select Backup Packages (*.BPG) from Files of type 
• Uncheck Open as read only 
• From Look in, browse into the drive and directory, in which the Backup Package resides 
• Click the Backup Package you want to open 
• Click Open 

 

Note! You can also enter the name of the Backup Package into File name, with or without a directory 
path. 

Note! You can limit the filenames displayed by entering a wildcard construct into File name and then 
clicking Open. 

3.3 To Backup All drives: 
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Note that for safety reasons you cannot backup the drives while control of some drive is taken. The 
command in the menu is disabled (grayed). 

See Also: To select the Drives to be backed up 

3.4 To select the Drives to be backed up: 

 
Note that for safety reasons you cannot backup any drive while control of some drive is taken. The 
command in the menu is disabled (grayed). 

3.4.1 When the Select Drives dialog box is displayed: 

• With Ctrl down, click the Drives you want to backup 
• Click Backup 

 

Note! You can also enter the names of the Drives into Drive names. If you enter more than one 
drivename, enclose each name in double quotes and separate them with a space. A single 
drivename does not need the double quotes. 

Note! You can limit the drivenames displayed by entering a wildcard construct into Drive names and 
then clicking Backup 
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Note! You can select a range by keeping Shift down instead of Ctrl. If you click a name without Shift or 
Ctrl down, all previous selections are lost. 

Note! Double clicking a name is a shortcut to selecting it and clicking Backup. 

While the DriveLoader enumerates the Drives, the following message is displayed: 

 

When connection to the Drives is made the first time, it may take minutes while the OPC server is 
doing its drive identification. 

If you selected just one Drive and it has already a backup in the Backup Package, the following 
message is displayed: 

 

If you click Yes, the already existing backup is overwritten, otherwise the Drive is not backed up. 

If you selected several Drives and some of them already have a backup in the Backup Package the 
following message is displayed: 

 

You have now options: 

• If you click Yes, the already existing backup is overwritten. 
• If you click Yes to All, the already existing backup is overwritten and no confirmations are 

requested any more but Yes is automatically used as an answer. 
• If you click No, the Drive is not backed up. 
• If you click No to All, the Drive is not backed up and no confirmations are requested any more 

but No is used as an answer. 
• If you click Cancel, the no backup is done. 

See Also: To Backup All Drives 
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3.5 Wait while backup is executing 

During the backing up, a dialog box is displayed: 

 

It displays: 

• Name of the Drive currently being backed up 
• Name of the FPROM file currently being uploaded 
• Progress indicator showing used time/total estimated time 
• Estimated time left 
• Amount of uploaded bytes/total bytes to be uploaded 

Note! The dialog box is not updated during a file upload but just after each file has been uploaded. 

Note! The estimated time left is very inaccurate until more than about 100 KB has been uploaded.  

If you want to abort the backup operation, click the Cancel button. The following confirmation message 
is displayed: 

 

If you click No, backing up continues, otherwise it is aborted. 

Note! Because the Cancel button is not checked during a file upload but just after each file has been 
uploaded, it may take even a minute before clicking of the Cancel takes effect. 
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If you aborted the backup operation but one or more drives have already been backed up, the following 
message box is displayed: 

 

If you click No, already backed up Drives are not disregarded, otherwise the backup operation is 
cancelled. 

Note! If a disregarded, aborted, or not yet done backup was supposed to replace an existing backup 
in the Backup Package, replacement is not done but the existing backup remains untouched in 
the Package. 

3.6 To save the Backup Package: 

 

If the Backup Package is new or if you selected Save As... instead of Save, a Save As dialog box is 
displayed. 
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3.6.1 When the Save As dialog box is displayed: 

• Select Backup Packages (*.BPG) from Files of type 
• From Save in, browse into the drive and directory, into which you want to save the Backup 

Package 
• Enter the name of the Backup Package into File name or, if you want to replace an existing 

file, click the filename you want to replace 
• Click Save 

 

If the file already exists, confirmation to replace it asked. 
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3.7 To close the Backup Package: 

 

If the Backup Package has not been saved or changes have been made into it since last save, a 
message box is displayed: 

 

If you click Yes, Save is done. If you click No, no saving is done and all changes are lost. If you click 
Cancel, closing is canceled and the Backup Package is still open. 

Note! The question about saving unsaved changes is asked also when you create a new or open an 
existing Package. 

Note! The question about saving unsaved changes is asked also when you exit from DriveWindow, 
but (in current version) you do not have the option to cancel exiting: 

 

If you click No, the Backup Package is not saved and all changes made into it are lost. 
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4. How to Restore 
Restoring means restoring the contents of FPROM of a Drive from a single backup file called Backup 
Package, which may contain backups of several Drives. The Drive is also reset at the end of the 
operation. 

Note that DriveWindow is not able to handle system software of native DriveDA OPC server drives 
(AC880 family). 

Note that for safety reasons you cannot restore any drive while control of some drive is taken. The 
command in the menu is disabled (grayed). 

Before it is possible to do restore, you must have a Backup Package open. 

To restore you: 

• Open an existing Backup Package 
• Select the Drive to be restored 
• Select a backup from the Backup Package to be downloaded to the Drive 
• Wait while restore is executing 
• Close the Backup Package 

If you do not have DriveWindow running, you can start DriveWindow by double clicking the name of a 
Backup Package file in Windows Explorer (for example). 

 

DriveWindow starts, opens the Backup Package, and asks you to select the Drive to be restored. 

See Also: How to Backup 
How to Download 
System Software Submenu 

4.1 To open an existing Backup Package: 
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4.1.1 When the Open dialog box is displayed: 

• Select Backup Packages (*.BPG) from Files of type 
• Check Open as read only (not mandatory) 
• From Look in, browse into the drive and directory, in which the Backup Package resides 
• Click the Backup Package you want to open 
• Click Open 

 

Note! You can also enter the name of the Backup Package into File name, with or without a directory 
path. 

Note! You can limit the filenames displayed by entering a wildcard construct into File name and then 
clicking Open. 

4.2 To select Restore: 
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Note that for safety reasons you cannot restore any drive while control of some drive is taken. The 
command in the menu is disabled (grayed). 

While the DriveLoader enumerates the Drives, the following message is displayed: 

 

When connection to the Drives is made the first time, it may take minutes while the OPC server is 
doing its drive identification. 

4.2.1 When the Select Drive dialog box is displayed: 

• Click the Drive you want to restore 
• Click Restore... 

 

Note! Only names of Drives that can be restored are displayed. 

Note! You can also enter the name of the Drives into Drive name. It can be enclosed in double 
quotes. 

Note! You can limit the drivenames displayed by entering a wildcard construct into Drive name and 
then clicking From... 

Note! Double clicking a name is a shortcut to selecting it and clicking From.... 
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4.2.2 When the Restore Drive from dialog box is displayed: 

• Click the backup you want to restore to the Drive 
• Click OK 

 

Note! Only names of backups that can be restored are displayed. 

Note! At the lowest DriveLoader authority level a backup can be restored only to the same numbered 
node, from which it was backed up, or into node number 1. Current DriveWindow has only the 
lowest authority level.  

Note! You can also enter the name of the backup into Backup. It can be enclosed in double quotes. 

Note! You can limit the backup names displayed by entering a wildcard construct into Backup and 
then clicking Restore. 

Note! Double clicking a name is a shortcut to selecting it and clicking Restore. 

A confirmation is then requested: 

 

If you click No, the restore operation is cancelled. 
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4.3 Wait while restore is executing 

During the restore, a dialog box is displayed: 

 

It displays: 

• Name of the Drive currently being restored 
• Name of the FPROM file currently being downloaded or the operation (clear, reset) currently 

being executed 
• Progress indicator showing used time/total estimated time 
• Estimated time left 
• Amount of downloaded bytes/total bytes to be downloaded 

Note! The dialog box is not updated during a file download or an operation (clear, reset) being 
executed, but just after each file has been downloaded or just after executing an operation 
(clear, reset). 

Note! Because contents of the Drive may have totally been changed, an internal Network Disconnect 
and then Reconnect is made in DriveWindow, which may change state and contents of 
windows of DriveWindow. 

4.4 To close the Backup Package: 

 
 

See Also: To close the Backup Package after Backup 
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5. How to Download 
Downloading means downloading to FPROM of a Drive new files containing factory settings. 
Downloading is done from a single file called Loading Package, which may contain files and options for 
several types of Drives. 

Note that DriveWindow is not able to handle system software of native DriveDA OPC server drives 
(AC880 family). 

Note that for safety reasons you cannot download to any drive while control of some drive is taken. The 
command in the menu is disabled (grayed). 

Before it is possible to do downloading, you must have a Loading Package open. 

To download you: 

• Open an existing Loading Package 
• Select the target Drive 
• Select the files to be downloaded by using a download wizard or entering a type code 
• Wait while download is executing 
• Close the Loading Package 

If you do not have DriveWindow running, you can start DriveWindow by double clicking the name of a 
Loading Package file in Windows Explorer (for example). 

 

DriveWindow starts, opens the Loading Package, and asks you to select the target Drive. 

Note! It is good practice to backup the drive before downloading, so that the drive can be restored in 
case something goes wrong. 

See Also: How to Restore 
System Software Submenu 

5.1 To open an existing Loading Package: 
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5.1.1 When the Open dialog box is displayed: 

• Select Loading Packages (*.LPG) from Files of type 
• Check Open as read only (not mandatory) 
• From Look in, browse into the drive and directory, in which the Loading Package resides 
• Click the Loading Package you want to open 
• It is good practice to set Open as read-only 
• Click Open 

 

Note! You can also enter the name of the Loading Package into File name, with or without a directory 
path. 

Note! You can limit the filenames displayed by entering a wildcard construct into File name and the 
clicking Open. 

5.2 To select Download: 
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Note that for safety reasons you cannot download to any drive while control of some drive is taken. The 
command in the menu is disabled (grayed). 

While the DriveLoader enumerates the Drives, the following message is displayed: 

 

When connection to the Drives is made the first time, it may take minutes while the OPC server is 
doing its drive identification. 

5.2.1 When the Select Drive dialog box is displayed: 

• Click the Drive you want to be downloaded 
• Click Download... 

 

Note! Only names of Drives that can be downloaded are displayed. 

Note! You can also enter the name of the Drives into Drive name. It can be enclosed in double 
quotes. 

Note! You can limit the drivenames displayed by entering a wildcard construct into Drive name and 
then clicking From... 

Note! Double clicking a name is a shortcut to selecting it and clicking Download.... 
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5.2.2 A dialog box asking the method to be used in selecting Download Options is shown: 

 

5.3 Using the Download Wizard 

Instead of entering the type code directly, you can use the Download Wizard to select options. 

5.3.1 When the Download Options dialog box is displayed: 

• Select Download Wizard 
• Click OK 

 



System Software 

DriveWindow 2 8-21 

5.3.2 With the DriveLoader Download Wizard dialog boxes: 

• Select the options you want 
• Click Next to move to the next option 
• Click Back to move back to the previous option 
• Click Finish in the last option 

 

Note! Type code field shows the type code with asterisk in positions not yet selected. 

Note! Back is grayed, when the first option is to be selected. 



System Software 

8-22 DriveWindow 2 

Note! Instead of Next, a grayed Finish is shown, if current selection is not valid. 
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5.3.3 When you click Finish, a confirmation is requested: 

Depending on the DriveWindow version and your authority level, the confirmation can contain a list of 
files and commands to be used when downloading. 

 

If you click No, the download operation is cancelled. 

5.4 Entering the Type Code 

Instead of using the Download Wizard, you can enter a type code directly. 

5.4.1 When the Download Options dialog box is displayed: 

• Select Type code 
• Enter the type code or select (and edit) a previously used type code 
• Click OK 
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Note! Although type codes are displayed as contiguous strings, you can enter separators (like space, 
hyphen, or slash) between different fields of the type code. 

Note! The last 16 type codes entered or selected by using the Download Wizard are remembered. 

 

Note! You can enter an asterisk into a type code field, which means that the Download Wizard will 
start to ask the missing options. 

 



System Software 

DriveWindow 2 8-25 

5.4.2 If the type code does not select all options, the Download Wizard starts: 

• Select the options you want 
• Click Next to move to the next option 
• Click Back to move back to the previous option 
• Click Finish in the last option 

 

Note! If the Download Wizard is started after entering the type code, it shows only those options that 
are not resolved by the type code entered. 

Note! If the type code decoding in a loading package is incomplete, the Download Wizard will start 
even if the type code entered does not contain asterisks. 
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5.4.3 When option selection is ready, a confirmation is requested: 

Depending on the DriveWindow version and your authority level, the confirmation can contain a list of 
files and commands to be used when downloading. 

 

If you click No, the download operation is cancelled. 

5.5 Wait while download is executing 

During the download, a dialog box is displayed: 
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It displays: 

• Name of the Drive currently being downloaded 
• Name of the FPROM file currently being downloaded or the operation (clear or reset, for 

example) currently being executed 
• Progress indicator showing used time/total estimated time 
• Estimated time left 
• Amount of downloaded bytes/total bytes to be downloaded 

Note! The dialog box is not updated during a file download or an operation (clear or reset, for 
example) being executed, but just after each file has been downloaded or just after executing 
an operation (clear, reset). 

Note! Because contents of the Drive may have totally been changed, an internal Network Disconnect 
and then Reconnect is made in DriveWindow, which may change state and contents of 
windows of DriveWindow. 

5.6 To close the Loading Package: 

 
 

See Also: To close the Backup Package after Backup 

6. Using Wildcards 
A wildcard construct can be used to limit number of names displayed in dialog boxes. A wildcard 
construct consists of one or more wildcard names separated by semicolons (;). 

A wildcard name is a name that contains one or more asterisks (*) and/or question marks (?). The 
question mark matches exactly one single character and asterisk matches a sequence of zero or more 
characters. 

Cases of the characters in a wildcard name are not meaningful. For example, letter A in a wildcard 
name matches with letters a and A in names. 
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A wildcard list matches all names that match at least one of the elements in the list. For example, the 
following wildcard construct matches all drivenames that start with letter A or a, or have a two 
character node number that starts with digit 1: 
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1. Handling of Exported Files 
Handling of files exported by DriveWindow depends on the application, into which you import them. 

Exporting can be done in two formats except for graphs, which can be exported only in the tab  
separated text format. The formats are: 

• Tab separated text format 
• XML format 

In this topic we discuss only the tab separated text format. 

The files exported in tab separated text format by DriveWindow have filename extension TXT. 

Note that an exported file is not meant for humans to read. Because it is for other applications, the 
accuracy of values is very big. Note also that the decimal symbol defined in the regional settings is 
used in tab separated text format files. So, extra care is required in exchanging exported files with 
other countries. 

The tab separated format is understood by many applications, by Word and Excel, for example, and 
can be easily imported in such kind of applications. 

We have included a couple of examples, how to get such exported files into Excel and Word. 
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1.1.1 Importing to Excel 

We have used Excel 2007 in the following example. Other versions of Excel work similarly, but their 
commands may have different names or be in different menus. Also outlook of wizards and dialog 
boxes can be different. 

In Excel you actually do not import the exported text file, but open it and let a wizard to put the 
information into cells.. 

Select Open from the File menu. 

 

An Open dialog box is presented. Browse to the folder containing the exported file and select Files of 
type Text Files (*.prn; *.txt; *.csv). 
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All text files a now displayed. Select the export file you want to import and click the Open button. 
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A Text Import Wizard dialog box is presented. Usually you do not need to go through all the steps. Just 
click the Finish button. 

 

Excel now opens a new workbook that contains the information exported by DriveWindow. You can 
now adjust the column widths by dragging their separators. 
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If you want to, you can also set the alignment of values in selected areas to be aligned right, for 
example. 
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or 
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You can also reduce the precision used in displaying of the selected numbers. 
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It may be that format of time stamps require changing, too. 
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With Excel, you can then analyze the data, make charts out of it, print data, etc. 

1.1.2 Pasting Items into Word 

We have used Word 2007 in the following example. Other versions of Word work similarly, but their 
commands may have different names or be in different menus. Also outlook of wizards and dialog 
boxes can be different. 
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In DriveWindow, copy the items, which you want to paste, into the clipboard. Note that since 
DriveWindow version 2.20 you are also able to directly drag and drop the items from DriveWindow to 
Word without using the clipboard. 

 

In your Word document, move the caret (text cursor) to the place, into which you want to paste the 
items. Select Paste command in the Edit menu (or press Ctrl+V key). 

 

Select the pasted text. 
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Select the Convert Text to Table command in the Table menu. 
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A Convert Text to Table dialog box is presented. Check that Tabs is selected in Separate text at. 
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Now you have the pasted information in a table. While all of the table is selected, you can, for example, 
add a grid. Select the Borders and Shading command in the Format menu. 
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A Borders and Shading dialog box is presented. Select your favourite style, color, width, borders 
setting, etc. Click the OK button when you are ready. 

 

You probably also want to adjust widths of the columns. You can do it by dragging the column 
separators with the mouse. 

 

1.1.3 Importing to Word 

We have used Word 2007 in the following example. Other versions of Word work similarly, but their 
commands may have different names or be in different menus. Also outlook of wizards and dialog 
boxes can be different. 

For this example, we have exported parameters of a drive in tab separated text format, and edited the 
parameter file by removing almost all parameter groups to get the example smaller. 
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In your Word document, move the caret (text cursor) to the place, into which you want to insert the 
items. Select File command in the Insert menu. 

 

An Insert File dialog box is presented. Browse to the folder containing the exported file and select Files 
of type Text Files (*.txt). 
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All text files a now displayed. Select the export file you want to import and click the OK button. 

 

Select the inserted text (only the beginning is shown here). 
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Select the Convert Text to Table command in the Table menu. 
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A Convert Text to Table dialog box is presented. Check that Tabs is selected in Separate text at. 
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Now you have the inserted information in a table. While all of the table is selected, you can, for 
example, add a grid. Select the Borders and Shading command in the Format menu. 
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A Borders and Shading dialog box is presented. Select your favourite style, color, width, borders 
setting, etc. Click the OK button when you are ready. 
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You probably also want to adjust widths of the columns. You can do it by dragging the column 
separators with the mouse (only the end is shown here). 

 

See Also: How to Export Parameters 
Exporting Trends  
Copying Items to the Clipboard 
Dragging and Dropping Items 



Miscellaneous 

DriveWindow 2 9-25 

2. Powerfail Recovery 
Powerfail recovery depends on the DDCS configuration and which part is recovering. 

Drives reachable through a DDCS channel can be connected to your PC two ways: 

• The channel consists of a ring without any branching units. A single drive connected directly 
to your PC is a regenerative case of a ring connection. 

• The channel consists of a tree of branching units with drives connected as leaves. 

2.1.1 DDCS Ring 

In case of a DDCS ring, if power of a drive fails (or the communication loop is broken for any reason), 
your PC cannot communicate with any of the drives connected in the ring. 

If you have the drive status display on-line, all images in front of the drives in the browse tree pane 
change to show question marks. 

Also, if you have items, faults, or events on-line in the item sets pane, they will show signal quality bad. 
The same happens, if you update any off-line item, fault, or event, while power of a drive is down. 

 

 

When the power is restored (or the broken communication loop is fixed), DriveWindow recovers 
automatically. Note that qualities of off-line items, faults, and events do not change until you update 
them. 

 

2.1.2 Branching Units Stay Up 

In case of a tree of branching units, if power of a drive fails (or the communication between it and its 
branching unit is broken for any reason), but all the branching units stay powered and functional, your 
PC can still communicate with all the other drives. 
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If you have the drive status display on-line, the image in front of the failed drive in the browse tree pane 
changes to show a question mark. Images of all other drives are shown normally. 

Also, if you have items, faults, or events of the failed drive on-line in the item sets pane, they will show 
signal quality bad. The same happens, if you update any off-line item, fault, or event of the failed drive, 
while power of a drive is down. Items, faults, and events of all other drives are shown normally. 

 

 

When the power is restored (or the broken communication loop is fixed), DriveWindow recovers 
automatically. Note that qualities of off-line items, faults, and events do not change until you update 
them. 

 

2.1.3 Branching Units Fail 

In case of a tree of branching units, if power of one or more branching units fails (or the 
communications between them and their parent units are broken for any reason), your PC cannot 
communicate with the drives behind the failing branching units. 
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If you have the drive status display on-line, the images in front of the drives behind the failed branching 
units in the browse tree pane change to show a question mark. Images of other drives are shown 
normally. 

Also, if you have items, faults, or events of the drives behind the failed branching units on-line in the 
item sets pane, they will show signal quality bad. The same happens, if you update any off-line item, 
fault, or event of a drive behind the failed branching units. Items, faults, and events of all other drives 
are shown normally. 

 

For example, if the root branching unit fails: 

 

In case a broken communication is fixed without taking power off from the branching units, 
DriveWindow recovers automatically. 

 

However, when power of the failed branching units is restored, they require re-programming by the 
DriveOPC communication library. DriveWindow does not know that power has been recovered, and 
automatic recovery is not possible. 

 

You have two main options to recover by yourself: 

• Restart DriveOPC, which can be done by disconnecting and re-connecting the OPC Server. 
• Command DriveOPC to ask its communication library to restart (re-identify and thus re-

program the DDCS network). 
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Restarting DriveOPC is simpler. You usually use it, if you are willing to lose contents of the monitor and 
any of the uploaded dataloggers. 

• Save your desktop to a workspace file. 
• Disconnect the OPC Server. 
• Restore the workspace from the file. Restoring also does the re-connecting of DriveOPC. 

 

 

 

 



Miscellaneous 

DriveWindow 2 9-29 

Note that qualities of off-line items, faults, and events do not change until you update them. 

Commanding of DriveOPC to recover from branching unit power fail is more complex. You must use it 
in case you do not want to stop monitoring, lose the monitor contents, or lose any uploaded datalogger 
contents. 

• Make sure that all failed branching units have been powered and also all drives behind them. 
• Add an item with OPC address Communication.Restart into the browsed item set. 

• Write the value ON to the added item. 
• Wait while the DriveOPC communication library does its identification and re-programming of 

the branching units. 

 or  

 

  or  
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Note that qualities of off-line items, faults, and events do not change until you update them. 

See Also: Viewing Status of Drives  
Viewing Parameters and Signals  
Browse Tree Pane  
Item Sets Pane 

3. Handling of Spare Parts 
We recommend that you reserve the node address one of each DDCS communication channel for 
drive control board spare parts. 

The reasons are: 

• Control boards made to be used as spare parts have usually node address one pre-
programmed, when they are shipped. 

• If a control board has not been programmed at all, it boots at node address one. 
• Functions within DriveWindow, which require or are able to restart a drive, cannot do 

restarting of drives at other nodes, if there is a drive at node address one. The reason is that 
any restarting drive uses node address one for while, and there would be two drives 
responding at the same node address during that time. 

If you do not follow these recommendations, you are not able to: 

• Restart other drives after downloading their parameters. 
• Restore or download system software to other drives. 

If you follow the recommendations and leave the node address one free for spare parts, replacing a 
control board, for example, with a spare is easy. 

After commissioning is done, take full backup of all drives. You can have them all in a single backup 
package file. 

If a control board of a drive fails and needs to be replaced by a spare: 

• Replace the control board with a spare. You do not need power off other drives. 
• If you have DriveWindow running, either disconnect the OPC Server or exit. 
• Power up the drive. 
• Start DriveWindow and/or connect the OPC Server. The repaired drive should appear at node 

address one. 
• Open the backup package file. 
• Select the repaired drive at node address one to be restored. 
• Select the original node from the backup package to be used in restoring. 
• Execute restoring. If all went well, the repaired drive will be shown at its original node address. 
• Clean up by closing the backup package. 

Note that you do not need to do any connection changes in the optical DDCS network, if using this 
method of handling spare parts. 
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See Also: What is a Backup Package 
How to Backup 
How to Restore 
How to Restore Parameters 

4. Limitations 

4.1.1 Maximum Number of Boards 

DriveWindow itself does not use the communication boards itself. So, the limits are set by the 
DriveOPC, which DriveWindow uses in communication with the drives. 

Since version 2.03 (included in DriveWindow version 2.02), DriveOPC can handle several DDCS 
communication boards. Number of supported boards depends on the operating system. 

Since version 2.08 (included in DriveWindow version 2.22), DriveOPC can handle also RUSB-02 
USB/DDCS adapters under Windows 2000/XP/Vista. 

Although supported by DriveOPC version 2.09 (included in DriveWindow version 2.30), DriveWindow 
2.30 (or newer) installation does not support NISA-03 boards and Windows NT. 

Since version 2.10 (included in DriveWindow version 2.40), DriveOPC can handle also NETA-21 
DDCS gateway under Windows 2000/XP/Vista/7/8. 

Since version 2.10 (included in DriveWindow version 2.40), DriveOPC the maximum number of 
channels has been increased from 10 to 1000. If connection is made using the DriveDA OPC sever, 
native DriveDA drives (ACS880 family) add another 1000 channels. So the total number of channels 
(2000), i.e. number boards and devices, is practically unlimited. 

Under 32-bit versions of Windows 2000, Windows XP, Windows Vista, Windows 7, and Windows 8 the 
communication boards/devices can be: 

• RUSB-02 USB/DDCS adapters. They have one DDCS optical channel. 
• NDPA-02 boards, which are of type PC Card (PCMCIA). They have one DDCS optical 

channel. 
• NETA-21 remote monitoring devices, which are devices with Ethernet connection. They have 

one DDCS optical channel. 

Under 64-bit versions of Windows Vista and Windows 7 the communication boards can be: 

• RUSB-02 USB/DDCS adapters. They have one DDCS optical channel. 
• NETA-21 remote monitoring devices, which are devices with Ethernet connection. They have 

one DDCS optical channel. 

4.1.2 Maximum Number of Channels 

DriveWindow does not use the communication channels itself. So, the limits are set by the DriveOPC, 
which DriveWindow uses in communication with the drives. 

Since version 2.03 (included in DriveWindow version 2.02), DriveOPC can handle several DDCS 
communication devices. 

Since version 2.10 (included in DriveWindow version 2.40), DriveOPC supports maximum 1000 
channels under Windows 2000/XP/Vista/7/8. Native DriveDA supports additional 1000 channels, so the 
total maximum (2000) is 2000, if DriveDA (not included in DriveWindow) is used. 

4.1.3 Maximum Number of Drives 

The limits are set by the DriveOPC, which DriveWindow uses in communication with the drives. 

The node address space of a communication channel is 256. 
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Two of these are reserved by the DDCS protocol. Additional 50 of the node addresses (76...125) are 
reserved for branching units by the communication library. Also, we recommend to leave the node 
address one for spare parts. 

Thus, each communication channel can connect 203 drives (plus one spare). 

Under Windows 2000/XP/Vista/7/8, 203000 drives (plus 1000 spares) are supported. 

However, there can be limitations introduced by the speed of your PC or using DriveOPC remotely. It 
may be that having drive status refreshing on-line, for example, chokes you PC long before the 
theoretical maximum is reached. 

4.1.4 Monitoring 

Maximum number of monitored 
items: 

 
6. 

Minimum drawing interval: 1 ms in fast mode, 10 ms in normal mode. 

 Note that the interval is used as a measurement cycle time, if 
possible. However, having a short interval and many channels to 
monitor slows down the measurement cycle. In fast mode it 
takes about 1 ms to read one value from a drive. In normal 
mode it takes 3...4 ms to read one value from a drive. These are 
valid only if there is no other load (including device drivers) in 
your PC, and your PC and its display driver are fast enough. 

Maximum size of the history 
buffer: 

 
2147483647 ms (almost 25 days). 

 Note that in practice the size of the (virtual) memory of your PC 
sets the upper limit for the size of the history buffer. 

Maximum absolute value of y-
axis minimum and maximum: 

 
3.40282356779733642751e+038. 

Maximum length of the x-axis: 32700 * interval. 

 Note that in practice you should not have longer x-axis than you 
have horizontal point on your screen. Updating the screen during 
monitoring gets slower, the more you have points to update. 

4.1.5 Dataloggers 

Limits of dataloggers are set by their implementation in the drives. There are some limits in 
DriveWindow, too. 

Maximum number of 
dataloggers in a drive: 

 
No limit in DriveWindow 2.30 itself, but DriveOPC 2.09 limit is 
10. Older versions: 2. 

Maximum number of logged 
variables: 

 
6. 

Maximum absolute value of y-
axis minimum and maximum: 

 
3.40282356779733642751e+038. 

Maximum length of the x-axis: 32700 * interval. 
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4.1.6 Maximum Number of Item Sets 

DriveWindow limits the number of item sets that can be present in the item sets pane as follows: 

• Maximum total number of item sets is 9. 
• There is exactly one item set of type browsed items. 
• Maximum number of item sets of type all faults is one. 
• Maximum number of item sets of type all events is one. 

4.1.7 Support for ACS880 Family of Drives 

DriveWindow 2.40 (and newer) has limited support for ACS880 family of drives in case using the 
DriveDA OPC sever (not included in DriveWIndow) is installed. 

The limitations are as follows: 

• No system software backup, restore, or load. 
• Parameter download should be avoided. 
• Only default language (English) is supported. 
• Drive names must contain Latin alphabet only. 
• No dynamic parameter support. 
• Dataloggers cannot be configured, just controlled. 
• Only six channels of a datalogger can be shown. 
• Only six channels can be monitored (ACS880 monitorlogger is used if possible). 

See Also: Monitor and Dataloggers 
Working with Item Sets 
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1. Architecture 
Architecture of DriveWindow, when used locally, is approximately as follows: 
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Architecture of DriveWindow, when used remotely, is approximately as follows: 

 

Architecture of DriveWindow, when used off-line, is approximately as follows: 

 

2. DriveOPC 
DriveOPC is an OPC Server based on OPC Data Access Standard 1.0A. It implements the obligatory 
custom interfaces and IOPCBrowseServerAddressSpace. 

In general, an OPC Server is a software module, which implements OPC data access specification 
made by OPC Foundation (www.opcfoundation.org). OPC stands for “OLE for Process Control”. 

According to OPC Foundation: 
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The OPC Specification is a non-proprietary technical specification that defines a set of 
standard interfaces based upon Microsoft’s OLE/COM technology. The application of 
the OPC standard interface makes possible interoperability between automation/control 
applications, field systems/devices and business/office applications. 

Traditionally, each software or application developer was required to write a custom 
interface, or server/driver, to exchange data with hardware field devices. OPC 
eliminates this requirement by defining a common, high performance interface that 
permits this work to be done once, and then easily reused by HMI, SCADA, Control and 
custom applications. 

In principle, DriveWindow is able to act as a user interface for any OPC Server as long as it 
implements the obligatory custom interfaces and IOPCBrowseServerAddressSpace of the Data 
Access Standard 1.0A. 

However, DriveWindow contains many drive dependent features, which require that the OPC Server is 
DriveOPC. DriveOPC is included in the installation of DriveWindow. When you install DriveWindow, 
you get also DriveOPC installed. 

There are two versions of an OPC Server: 

• In-process server (SMP.DLL). It can be used only locally. 
• Local server (SMP.EXE). It is used at the remote end, but can also be used locally. 

If a client program uses the OPC Server locally, it can select, which version to use, when connecting to 
the OPC Server. DriveWindow, however, like many other client programs, delegate the selection to the 
operating system, which selects the in-process server, if it is available. If not, local server is selected. 
The in-process server can be taken out of use by a register change, if needed. 

However, depending on your operating system and how it is configured, it may also be possible to use 
the local server (EXE) version “remotely”. Typically, connecting remotely to \\localhost or 127.0.0.1, 
actually connects to the local server in the same PC. 

When using DriveOPC in-process server (DLL), each client program running simultaneously in the 
same PC gets its own instance of the server. There is an internal lock within DriveOPC, which allows 
only one instance to use the communication library. If, for example, more than one DriveWindow are 
running simultaneously and connect to the local in-process server, only the first one is able to see the 
drives, others see nothing. 

Since DriveOPC version 2.02 (included in DriveWindow 2.01), the communication library shows a 
message box, if another instance of the library is already running. 

 

Note, however, that the message is not shown in case DriveOPC is configured to be used remotely. 

Note that also the local server (EXE) uses also the communication library. So it is also one of the 
“clients” competing about the use of the internal lock in the library. 
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When using the local server (EXE) either locally or remotely (if properly configured), several clients can 
connect and use the server simultaneously. DriveWindow, however, always checks, if other 
DriveWindow instances are trying to use the same server. If that is the case, DriveWindow refuses to 
connect, and informs the user about the simultaneous use, first with a detailed error message and 
immediately after that with a more understandable explanation: 

 

 

See Also: What is OPC Server 
OfflineOPC 
Information about OPC Server 

2.1 Remote Use 

Because of security risks involved in DCOM, we do not recommend using DriveOPC remotely. 

DriveOPC does not have a user interface and is based on COM technology, so it can be used also 
remotely through DCOM. DriveWindow has the ability to connect to a remote OPC Server, too. It is 
required, however, that the same OPC Server is also installed locally, because DriveWindow gets the 
list of available servers locally. 

DriveWindow acting as a client for a remote OPC Server is ready for use after installation. 

The remote end requires that DriveOPC or another DriveWindow (includes DriveOPC) is installed in 
the remote end PC. In addition, the remote end needs to be configured, so that clients can access the 
remote PC, can launch DriveOPC, and can access DriveOPC. 

Configuring DriveOPC for remote use is out of scope of this document. 

See Also: DriveOPC 
What is OPC Server 
Connecting to OPC Server 
Remote Connection 
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2.2 Several Clients 

Although there is no need to run several instances of DriveWindow locally, there may be other 
applications, which you want to be able to use the local DriveOPC simultaneously. 

Because DriveWindow delegates the selection of DriveOPC (SMP.DLL or SMP.EXE) to the operating 
system, the in-process (DLL) version will be selected. It means that simultaneous communication from 
several clients is not possible. 

Depending on your operating system and how it is configured, it may be possible to use the local 
server (EXE) version “remotely”. Typically, connecting remotely to \\localhost or 127.0.0.1, actually 
connects to the local server in the same PC. Of course, all clients must then be able to do remote 
connection. 

Another way is to make changes to the registry, so that the in-process (DLL) version is taken out of 
use. Then the operating system has to select the local server (EXE) version, which is then shared by 
all applications using DriveOPC locally. Even DriveWindow will use the EXE version then. 

Note that the local server (EXE) version is inherently slower than the in-process (DLL) version. So, we 
do not recommend forcing the use of the local server (EXE) version unless absolutely necessary. 

If possible, the in-process (DLL) version should be taken back in use, if the forcing the use of the local 
server (EXE) version is not needed any more. It is done by restoring back the original values in the 
registry. 

Before making any registry changes concerning DriveOPC, stop all programs using it. 

There are two methods of making registry changes: 

• Editing the registry with a registry editor 
• Using self-registering and unregistering features of the servers 

The latter method can be used if DriveOPC version is 2.02 (included in DriveWindow 2.01) or newer. 
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2.2.1 Editing Registry 

Start your favourite registry editor (RegEdit.exe, for example). 

 

UAC may ask your permission to continue. 
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Search for SMP.DLL (in data). 

  

If necessary, repeat, until the key InprocServer32 having SMP.DLL (preceded by path) in its default 
value. 

 

Rename the InprocServer32 key to, for example, InprocServer32.bak. 
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After this change all applications, which use DriveOPC locally, will use the local server (EXE) instead of 
the in-process server (DLL). 

2.2.2 Using Self-Registering Features 

This is the preferred method if DriveOPC version is 2.02 (included in DriveWindow 2.01) or newer. 

To disable the in-process server (DLL), check SMP.DLL location, and unregister it by running 
RegSvr32 (assuming SMP.DLL is in folder C:\Program Files\Common Files\DriveWare\DriveOPC): 

Regsvr32 -u "C:\Program Files\Common Files\DriveWare\DriveOPC\SMP.DLL" 

Note than in Windows Vista/7/8 you may need to customize the start menu in start menu properties in 
order to see the Run command in the start menu. However, by pressing Windows key + R, you will get 
the Run dialog box in all operating system versions. 

 

Regsvr32 should tell you about successful unregistration. 
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Because unregistering the in-process server removes some information needed by the local server, 
you need to re-register the local server (EXE). To re-register it, check SMP.EXE location, and run it 
(assuming SMP.EXE is in folder C:\Program Files\Common Files\DriveWare\DriveOPC): 

"C:\Program Files\Common Files\DriveWare\DriveOPC\SMP.EXE" -RegServer 

Note than in Windows Vista/7/8 you may need to customize the start menu in start menu properties in 
order to see the Run command in the start menu. However, by pressing Windows key + R, you will get 
the Run dialog box in all operating system versions. 

 

Now all applications, which use DriveOPC locally, will use the local server (EXE) instead of the in-
process server (DLL). 

If you want to restore the in-process server (DLL) into use, check SMP.DLL location, and register it by 
running RegSvr32 (assuming SMP.DLL is in folder C:\Program Files\Common 
Files\DriveWare\DriveOPC): 

Regsvr32 "C:\Program Files\Common Files\DriveWare\DriveOPC\SMP.DLL" 

Note than in Windows Vista/7/8 you may need to customize the start menu in start menu properties in 
order to see the Run command in the start menu. However, by pressing Windows key + R, you will get 
the Run dialog box in all operating system versions. 
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Regsvr32 should tell you about successful registration. 

 

2.2.3 Checking the Server 

You can check it by using task manager, for example. When an application has connected to 
DriveOPC, there is a process called SMP.EXE running. 

 

You can also ask information about the OPC Server, and it should show that Local DriveOPC 
(SMP.EXE) is the server in use. 

See Also: DriveOPC 
What is OPC Server 
Information about OPC Server 
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3. OfflineOPC 
OfflineOPC is an OPC Server based on OPC Data Access Standard 1.0A. It implements the obligatory 
custom interfaces, IOPCBrowseServerAddressSpace interface, and IPersistFile interface. 

In general, an OPC Server is a software module, which implements OPC data access specification 
made by OPC Foundation (www.opcfoundation.org). OPC stands for “OLE for Process Control”. See 
DriveOPC for more information about OPC Specification. 

There is only an in-process version of the server (OfflineOPC.DLL). 

OfflineOPC is capable of collecting data from a real OPC Server or from a client, saving the data into a 
file, and restoring data from a file. 

OfflineOPC is included in DriveWindow since version 2.10. DriveWindow uses it in: 

• Saving graphs into a graph file. 
• Saving graphs into a workspace file. 
• Saving a workspace for off-line. 
• Simulating drives in off-line mode. 

Connection to OfflineOPC is done internally in DriveWindow when needed. A user should never 
connect directly to OfflineOPC. 

When simulating drives, there can be two instances of OfflineOPC created by DriveWindow. One is 
simulating the drives and the other is for saving graphs and workspaces for off-line. 

Detailed specifications of OfflineOPC and how to use it are out of scope of this document. 

See Also: What is OPC Server 
DriveOPC 
Off-line Mode 
Information about OPC Server 

4. Configuring Parameter Backup and Restore 
DriveWindow is able to save and restore (download) drive parameters. 

When parameters of a drive are saved into a file, actually all drive parameters and signals, which are 
not protected by pass code, are saved. In addition, even pass code protected ID run result parameters 
are saved. 

When parameters are restored from a file, the user is requested, whether she wants to restore user 
parameters, ID run result parameters, or both. 

Because many of the ID run result parameters are pass code protected, it is essential to know, which 
are the ID run result parameters, because they depend on the drive. 

DriveWindow uses the value of Properties.Kind to determine, which parameters to save and 
restore in addition to the not protected ones. 

DriveWindow has hard coded default values for many kinds of drives. However, if the drive is not 
known by DriveWindow or the default values need to be overridden, it can be done by creating 
DW2.INI file into the DriveWare folder of ProgramData. 

Note that DriveWindow is not able to handle ID run result parameters of native DriveDA OPC server 
drives (AC880 family). Instead, all unhidden parameters are saved. Thus the INI-file is not used for 
ACS880 family of drives. 

More detailed explanation of saving and restoring parameters and the hard coded default values can 
be found in “Saving and Restoring Parameters.pdf” (00130808.DOC) in DriveWindow installation 
folder. 
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Note that since version 2.12, the user parameters listed in the INI-file are restored before parameters 
in groups 10…98. This ordering makes it possible to download some parameters, which would be 
locked otherwise. 

4.1.1 The INI-file 

Note that DriveWindow is not able to handle ID run result parameters of native DriveDA OPC server 
drives (AC880 family). Instead, all unhidden parameters are saved. Thus the INI-file is not used for 
ACS880 family of drives. 

The INI-file is an ASCII-file and consists of sections. 

Each section starts with a line containing the kind of the drive within brackets. The section name is not 
case sensitive. 

After the section name comes lines, each containing a key-value pair separated with an equal sign. 
Spaces surrounding the equal sign are ignored. The keys and the values are not case sensitive. The 
order of the lines does not matter. 

The key-value list ends, when a new section or end of file is encountered. 

4.1.2 Keys 

The following keys within sections are recognized: 

Key Value Remarks 

LockParameter Group.Index or empty If empty, there is no parameter lock 

CheckGroupCount n Number of CheckGroup keys. 

CheckGroupn Parameterlist n = 1... CheckGroupCount 

UserGroupCount n Number of UserGroup keys. 

UserGroupn Parameterlist or Pause n = 1... UserGroupCount 

IdRunGroupCount n Number of IdRunGroup keys. 

IdRunGroupn Parameterlist or Pause n = 1... IdRunGroupCount 

• Group is the parameter group. 

• Index is the index of parameter within a group 

• n is a number 0...(in GroupCount values) or 1... (in Group keys). 

• Pause is Pause:s, where s is the time in seconds paused when restoring the parameters 

• ParameterList is Group:IndexList, which lists parameters belonging to Group. 

• IndexList is a comma separated list, elements of which consist of either Index-Index or Index. The 
hyphen separated notation means a range of indexes. For example, 2-5 means 2,3,4,5. 

Spaces surrounding colon, comma, and hyphen are ignored. 

All parameters must be readable and other than CheckGroup parameters also writeable. 

Note that there is no error checking when reading the restore lists, so editing the lists must be done 
with extra care and the changes should be tested carefully.  

4.1.3 LockParameter 

Unless empty, this is the (Boolean) parameter, which must contain FALSE (0) when restoring 
parameters. 



Advanced Information 

10-14 DriveWindow 2 

4.1.4 CheckGroup 

Contains parameters that are used in checking phase during restoration. In addition to the properties 
always checked, the values of these parameters should be the same both in the drive and the 
parameter file to be downloaded. 

4.1.5 UserGroup 

Contains additional parameters, which are restored when user has selected restoration of User 
Parameters. Parameters other than type string, which are in groups 10...98 and are not pass code 
protected, need not to be listed here, because they are automatically included. 

4.1.6 IdRunGroup 

Contains parameters, which are restored when user has selected restoration of Id Run Result 
Parameters. 

4.1.7 Ordering 

During restore, the Groupn values are handled in order 1...n. Their order in the file does not matter. 

During save, any parameter is put into the save file only once, even if it is not pass code protected and 
appears several times in restore lists. 

4.1.8 Overriding Defaults 

It is not necessary to put into DW2.INI the values already defined as defaults, if only small 
modifications are needed, and you can be sure about the defaults. 

For example, moving 101.3 from User Parameters to Id Run Result Parameters of ACW600 can be 
done by entering the following in the DW2.INI-file. 

[ACW600] 
UserGroupCount=0 
IdRunGroupCount=5 
IdRunrGroup5=101:3 

See Also: What are Parameters and Signals 
How to Save Parameters 
How to Restore Parameters 
Browsing with Pass Code Changes 
Folder Locations 

5. Fast Monitoring 
There are two modes of monitoring: 

• Normal mode 
• Fast mode 

In normal mode you are able, in principle, to monitor any kind of item. The minimum interval in this 
mode is 10 ms. Normal mode is the mode you should almost always use. 

In fast mode you can monitor only drive parameters and signals of type real or integer. The minimum 
interval in this mode is 1 ms. You should avoid using this mode, because it may hang-up you PC 
and/or cause panel losses in drives. 
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Note! Windows is not a real-time operating system. It means that, in practice, even if the 
measurements are done cyclically, they are not done with equal time intervals. Load caused by 
drives in Windows kernel may cause interrupts in measurements in order of hundreds of 
milliseconds. These interrupts can hide the phenomena you are trying to monitor, especially 
when your monitoring interval is small. 

In fast mode DriveOPC uses a lower level communication protocol and may run in a loop while waiting 
responses from a drive, which causes high processor load. Also, the communication throughput in the 
lower level communication is about 1 measurement/millisecond. Thus, if you are monitoring more than 
one channel with interval of 1 ms, for example, the interval is the resolution used in drawing the trends, 
not the actual interval between measurement cycles. 

The following shows the same stepping signal measured on four channels with 1 ms interval. It clearly 
shows the delays caused measurement bottle-neck. It also shows the effect of digital signal settings: 

 

Using fast mode with a remote OPC Server does not make much sense, although it is possible to do it. 
There is not much processor load then, but the actual measurement cycle time may be several 
hundreds of milliseconds because of the intranet (or internet) communication delays. 

See Also: Monitor and Dataloggers 
Setting Monitoring Mode 
Garbage Removal from Monitor Display 

6. Increasing Virtual Memory 
Although the possibility of running out of (virtual) memory is greatest when you are setting size of the 
monitor history buffer or the monitoring interval, it is, in theory, possible while changing any of the 
settings. The setting you are changing is accepted, but the combination of settings cannot be used by 
DriveWindow. 
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When you run out of memory, you get an error message: 

 

You should first try to stop other applications. If it does not help, but you have lot of free hard disk 
space, you can increase the size of the virtual memory, if you really need to collect huge amounts of 
data. 

Note that you need to have administrative right to be able to make changes in virtual memory 
configuration of the operating system. 

Before making any changes into the virtual memory configuration, stop all applications. 

Open the control panel and click System. 
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In System click Advanced system settings. 

 

A System Properties dialog box is presented. Select the Advanced tab and click the Performance 
Settings button. 
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A Performance Options dialog box is presented. Select the Advanced tab and click the Virtual memory 
Change button. 
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A Virtual Memory dialog box is presented. Select the drive, settings of which you want to change. 
Either select System managed size (recommended) or edit Initial Size (MB) and Maximum Size (MB). 
Click the Set button. Repeat for other drives, if you wish. 

Typically paging file size for all drives is managed automatically by system (Automatically manage 
paging file size for all drives is checked). 

Note that selecting No paging file for a drive removes the virtual memory from that drive. When you are 
ready, click the OK button. 

 

If the initial size is too small or there is no paging file, Windows may not be able to make a crash dump. 
You are requested to accept this condition when you click the Set button. 
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When you close the Virtual Memory dialog box by clicking OK, a warning message is shown, which 
tells you that the changes you made require restarting your computer before they take effect. 

 

After you close the System Properties dialog box, a message requesting to restart your computer is 
shown. The changes you made do not take effect until your PC is restarted. Click the Restart Now 
button to restart immediately, click Restart Later, if you want to restart your PC later. 

 

7. Caching 
When a value is displayed on the screen, it is usually not fetched directly from a drive. We will explain 
here the principles of moving data around in DriveWindow and DriveOPC. 

We use here the following OPC terminology: 

• Device is same as drive (control board) 
• Group is a collection of items within DriveOPC. It is not the same as a parameter group in a 

drive. 
• Items within a group can be active or inactive. 
• A group can be active or inactive. For each active group, there is a cyclically running thread 

within DriveOPC. The thread reads the active item values from a device and calls a so called 
advise sink within DriveWindow. This call-back mechanism is used by all on-line activities 
within DriveWindow. 

• Always, when a value is read from or written to a device, it is also cached within DriveOPC. 
• DriveWindow also reads and writes values directly without the call-back. Each read/write 

operation can contain several items. 
• The initial quality of values in the DriveOPC cache is bad. Some items (such as datalogger 

channel buffers) are not automatically read from a device by DriveWindow, and their quality 
stays bad, until the user requests updating of them. 
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In case the local server (EXE) version is used, there are additional threads not shown here for 
simplicity. They are needed because DriveWindow and DriveOPC are running is separate processes 
and thus have separate address spaces. The operating system, however, takes care of thread 
synchronisation. A client thread always waits while the working thread is executing a job for it, so we do 
not lose anything important when we simplify by saying that the client thread does the job. 

The general data flow structure is as follows: 

 

When a thread, whether an internal DriveOPC thread or a DriveWindow thread accesses a device or 
the internal data structures within DriveOPC, access is synchronised by a lock, which allows only one 
thread at a time to handle data. 

This means that a group having huge amount of active items, for example, can block all other access 
for a long time, because all the items are handled before the lock is released. 

7.1.1 Screen Refresh 

In this case there no direct request from the user to change the values on the screen, but the screen 
needs to be redrawn for other reasons (restoring a minimized DriveWindow, for example). The values 
are drawn from the DriveWindow internal cache. The operation is done internally in DriveWindow. 
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7.1.2 Selection Change 

In this case the user changes selection in the browse tree pane, and the item sets pane is 
reconstructed by using the values cached by DriveOPC. Changing selection in the datalogger display 
pane to an already uploaded datalogger works the same way. The operation is done by a DriveWindow 
thread using inactive items. 

 

7.1.3 Update 

In this case the user requests DriveWindow to update the selected items or upload a datalogger, and 
the data is fetched from the device and cached. The operation is done by a DriveWindow thread using 
inactive items. 

 

7.1.4 On-line 

All on-line values (drive status refresh, on-line items in the item sets pane, etc.) are handled the same 
way, but there are several groups and thus several DriveOPC threads handling them. 

There are active groups for the drive status refresh, the drive panel toolbar, the monitor, and for the 
item set currenlty visible in the item sets pane. Groups for other than the currently visible item set are 
not active. 
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The values are read by the DriveOPC thread, which also calls back the advise sink in DriveWindow. 
Within the advise sink, the values are cached, and a message is posted to a DriveWindow thread, 
which then draws the values. 

The on-line items are active in an active group. 

 

7.1.5 Running Monitor 

A running monitor is otherwise handled the same way as all other on-line items, but there is an 
additional measuring buffer within DriveWindow. 
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7.1.6 Paused Monitor 

While a monitor is paused, the data is still collected into the measuring buffer, but the cache within 
DriveWindow is not updated until the monitor is continued. 

 

 

7.1.7 Writing 

Values are always written to the device. The written value is also cached, but quality is marked 
uncertain. 

DriveWindow reads immediately the value back (if it is readable) from the device, so the uncertain 
quality is rarely seen. However, DriveOPC may know some connections between items (control and 
status items, for example), in which writing an item also changes the value of another item. DriveOPC 
does the change internally in its cache, which causes the quality of the other item to be uncertain, too, 
but the immediate read-back by DriveWindow is not done for it. 

The read-back is not shown in the following, but it is done the same way as in update. 

 

7.1.8 Control.Local 

The item Control.Local has a special handling within DriveOPC. Note that not all drives have this 
item. 
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Purpose of the item is to take and release control by DriveWindow. When the value ON is written to the 
item, control is taken. However, many drives have a watchdog, which requires the ON value to be 
refreshed within 10 seconds, otherwise the drive faults with panel loss. 

In addition to writing values normally to the item, DriveOPC internally also writes the ON value, when 
the item is read, with the following logic: 

• The item is read from the device (and cached). 
• If the read value is ON, and 0.5 seconds has elapsed since the ON value was written last 

time, value ON is re-written (and cached with quality uncertain). 

Because DriveOPC internally reads cyclically active items in an active group, a watchdog can be kept 
alive just by locking and putting the item on-line in the item sets pane in DriveWindow. However, if you 
are going to use the drive panel toolbar, which does the same thing when control is taken, we do not 
recommend putting the item on-line in the item sets pane, too. 

The special handling explains, why you often see quality uncertain shown with the item value, when 
control of the drive is taken. 

8. Configuring DDCS Communication 
Sometimes the physical construction of a DDCS network is such that you need to change the 
communication board settings. 

Configuring must be done locally. Configuring remotely is not possible. Change of the settings and its 
user interface is included the communication library of DriveOPC. However, if DriveOPC is configured 
to act as a remote OPC Server, all user interfaces within it are disabled. 

Note that although DriveWindow is used as the client to invoke the communication settings, it can be 
done with any OPC client (WriteOPC included in DriveOPC distribution, for example), which is capable 
of writing to an OPC item. 

To configure the DDCS communication, close all applications, which use DriveOPC. 

If you are configuring a (remote end) PC, which is configured to serve remote clients, you also have to: 

• Make sure that no client will use DriveOPC, while you are configuring the DDCS 
communication. If you cannot do it otherwise, you can disable DCOM by using 
DCOMCNFG.EXE. 

• Edit DWC_DEF.INI in the DriveWare folder of ProgramData and change Remote=1 to 
Remote=0 in the [OPC] section. 

In all cases, you should check DWC_DEF.INI. If it does not have [OPC] section at all, there is no 
Remote key under it, or the value of Remote is zero, it is OK. 

If DriveOPC version is older than 2.03 (DriveWindow 2.01 or older), and the PC has been configured 
by a register change to use the local server (EXE) version of DriveOPC instead of the in-process (DLL) 
version in all cases, you should revoke the register changes, so that the in-process (DLL) version is 
used. 

After these preparations, start DriveWindow and connect to the local DriveOPC. Put drive status 
refresh off-line. 
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Add an item with OPC address Communication.ConfigureDialog into the browsed item set. 

 or  

 

Write the channel number (0, 1, ..), which you want to configure, into the added item. 

 

A DDCS dialog box is presented by the DriveOPC communication library. 

Note! If DriveOPC version is older than 2.03 (DriveWindow 2.01 or older), the user interface of 
DriveWindow (or any other client) may be active. Please do not use it until you have closed the 
dialog box. If you do, you will probably crash the client program. 
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Now you can change link rate, beam intensity, and busy time-out. Please do not change any other 
settings. Click the Save button to save the changes and then the OK button to close the dialog box. 

 

When you click the Save button, DriveOPC communication library always writes the changes into the 
DWC_DEF.INI file in the DriveWare folder of ProgramData. When DriveOPC is restarted, it also 
restarts the communication library, which reads the new settings from DWC_DEF.INI. 

Repeat the writing in DriveWindow, if you want to configure other channels as well. When you are 
done, close DriveWindow. 

Finally, restore back the settings you possibly changed at the beginning of the procedure. 

9. Special Items 
In addition of the browsable items, DriveOPC contains items, which you can use, although they cannot 
be browsed using the DriveWindow browse tree pane, for example. 

We present here some of such items, which we think may be useful for advanced users. You can find 
more information about items (browsable and non-browsable) in “User Manual.pdf” (00073846.DOC) in 
DriveOPC folder, which is a sibling folder of the DriveWindow installation folder. 
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OPC address Type R/W Note 

{c}{a}Par.m.Description string R Description of drive parameter group m. 

{c}{a}Par.m.n.Description string R Description of drive parameter m:n. 

{c}{a}FL.Lm.Description string R Description of fault m. 

{c}{a}FL.Lm.Status string R Status (active or reset) of fault m. 

{c}{a}FL.Lm.Type string R Type (fault or warning) of fault m. 

{c}{a}Mem.Ram.X.0Xaddr unsigned (hex) integer R/W Absolute location in X-memory. 

{c}{a}Mem.Ram.Y.0Xaddr unsigned (hex) integer R/W Absolute location in Y-memory. 

{c}{a}Mem.Ram.P.0Xaddr unsigned (hex) integer R/W Absolute location in P-memory. 

AllowZombies Boolean R/W TRUE allows you to add items of brain-dead 
(or even not existing) drives. 

Communication.Restart Boolean W TRUE restarts the communication. 

Communication.ConfigureDialog integer W The number of the DDCS communication 
channel, which is to be configured. 
Configuring is done by displaying a dialog 
box. Does nothing in case DriveOPC is 
configured to be a remote server 

10. Using Symbol Tables 
Although you have access to the memory of a drive control board by using special items, that method 
is too complex, if you need to access memory locations frequently. 

However, if you have symbol table for the drive application program (.X01) or for the system software 
(.CLD) available, you can use the symbols defined in them to access control board memory locations. 

Note! Neither DriveWindow nor DriveOPC do any checking, whether a symbol table you are using is 
correct version or not. It is up to you to confirm yourself that you are using a correct symbol 
table. 

Note that symbol table files are opened by DriveOPC. It means that using symbol tables remotely is not 
an easy thing, because the opening will be done at the remote end. You need to give a path 
understood by the remote end. However, you can precede the path with a your computer (UNC) name, 
if the remote end has access granted to your computer, the folder, and the symbol table file. 

10.1.1 Application Symbols 

To open an application symbol table, browse in the browse tree pane the Pins sub-branch under the 
Application sub-branch of the drive. 

You can now write to the Pin file (*.x01) in the browsed item set the path and the name of the symbol 
table file. Note that if the file is in the DriveWindow start-in folder (usually the installation folder), you 
can omit the path. 

In case of ACS880 family of drives (native DriveDA OPC server drives) Symbol file (*.xml) is used 
instead of Pin file (*.x01). 
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Instead of writing the path and name of the file, you can also click the browse button in the Pin file 
(*.x01) or Symbol file (*.xml) dialog box. 

 

A dialog box similar to an open dialog box is displayed: 

• From Look in, browse into the drive and folder, in which the symbol table file resides 
• Click the symbol table file you want to open 
• Click Open 

 

Note! You can also enter the name of the symbol table file into File name, with or without a folder 
path. 

Note! You can limit the filenames displayed by entering a wildcard construct into File name and then 
clicking Open. 

Path and name of the file are now shown in the Pin file (*.x01) dialog box. 
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If the file is found, the application constant and PC element structures will appear as sub-branches 
under the Pins sub-branch in the browse tree pane. The name of the file is shown as value of the Pin 
file (*.x01) item in the browsed item set. 

 

If the file could not be opened, you get an error message informing you that writing to pin file item 
failed. 

The pins and constant values are shown in the browsed item set, when you browse to the leaves of the 
sub-branches. 

 

You can close the symbol table file by writing an empty string to the pin file (name) in the browsed item 
set. After closing the file, also collapse the Pins sub-branch by double-clicking it in the browse tree 
pane. 

10.1.2 System Software Symbols 

To open a system software symbol table, browse in the browse tree pane the Ram sub-branch under 
the Memory sub-branch of the drive. 

In case of ACS880 family of drives (native DriveDA OPC server drives) system software symbols are 
not available. 

You can now write to the Memory map file (*.CLD) in the browsed item set the path and the name of 
the symbol table file. Note that if the file is in the DriveWindow start-in folder (usually the installation 
folder), you can omit the path. 

Instead of writing the path and name of the file, you can also click the browse button in the Memory 
map file (*.CLD) dialog box. 
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A the dialog box similar to an open dialog box is displayed: 

• From Look in, browse into the drive and folder, in which the symbol table file resides 
• Click the symbol table file you want to open 
• Click Open 

 

Note! You can also enter the name of the symbol table file into File name, with or without a folder 
path. 

Note! You can limit the filenames displayed by entering a wildcard construct into File name and then 
clicking Open. 

Path and name of the file are now shown in the Memory map file (*.CLD) dialog box. 

 

If the file is found, system software symbols for X-, Y-, and P-memory will appear in sub-branches 
under the corresponding sub-branches of the Ram sub-branch in the browse tree pane. The name of 
the file is shown as value of the Memory map file (*.CLD) item in the browsed item set. 
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If the file could not be opened, you get an error message informing you that writing to memory map file 
item failed. 

For easier handling, the symbols are arranged alphabetically in sub-branches, names of which is the 
same as the first symbol in the sub-branch. 

The symbol values are shown in the browsed item set, when you browse to the leaves of the sub-
branches. 

 

You can close the symbol table file by writing an empty string to the memory map file (name) in the 
browsed item set. After closing the file, also collapse the Ram sub-branch by double-clicking it in the 
browse tree pane. 

10.1.3 Setting the Start-in Folder 

If you do not have the possibility to keep the symbol table file in the default DriveWindow start-in folder 
(the installation folder), but you have a constant place for them, you create or edit DriveWindow 
shortcut, which has your symbol table folder defined as the start-in folder. Just right-click the shortcut 
icon and select properties. 
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Select the Shortcut tab, enter path of your symbol table folder into the Start in field, and click the OK 
button. 

 

When you start DriveWindow using this shortcut icon, you do not need to enter paths for symbol table 
files residing in the specified symbol table folder. 

If you have more than one, but not too many symbol table folders, you can create a separate shortcut 
for each of them, if you wish. 

See Also: Browsing Parameters and Signals 
Changing Parameters 



Advanced Information 

10-34 DriveWindow 2 

11. Garbage Removal from Monitor Display 
With some operating system/display driver/display adapter combination garbage may be seen during 
real time drawing of the monitor trends. Garbage appears especially at the right end of the x-axis. 

 

Because real time drawing must be fast, the background cannot be totally repainted all the time. 
However, a periodic repaint has been added into DriveWindow version 2.12 (and newer), which 
removes possible garbage periodically. 

In older versions of DriveWindow the removal period in milliseconds is determined by the value named 
GarbageRemovalInterval under the user specific key HKEY_CURRENT_USER\Software\ABB 
Oy\DriveWindow\Monitor. If no such value is found the registry, the default value is 500 ms. 

Since DriveWindow version 2.30 the removal period in milliseconds is determined by the value named 
GarbageRemovalInterval within the section named [Monitor] in the user specific DW21.INI file in the 
DriveWare folder of My Documents. 

Note that if x-axis length is greater than 5 times GarbageRemovalInterval, the garbage removal period 
1/5 of the x-axis length is used instead. 

Garbage removal causes some additional processor load. So, if your PC does not have the monitor 
display garbage problem, or if your CPU is slow, you may want to change the removal period. A 
hexadecimal value FFFFFFFF in practice disables the garbage removal. 

Note that any changes you make take effect just when you restart DriveWindow. 

See Also: Monitor and Dataloggers 
Fast Monitoring 

12. Printing and Exporting in XML Format 
Note that this discussion does not concern trends. Printing of trends is done by the graphical drawing 
package and is separate of all other printing within DriveWindow. Also, it is not possible to export 
trends in XML format. 

We assume that you have some knowledge about XML, XSL, XSD, CSS, and MSXML. 

We also assume that you are using common instead of personalized workspace preferences. If you 
are using personalized workspace preferences, DriveWindow uses the user specific DW21.INI in the 
DriveWare folder of My Documents instead of the common DW21.INI in the DriveWare folder of 
ProgramData. 

The reason, why printing and exporting in XML-format are discussed together, is that DriveWindow 
actually exports in XML format even when you request printing. The only difference is that the 
reference to the XSL style sheet file is commented out when you are exporting instead of printing. Also 
the XML file created by printing is temporal and DriveWindow deletes it when it is exiting. 
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When you export, DriveWindow asks the name of the XML file, exports, and the operation is done. 

When you print, the exported temporal XML file is handed over to Internet Explorer (component), which 
uses the XSL style sheet referenced by the XML file to convert XML to HTML, and also does the 
printing (unless otherwise specified in the DW21.INI file). 

 

Note that if you print, you need to have IE 6 (or newer) installed, because it is the first version that uses 
MSXML3, which can do XSL transformations. 

The XML file created by DriveWindow contains reference to the schema definition (XSD), which can be 
used to validate the XML. You need to use MSXML4 or newer to validate the XML. 

However, IE 6 always uses MSXML3, even if you have a newer version of MSXML installed (side by 
side). So, the XML is not validated although the mechanism is there (for future enhancements of IE). 

DriveWindow uses DW21.INI to determine the XSL and optional CSS files to be used for different 
kinds of printing. Normally there is nothing added into DW21.INI, which means that the defaults are 
used. 

See Also: How to Print Parameters 
Printing Item Sets 
Configuring Printing 
Printing Later 
Helper Files and Customising Printing 
Special Printing Features 
Consequences of Modeless Printing 

12.1 Configuring Printing 

Because printing (other than trends) is done by Internet Explorer (used as a component), settings of IE 
affect the print-out of DriveWindow, too. 

• Page Setup is common with IE, except paper orientation, which is always reset when printing 
in DriveWindow. 

• The advanced IE setting “Print Background Colors and Images” affects outlook of printing in 
DriveWindow as well. We recommend that you do print background colors and images with 
DriveWindow. 
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The last mentioned IE setting can be found by selecting Internet Options from the Tools menu, 
selecting the Advanced tab, and browsing for Printing. 
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See Also: Printing and Exporting in XML Format 

12.2 Printing Later 

Printing (other than trends) in DriveWindow is done by using Internet Explorer version 6 (or newer) as 
a component. If you do not have proper components installed, printing (other than trends) is disabled 
(grayed) in DriveWindow. However, it is possible to configure DriveWindow to “print” into a file. The 
generated XML file can be printed later in another computer, in which DriveWindow is capable to print. 

Of course you can print the generated XML file in the same computer, too. 

The actual printing requires that the DriveWindow installation folder (typically 
C:\Program Files\DriveWare\DriveWindow or C:\Program Files (x86)\DriveWare\DriveWindow in a 64-
bit operating system) is the same in both computers, because there are some absolute paths 
referencing the installation folder involved in printing. 

DriveWindow will save the XML file instead of printing it if you add the following lines (do not add 
[Printing] section if it already exists) into DW21.INI. 

[Printing] 

PrintLater=1 
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Note! Be careful not to corrupt the DW21.INI-file because DriveWindow keeps there its internal state 
and reads it without any validation. A corrupted DW21.INI may crash DriveWindow. However, it 
is safe to delete the file, which restores DriveWindow to default settings when it is started. 

To resume normal printing just comment out the line starting with PrintLater= by putting a semicolon in 
beginning of the line. 

If you are using personalized workspace preferences, DriveWindow uses the user specific DW21.INI in 
the DriveWare folder of My Documents instead of the common DW21.INI in the DriveWare folder of 
ProgramData. 

Now, when you print (other than trends), DriveWindow asks you the name of the XML file and skips 
printing. 

 

12.2.1 Printing a Saved File 

Printing an XML file created by DriveWindow when it was configured to print later is done by using 
Internet Explorer version 6 (or newer). You do not need to have DriveWindow running. 

Printing requires that the DriveWindow installation folder (typically 
C:\Program Files\DriveWare\DriveWindow or C:\Program Files (x86)\DriveWare\DriveWindow in a 64-
bit operating system) is the same in the saving and printing computers, because involved in printing 
there are some absolute paths referencing the installation folder. 
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Open in Internet Explorer the XML-file saved by DriveWindow. 
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Internet Explorer shows contents of the file as it will be printed. Select the Print command from the File 
menu of Internet Explorer. 
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Internet Explorer displays the same Print dialog as DriveWindow does when not printing later. Make 
your selections and click the Print button to send the document to the printer. If you click Cancel, 
printing is cancelled. 

 

See Also: Printing and Exporting in XML Format 

12.3 Helper Files and Customising Printing 

When printing (other than trends), DriveWindow generates a temporal XML file, contents of which 
contains just information about the data the user want to print. The XML file is then transformed by 
Internet Explorer (used as a component) using helper files. They control the actual content and style of 
the print-out. 

Some of the helper files can be replaced or added by the user by editing the DW21.INI in the 
DriveWare folder of ProgramData (assuming that you are using common workspace preferences) or in 
the DriveWare folder of My Documents (if you are using personalized workspace preferences). It 
means that an advanced user can customise printing. Detailed customising requires good knowledge 
about XML, XSD, XSL, CSS, HTML, and MSXML and is out of the scope of this document. 

There are four kinds of printing/exporting that use XML: 

• Parameter differences 
• Parameters of drives or an open parameter file 
• Items in an item set 
• Faults and events 
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12.3.1 Temporal filenames 

The temporal files used in printing are created in the temporal folder. 

The temporal folder is defined by the TMP environment variable or, if TMP is not defined, by TEMP 
environment variable, or if TEMP is not defined, the (virtual) windows folder is used as the temporal 
folder. 

The same file is reused for the same kind of printing. The created files are deleted when DriveWindow 
exits. 

Each kind of printing uses a filename of its own. 

Kind of Printing Filename 

Parameter differences ParameterDifferences.xml 

Parameters Parameters.xml 

Items ItemList.xml 

Faults and events EventList.xml 

12.3.2 Schema definitions 

The schema definition (XSD) files, which describe the XML files used in printing and exporting, reside 
in the DriveWindow installation folder. 

Each kind of printing/exporting has a XSD file of its own. All of them reference (include) the file 
common schema DWTypes.xsd, which resides in the same folder. 

Kind of Printing/Exporting Filename 

Parameter differences ParameterDifferences.xsd 

Parameters Parameters.xsd 

Items ItemList.xsd 

Faults and events EventList.xsd 

12.3.3 Cascading style sheets 

The default XSL style sheets create HTML code, which has styles defined within <style> tags in the 
beginning of the document. 

If the XML file does not indicate otherwise, no link to a cascading style sheet (CSS) is made. 

However, it is possible to add or override styles by defining location of an external cascading style 
sheet of your own in the DW21.INI file. 

To tell DriveWindow about your external cascading style sheet, you need to add the following line into a 
section in DW21.INI. 

css=your path\your css file 

Note that full path (with drive) is required. Otherwise IE may not be able to find your CSS file. 
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The section depends on the kind of printing, the cascading style sheet for which you want to add. 

Kind of Printing Section 

Parameter differences [ParameterDifferences] 

Parameters [Parameters] 

Items [ItemList] 

Faults and events [EventList] 

DriveWindow adds information about the external CSS file into the temporal XML file. The default XSL 
style sheet notices the information and creates a link to your CSS file into the HTML code. 

12.3.4 Example of cascading style sheet 

For testing purposes, DriveWindow installation includes an example of an external cascading style 
sheet (CSS) for printing of parameter differences. It changes color, font and size of the first letter of the 
title and color, font, and size of the data presented in the value columns. 

To take the external cascading style sheet (named MyCss.css) into use, you need to add the following 
lines (assuming there is no [ParameterDifferences] section yet) into DW21.INI (assuming that your 
DriveWindow is installed into folder “C:\Program Files\DriveWare\DriveWindow”). 

[ParameterDifferences] 

css=C:\Program Files\DriveWare\DriveWindow\MyCss.css 

Note! Be careful not to corrupt the DW21.INI-file because DriveWindow keeps there its internal state 
and reads it without any validation. A corrupted DW21.INI may crash DriveWindow. However, it 
is safe to delete the file, which restores DriveWindow to default settings when it is started. 

After you have finished with your experiment, just comment out the line starting with css= by putting a 
semicolon in beginning of the line. 

12.3.5 XSL style sheets 

XSL style sheets are used by IE (actually MSXML3) to transform XML to HTML. 

The default XSL style sheet files used in printing reside in the DriveWindow installation folder. 

Each kind of printing has a default XSL file of its own. 

Kind of Printing Filename 

Parameter differences ParameterDifferences.xsl 

Parameters Parameters.xsl 

Items ItemList.xsl 

Faults and events EventList.xsl 

You can use an XSL style sheet file of your own for a certain kind of printing. To tell DriveWindow 
about your XSL style sheet, you need to add the following line into a section in DW21.INI. 

StyleSheet=your path\your xsl file 

Note that full path (with drive) is required. Otherwise IE may not be able to find your XSL style sheet 
file. 
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The section depends on the kind of printing, the XSL style sheet of which you want to change. 

Kind of Printing Section 

Parameter differences [ParameterDifferences] 

Parameters [Parameters] 

Items [ItemList] 

Faults and events [EventList] 

12.3.6 Example of customised XSL style sheet 

For testing purposes, DriveWindow installation includes an example of a customised XSL style sheet 
for printing of parameters. In addition of some text changes, it changes the printing of parameters so 
that only readable parameters in groups 10...99 are included. 

To take the XSL style sheet (named MyStyle.xsl) into use, you need to add the following lines 
(assuming there is no [Parameters] section yet) into DW21.INI (assuming your DriveWindow is 
installed into folder “C:\Program Files\DriveWare\DriveWindow”). 

[Parameters] 

StyleSheet=C:\Program Files\DriveWare\DriveWindow\MyStyle.xsl 

Note! Be careful not to corrupt the DW21.INI-file because DriveWindow keeps there its internal state 
and reads it without any validation. A corrupted DW21.INI may crash DriveWindow. However, it 
is safe to delete the file, which restores DriveWindow to default settings when it is started. 

The MyStyle.xsl style sheet transforms XML file into HTML, which references a file named logo.gif 
without a path. It means that you also need to copy the file logo.gif from the DriveWindow installation 
folder into the temporal folder used in printing. 

The temporal folder is defined by the TMP environment variable or, if TMP is not defined, by TEMP 
environment variable, or if TEMP is not defined, the (virtual) windows folder is used as the temporal 
folder. 

If you do not copy logo.gif, printing is still possible, but the logo is not included in the resulting print-out. 

After you have finished with your experiment, just comment out the line starting with StyleSheet= by 
putting a semicolon in beginning of the line. 

See Also: Printing and Exporting in XML Format 
Special Printing Features 

12.4 Special Printing Features 

There are some special features implemented in DriveWindow printing to help you in testing, if you are 
customizing some print-out. 

The special features are enabled by editing DW21.INI in the DriveWare folder of ProgramData 
(assuming that you are using common workspace preferences) or in the DriveWare folder of My 
Documents (if you are using personalized workspace preferences).. 

Note! Be careful not to corrupt the DW21.INI-file because DriveWindow keeps there its internal state 
and reads it without any validation. A corrupted DW21.INI may crash DriveWindow. However, it 
is safe to delete the file, which restores DriveWindow to default settings when it is started. 

The special features reside in the [Printing] section. Note that enabling the printing later feature 
(PrintLater=1 in the same section) overrides all settings explained here. 
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12.4.1 Hiding the Print dialog 

DriveWindow does not show the Print dialog, if you add the following line into the [Printing] section of 
DW21.INI. 

ShowPrintDialog=0 

After you have finished with your testing, just comment out the line you added by putting a semicolon in 
beginning of it. 

12.4.2 Viewing XML source 

DriveWindow does not print but shows the XML source in Notepad, if you add the following line into the 
[Printing] section of DW21.INI. 

PrintingMethod=0 

After you have finished with your testing, just comment out the line you added by putting a semicolon in 
beginning of it. 

12.4.3 Browser control 

DriveWindow does not print but displays the print-out as a HTML document in a browser like control, if 
you add the following line into the [Printing] section of DW21.INI. 

PrintingMethod=2 

The “minibrowser” has, among other things, commands for previewing and printing the document 
shown. 

 

After you have finished with your testing, just comment out the line you added by putting a semicolon in 
beginning of it. 

See Also: Printing and Exporting in XML Format 
Printing Later 
Helper Files and Customising Printing 
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12.5 Consequences of Modeless Printing 

Printing (other than trends) in DriveWindow is done by using Internet Explorer version 6 (or newer) as 
a component. When printing is started within the IE component, it creates a separate thread for 
handling the printing process. The calling DriveWindow thread continues, which means that you can do 
other operations within DriveWindow while IE is printing. Thus, for example, the dialogs that the 
printing process displays are modeless. This means that you can start a new printing while the 
previous one is still executing, for example. 

DriveWindow is not able to control the printing thread after it has been started. 

Our recommendations about printing are: 

• Let the previous printing finish before starting a new one. 
• Let the printing finish before quitting DriveWindow. 

Have you ever started a new printing in IE while the previous one is still displaying the Print dialog? You 
may have found that clicking the Print or Cancel button of the first dialog cause no action. 

Although we have tried to make DriveWindow to handle such a situation better, it is still possible that 
DriveWindow occasionally has the same behaviour. Thus it is better to let the previous printing finish 
before starting a new printing. 

Have you tried to close IE while a Print dialog is displayed? You may have noticed that IE refuses to 
quit. 

DriveWindow allows you to quit in such a situation, but it wants you to confirm that you really want to do 
that. 

 

We recommend that you finish printing before quitting. If you quit before finishing printing, 
DriveWindow may warn you about a potential deadlock situation, in which DriveWindow stays running 
in the background without any user interface. 
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To get rid of such a deadlock, you either need to log off (as DriveWindow recommends), or kill 
DriveWindow by using Windows Task Manager. 

 

If DriveWindow is not shown in the Task Manager list, quitting DriveWindow did not lead to deadlock 
but normal termination. 

See Also: Printing and Exporting in XML Format 
File Menu 

13. Folder Locations 
Because in Windows Vista/7/8 security has been elevated to higher levels, some file locations have 
been changed in DriveWindow version 2.30 (and newer). The new file locations concern all operating 
systems. 

If you have used DriveWindow version 2.22 or older, some files are still left in your computer after 
uninstalling DriveWindow. However, DriveWindow 2.30 (and newer) will move or copy them to correct 
locations the first time it is started. Copying happens if you do not have privilege to delete the source 
files. 

We recommend that DriveWindow 2.30 is run by an administrator the first time after installation.  
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13.1.1 INI-file Folders 

Since version 2.30 DriveWindow INI-files common for all users are no more kept in the Windows 
folder. Instead, they are located in folder <AllUsersAppData>\DriveWare, typically: 

• Windows 2000/XP: C:\Documents and Settings\All Users\Application Data\DriveWare. 
• Windows Vista/7/8: C:\Program Data\DriveWare. 

Personalized settings, which were earlier kept in registry, are now in DW21.INI located in folder 
<AppData>\DriveWare, typically: 

• Windows 2000/XP: C:\Documents and Settings\{User}\Application Data\DriveWare. 
• Windows Vista/7/8: C:\Users\{User}\AppData\Roaming\DriveWare. 

Note that if you have used DriveWindow version 2.22 or older, DriveWindow 2.30 (and newer) will 
create the personal DW21.INI using the values found in registry the first time it is started. It also 
removes the values from registry.  

13.1.2 Other Folders 

By default, DriveWindow installation folder (<InstallDir>) is <ProgramFiles>\DriveWare\DriveWindow, 
typically C:\Program Files\DriveWare\DriveWindow in a 32-bit operating system and C:\Program Files 
(x86)\DriveWare\DriveWindow in a 64-bit operating system. 

The installation folder can be changed during installation. 

The installation folder contains DriveWindow with its documentation, but not common components. 

DriveOPC utility files and documentation is installed into folder <InstallDir>\..\DriveOPC, typically 
C:\Program Files\DriveWare\DriveOPC in a 32-bit operating system and C:\Program Files 
(x86)\DriveWare\DriveOPC in a 64-bit operating system. 

Common COM components are installed under <CommonFiles>\DriveWare, each into a subfolder of 
its own folder, in a 32-bit operating system typically: 

• C:\Program Files\Common Files\DriveWare\DriveLoader. 
• C:\Program Files\Common Files\DriveWare\DriveOPC. 
• C:\Program Files\Common Files\DriveWare\DWPrintHTML. 
• C:\Program Files\Common Files\DriveWare\OfflineOPC. 

In a 64-bit operating system typically: 

• C:\Program Files (x86)\Common Files\DriveWare\DriveLoader. 
• C:\Program Files (x86)\Common Files\DriveWare\DriveOPC. 
• C:\Program Files (x86)\Common Files\DriveWare\DWPrintHTML. 
• C:\Program Files (x86)\Common Files\DriveWare\OfflineOPC. 
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Communication library consisting of three DLLs (DWC_*.dll), are installed into folder 
<SystemRoot>\System32 in a 32-bit operating system, typically C:\Windows\System32, or 
<SystemRoot>\SysWOW64 in a 64-bit operating system, typically C:\Windows\SysWOW64. 

Driver of the NDPA-02 board (ndpa.sys) is installed into folder <SystemRoot>\System32\drivers 
System32 in a 32-bit operating system, typically C:\Windows\System32\drivers. INF-file for it is 
installed into folder <SystemRoot>\inf, typically C:\Windows\inf. Although they cannot be used in a 64-
bit operating system, the files are installed anyway. However, ndpa.sys is installed into 
<SystemRoot>\SysWOW64\drivers. 

13.1.3 Diagnostic Files 

Diagnostic result files and log files created, when debugging is enabled (enabling of debugging is out of 
scope of this document), will be created into user specific folder <MyDocuments>\DriveWare, typically: 

• Windows 2000/XP: C:\Documents and Settings\{User}\My Documents\DriveWare. 
• Windows Vista: C:\Users\{User}\Documents\DriveWare. 
• Windows 7/8: C:\Users\{User}\My Documents\DriveWare. 

A shortcut to <MyDocuments> can usually be found in the Start menu and/or on desktop. 

13.1.4 Determining Folder Locations 

To determine location of <AllUsersAppData>, start command prompt, type the command Set without 
any parameters. Location is the value of the environment variable ProgramData or 
ALLUSERSAPPDATA. If the variables do not exist, Location is \Application Data appended to the 
value of ALLUSERSPROFILE. 

To determine location of <AppData>, start command prompt, type the command Set without any 
parameters. Location is the value of the environment variable APPDATA. 

To determine location of <ProgramFiles>, start command prompt, type the command Set without any 
parameters. Location is the value of the environment variable ProgramFiles. 

To determine location of <CommonFiles>, start command prompt, type the command Set without any 
parameters. Location is the value of the environment variable CommonProgramFiles. 

To determine location of <SystemRoot>, start command prompt, type the command Set without any 
parameters. Location is the value of the environment variable SystemRoot. 

To determine location of <MyDocuments>, right click My Documents (Documents in Windows Vista) in 
the Windows Explorer, select Properties, and look at Target folder location in the Target tab (in 
Windows 2000/XP) or the location in the Location tab (Windows Vista/7/8). 

To determine location of <InstallDir>, right click DriveWindow in the start menu or its icon on the 
desktop, select Properties, and look at the path in Target of the Shortcut tab. 

See Also: Workspace Preferences 
Configuring Parameter Backup and Restore 
Configuring DDCS Communication 
Garbage Removal from Monitor Display 
Printing and Exporting in XML Format 
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